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IIIOverview of Practical Auditing

Auditing is an independent examination of books of accounts, vouchers, documents, 
and statutory records of an organisation to ascertain whether the financial 
statements represent a true and fair view of the state of affairs of the business 
concern. The scope of the subject Practical Auditing involves examination of the 
system of accounting, checking the accuracy of transactions, verification of the 
assets and liabilities and ensuring the truthfulness and correctness of the items 
in Profit and Loss Account and Balance Sheet with a view to express an opinion 
thereon.

Practical Auditing is an important paper for Commerce students. This book 
explains basic concepts about auditing in a simple and easy to understand manner. 
The subject is explained with a practical approach by means of illustrations. All 
important concepts have been explained in detail with diagrams and flowcharts. 
Further, summarized form of advantages and limitations to important concepts 
has been given to make the students remember and recollect the points easily. 
Computerised Accounting System and Electornic Data Processing audit (EDP) 
has been included into revamped syllabus to ensure more employability for the 
students. At the end of each chapter, summary has been given to give a clear 
understanding to the students. A Glossary of the key terms used in the book is 
given at the end of the book.

This Practical book has been revamped by SCERT in collaboration with 
Tamil Nadu Skill Development Corporation in order to get immediate employment 
opportunities  for the vocational students in the Industrial Sectors in future. The 
skill certificate for practical assessment is given to every student by concerned 
Sector Skill Councils (SSCs) which are accredited by National Skill Development 
Corporation (NSDC) and TNSDC.

OVERVIEW OF PRACTICAL AUDITING
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1Introduction to Audit

•	 Meaning	and	Definition	of	Auditing
•	 Primary	and	Secondary	Objects	of	Auditing
•	 Various	Types	of	Errors	and	Frauds
•	 Advantages	and	Limitations	of	Auditing
•	 Meaning	and	Definition	of	Investigation	
•	 Objectives	of	Investigation
•	 Distinguish	between	Auditing	and	Investigation

Learning Objectives

 1.1  Introduction

In	ancient	days,	the	owners	of	the	business	
verify	their	accounts	by	expert	accountants	
or	 book	 keepers	 to	 detect	 errors	 and	
frauds.	 Even	 the	 Kings	 and	 Zamindars	
used	to	listen	from	the	accounts	regarding	
receipts	and	payments	of	their	kingdom.

At	the	end	of	Fifteenth	Century	due	to	
revival	 in	 Italy,	 there	was	 a	 rapid	 growth	
in	 industry,	 trade	 and	 commerce.	 The	
principle	 of	 double	 entry	 system	 was	
introduced	by	Luca	Pacioli,	a	famous	Italian	
mathematician.	Besides	cash	transactions,	
credit	transactions	are	recorded	in	books,	
as	 a	 result	 complexity	 of	 accounts	 was	
increased.

As	a	 result	of	 Industrial	 revolution	 in	
England	 in	 the	Eighteenth	 century,	 there	
was	a	substantial	increase	in	the	volume	of	
business.	A	rapid	increase	 in	commercial	
activity,	emergence	of	banking,	insurance,	
joint	 stock	 companies	 and	 growing	
activities	 in	 the	 Government	 sector	 led	
the	need	for	audit	of	accounts.

The	 technological	 development,	
globalization	 of	 business,	 complex	
business	environment,	requirement	of	the	
interested	parties	regarding	true	accounts,	
necessity	of	the	government	to	get	audited	
accounts	 for	 different	 purposes	 have	
influenced	 auditing	 to	 be	 used	 as	 a	 fact-
finding	 tool	 and	 have	 caused	 a	 greater	
responsibility	 in	 the	 technique,	 scope,	
professional,	 legal,	 moral	 and	 ethical	
responsibilities	from	the	auditors.

 1.2  Meaning of Auditing

The	term	‘Audit’	is	derived	from	the	Latin	
word,	“Audire”,	which	means,	‘to	hear”.	

Auditing	 is	 a	 detailed	 and	 critical	
examination	 of	 books	 of	 accounts	 and	
support	documents	to	verify	whether	the	
financial	 statements	which	 include	Profit	
and	 Loss	 Account	 and	 Balance	 Sheet	
represent	a	true	and	fair	view	of	the	state	
of	affairs	of	the	business	concern.

It	 is	 the	 verification	 of	 financial	
position	 as	 it	 is	 disclosed	 by	 the	 Balance	

INTRODUCTION TO AUDIT1Chapter



2 Introduction to Audit

whether	 they	 correctly	 and	 completely	
reflect	 the	 transaction	 to	 which	 they	
purport	to	relate”.

•	 Montgomery	defines	the	term	as	“Auditing	
is	a	systematic	examination	of	books	and	
records	of	a	business	or	other	organization	
in	order	to	ascertain	or	verify	and	to	report	
upon	 the	 facts	 regarding	 its	 financial	
operations	and	the	result	thereof”.

The Institute of Chartered Accountants of 
India (ICAI) is regulating the accountancy 
profession in India established under the 
Chartered Accountants Act, 1949 passed 
by the Parliament of India.

A U D I TPROCEDURES

CONTROLS

PLANNING

RISK

METHODS

MANAGEMENT

FACTS

 1.4   Features (or) 
Characteristics of Auditing

1.	 It	 is	 a	 systematic	 and	 independent	
examination	 of	 financial	 information	
of	a	concern.

2.	 Its	main	motive	is	to	detect	errors	and	
frauds	 in	 the	 books	 of	 accounts	 and	
financial	statement.

3.	 It	 is	 conducted	 either	by	 independent	or	
body	 of	 persons	 who	 possess	 in	 depth	
knowledge	 and	 extensive	 practical	
training.

4.	 It	 ensures	 the	 correctness	 of	 Trading,	
Profit	 and	 Loss	 Account	 and	 Balance	
Sheet	 whether	 it	 reflects	 a	 true	 and	
fair	 view	 of	 the	 state	 of	 affairs	 of	 the	
business.

5.	 It	 further	 ensures	 that	 the	 financial	
state	ments	 follow	 the	 accounting	
standards.

Sheet	 and	 the	Profit	 and	Loss	Account.	 It	
is	an	examination	of	accounts	to	ascertain	
whether	 the	 Balance	 Sheet	 and	 the	 Profit	
and	Loss	Account	give	a	true	and	fair	view	
of	financial	position	and	Profit	or	Loss	of	the	
business.	For	this	purpose,	all	the	business	
transactions	 and	 the	 manner	 in	 which	
these	are	recorded	must	be	examined.	

Auditing	is	the	intelligent	and	critical	test	
of	accuracy,	adequacy	and	dependability	of	
accounting	data	and	accounting	statements.	
It	 is	 concerned	 with	 examination	 of	
accounting	data	to	determine	the	extent	of	
accuracy	of	Profit	and	Loss	account	and	the	
Balance	sheet	prepared	from	such	data.	

 1.3    Definition of Auditing

•	 The	Institute of Char tered Accountants 
of India	 describes	 audit	 as	 “the	
independent	 examination	 of	 financial	
information	of	any	entity,	whether	profit	
oriented	or	not,	and	irrespective	of	its	size	
or	legal	form,	when	such	examination	is	
conducted	with	a	view	to	expressing	an	
opinion	there	on”.	

•	 Spicer and Pegler	 defines	 auditing	
as,	 “such	 an	 examination	 of	 books	 of	
accounts	 and	 vouchers	 of	 a	 business	
as	will	enable	 the	auditor	 to	satisfy	 the	
Balance	 Sheet	 is	 properly	drawn	up	 so	
as	to	give	a	true	and	fair	view	of	the	state	
of	 affairs	 of	 the	 business,	 whether	 the	
Profit	and	Loss	account	gives	a	true	and	
fair	 view	 of	 the	 profit	 and	 loss	 for	 the	
financial	period,	according	to	the	best	of	
his	 information	 and	 explanation	 given	
to	 him	 as	 shown	 by	 the	 books,	 and	 if	
not,	in	what	respect	he	is	not	satisfied.”

•	 In	 the	 words	 of L.R.Dicksee,	 “Auditing	
is	 an	 examination	 of	 accounting	 records	
undertaken	 with	 a	 view	 to	 establishing	



3Introduction to Audit

 1.5   Difference Between Accountancy and Auditing

Basis Accountancy Auditing

1.	Meaning It	is	the	process	of	recording,	
classifying,	summarising	and	
interpreting	all	the	financial	
transactions.

It	is	the	process	of	examining	books	
of	accounts	and	reporting	on	the	
financial	statements.

2.	Objectives Its	main	objective	is	to	find	out	
profit	earned	or	loss	suffered	
by	a	company	and	to	show	the	
financial	position	of	the	company	
for	a	particular	period.

Its	main	objective	is	to	examine	
the	correctness	of	the	accounts	and	
financial	statements	and	certify	that	
whether	the	company	exhibits	a	true	
and	fair	view	of	state	of	affairs	of	the	
concern.

3.		Nature	of	
Employment

An	accountant	is	a	permanent	
employee	of	the	organisation.

An	auditor	is	an	independent	
person	and	is	not	an	employee	of	the	
organisation.

4.	Qualification He	should	have	the	knowledge	
of	double	entry	system	of	book	
-keeping		and	principles	and	
concepts	of	accounting.	

An	auditor	should	be	a	qualified	
chartered	accountant	certified	by	the	
Institute	of	Chartered	Accountants	
of	India	for	auditing	joint	stock	
companies.

5.	Reports Accountant	is	not	required	
to	submit	the	report	on	
the	financial	statements	
prepared	by	him.

Auditor	should	submit	the	report	
certifying	the	truth	and	fairness	of	
the	financial	statements.

6.	Remuneration An	accountant	is	
remunerated	in	the	form	of	
salary.

An	auditor	is	remunerated	in	the	
form	of	professional	fees.

7.		Commencement	
of	work

Accountancy	starts	where	
Book-keeping	ends.

Auditing	starts	where	Accountancy	
ends.
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 1.6  Auditor

  1  .6.1 Meaning – Auditor

The	 person	 who	 checks	 the	 accuracy	 of	
the	 books	 of	 accounts	 and	 expresses	 an	
opinion	on	the	financial	statements	of	the	
business	 concern	 is	 called	 as	 an	Auditor.	
The	person	who	is	a	Chartered	Accountant	
holding	 Certificate	 of	 Practice	 from	
the	 Institute	 of	 Chartered	 Accountants	
of	 India	 is	 referred	 to	 as	 an	 Auditor.	
Auditors	 enjoy	 a	 distinctive	 professional	
status	in	the	society	because	of	specialized	
functions	of	auditing.

   1.6.2 Functions of an 
Auditor

The	 following	 are	 the	 functions	 or	 basic	
aspects	to	be	covered	by	the	auditor	in	the	
course	of	audit.	They	are:

1. Examination:	Auditor	should	examine	
the	accounting	system	to	ensure	about	
their	appropriateness.

2. Books:	Check	the	books	of	accounts	to	
ensure	the	arithmetical	accuracy.

3. Evidence:	The	auditor	should	examine	
documentary	 evidence	 to	 support	 the	
entries	in	the	books	of	accounts.

4.	 	Full Inclusion:	Check	whether	all	entries	
in	the	books	of	accounting	have	been	taking	
while	preparing	financial	statements.

5. Properness:	 Examine	 whether	
information	 contained	 in	 financial	
statements	 is	 proper	 and	 it	 does	 not	
contain	any	fraudulent	entry.

6.	 	Verification of Assets and Liabilities: 
Check	 the	 existence,	 valuation	 and	
disclosure	of	all	assets	and	liabilities	in	
financial	statements.

7.	 	Statutory Compliance:	 Verify	 the	
compliance	of	financial	statements	with	
the	relevant	statutory	authorities.

8. Disclosure:	 Examine	 whether	 the	
information	 in	 financial	 statements	 is	
disclosed	 properly	 as	 per	 accounting	
principles.

9.	 	Truth and Fairness:	 Check	 whether	
financial	statements	represent	a	true	and	
fair	view	of	profit	or	loss	and	of	assets	and	
liabilities	of	the	business	concern.

STUDENTS ACTIVITY

Meet	 a	 practicing	 Chartered	
Accountant	 and	 collect	 information	
about	him	and	his	auditing	experience.	
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Who is a Chartered Accountant?

Chartered	Accountant	 is	 a	 person	who	 deals	 with	 the	management	 of	money	 and	

provides	financial	advice.

What work they do?

•	 Financial	 Accounting,	 Auditing,	 Cost	 Accounting,	 Tax	 Management	 and	

Consulting.

•	 Liasioning	 with	 business	 concerns	 and	 provide	 financial	 information	 and	

advice.

•	 Undertaking	 financial	 audits,	 reviewing	 the	 company's	 system	 and	 analysing	

risk.

•	 Guide	and	counsel	business	conerns	to	improve	their	area	of	operation.

Skills required for a Chartered Accountant

•	 General	business	interest

•	 Strong	analytical	and	problem	solving	skills

•	 Strong	communication	and	interpersonal	skills

•	 Self-motivation	and	commitment,	in	order	to	combine	study	while	working.

Education Pathway

Level	I	-	Foundation:	Student	from	any	stream	who	has	appeared	for	XII	Standard	can	

appear	for	the	exam.

Level	 II	 -	 Intermediate:	 Student	who	has	passed	Foundation	or	 any	Graduate	with	

55%	of	marks	is	eligible.

Level	 III	 -	 Final:	 Pass	 in	 Intermediate	 with	 3	 years	 of	 articleship	 training	 with	 a	

practicing	Chartered	Accountant	is	eligible.



6 Introduction to Audit

 1.7   Objectives of Auditing

The	 objective	 of	 an	 audit	 is	 to	 express	
an	 opinion	 on	 financial	 statements.	
The	 auditor	 has	 to	 verify	 the	 financial	
statements	 and	 books	 of	 accounts	 to	

certify	 the	 truth	 and	 fairness	 of	 the	
financial	position	and	operating	results	of	
the	business.	Therefore,	 the	objectives	of	
audit	are	categorized	as	primary	or	main	
objectives	and	secondary	objectives.

E-Resources: 
https://www.icai.org
https://cacourse.net/ca-course-details/
https://www.charteredclub.com
https://superprofs.com

•	 Members	of	the	Institute	of	Chartered	Accountants	of	India	(ICAI)	are	known	as	
Chartered	Accountants.	

•	 ICAI	had	3,27,000	registered	members	as	on	April	2022.
•	 Comptroller	and	Auditor	General	(CAG)	of	India	is	an	authority,	established	by	the	

Constitution	under	Constitution	of	India,	who	audits	all	receipts	and	expenditure	
of	the	Government	of	India	and	the	state	governments.

OBJECTIVES OF  
AUDITING

PRIMARY OBJECTIVE

1.	To	Examine	the	Accuracy	of	Books	
of	Accounts

2.	To	 Express	 Opinion	 on	 Financial	
Statements

SECONDARY OBJECTIVE

1.	Detection	and	Prevention	of	Errors
2.	Detection	and	Prevention	of	Frauds
	

1.7.1 Primary Objectives

The	primary	or	main	objective	of	audit	is	
as	follows:

1.  To Examine the Accuracy of the 
Books of Accounts

An	 auditor	 has	 to	 examine	 the	 accuracy	
of	 the	 books	 of	 accounts,	 vouchers	 and	

other	 records	 to	 certify	 that	 Profit	 and	
Loss	Account	discloses	a	true	and	fair	view	
of	 profit	 or	 loss	 for	 the	 financial	 period	
and	 the	Balance	Sheet	on	a	given	date	 is	
properly	drawn	up	to	exhibit	a	true	and	fair	
view	of	the	state	of	affairs	of	the	business.	
Therefore	the	auditor	should	undertake	the	
following	steps:
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•	 Verify	 the	 arithmetical	 accuracy	 of	
the	books	of	accounts.

•	 Verify	 the	 existence	 and	 value	 of	
assets	and	liabilities	of	the	companies.

•	 Verify	 whether	 all	 the	 statutory	
requirements	 on	 maintaining	
the	 book	 of	 accounts	 has	 been		
complied	with.

Meaning of Books of Accounts
	Books	of	Accounts	mean	the	financial	records	maintained	by	a	business	concern	

for	a	period	of	one	year.	The	period	of	one	year	can	be	either	calendar	year	 i.e.,	
from	 1st	 January	 to	 31st	December	 or	 financial	 year	 i.e.,	 from	 1st	April	 to	 31st	
March.	Usually,	business	concerns	adopt	financial	year	for	accounting	all	business	
transactions.	

	Books	of	accounts	include	the	following:	ledgers,	subsidary	books,	cash	and	other	
account	books	either	in	the	written	form	or	through	print	outs	or	through	electronic	
storage	devices.

2.  To Express Opinion on Financial 
Statements

After	 verifying	 the	 accuracy	 of	 the	 books	
of	 accounts,	 the	 auditor	 should	 express	
his	 expert	 opinion	 on	 the	 truthness	 and	

fairness	of	the	financial	statements.	Finally,	
the	auditor	should	certify	that	the	Profit	and	
Loss	Account	and	Balance	Sheet	represent	
a	true	and	fair	view	of	the	state	of	affairs	of	
the	company	for	a	particular	period.

	Meaning of Financial Statement
Financial	Statement	means	the	statements	prepared	at	the	end	of	the	year	taking	into	
account	the	business	activities	that	took	place	for	a	year,	for	example,	transactions	
that	takes	place	in	a	business	concern	from	1st	April	to	31st	March.	

	Components of Financial Statement
Financial	Statement	includes	the	following:	
1.	 Trading	and	Profit	and	Loss	Account,	and	
2.	 Balance	Sheet.

	Elements of Financial Statements include the following:
1.	 	Assets:	Assets	include	cash	and	bank	balance,	value	of	closing	stock,	debtors,	

bills	receivable,	investments,	fixed	assets,	prepaid	expenses	and	accrued	income.
2.	  Liabilities:	 Liabilities	 include	 capital,	 profit	 and	 loss	 balance,	 creditors,	 bills	

payable,	outstanding	expenses	and	income	received	in	advance.
3.	 	Revenue:	 Revenue	 includes	 sales,	 collection	 from	 debtors,	 rent	 received,	

dividend,	interest	received	and	other	incomes	received.
4.	  Expenditure: Expenditure	 includes	 purchases,	 payment	 to	 creditors,	

manufacturing	 and	 trade	 expenses,	 office	 expenses,	 selling	 and	 distribution	
expenses,	interest	and	dividend	paid.
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1.7.2  Secondary Objectives

The	 secondary	 objectives	 of	 audit	 are:	
Detection	 and	 Prevention	 of	 Errors	 and	
Detection	and	Prevention	of	Frauds.

Detection and Prevention of Errors
The	Institute	of	Chartered	Accountants	of	
India	defines	an	error	as,	“an	unintentional	

TYPES	OF	ERRORS

CLERICAL	ERROR

1.	 Error	of	Omission
2.	Error	of	

Commission

ERROR	OF	
DUPLICATION

ERROR	OF	
COMPENSATION

ERROR	OF	
PRINCIPLE

mistake	in	the	books	of	accounts.”	Errors	
are	 the	 carelessness	 on	 the	 part	 of	 the	
person	 preparing	 the	 books	 of	 accounts	
or	committing	mistakes	 in	the	process	of	
keeping	accounting	records.	Errors	which	
take	 place	 in	 the	 books	 of	 accounts	 and	
the	duty	of	an	auditor	to	locate	such	errors	
are	discussed	below:

1. CLERICAL ERROR
Errors	 that	 are	 committed	 in	 posting,	
totalling	 and	 balancing	 of	 accounts	 are	
called	as	Clerical	Errors.	These	errors	may	
or	 may	 not	 affect	 the	 agreement	 of	 the	
Trial	Balance.

Types of Clerical Errors:
(A)  Errors of Omission:	
When	 a	 transaction	 is	 not	 recorded	 or	
partially	recorded	in	the	books	of	account	
is	 known	 as	 Errors	 of	 Omission.	 Usually,	
it	arises	due	to	the	mistake	of	clerks.	Error	
of	 omission	 can	 occur	 due	 to	 complete	
omission	or	partial	omission.

(1)  Error of Complete Omission:	 When	
a	 transaction	 is	 totally	 or	 completely	
omitted	to	be	recorded	in	the	books	it	is	
called	as	“Error	of	Complete	Omission”.	
It	 will	 not	 affect	 the	 agreement	 of	 the	
Trial	Balance	and	hence	it	is	difficult	to	
detect	such	errors.

Example – 1:	Goods	purchased	on	credit	
from	Mr.	X	on	10.5.2016	for	₹20,500,	not	
recorded	in	Purchases	Book.
Example – 2:	 Goods	 sold	 for	 cash	
to	Ram	 for	₹10,000	 on	 1.7.2016,	 not	
recorded	in	Cash	Book.

(2)  Errors of Partial Omission: When	 a	
transaction	is	partly	recorded,	it	is	called	
as	“Error	of	Partial	Omission”.	Such	kind	
of	errors	can	be	detected	easily	as	it	will	
affect	the	agreement	of	the	Trial	Balance.

Example – 1:	 Credit	 purchase	 from	
Mr.C	 for	 ₹45,000	 on	 10.12.2016,	 is	
entered	in	the	Purchases	Book	but	not	
posted	in	Mr.C’s	account.

Example – 2:	 Cash	 book	 total	 of	
₹1,10,100	 in	 Page	 5	 is	 not	 carried	
forward	to	next	page.
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(B)  Errors of Commission:	
Errors	 which	 are	 not	 supposed	 to	 be	
committed	or	done	by	carelessness	is	called	
as	Error	of	Commission.	Such	errors	arise	
in	the	following	ways:	

(1)	 Error	of	Recording,
(2)	 Error	of	Posting,
(3)	 Error	 of	 casting,	 or	 Error	 of	 Carry-

forward.	
(1)  Error of Recording:	The	error	arises	when	

any	 transaction	 is	 incorrectly	 recorded	
in	the	books	of	original	entry.	This	error	
does	not	affect	the	Trial	Balance.

Example – 1:	Goods	purchased	 from	
Shyam	for	₹1000	wrongly	recorded	in	
Purchases	Day	Book	as	₹100.
Example – 2:	Goods	purchased	 from	
Ram	for	₹1,000,	instead	of	entering	in	
Purchase	Day	 Book	wrongly	 entered	
in	Sales	Day	Book.

(2)  Error of Posting:	 The	 error	 arises	
when	 a	 transaction	 is	 correctly	
journalised	 but	 wrongly	 posted	 in	
ledger	account.

Example – 1:	Rent	paid	to	landlord	
for	₹10,000	on	1.5.2016	 is	wrongly	
posted	 to	 debit	 side	 of	 Repairs	
account	 instead	 of	 debit	 side	 of	
Rent	account.
Example – 2:	 Rent	 paid	 to	 landlord	
for	 ₹10,000	 on	 1.5.2016	 is	 wrongly	
posted	to	credit	side	of	Rent	account	
instead	of	debit	side	of	Rent	account.

(3)  Error of casting, or Error of Carry-
forward:	 The	 error	 arises	 when	 a	

mistake	 is	 committed	 in	 carrying	
forward	 a	 total	 of	 one	 page	 on	 the	
next	page.	This	error	affects	 the	Trial	
Balance.

Example – 1:	 Purchases	 Book	
is	 totalled	 as	 ₹10,000	 instead	 of	
₹1,000.
Example – 2:	Total	of	Purchases	Book	
is	carried	forward	as	₹1,000	instead	of	
₹100.

2. ERROR OF DUPLICATION
Errors	of	duplication	arise	when	an	entry	
in	a	book	of	original	entry	has	been	made	
twice	 and	 has	 also	 been	 posted	 twice.	
These	errors	do	not	affect	 the	agreement	
of	 trial	 balance,	 hence	 it	 can’t	 located	
easily.

Example:	 Amount	 paid	 to	 Anbu,	 a	
creditor	 on	 1.10.2016	 for	 ₹75,000	
wrongly	 accounted	 twice	 to	 Anbu’s	
account.

3.  ERROR OF COMPENSATION (or) 
COMPENSATING ERRORS

When	 one	 error	 on	 debit	 side	 is	
compensated	 by	 another	 entry	 on	 credit	
side	 to	 the	 same	 extent	 is	 called	 as	
Compensating	Error.	They	are	also	called	
as	Off-setting	Errors.	These	errors	do	not	
affect	 the	 agreement	 of	 trial	 balance	 and	
hence	it	cannot	be	located.
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STUDENTS ACTIVITY

Collect	 novelist	 experiences	 about	
errors	 come	 across	 by	 a	 nearby	
Auditor.	

Detection and Prevention of 
Frauds
Fraud	 is	 the	 intentional	 or	 wilful	
misrepresentation	 of	 transactions	 in	 the	
books	of	accounts	by	the	dishonest	employees	
to	 deceive	 somebody.	 Thus	 detection	 and	
prevention	of	fraud	is	of	great	importance	and	
constituents	an	important	duty	of	an	auditor.	
Fraud	can	be	classified	as:

1. MISAPPROPRIATION OF CASH
This	 is	 a	 very	 common	 method	 of	
misappropriation	of	cash	by	the	dishonest	
employees	by	giving	false	representation	in	
the	books	of	accounts	intentionally.	In	order	
to	 detect	 and	 prevent	 misappropriation,	
the	 auditor	 should	 verify	 the	 system	 of	
internal	check	in	operation	and	by	making	
a	 detailed	 examination	 of	 records	 and	
documents.	Cash	may	be	misappropriated	
in	the	following	ways:

(1)	By	omitting	to	enter	cash	which	has	
been	received.

Example:	 A’s	 account	 which	 was	 to	
be	 debited	 for	 ₹5,000	 was	 credited	
as	 ₹5,000	 and	 similarly	 B’s	 account	
which	 was	 to	 be	 credited	 for	 ₹5,000	
was	debited	for	₹5,000.

4. ERROR OF PRINCIPLE
An	 error	 of	 principle	 occurs	 when	 the	
generally	accepted	principles	of	accounting	
are	 not	 followed	 while	 recording	 the	
transactions	in	the	books	of	account.	These	
errors	may	 be	 due	 to	 lack	 of	 knowledge	
on	 accounting	 principles	 and	 concepts.	
Errors	of	principle	do	not	affect	the	trial	
balance	 and	hence	 it	 is	 very	difficult	 for	
an	 auditor	 to	 locate	 such	 type	 of	 errors.

Example – 1:	 Repairs	 to	 Office	
Building	 for	 ₹32,000,	 instead	 of	
debiting	to	repairs	account	is	wrongly	
debited	to	building	account.
Example – 2:	 Freight	 charges	 of	
₹3,000	 paid	 for	 a	 new	 machinery,	
instead	 of	 debiting	 to	 Machinery	
account	 wrongly	 debited	 to	 Freight	
account.

TYPES	OF	FRAUDS

MISAPPROPRIATION	
OF	CASH

MISAPPROPRIATION	
OF	GOODS

MANIPULATION	OF	
ACCOUNTS
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2. MISAPPROPRIATION OF GOODS
Fraud	 which	 takes	 places	 in	 respect	 of	
goods	is	Misappropriation	of	Goods.	Such	
a	 type	 of	 fraud	 is	 difficult	 to	 detect	 and	
usually	 takes	 place	 where	 the	 goods	 are	
less	bulky	and	are	of	high	value.	

•	 By	 showing	 less	 amount	 of	 purchase	
than	 actual	 purchase	 in	 the	 books	 of	
accounts.

•	 By	showing	issue	of	material	more	than	
actual	issue	made.

•	 By	showing	good	materials	as	obsolete	
or	poor	line	of	goods.

•	 By	 showing	 fictitious	 entries	 in	 the	
books	of	accounts.

Example – 1:	Goods	purchased	amounting	
to	 ₹58,000	 is	 wrongly	 accounted	 in	
Purchases	 Book	 as	 ₹50,000.	 Hence,	
showing	 less	 amount	 of	 purchases	 than	
the	 actual	 and	 misappropriating	 goods	
worth	₹8,000.
Example – 2:	 Goods	 issued	 from	
stores	 for	 1000	 units	 is	 wrongly	
accounted	 in	 the	 Ledger	 accounts	 as	
3000	 units	 issued.	 The	 difference	 of	
2000	units	may	be	misappropriated	by	
the	storeskeeper.
Example – 3:	Entries	in	the	Purchases	
Book	may	be	suppressed	or	inflated	to	
show	more	or	less	profit.

Detection	 of	 Misappropriation	 of	
goods	 is	 a	 difficult	 task	 for	 an	 Auditor.	
Only	through	efficient	system	of	inventory	
control,	 periodical	 stock	 verification,	
internal	 check	 system	 and	 adequate	
security	 arrangement	 the	 scope	 for	 such	
frauds	 can	 be	 eliminated	 or	 minimized.	

Example:	Cash	received	on	account	of	
cash	sales	for	₹35,000	is	not	accounted	
in	the	debit	side	of	the	cash	book.

(2)	By	 accounting	 less	 amount	 on	 the	
receipt	 side	of	 cash	book	 than	 the	 actual	
amount	received.

Example:	 Cash	 received	 on	 account	
of	cash	sales	for	₹35,000	is	accounted	
in	 the	debit	 side	of	 the	 cash	book	 as	
₹25,000.	 The	 difference	 of	 ₹10,000	
may	be	defrauded	by	the	cashier.

(3)	By	 recording	 fictitious	 entries	 on	
the	payment	side	of	cash	book.

Example:	 Cash	 book	 is	 credited	 for	
₹44,000	as	amount	paid	to	Mr.X	for	goods	
purchased	on	credit	but	actually	no	amount	
is	 paid.	 Hence,	 cashier	 misappropriates	
₹44,000	of	cash	as	paid	to	Mr.X.

(4)	By	 accounting	 more	 amount	 on	
payments	side	of	cash	book	than	the	actual	
amount	paid.

Example:	 Amount	 paid	 to	Gopal	 for	
₹5,000	is	accounted	on	the	credit	side	
of	cash	book	as	₹15,000.	The	difference	
of	₹10,000	may	 be	 defrauded	 by	 the	
cashier.

(5)	Teeming	and	Lading	of	Fraud	which	
means	cash	received	from	one	customer	is	
misappropriated	 and	 remittance	 received	
from	another	debtor	is	posted	to	the	first	
debtors	account.
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Auditor	 has	 to	 thoroughly	 scrutinize	 the	
inward	 and	 outward	 registers,	 invoices,	
sales	memos,	audit	notes,	etc.,	to	detect	the	
goods-related	frauds.

3. MANIPULATION OF ACCOUNTS
There	 is	 a	 very	 common	 practice	 almost	 in	
every	organization,	some	dishonest	employees	
have	 intention	 to	 commit	 this	 type	 of	 fraud.	
Manipulation	of	accounts	is	the	procedure	to	
alter	books	of	accounts	in	such	a	way	that	there	
will	be	an	increase	or	decrease	in	the	amount	
of	 profit	 to	 achieve	 some	personal	 objectives	
of	the	high	officials.	It	is	very	difficult	for	the	
auditors	to	identify	such	frauds	which	may	be	
due	to	manipulation	of	accounts.	

Causes of Manipulation of Accounts

There	are	different	reasons	for	manipulation	
of	accounts.	The	reasons	are:

•	 To	get	more	commission	calculated	on	
profit

•	 For	evasion	of	income	tax	and	sales	tax
•	 To	 get	 huge	 loan	 from	 financial	

institutions	by	 showing	more	profit	 in	
the	books	of	accounts.

•	 To	 declare	 more	 dividend	 to	 the	
shareholders.

•	 By	 showing	more	profit	 than	actual	 to	
get	confidence	of	the	shareholders.

•	 To	make	secret	reserves	by	showing	less	
income	 or	 by	 showing	more	 expenses	
in	the	books	of	accounts.

STUDENTS ACTIVITY

Collect	 any	 one	 company’s	 details	
which	 involved	 in	 accounting	 frauds	
identified	through	auditing.	

Ways of Manipulation of Accounts

Manipulation	of	accounts	may	be	made	in	
the	following	ways:
•	 By	 showing	 more	 or	 less	 amount	 on	

fixed	assets,
•	 By	 showing	 over	 valuation	 or	 under	

valuation	of	stock,
•	 Over	or	under	valuation	of	liabilities,
•	 Creation	of	over	or	under	provision	for	

depreciation,
•	 Charging	capital	expenditure	as	revenue	

expenditure	or	vice	versa,
•	 By	making	more	 or	 less	 provision	 for	

bad	debts	and	for	outstanding	liabilities,
•	 By	 showing	 advance	 income	 or	

expenditure	in	the	current	year	accounts.

Objectives of Manipulation of Accounts

The	 objectives	 of	 Manipulation	 may	 be	
window	dressing	or	creation	of	secret	reserves.

•	 Window Dressing:	In	window	dressing,	
accounts	 are	 manipulated	 in	 such	 a	
manner	 to	 reveal	 a	 much	 better	 and	
sound	financial	position	of	the	business	
than	 what	 actually	 it	 is,	 in	 order	 to	
mislead	 the	 outsiders	 by	 inflating	 the	
profit.

•	 Secret Reserves:	 Accounts	 are	
prepared	 in	 such	 a	 manner	 that	 they	
disclose	 a	 worse	 financial	 position	
than	 the	 real.	 The	 real	 picture	 of	 the	
business	 is	 concealed	 and	 a	 distorted	
one	is	revealed.

 1.8   Advantages of 
Auditing:

Auditing	 provides	 benefits	 to	 the	
business,	 owners	 and	 to	 the	 outsiders	 in	
the	following	ways:
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4.	 Check on Employees:	When	accounts	
are	audited	it	creates	a	moral	pressure	
on	the	employees	to	be	very	cautious	
and	regular	 in	 their	work,	 as	a	 result	
the	 chances	of	 errors	 and	 frauds	will	
be	minimized.

5.	 Helps in Resolving Disputes: Audited	
accounts	 provides	 a	 basis	 for	 settling	
disputes	and	conflicts	among	the	partners	
in	the	case	of	partnership	firm	and	to	settle	
disputes	with	regard	to	bonus,	wages	etc.	
in	the	case	of	companies.

6.	 Helps in Determination of Claims:	
An	 insurance	company	 settles	 claims	
to	 the	 companies	 for	 the	 loss	 due	 to	
damage	of	business	property	only	on	
the	basis	of	audited	accounts.	

7.	 Helps in Obtaining Loan: Loans	
can	 be	 easily	 borrowed	 from	 banks	

I.  Benefits to the Business
1.	 Exhibits a True and Fair View of the 

Financial Statements:	 Audited	 accounts	
enables	 to	 reveal	 that	 the	 Profit	 and	 Loss	
Account	and	Balance	Sheet	of	the	business	
concern	shows	a	 true	and	 fair	view	of	 the	
state	of	affairs	of	the	business	concern.	

2.	Detection and Prevention of Errors 
and Frauds:	When	 books	 of	 accounts	
are	 audited,	 errors	 and	 frauds	 can	 be	
detected	 and	 necessary	 action	 can	 be	
taken	to	prevent	it.

3.	 Expert Advice:	 Auditors	 who	 possess	
professional	outlook	provide	expert	advice	
to	 the	company	on	various	aspects	such	
as	 tax	 matters,	 internal	 check,	 internal	
control	and	submission	of	various	reports	
to	 the	 statutory	 authorities,	 preparation	
of	project	reports	etc.

ADVANTAGES	OF	
AUDITING

TO	THE	BUSINESS

	 1.	 	Exhibit	a	true	and	fair	view
	 2.	 	Detection	 and	 Prevention	

of	Errors	and	Frauds
	 3.	 Expert	Advice
	 4.	 Check	on	Employees
	 5.	 	Resolving	Disputes
	 6.	 	Determination	of	Claims
	 7.	 	Helps	in	Obtaining	Loan
	 8.	 	Helps	in	Decision-making
	 9.	 	Determining	Future	Trends	
10.	Increases	Goodwill

TO	THE	
OWNERS

1.	 Sole	Proprietors
2.	 Partners
3.	 	Shareholders
4.	 	Trustees	and	

Co-operative	
memmbers

TO	THE	OUTSIDERS

1.	 Creditors
2.	 	Banks	 and	 Financial	

Institutions
3.	 Insurance	Companies
4.	 Statutory	authorities
5.	 Prospective	Investors
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they	 get	 a	 real	 picture	 of	 the	 financial	
position	 of	 the	 company	 and	 that	
directors	and	managing	directors	have	
not	taken	any	undue	advantage	of	their	
position.	

4.	 Benefit to Trust, Co-operative Societies: 
Audit	 of	 accounts	 of	 co-operative	
societies	 and	 Trusts	 provide	 evidence	
that	 the	 interest	of	 the	beneficiaries	and	
members	are	properly	protected.

III.   Benefits to the Third 
Parties

1.	 Bank and Financial Institutions: Banks	
and	 other	 financial	 institutions	 grant	
loan	to	the	business	concern	on	the	basis	
of	audited	financial	statements.

2.	 Creditors: Creditors	 who	 supply	 goods	
to	 the	 business	may	 assess	 the	 solvency	
and	liquidity	position	of	the	business	on	
the	basis	of	audited	accounts.	

3.	 Insurance Companies:	 For	 settlement	
of	 insurance	 claims,	 insurance	
companies can	rely	on	audited	accounts.

4.	Statutory Authorities:	 Statutory	
authorities	 like	 income	 tax,	 sales	
tax,	 wealth	 tax	 etc.	 accept	 audited	
statements	for	determining	the	liability	
which	 arises	 due	 to	 income,	 sales		
and	wealth.

5.	Prospective Investors: Prospective	
investors	who	wish	to	 invest	money	in	
shares	 and	 debentures	 of	 a	 company	
rely	on	audited	accounts.

 1.9   Limitations of  
Auditing

The	 limitations	 or	 disadvantages	 of	
auditing	are	as	follows:

and	 other	 financial	 institutions	 on	
the	 basis	 of	 audited	 accounts,	 as	 the	
audited	 accounts	 authenticate	 the	
truthfulness	of	the	books	of	accounts	
and	financial	statements.

8.	 Helps in Decision-Making: Audited	
accounts	 are	 relied	 upon	 for	 the	
purpose	 of	 decision-making	 by	 the	
management.

9.	 Helps to Determine Future Trends:	
By	 comparing	 the	 audited	 accounts	
with	past	years,	the	trend	of	financial	
activities	 can	 be	 determined.	On	 the	
basis	of	review,	weaknesses	are	found	
out	and	policies	for	the	future	period	
can	be	determined.

10.	 Increase in Goodwill:	 Audit	 of	
business	on	a	regular	basis	increases	
confidence	 to	 the	 interested	 parties	
and	 general	 public,	 as	 a	 result	
goodwill	 of	 the	 business	 can	 be	
enhanced.

II.  Benefits to the Owners 
1.	Benefits to the Sole Proprietors: 

Audited	 accounts	 provide	 assurance	
to	 the	proprietor	about	 the	accuracy	of	
accounts	 maintained	 by	 his	 employees	
and	 also	 enables	 to	 know	 the	 financial	
performance	 of	 the	 business.	 It	 further	
enables	the	proprietor	to	obtain	loan	and	
in	computation	of	income	tax	liability.	

2.	Benefit to the Partners:	 In	 case	 of	
partnership	business,	audited	accounts	
help	 the	 partners	 in	 settlement	 of	
accounts	 among	 the	 partners	 at	 the	
time	of	admission,	retirement	or	in	the	
case	of	death	of	a	partner.	

3.	Benefit to the Shareholders: Share-
holders	are	the	owners	of	the	company.	
With	 the	 help	 of	 audited	 accounts,	
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fair	 view	 of	 the	 financial	 position	 of		
the	business.

4.	No Evaluation of Managerial 
Efficiency:	 An	 Auditor	 is	 not	 an	
advisor,	 therefore,	 he	 cannot	 give	
his	 opinion	 regarding	 managerial	
efficiency	 because	 every	 concern	
has	 its	 own	 policy,	 procedures		
and	practices.

5.	 Not Preventive:	 Audit	 is	 a	 post-mortem	
examination.	The	work	of	audit	starts	after	
the	completion	of	transactions	recorded	in	
the	 books	 of	 accounts.	Therefore,	 audited	
accounts	 can	 prevent	 the	 future	 activities	
but	not	the	past.

 1.10  Investigation

MEANING

Investigation	 is	 a	 detailed	 examination	
of	 accounts	and	enquiry	 into	 the	 state	of	
affairs	 of	 the	 business	 or	 for	 a	 specific	

1.	Gives Opinion:	 After	 the	 completion	
of	 audit,	 an	 auditor	 gives	 only	 the	
opinion	 regarding	 true	 and	 fair	 view	
of	 the	books	of	accounts	and	 financial	
position	 of	 the	 business.	 Therefore,	
an	 auditor	 is	 not	 an	 insurer;	 he	 does	
not	 give	 guarantee	 regarding	 financial	
reflections	of	the	business.

2.	Chances of Undisclosed Errors and 
Frauds:	An	Auditor	has	to	depend	on	
many	 financial	 data	 and	 statements	
supplied	 by	 the	 management	 which	
may	 be	 wrong	 or	 misleading.	
Therefore,	 there	 may	 be	 some	
undisclosed	 errors	 and	 frauds	 in	 the	
books	of	accounts.

3.	Lack of Proper Care and Skill:	Often	
it	 is	 seen	 that	 an	 Auditor	 does	 not	
apply	 proper	 care	 and	 skill	 to	 verify	
the	books	of	 accounts	and	 take	 it	 as	 a	
routine	matter.	 As	 a	 result,	 the	 books	
of	 accounts	 do	 not	 reflect	 true	 and	

Opinion cannot 
be given on 
Managerial 
Efficiency

Lack of 
Proper care 

and skill

Chances of 
Undisclosed 
Errors and  

Frauds

Express Only 
Opinion

No Control 
Over Past 
Activities

DISADVANDAGES
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the	 technical,	 financial	 and	 economic	
position	of	the	organisation”.

OBJECTIVES

The	 following	 are	 the	 objectives	 of	
Investigation:	

1.	To	ascertain	the	financial	position	and	
the	earning	capacity	of	the	concern.

2.	To	investigate	when	fraud	is	suspected	
by	the	proprietor.

3.	To	investigate	on	behalf	of	Income	Tax	
authorities	for	tax	liability.

4.	To	investigate	for	the	purpose	of	lending	
money	to	a	concern.

5.	To	 investigate	 for	 claims	 under	
insurance	policy	covering	losses.

STUDENTS ACTIVITY

Collect	 any	 one	 company’s	 accounts	
investigation	report.

purpose.	 It	 involves	 the	 process	 of	
analysing,	collecting	and	presenting	facts	
in	 a	 manner	 which	 enables	 the	 parties	
to	 know	 the	 essential	 facts	 regarding	
the	 matter	 under	 enquiry.	 Investigation	
covers	more	than	one	financial	period	and	
the	 programme	depends	 on	 each	 type	 of	
investigation.

Example:	 Investigation	 is	 conducted	
in	 deduction	 of	 suspected	 fraud	
and	 theft,	 to	 identify	 causes	 for	
continuous	loss	and	low	productivity	
and	to	evaluate	the	credit	worthiness	
of	business.

DEFINITION
•	 According	 to	 Spicer and Pegler, “The	

term	investigation	implies	an	examination	
of	records	for	some	special	purpose”.	

•	 Taylor and Perry,	 “Investigation	
involves	 and	 enquriy	 into	 the	 fact	
beyond	 the	 books	 of	 accounts	 into	

 1.11  Differences between Auditing and Investigation

The	point	of	difference	between	auditing	and	investigation	can	be	explained	as	follows:	
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S. No.
Basis of 

Difference
Auditing Investigation

1 Meaning	

Auditing	 is	 concerned	 with	
examining	 the	 accounts	
and	 reporting	 on	 financial	
statements.

Investigation	 is	 the	
examination	of	accounts	of	a	
business	for	special	purpose.

2 Objective

The	 objective	 of	 Auditing	 is	
to	 express	 an	 opinion	 on	 the	
financial	 statements	 of	 the	
concern.

Investigation	 is	 done	 for	
some	specific	purpose.

3 Compulsion It	is	compulsory	in	case	of	Joint	
stock	companies. It	is	not	compulsory

4 Period Auditing	 is	 done	 at	 the	 end	 of	
the	financial	year.

Investigation	 can	 be	 done	
over	a	period	of	years.

5 Conduct Audit	is	conducted	on	behalf	of	
the	owners	of	the	company

Investigation	 is	 conducted	
on	 behalf	 of	 outsiders	 and	
owners	at	some	times.

6 Scope It	is	has	a	narrow	scope It	has	a	wide	scope

7 Appointment
An	auditor	 is	appointed	by	the	
shareholders	or	directors	or	by	
Government.

An	investigator	is	appointed	
by	the	outsider.

8
Report Auditor	 has	 to	 give	 a	 report	

about	the	true	and	fair	view	of	
the	final	accounts.

The	 Investigator	 gives	
a	 report	 on	 the	 basis	 of	
conclusion	 and	 enquiries.	
Expression	of	the	opinion	is	
not	necessary.

9 Qualification
Only	 Chartered	 Accountants	
are	 qualified	 to	 conduct	 audit	
of	companies.

An	 investigation	 need	 not	
be	conducted	by	a	Chartered	
Accountant.

10 Process	of	
Work

Investigated	 accounts	 are	 not	
audited	in	ordinary	course.

Generally	 audited	 books	 of	
accounts	 are	 taken	 up	 for	
investigation.
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Auditing - Meaning 
•	 Auditing	 is	 a	 detailed	 and	 critical	 examination	 of	 books	 of	 accounts	 by	 an	

independent	and	qualified	person	to	ascertain	 the	 true	and	fair	view	of	state	of	
affairs	of	the	business.

Advantages of Auditing
•	 Auditing	is	useful	to	owners,	company	and	outsiders.	The	advantages	of	auditing	

include	 detection	 and	 prevention	 of	 errors	 and	 frauds,	weaknesses	 of	 control	
system,	 to	 have	 moral	 check	 on	 employees,	 professional	 advice,	 to	 resolve	
disputes,	insurance	claims,	settle	wages	and	bonus	and	to	determine	tax	amount.

Objectives of Auditing
•	 Objectives	of	auditing	are	classified	as	primary,	secondary	and	other	objectives.	

The	primary	objective	of	an	auditor	 is	 to	examine	 the	accuracy	of	 the	books	of	
accounts	and	to	express	his	opinion	on	the	financial	statements.

•	 The	 secondary	 objective	 of	 auditing	 is	 to	 detect	 errors	 and	 frauds.	 Errors	 are	
unintentional	mistake	 in	 the	 books	 of	 accounts	 and	may	 arise	 in	 the	 following	
ways:	 (1)	 Clerical	 error	 i.e.,	 error	 of	 omission	 and	 commission,	 (2)	 Error	 of	
principle,	(3)	Compensating	error,	and	(4)	Error	of	Duplication.

Fraud
•	 False	representation	or	entries	made	intentionally	in	the	books	to	defraud	somebody	

are	called	as	fraud.	Frauds	take	place	in	the	form	of	(1)	Misappropriation	of	cash,	
(2)	Misappropriation	of	goods,	and	(3)	Manipulation	of	accounts.

Investigation
•	 Investigation	means	 an	 enquiry	 or	 examination	 of	 books	 of	 accounts	 for	 some	

specific	objectives.	It	involves	the	process	of	analysing,	collecting	and	presenting		
facts	in	a	manner	which	enables	the	parties	to	known	the	essential	facts	regarding	
the	matter	under	enquiry.

SUMMARY



19Introduction to Audit

•	 Auditing: It	 is	 a	 detailed	 and	 critical	 examination	 of	 books	 of	 accounts	 by	 an	
independent	 and	qualified	 person	 to	 ascertain	 the	 true	 and	 fair	 view	of	 state	 of	
affairs	of	the	business.

•	 Auditor: The	 person	 who	 checks	 the	 accuracy	 of	 the	 books	 of	 accounts	 and	
expresses	an	opinion	on	the	financial	statements	of	the	business	concern.

•	 Investigation: Investigation	is	a	detailed	examination	of	accounts	and	enquiry	into	
the	state	of	affairs	of	the	business	or	for	a	specific	purpose.

•	 Error: Errors	are	unintentional	mistakes	in	the	books	of	accounts.

•	 Fraud: False	 representation	 or	 entries	 made	 intentionally	 in	 the	 books	 to		
defraud	somebody.

•	 Clerical Error: Errors	 that	are	committed	 in	posting,	 totalling	and	balancing	are	
called	as	Clerical	Errors.

•	 Error of Principle: When	a	transaction	is	recorded	in	contravention	of	accounting	
principles	is	known	as	Error	of	Principle.

•	 Compensating Error: An	error	when	committed	on	debit	side	is	compensated	by	
another	error	on	credit	side	to	the	same	extent	is	called	as	Compensating	Error.

•	 Error of Duplication: Error	of	duplication	arises	when	the transaction	is	recorded	
twice	in	the	books	of	accounts	or	posted	twice	in	the	ledger.

•	 Misappropriation of Cash: Fraud	which	takes	place	by	misappropriating	cash.

•	 Misappropriation of Goods: Fraud	in	respect	of	misappropriating	the	goods.

•	 Manipulation of Accounts: Manipulation	of	accounts	is	the	procedure	to	alter	the	
books	of	accounts	in	such	a	way	that	there	will	be	an	increase	or	decrease	in	the	
amount	of	profit	to	achieve	some	personal	objectives	of	the	high	officials.

•	 Window Dressing: It	 is	manipulating	 the	accounts	with	a	view	to	present	better	
picture	of	the	state	of	financial	affairs	than	the	actual.

•	 Teeming and Lading of Fraud: Teeming	and	Lading	of	Fraud	means	cash	received	
from	 one	 customer	 is	 misappropriated	 and	 remittance	 received	 from	 another	
debtor	is	posted	to	the	first	debtors	account.

KEY TERMS
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I. Multiple Choice Questions

1.	 The	term	“Audire”	literally	means	
____________________________	.
a.	 to	hear
b.	 to	check
c.	 to	prevent
d.	to	inform

2	 The	term	audit	is	derived	from	
	.

a.	 Latin
b.	French
c.	 Greek
d.	Japanese

3	 Primary	object	of	auditing	is	to	
	.

a.	 Detect	fraud
b.	Detect	error
c.	 Prevent	fraud	and	error
d.	Verify	of	accounts	and	statement	

4.	 Transposition	of	figure	is	an	error	of	
	.

a.	 Principle
b.	Omission
c.	 Commission
d.	Compensation

5.	 Incorrect	addition,	wrong	postings	
and	entries	are	errors	of	_________	.
a.	 Commission
b.	Duplication
c.	 Principle
d.	Omission

6.	 Accounts	seem	to	indicate	much	
better	and	sound	financial	position	
of	the	business	enterprises	

	.
a.	 Amortization
b.	Teeming	and	lading
c.	 Secret	reserve
d.	Window	dressing

7.	 The	 wrong	 allocation	 of	 amount	
between	capital	and	revenue	is	an	error	
of	 	.
a.	 Compensation
b.	Principle	
c.	 Commission
d.	Omission

8.	 Fraud	in	respect	of	goods	is	______	
_____________________________	.
a.	Misappropriation	of	cash
b.	Misappropriation	of	goods
c.	Manipulation	of	accounts
d.	All	the	above

9.	 If	 any	 transaction	 is	 recorded	 twice	
in	 the	 books,	 this	 type	 of	 error	 is	

	.
a.	 Compensation	
b.	Principle		
c.	 Duplication			
d.	Commission

 EVALUATION 
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10.	The	effect	of	window	dressing	results	
in	 	.
a.	 Deflating	profit	
b.	 Inflating	profit	

c.	 Deflating	and	inflating	profit		
d.	Curtaining	the	loss.

[Answers: 1.(a),  2.(a),  3.(d),  4.(c),  
5.(a),  6.(d),  7.(b),  8.(b),  9.(c),  10.(b)]

II. Very Short Answer Questions.

1.	What	is	the	literal	meaning	of	“audire”?
2.	Define	Auditing.
3.	What	 are	 the	 primary	 objectives	 of	

Auditing?
4.	What	is	an	Error?

5.	What	is	Fraud?
6.	What	is	Window	dressing?
7.	What	is	Teeming	and	lading?
8.	Define	Investigation.

III. Short Answer Questions.

1.	Enumerate	the	various	clerical	errors.

2.	Who	is	an	Auditor?

3.	What	are	the	disadvantages	of	Auditing?

IV. Essay Type Questions.

1.	What	 are	 the	 differences	 between	
Accountacy	and	Auditing

2.	 Explain	the	various	objectives	of	Auditing.

3.	What	 are	 the	 advantages	 and	
disadvantages	of	Auditing?

4.	Distinguish	 between	 Auditing	 and	
Investigation.
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•	 Classifications	of	Audit
•	 Meaning		and	Advantages	of		an	Audit	of	Sole	Proprietor,	

Partnership	firm	and	Joint	Stock	Company.	
•	 Meaning	and	Advantages	and	Disadvantages	of		Continuos	

Audit,	Occasional	Audit,	Annual	Audit,	Interim	Audit.
•	 Meaning	of	Balance	Sheet	Audit,	Standard	Audit.	
•	 Audit	 of	 Special	 Entities	 like	 Hotel,	 Hospital,	 Education	

Intitutions	and	Cinema Theatres.	
•	 Difference	between	Continuous	Audit	and	Annual	Audit.
•	 Difference	between	Continuous	Audit	and	Interim	Audit

Learning Objectives

 2.1  Introduction
Auditing	is	a	multi-dimensional	and	compre-
hensive	 technique.	 An	 effective	 insight	 into	
the	 nature	 of	 auditing	 can	 be	 obtained	 by	
understanding	 the	 various	 types	 of	 audit,	

which	 together	 constitute	 the	 auditing	
discipline.	 Auditing	 can	 be	 classified	 from	
various		view	points.	In	this	chapter,	the	detailed	
classification	of	audit	will	be	discussed.

 2.2    Classification of Audit

TO BE RECALLED

In	the	previous	Unit	we	have	studied	Meaning,	Definition,	Objectives,	advantages	
and	disadvantages	of	Auditing,	Types	of	Frauds	and	Errors,	Auditor’s	Duty	in	
relation	 to	 Errors	 and	 Frauds,	 Meaning	 and	 Definition	 of	 Investigation	 and	
Difference	between	Auditing	and	Investigation.	

Classification of Audit

Based on 
Organization 
Structure 

A.	Audit	of	Sole	Trader	
B.	Audit	of	partnership	

firm	
C.	Audit	of	Joint	Stock	

Company	

Based on Period 
A.	Continuous	

Audit	
B.	Occasional	

Audit	
C.	Annual	Audit	
D.	Interim	Audit	

Based on Objective 
A.	Standard	Audit	
B.	Balance	Sheet	

Audit	

Based on Functions 
of Special Entities 
A.	Audit	of	Hotel	
B.	Audit	of	Hospital	
C.	Audit	of	Education	

institutions	
D.	Audit	of	Cinema	

Theatres	
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4.  Discovery of Defalcations:	 He	 is	
also	 assured	 of	 not	 being	 defrauded	
by	 any	 of	 his	 employees	 or	 agents,	 as	
the	 defalcations	 are	 discovered	 by		
the	auditor.	

5.  Helps in Comparing Accounts:	 The	
presentation	of	accounts	on	a	uniform	
basis	 helps	 comparison	 of	 various	
classes	 of	 expenditure	 from	 year	 to	
year.	 In	 case	 the	 expenditure	 crosses	
the	 budgeted	 targets,	 causes	 for	 the	
same	may	be	ascertained	and	remedial	
measures	may	be	taken.	

6.  Relied by Statutory Authorities:	
The	 audited	 accounts	 are	 the	 reliable	
document	 for	 income	 tax	 and	 wealth	
tax	purposes.	

7.  Helps in Settlement of Claims:	
Audited	accounts	may	also	facilitate	the	
settlement	of	various	kinds	of	claims.

8.  Moral Check on Employees:	It	enables	
a	 moral	 check	 among	 employees	
especially	among	dishonest	staff.

[B]  Audit Of Partnership Firm
The	 Indian	 Partnership	 Act,	 1932	 does	
not	 require	 audit	 of	 a	 partnership	 firm.	
Considering	the	benefits	of	audit	many	firms	
get	 their	 accounts	 audited	 by	 a	 qualified	
auditor.	 The	 scope	 and	 conduct	 of	 audit	
and	 rights	 and	 duties	 of	 the	 auditors	 are	
determined	 on	 the	 basis	 of	 the	 agreement	
between	 the	 firm	 and	 auditor.	 While	
conducting	 audit	 of	 partnership	 firm	 the	
auditor	must	refer	to	the	deed	of	partnership.			

   Advantages
The	 following	 are	 some	 of	 the	 benefits	 in	
auditing	the	accounts	of	a	partnership	firm:

   2.2.1 Based On 
Organisation Structure

[A] Audit Of Sole Trader
Sole	 Proprietor	 or	 trader	 is	 a	 person	
who	 solely	 owns,	 manages	 and	 controls	
a	 business.	 Sole	 proprietor	 decides	 upon	
auditing	the	accounts	and	decides	upon	the	
scope	of	audit	and	appointment	of	auditor.	
There	 is	 no	 legal	 compulsion	 for	 audit	 of	
accounts	 of	 a	 sole	 proprietor	 but	 usually	
business	 concerns	 get	 audited	 especially	
when	 the	 volume	 of	 transaction	 is	 large.	
Before	conduct	of	audit,	the	auditor	should	
obtain	 an	 agreement	 from	 the	 proprietor	
stating	the	scope,	conduct	and	any	specific	
instructions	of	audit.	The	rights	and	duties	
of	an	auditor	will	depend	upon	the	terms	
of	 agreement	 with	 the	 client.	 In	 future	
when	the	auditor	is	charged	for	negligence,	
he	 can	 protect	 himself	 by	 producing	 the	
agreement	of audit.

   Advantages
The	 sole	 proprietor	 gets	 several	 benefits	
from	audited	accounts;	some	of	them	are	
as	follows:		

1.  Accuracy of Accounts:	 Audited	
accounts	 reveal	 the	 truthness	 and	
correctness	of	transactions	and	provide	
an	assurance	that	accounts	are	properly	
maintained.	

2.  Detection and Prevention of Errors 
and Frauds:	 It	 helps	 in	 detecting	 and	
preventing	 errors	 and	 frauds	 in	 the	
books	of	accounts.	

3.  Provides Assurance of Proper 
Accounting:	The	trader	is	assured	that	
his	incomes	are	properly	accounted	and	
expenditures	are	properly	vouched.
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[C]   Audit Of Joint Stock 
Company

Companies	 formed	 and	 registered	
under	 the	 Companies	 Act,	 1956	 have	 to	
compulsorily	 its	books	of	accounts	as	 the	
owners	(shareholders)	and	the	management	
of	the	company	is	different.	The	company	
auditor’s	 rights,  duties,	 appointment,	
remuneration	 etc.	 are	 governed	 by	 the	
provisions	of	the	Companies	Act.	This	type	
of	audit	is	called	as	Statutory	Audit	and	the	
person	who	conducts	the	audit	is	called	as	
Statutory Auditor.

The	main	objective	of	external	or	statutory	
audit	 is	 to	examine	 the	accuracy	 that	 the	
financial	statements	reflect	a	true	and	fair	
view	of	the	state	of	affairs	of	the	business.	
In	other	words,	 the	company	auditor	has	
to	 verify	 that	 the	 books	 of	 accounts	 and	
certify	 that	 the	 books	 of	 accounts	 and	
financial	statements	exhibit	a	true	and	fair	
view	of	the	state	of	affairs	of	the	business	
concern	 in	 the	 form	 of	 a	 report	 to	 the	
shareholders	of	the	company.	

1.  Proper Maintenance of Accounts:	
When	accounts	are	audited,	it	provides	
an	assurance	that	the	books	of	accounts	
are	maintained	properly	and	 financial	
statements	give	a	true	and	fair	view	of	
state	of	affairs	of	the	business.	

2.  Detection of Errors and Frauds:	 An	
audited	 account	 helps	 in	 quick	 and	
easy	detection	of	errors	and	frauds.	

3.  Easy Settlement of Accounts:	 An	
audited	 account	 helps	 in	 quick	 and	
easy	 detection	 of	 Audited	 accounts	
ensure	easy	settlement	of	accounts	and	
valuation	 of	 goodwill	 on	 retirement,	
death	or	on	admission	of	a	partner.	Audit	
of	 accounts	 is	 advisable	 to	 avoid	 any	
financial	dispute	among	the	partners.	

4.  Grant of Easy Loans and Advances:	
Firm	 can	 obtain	 easy	 loans	 and	
advances	 from	 various	 financial	
institutions	based	on	audited	accounts.	

5.  Taxation Purpose:	 The	 firm	 can	 use	
audited	accounts	for	the	purpose	of	taxation	
or	for	improvements	in	operations.
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transaction	 and	 accuracy	 of	 books	
of accounts.	

2.  Detection and Prevention of Errors 
and Frauds:	 Audit	 helps	 in	 detecting	
and	preventing	both	errors	and	frauds	
and	 also	 exhibits	 a	 true	 and	 fair	 view	
of	state	of	affairs	of	the	company	to	the	
shareholders	who	are	the	owners	of	the	
company.		

3.  Moral Check on the Management:	
Audit	 of	 accounts	 enables	 to	 have	 a	
moral	 check	 on	 the	 management	 in	
order	 to	 protect	 the	 interest	 of	 the	
shareholders.

4.  Safeguards Interest of Shareholders: 
When	 accounts	 are	 audited	 by	 a	
qualified	 auditor,	 the	 interest	 of	 the	
shareholders	 and	 third	 parties	 are	
protected	and	safeguarded	against	any	
frauds	 committed	 by	 the	 directors,	
promoters	or	managers.	

5.  Valuable Suggestions:	 Besides	 the	
above	 advantages,	 auditor	 who	 is	 in	
touch	 with	 the	 company	 operations	
can	provide	valuable	suggestions.

   Preliminaries before 
Conduct of Audit

A	 company	 is	 an	 artificial	 judicial	 person	
and	 has	 separate	 legal	 entity.	 The	 share	
holders	 of	 the	 company	 are	 interested	 to	
know	the	financial	position	of	the	company.	
Hence,	 the	 audit	 of	 books	 of	 accounts	 for	
the	 limited	 company	 is	 compulsory.	 The	
auditor	has	to	produce	a	report	on	the	books	
examined	by	him	and	express	a	true	and	fair	
view	of	the	profit	and	loss	account	prepared	
by	the	client.	Before	commencing	the	audit	
work,	 the	auditor	has	 to	undertake	certain	
preliminary	steps.	They	are:

   Characteristics or  
Features 

1.	 The	 main	 objective	 of	 external	 or	
statutory	 audit	 is	 to	 examine	 the	
accuracy	that	the	financial	statements	
reflect	a	true	and	fair	view	of	the	state	
of	affairs	of	the	business.	

2.	 The	 scope	 of	 work	 is	 determined	 by	
the	 Companies	 Act	 and	 the	 auditor	
possesses	 an	 independent	 status	 and	
the	management	has	no	 control	 over	
the	auditor.		

3.	 Auditor	 should	 be	 a	 qualified	
Chartered	Accountant	as	laid	down	in	
the	provisions	of	the	Companies	Act.	

4.	 Statutory	 auditor	 is	 appointed	 and	
removed	 by	 the	 shareholders	 of	 the	
company.	

5.	 The	 powers	 and	 duties	 of	 statutory	
audit	 are	 determined	 by	 the	
Companies	Act.	

6.	 Statutory	 or	 Company	 auditor	 is	
liable	both	to	shareholders	and	to	the	
third parties.	

7.	 After	 audit	of	 account	of	 a	 company,	
auditor	 has	 to	 submit	 a	 audit	 report	
to	the	shareholders	at	annual	general	
meeting	in	prescribed	format.

8.	 Company	 or	 statutory	 auditor	 is	
responsible	 to	 shareholders	 and	 acts	
as	a	watch-dog	for	the	shareholders.			

   Advantages
The	 following	 are	 the	 advantages	
of	 auditing	 the	 accounts	 of	 a	 Joint	
Stock Company.	

1.  Verification of Accuracy of Books 
of Accounts:	Audit	of	accounts	helps	to	
verify	 the	 correctness	 of	 the	 financial	
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2. Inspection of Documents, Contracts 
and Registers
He	should	obtain	a	certified	list	of	all	the	
books	used	 in	 the	company	and	examine	
the	records,	documents	and	registers	with	
reference	to	the	following:

(a) Memorandum of Association: The	
Memorandum	of	Association	 is	 the	basic	
document	of	the	company.	It	authorizes	a	
company	 to	 engage	 in	 specific	 activities.	
Therefore,	 it	 is	 necessary	 for	 the	 auditor	
to	 examine	 the	 scope	 and	 powers	 of	 the	
company.	

The	auditor	should	have	a	complete	study	
of	 Memorandum	 of	 Association	 in	 the	
following	aspects:

•	 Whether	 the	 transactions	 carried	 by	
the	company	are	subject	 to	the	clauses	
in	 the	 Memorandum	 of	 Association,	
if	not	 the	 transactions	of	 the	company	
become	ultra	vires.

•	 The	 auditor	 has	 to	 check	 the		
share	 capital	 issued	 is	 within	 the	
authorized	capital.

•	 He	 should	 scrutinize	 the	 object	 clause	
and	borrowing	powers	of	the	company.

•	 He	has	to	check	other	provisions,	which	
are	 likely	 to	 affect	 the	 accounts	 of		
the	company.

(b) Articles of Association: The	Articles	
of	 Association	 deals	 with	 rules	 and	
regulations	of	the	internal	management	of	
the	company.	

The	auditor	has	to	examine	the	following	
particulars	in	the	Articles	of	Association:

•	 Issue,	allotment	and	forfeiture	of	shares	
and	declaration	of	dividend.

•	 Examining	the	validity	of	appointment

•	 Inspection	 of	 Documents,	 Contracts	
and	Registers

•	 Other	Information.

   Examining the Validity of 
Appointment

The	 auditor	 has	 to	 check	 that	 his	
appointment	 has	 been	 made	 as	 per	 the	
provisions	 of	 Companies	 Act.	 He	 has	 to	
ensure	 that	 his	 appointment	 has	 been	
validly	 made	 based	 on	 the	 different	
provisions	for	the	appointment	of	auditor	
under	Companies	Act.	

The	 following	 are	 the	 various	
circumstances	of	appointment	of	auditor:

•	 Where	he	 is	appointed	as	 first	auditor,	
get	 a	 copy	 of	 the	 resolution	 by	 the	
directors	about	his	appointment;

•	 Where	 he	 is	 appointed	 in	 the	 place	 of	
retiring	 auditor,	 he	 should	 enquire	 from	
the	 retiring	 auditor	 in	 writing,	 whether	
due	notice	was	given	 to	him	and	also	 the	
circumstances	under	which	he	retired,	and	
also	if	the	retiring	auditor	has	any	objection	
to	 his	 accepting	 the	 appointment.	 Failure	
on	the	part	the	auditor	shall	be	treated	as	a	
breach	of	professional	ethics.

•	 Where	 his	 appointment	 is	 made	 by	
the	 shareholders	 in	 annual	 general	
meeting,	 he	 should	 procure	 a	 copy	 of	
the	 shareholders	 resolution	 regarding	
his	 appointment,	 and	 inform	 the	
Registrar	within	30	days	whether	he	is	
accepting	the	appointment.

•	 Where	 he	 is	 appointed	 in	 a	 casual	
vacancy,	 by	 the	 directors,	 he	 should	
obtain	a	copy	of	the	director's	resolution	
to	this	effect.



27Classification of Audit

of	account,	statistical	and	statutory	books	
maintained	 by	 the	 company.	 Important	
books	are	kept	at	the	Registered	Office	of	
the	company.

(e) Contracts: The	 auditor	 has	 to	 check	
the	date	 of	 agreement	 or	 contracts	made	
by	 the	 company	 with	 other	 parties,	 like,	
vendors,	 underwriters,	 promoters	 or	
brokers	 etc.	 Further,	 the	 auditor	 should	
verify	 whether	 the	 agreements	 are	made	
by	the	authorized	person	of	the	company.	
He	 should	 see	 that	 entries	 relating	 to	
contracts	are	recorded	correctly.

(f) Minutes Books:  Every	 company	 has	
to	 maintain	 a	 book	 in	 order	 to	 record	
the	 proceedings	 in	 the	 general	meetings,	
meetings	 of	 board	 of	 directors	 and	
committee	 of	 the	 board.	 They	 are	 in	 the	
form	of	 a	 bound	note	 book.	The	 auditor	
has	 to	 verify	 that	 the	 chairman	 has	
certified	 the	minute	books	with	date	and	
signature.	The	audit	of	the	Minute	Books	
helps	 the	 auditor	 in	 vouching	 various	
transactions	 e.g.,	 adoption	 of	 the	 annual	
accounts,	 calls	 on	 shares,	 directors	 fees	
and	expenses,	appointment	of	first	auditor	
and	 his	 remuneration	 and	 authorization	
of	capital	expenditure	etc.

(g) Certificate of Incorporation: 
Certificate	 of	 Incorporation	 is	 an	
important	 document	 which	 brings	 the	
private	company	into	legal	existence.	The	
auditor	has	 to	check	that	all	 legal	official	
procedures	 have	 been	 fulfilled	 subject	 to	
the	provisions	of	the	Companies	Act.

(h) Certificate of Commencement of 
Business: A	 public	 company	 has	 to	 get	
Certificate	 of	 Commencement	 of	 business	
before	 it	 commences	 its	 business.	 The	
auditor	 should	 examine	 the	 Certificate	 of	

•	 Appointment	and	removal	of	directors	
and	 officers	 of	 the	 company	 and	 the	
provisions	relating	thereto.

•	 Provisions	 regarding	 meeting	 and	
voting	rights	of	share	holders.

•	 Borrowing	powers	of	company.

•	 Payment	 of	 interest	 on	 capital,	
underwriting	 commission	 and	
brokerage.

•	 The	 auditor	 has	 to	 make	 thorough	
study	of	the	Articles	of	Association	and	
he	has	to	apply	his	skill	and	knowledge	
on	various	transactions	of	the	company.

(c) Prospectus: A	 Prospectus	 is	 an	
invitation	 to	 the	 public	 to	 subscribe	 for	
shares	and	debentures	of	 the	company.	It	
holds	all	the	rules	and	regulations	for	the	
issue	 of	 shares.	 Normally	 all	 the	matters	
which	are	in	the	articles	of	association	are	
also	found	in	the	prospectus.	

The	auditor	should	make	a	detail	study	in	
the	following	matters:

•	 He	 should	 verify	 the	 name,	 addresses,	
remuneration	 of	 directors	 and	 other	
statutory	officers	whose	particulars	are	
specified	in	the	prospectus.

•	 He	 should	 see	 that	 all	 the	 statements	
made	in	the	prospectus	are	true.

•	 He	 should	 examine	 in	 the	 prospectus	
that	the	amount	payable	at	the	time	of	
allotment	and	call.

•	 He	 has	 to	 examine	 that	 any	 material	
contract	made	 by	 the	 company	within	
two	 years	 from	 the	 date	 of	 issue	 of	
prospectus.

(d)  List of Books: Auditor	should	ask	the	
company	to	submit	a	 list	of	all	 the	books	
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obtain	 detailed	 information	 about	 the	
internal	check	and	internal	control	system	
in	 the	 company.	 This	 will	 enable	 him	 to	
identify	 the	 defects	 in	 the	 accounting	
system.	 Further,	 he	 has	 to	 verify	 the	
recommendations,	if	any,	made	in	the	last	
year	audit	report.

   2.2.2 Based on Period

[A] Continuous Audit
Continuous	 audit	 implies	 a	 detailed	
examination	 of	 all	 the	 transactions	 by	
auditor	 continuously	 throughout	 the	
year.	 In	 other	 words,	 when	 the	 accounts	
of	 the	 client	 are	 checked	 continuously	
throughout	the	whole	year	or	at	intervals	
during	 the	 financial	 period	 is	 called	 as	
Continuous	 Audit.	 At	 the	 end	 of	 the	
financial	 period,	 the	 auditor	 checks	 the	
correctness	 of	 the	 financial	 statements	
and	 submits	 a	 report	 without	much	 loss	
of	time.

   Features or Characteristics

1.	 It	 involves	 detailed	 examination	 of	 all	
transactions	by	the	auditor.

2.	The	auditor	visits	the	business	concern	
at	 frequent	 intervals,	 say,	 weekly	 or	
fortnightly	 or	 monthly	 during	 the	
period	of	audit.

3.	Continuous	audit	is	done	simultaneously	
with	the	preparation	of	accounts.

Commencement	 of	 business	 in	 case	 of	 a	
public	company.

(i) Previous Year Balance Sheet, 
Profit and Loss Account and Audit 
Report:	 The  auditor	 has	 to	 verify	 the	
last	 year	 Balance	 Sheet	 and	 ensure	 that	
the	 balances	 are	 correctly	 recorded	 in	
the	 current	 books.	 He	 has	 to	 check	 the	
minute	 book	 of	 the	 share	 holders	 about	
the	 adoption	 of	 the	 accounts.	 Moreover,	
he	 has	 to	 get	 the	 copies	 of	 last	 year’s	
Profit	 and	 Loss	 Account	 and	 Balance	
Sheet	 which	 is	 required	 for	 conduct	 of	
his	 audit	 work.	 He	 should	 ensure	 that	
the	 objections	 or	 qualifications	 raised	 in	
the	previous	audit	 report	have	been	duly	
met	by	 the	company.	He	 should	examine	
the	 Directors	 report	 to	 the	 members	
containing	 the	 recommendations	 of	 the	
Directors	in	respect	of	the	appropriations	
of	profits	made	last	year.	

    Other Informations
(a) System of Accounting: The	 auditor	
has	 to	 study	 the	 accounting	 system	
followed	 in	 the	 company	 and	 has	 to	
observe	the	inefficiencies.

(b) List of Officers: The	 auditor	 has	 to	
obtain	the	 list	of	officers	 in	 the	company	
with	their	specimen	signature.

(c) Evaluation of Internal Check and 
Control System: The	 auditor	 has	 to	

LEGAL DECISIONS 
In	a	case	between	State Steel Trust Co. Vs. Ernst.,	a	client	raised	a	loan	on	the	basis	
of	 audited	 accounts,	 it	was	held	 that	 the	 auditors	duty	of	 reasonable	 care	 and	 skill	
extends	not	only	to	the	client	but	also	to	third	parties	who	relied	on	the	audit	report.	
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5. Detailed Examination:	 As	 the	 auditor	
visits	 his	 clients	 at	 regular	 intervals	
throughout	 the	 year,	 a	 detailed	 and	
exhaustive	checking	of	accounts	is	possible.

6. Preparation of Interim Accounts:	
Continuous	 audit	 helps	 in	 quick	
preparation	 of	 interim	 accounts	 and	
helps	 the	board	of	directors	 to	declare	
interim	dividend.

7. Valuable Suggestions:	 Regular	
visit	 of	 an	 auditor	 helps	 the	 auditor	
to	 understand	 the	 technicalities	 of	
business.	 This	 enables	 the	 auditor	 to	
make	suggestions	for	the	improvement	
of	business.

   Disadvantages

1. Possibility of Alteration:	Records	and	
figures	in	the	books	of	accounts	which	
have	 already	 been	 checked	 by	 the	
auditor	may	 be	 altered	 after	 the	 audit	
is	over.

2. Dislocation of Client’s Work:	 The	
frequent	visit	made	by	the	auditor	may	
dislocate	 the	 work	 of	 his	 client	 and	
cause	inconvenience	to	him.	

3. No Continuity in Work:	In	continuous	
audit,	 the	auditor	conducts	audit	work	
at	 intervals.	Hence	he	 loses	 continuity	

4.	The	 auditor	 is	 constantly	 engaged	 in	
checking	 the	 accuracy	 of	 the	 accounts	
during	the	whole	accounting	period.

5.	At	 the	 end	 of	 the	 financial	 period,	
the	 auditor	 checks	 the	 correctness	 of	
the	 financial	 statements	 and	 submits		
a	report.

   Advantages

1. Easy Detection of Errors and Frauds:	
The	 detailed	 checking	 involved	 in	
continuous	 Audit	 can	 discover	 errors	
and	frauds	easily	and	quickly.

2. Quick Presentation of Accounts:	Since	
the	 accounts	 are	 checked	 throughout	
the	 year,	 it	 is	 possible	 to	 present	 the	
audited	 accounts	 to	 the	 shareholders	
soon	after	the	close	of	the	financial	year.

3. Proper Planning:	 The	 regular	 visits	
performed	 by	 the	 auditor	 makes	 the	
clerk	 alert	 in	 maintaining	 day-to-day	
accounts.	It	also	enables	the	auditor	in	
timely	completion	of	the	audit	work.

4. Moral Check on the Employees:	 As	
the	 auditor	 pays	 surprise	 visits	 to	 the	
business	 in	 continuous	 audit,	 it	 has	
a	 considerable	 moral	 check	 on	 the	
clerks	 as	 they	 are	 not	 aware	when	 the		
auditor	comes.

SUITABILITY OF CONTINOUS AUDIT
•	 When	 final	 accounts	 are	 to	 be	 presented	 immediately	 after	 the	 close	 of	 the		

financial	year.
•	 When	the	volume	of	the	transaction	is	very	large.
•	 When	the	system	of	internal	check	is	not	satisfactory.
•	 When	the	management	insist	the	statement	of	accounts	to	be	presented	at	the	end	

of	every	month	or	quarter.
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makes	 a	 detailed	 or	 random	 check	 of	
the	 transaction	which	has	 taken	place	 in	
the	 books	 of	 accounts	 and	 examines	 the	
correctness	 and	 fairness	 of	 the	 financial	
statements.	This	type	of	audit	is	free	from	
the	defects	of	continuous	audit	and	carries	
other	 advantages	 with	 it,	 but	 detailed	
checking	 is	 not	 possible.	 Hence,	 errors	
and	 frauds	 cannot	 be	 detected	 easily	
and quickly.

   Features or Characteristics

•	 The	auditor	visits	the	clients	only	once	
in	 a	 year	 and	 checks	 the	 accounts	 in	
one	visit.

•	 Auditor	 makes	 a	 detailed	 or	 random	
check	of	the	transactions	and	examines	
the	 correctness	 and	 fairness	 of	 the	
financial	statements.

•	 Detailed	 checking	 is	 not	 possible	 and	
hence	 errors	 and	 frauds	 cannot	 be	
detected	easily	and	quickly.

   Advantages
1. No Inconvenience and Dislocation 

in Work:	 The	 work	 of	 audit	 does	

and	 fails	 to	 seek	 clarifications	 of	 the	
queries	arising	in	the	previous	visit.	

4. Creation of Unhealthy Relationship:	
The	 frequent	 visits	 of	 the	 auditor	may	
establish	 an	 unhealthy	 relationship	
between	him	and	the	clerks.	

5. Expensive:	 It	 is	a	very	expensive	 form	
of	audit.

[B] Occasional Audit
Occasional	audit	is	conducted	as	a	special	
event,	 normally	 in	 those	 organisations	
when	 routine	 audit	 are	 not	 taken	 place.	
For  example,	 audit	 conducted	 in	 a	
partnership	 firm	 on	 admission	 or	 on	
retirement	of	 a	partner.	Occasional	 audit	
is	 also	 performed	 when	 Government	
orders	 for	 a	 special	 audit	 to	 investigate	
into	certain	matters.

[C] Annual or Final Audit
Annual	 or	 final	 audit	 is	 conducted	
after	 closing	 the	 books	 of	 accounts	
and  preparing	 the	 financial	 statements.	
In  such	 a	 case,	 the	 auditor	 visits	 the	
clients  only	 once	 in	 a	 year	 and	 checks	
the	 accounts	 in	 one	 visit.	 The	 auditor	

Summary of Advantages and Disadvantages of Continuous Audit
Advantages Disadvantages

1.	Easy	Detection	of	Errors	and	Frauds 1.	Possibility	of	alteration
2.	Quick	presentation	of	accounts 2.	Dislocation	of	client’s	work
3.	Proper	planning 3.	No	continuity	in	work
4.	Moral	Check	on	the	Employees 4.	Creation	of	unhealthy	relationship
5.	Detailed	examination 5.	Expensive
6.	Preparation	of	interim	accounts
7.	Valuable	suggestion
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not	 present	 any	 inconvenience	
and  dislocation	 in  the	 work	 of	 the	
concern	as	the	auditor	comes	only	once	
in	a	year.

2. Less Expensive:	 Periodical	 audit	
is	 less  expensive	 and	 more	 useful	
for	 small  business	 concern	 than	
continuous audit.

3. Quick Finalisation of Accounts:	 In	
annual	 audit,	 the	 work	 of	 the	 auditor	
can	 be	 finished	 quickly	 and	 within	 a	
reasonable	 time.	 The	 auditor	 ensures	
quick	completion	of	work	in	one	session	
due	to	continuity.

4. No Chance of Collusion:	 There	
is	 no	 undue  collusion	 between	 the	
auditor	 and	 the	 clerk	 as	 in	 the	 case	of	
continuous audit.

5. No Chance of Tampering Books:		
The	 possibility	 of	 tampering	
with  the books	of	 accounts	during  the	
audit  is	 reduced	 as	 the	 audit	
work  starts  only  after	 the	 books	
are closed.

6. Time Effectiveness:	 The	 auditor	
uses	 statistical	 sampling	 methods	
and	 techniques	 which	 lead	 to	 time	
effectiveness.

   Disadvantages

1. Detailed Checking not Possible:	 In	
annual	 audit,	 detailed	 checking	 of	
accounts	is	not	possible	and	hence	there	
are	 chances	 of	 errors	 and	 frauds	 which	
remain	undetected.

2. Delayed Presentation of Audited 
Financial Statement: The	 work	 of	 an	
auditor	 starts	only	 after	 the	 close	of	 the	
financial	period,	therefore	there	is	undue	
delay	in	finalising	the	financial	statements	
and	in	preparing	the	audit	report.	 

3. Difficulty in Fixing Responsibility: 
Another	major	 drawback	 is	 that	 all	 the	
errors	 and	 frauds	 are	 found	 at	 the	 end	
of	 the	 accounting	 year,	 which	 makes	
it	 very	 difficult	 to	 fix	 responsibility	 for	
defalcations.
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4. No Moral Check on Clients Staff:	
There	is	no	sense	of	moral	check	on	the	
employees	in	clients	organisation	as	the	
auditor	 visits	 the	 company	 only	 after	
the	end	of	the	financial	period.

[D]  Interim Audit
Interim	 audit	 is	 an	 audit	 which	 is	
conducted  in	 between	 two	 annual	 audits	
to	 find	 out	 interim	 profits	 to	 enable	 the	
company	 to	declare	 an	 interim	dividend.	
It	 involves	 complete	 and	 detailed	
examination	 of	 transactions	 and	 review	
of	 records	 and	 accounts	 upto	 the	 date	
of	 interim	 audit.	 It	 is	 an	 audit	 which	 is	
conducted	 in	 between	 two	 balance	 sheet	
audits.	 It	 is	 conducted	 for	 a	 specific	
period	with	an	object	of	declaring	interim	
dividend	or	 to	determine	value	of	 shares	
at	a	certain	date.	

   Features or Characteristics

•	 It	 is	 an	 audit	 which	 is	 conducted	 in	
between	 two	 annual	 audits	 i.e.,	 audit	
for	 a	 period	 of	 six	 months	 or	 half	
yearly audit.

•	 It	 involves	 complete	 and	
detailed  examination	 of	 transactions	
and	 accounts	 upto	 the	 date	 of	
interim audit.

•	 It	is	conducted	for	a	specific	period	with	
an	object	of	declaring	interim	dividend	
or	 to	 determine	 value	 of	 shares	 at	 a	
certain	date.	

•	 The	 objective	 of	 conducting	 interim	
audit	 is	 to	 know	 the	 reliability	 and	
accuracy	 of	 financial	 statements	 of	 a	
business	for	a	part	of	the	year.

   Advantages
1. Quick Detection of Errors and Frauds:	

Errors	 and	 frauds	 can	 be	 detected	
quickly	and	easily.

2. Helps in making Improvement:	
It  helps	 the	 management	 to	 assess	
the  financial  position	 of	 business	 for	
part	 of	 a	 year.	 Any	 deficiency	 noticed	
during	 first	 part	 of	 the	 year	 can	 be	
improved	 during	 later	 part	 of	 the	
accounting	year.

3. Helps in Publication of Interim 
Results:	 Interim	 audit	 helps	 in	
finalisation	 of	 interim	 results	 for	 the	
purpose	of	declaring	interim	dividend.

4. Early Completion of Annual Audit:	It	
helps	the	financial	auditor	to	complete	
the	 annual	 audit	 within	 a	 short	
period	 and	 submit	 the	 report	 as	 early	
as possible.

5. Review Internal Control System:	 It	
enables	 the	 external	 auditor	 to	 review	
the	internal	control	system	in	detail	as	
to	their	effectiveness	and	continuity.

6. Moral Check on Clients Staff:	It	helps	
in	 exercising	moral	 check	 on	 the	 staff	
of	the	client.

   Disadvantages
1. Increase in Work load of Audit Staff:	

Interim	 audit	 involves	 finalisation	
of	 accounting	 statements	 for	 some	
specific	period	of	time	which	increases	
the	work	load	of	audit	staffs.

2. Possibility of Alteration of Accounts:	
An	 inherent	 danger	 of	 interim	 audit	
is	 alteration	of	 figures	 that	are	already	
checked	and	finalised.
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3. Erosion of Capital:	Wrong	assessment	
of	profit	may	lead	to	erosion	of	capital	
through	interim	dividend.		

   2.2.3 Based on Objective

[A]  Standard Audit
Standard	Audit	refers	to	detailed	checking	
and	analysis	of	certain	transaction	only	and	
the	 remaining	 transactions	 are	 subjected	
to	 sample	 checking	 provided	 there	 is	 a	
good	 and	 effective	 system	 of	 internal	
check	 in	 operation.	 In	 other	 words,	 it	 is	
a	sample	checking	after	a	satisfactory	and	
detailed	checking	of	some	of	the	items.

It	is	defined	as,	“	a	complete	check	and	
analysis	 of	 certain	 items	 and	 contingent	
upon	 effective	 check,	 an	 appropriate	 test	
check	 on	 remaining	 items,	 the	 whole	 of	
the	work	being	in	accordance	with	general	
audit	 standards	 quite	 adequate	 to	 justify	
an	unqualified	person.”

[B]  Balance Sheet Audit

The	 term	 “Balance	 sheet	 Audit”	 is	 an	
American	contribution.	It	is	more	popular	
in	U.S.A.	It	is	very	rarely	used	in	India	and	
other	countries.	In	balance	sheet	audit,	the	
auditor	 verifies	 the	 balance	 sheet	 items	
such	 as	 capital,	 liabilities,	 reserves	 and	
provisions,	 assets	 and	 other	 items	 given	
in	 the	 balance	 sheet.	 The	 auditor	 checks	
only	 those	 documents,	which	 are	 related	
to	the	items	given	in	the	balance	sheet	and	
does	not	review	other	items	which	are	not	
connected	with	the	Balance	Sheet.	

Although,	 Balance	 Sheet	 Audit	
concentrates	 on	 the	 items	 of	 Balance	
Sheet,	 it	 does	 not	 exclude	 audit	 of	 other	

business	 operations.	 As	 the	 balance	 of	
Profit	and	Loss	Account	itself	is	part	of	the	
Balance	 Sheet,	 it	 will	 invariably	 include	
the	examination	of	 the	 items	recorded	 in	
the	Profit	and	Loss	Account.	 It	 is	 similar	
to	an	annual	audit.	In	India,	no	distinction	
is	made	between	Balance	Sheet	Audit	and	
Annual	Audit.

In	 this	 audit,	 a	 backward	 process	 is	
followed	 to	 audit	 the	balance	 sheet.	First	
the	 item	 is	 located	 in	Balance	Sheet,	 and	
then	 it	 is	 located	 in	 the	 original	 records	
for	the	purpose	of	verification.	This	audit	
is	 based	 on	 the	 assumption	 that	 there	
exists	a	reliable	system	of	internal	control.	
It	 presumes	 that	 auditor	 is	 highly	 skilled	
and	experienced.

   2.2.4 Based on Function of 
Special Entities

[A] Audit of Hotel
1.	Auditor	should	examine	the	formation	

of	establishment	and	check	 the	related	
documents

2.	 He	 should	 verify	 the	 system	 of	 internal	
check	 with	 regard	 to	 cash	 collections,	
payments	 and	 services	 provided	 to	
customers.

3.	He	 should	 check	 that	 cash	 collected	
from  customers	 are	 properly	 recorded	
and	deposited	in	bank	on	the	same	day.

4.	He	should	ensure	that	all	payments	with	
regard	to	wages	and	salaries,	purchase	of	
consumable	stores,	crockery	and	utensils	
are	authorised	by	a	responsible	person.

5.	 He	 should	 ensure	 that	 management	 of	
hotels	 conduct	 physical	 verification	 of	
fixed	assets	and	stores	at	frequent	intervals.
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[B]   Audit of Hospital
1.	 Auditor	should	examine	 the	Trust	Deed	

or	 Constitution	 under	 which	 hospital	
has	 been	 established	 and	 review	 the	
provisions	 and	 laws	 governing	 the	
institution.

2.	He	 should	 verify	 the	 internal	 check	
system	 practised	 in	 the	 hospital	 with	
respect	 to	 patient	 admission,	 billing,	
procurement	 and	 issue	 of	 medicines	
and	equipments.

3.	He	should	check	all	source	of	income	to	
hospital	in	the	form	of	collections	from	
patients,	donations	and	grants	received	
are	properly	accounted.

4.	He	 should	 vouch	 that	 all	 expenses	 in	
the	 form	of	 salaries	and	wages	 to	 staff;	
honorarium	 paid	 to	 specialists	 and	
other	 incidental	 expenses	 are	 recorded	
and	sanctioned	by	an	authorised	person.

5.	He	 should	 ensure	 that	 hospital	
management	 conducts	 physical	
verification	of	stock,	fixed	assets	and	cash	
balance	at	frequent	intervals.

[C]   Audit of Education 
Institutions

1.	Auditor	 should	 verify	 legal	 status	
of	 the	 institution	 by	 examining	 the	
constitution,	 trust	 deed	 or	 charter	 in	
case	of	schools	or	colleges.	

2.	He	 should	 verify	 the	 minutes	 of	 the	
meetings	 of	 managing	 committee	 or	
governing	body	and	resolutions	passed	
in	the	meeting.

3.	He	 should	 evaluate	 the	 efficiency	 of	
internal	check	system	in	operation.

4.	He	should	verify	that	all	cash	collections	
in	 the	 form	 of	 admission	 and	 tutition	

fees;	donations	and	grants	received	from	
Government	 and	 Non-Government	
organisations	are	properly	accounted.

5.	He	 should	 check	 that	 all	 payments	
with	 respect	 to	 expenses	 like	 salaries,	
scholarships,	 purchase	 of	 furniture,	
books	 and	 stationaries	 are	 properly	
recorded	 and	 authorised	 by	 a	
responsible	person.

6.	He	 should	 ensure	 that	 management	 of	
education	institution	at	frequent	interval	
conducts	physical	verification	of	furniture,	
laboratory	and	sports	equipments,	library	
books	and	stationeries.	

[D] Audit of Cinema Theatres
1.	Auditor	should	examine	the	formation	

of	establishment	and	check	 the	related	
documents.

2.	He	 should	 verify	 the	 internal	 control	
system	 with	 respect	 to	 sale	 of	 tickets,	
advance	 booking,	 collection	 from	
advertisement,	canteen,	parking	etc.

3.	He	 should	 check	 that	 all	 incomes	
received	in	the	form	of	collections	from	
sale	 of	 tickets,	 advertisement,	 sale	 of	
refreshments	and	parking	fees	collected	
are	 properly	 accounted	 in	 the	 books	
and	cash	deposited	 in	 the	bank	on	the	
same	day	of	collection.

4.	He	should	check	that	all	payments	with	
regard	 to	 salaries,	 film	hiring	 charges,	
advertisement	 expenses,	 repairs	 and	
maintenance	 charges	 are	 accounted	
and	authorised.

5.	He	 should	 ensure	 that	 management	
of	 cinema	 theatre	 conducts	 physical	
verification	 of	 furniture	 and	 fixtures,	
projector,	generator	and	other	equipments	
at	frequent	intervals.
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2.3    Difference between Continuous Audit and Annual Audit

S.No Basis Continuous Audit Annual Audit

1. Frequency	of	
Auditors	Visit

In	case	of	Continuous	
Audit,	auditor	frequently	
visits	and	checks	the	
accounts	of	the	business.

In	case	of	Annual	Audit,	
auditors	visits	the	business	only	
once	after	the	close	of	the	year.

2. Conduct	of	
Audit

Audit	is	conducted	
periodically	throughout	the	
financial	year.

Audit	is	commenced	only	after	
the	close	of	the	financial	year.

3. Regularity	of	
Audit	Staff

Client’s	staff	becomes	more	
efficient	and	regular.

It	may	not	be	so	because	client’s	
staff	knows	well	that	audit	work	
will	start	only	after	the	close	of	
financial	year.

4. Verification	of	
Transactions

Each	and	every	transaction	
is	verified	immediately	after	
it	is	recorded.	

Audit	staff	checks	and	verifies	
the	transactions	only	after	the	
close	of	the	year.

5. Cost	involved	
in	the	Audit

It	is	very	much	expensive It	is	less	expensive	and	
economical.	

 2.4    Difference between Continuous Audit and Interim Audit

Basis Continuous Audit Interim Audit

1.	Objective The	main	object	is	to	detect	
errors	and	frauds.

The	main	object	is	to	determine	
the	profit	or	loss	for	the	purpose	
of	declaration	of	dividend	to	
shareholders.

2.		Duration	 of	
Audit

Audit	is	conducted	up	to	
any	date	according	to	the	
convenience	of	the	auditor	and	
his	clients.

Audit	work	is	done	up	to	a	definite	
ate	according	to	the	instructions	of	
the	client.

3.		Preparation	
of	Trial	
Balance

Trial	balance	is	not	prepared	
but	the	totals	of	certain	
accounts	are	noted.

Trial	Balance	must	be	prepared	at	
the	end	of	the	period.

4.		Verification	
of	assets	and		
liabilities

Assets	and	liabilities	are	
verified	after	the	preparation	
of	the	balance	sheet	at	the	end	
of	the	accounting	year.

Assets	and	liabilities	are	verified	
when	the	audit	work	is	conducted.
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•	 Audit of sole propreietor:	 Sole	 Proprietor	 or	 trader	 is	 a	 person	 who	 solely	
owns,	manages	and	controls	a	business.	Sole	proprietor	decides	upon	auditing	
the	accounts	and	decides	upon	the	scope	of	audit	and	appointment	of	auditor.	
There	is	no	legal	compulsion.

•	 Audit of partnership firm:	The	Indian	Partnership	Act,	1932	does	not	require	
audit	of	a	partnership	firm.	Considering	the	benefits	of	audit	many	firms	get	their	
accounts	audited	by	a	qualified	auditor.	While	conducting	audit	of	partnership	firm	
the	auditor	must	refer	to	the	deed	of	partnership.

•	 Audit of joint stock company:	 Companies	 formed	 and	 registered	under	 the	
Companies	Act,	1956	have	to	compulsorily	its	books	of	accounts	as	the	owners	
(shareholders)	and	the	management	of	the	company	is	different.	The	company	
auditor’s	 rights,  duties,	 appointment,	 remuneration	 etc.	 are	 governed	 by	 the	
provisions	of	the	Companies	Act.

•	 Continuous Audit:	 Continuous	 audit	 implies	 a	 detailed	 examination	 of	 all	
the	 transactions	by	Auditor	 continuously	 throughout	 the	 year.	At	 the	 end	of	
financial	period,	the	auditor	checks	the	financial	accounts.

•	 Annual or final audit:	 Annual	 or	 Periodical	 audit	 is	 done	 at	 the	 close	 of	
financial	period	after	the	final	accounts	are	prepared.	

•	 Interim Audit: Interim	audit	is	conducted	between	two	annual	audits	to	find	
out	interim	profits	to	enable	the	company	to	declare	an	interim	dividend.	

•	 Occasional Audit:	Occasional	audit	is	conducted	as	a	special	event,	normally	
in	those	organisations	when	routine	audit	are	not	taken	place.

•	 Standard Audit: Standard	Audit	refers	to	detailed	checking	and	analysis	of	certain	
transaction	only	and	the	remaining	transactions	are	subjected	to	sample	checking	
provided	there	is	a	good	and	effective	system	of	internal	check	in operation.

•	 Balance Sheet Audit:	 Auditor	 verifies	 the	 balance	 sheet	 items	 such	 as	
capital, liabilities,	reserves	and	provisions,	assets	and	other	items	given	in	the	
balance	sheet.

KEY TERMS

The	present	unit	discussed	about	the	introduction	to	Audit,	types	of	audit	with	their	
advantages	and	disadvantages.	It	also	presented	the	differences	between	Continuous	
Audit	and	Annual	Audit	and	Interim	Audit	and	Continuous	Audit.

SUMMARY / POINTS TO BE REMEMBERED:
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I. Multiple Choice Questions:

1.	 Audit	 is	 compulsory	 for	
___________________.
a.	 Sole	proprietor
b.	Partnership	firm
c.	 Joint	Stock	Company
d.	Special	

2.	 All	 the	 transactions	 verified	 by	 the	
auditor	continuously	throughout	the	
year	is	_____________________________
a.	 Interim	audit
b.	Continuous	audit	
c.	 Balance	sheet	audit	
d.	Special	audit

3.	 ___________________	 audit	 helps	 in	
settlement	of	claims	and	in	resolving	
disputes	among	partners.
a.	 Sole	proprietor
b.	Partnership	firm
c.	 Joint	Stock	Company
d.	Trust

4.	 ___________________	 is	 a	 person	 who	
individually	 owns,	 manages	 and	
controls	the	business	entity.
a.	 Sole	proprietor
b.	Partner
c.	 Directors
d.	Trustee

5.	 audit	 is	 done	 at	 the	 close	
of	 the	 finance	 year	 is	 called	
_____________________________
a.	 annual	audit
b.	Continuous	audit	

c.	 Balance	sheet	audit
d.		Special	audit

6.	 periodical	 audit	 is	 called	
___________________
a.	 Special	audit
b.	Continuous	audit	
c.	 Balance	sheet	audit
d.		annual	audit

7.	 audit	 conducted	 in	 between	
two	 annual	 audit	 is	 callled	 	 as	
_____________________________
a.	 Balance	sheet	audit
b.	Continuous	audit	
c.	 Interim	audit
d.	Annual	audit

8.	 the	 term	 balance	 sheet	 audit	
is___________________contribution
a.	 India
b.	China
c.	 England
d.	America

9.	 ___________________is	 suitable	 in	 case	
of	 small	 business	 concerns	 where	
there	are	only	limited	transactions.
a.	 Continuous	audit
b.	Annual	audit
c.	 Interim	audit
d.	Occasional	audit

 EVALUATION 
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10.	 ___________________	 is	 	 the	 basic	
document	of	the	company.	
a.	 Partnership	Deed
b.	Memorudum	Of	Association

c.	 Articles	Of	Association
d.	Trust	Deed

II. Very Short answer Questions

1.	What	are	the	different	kinds	of	Audit?

2.	What	is	meant	by	Continuous	Audit?
3.	What	is	Annual	Audit?
4.	 State	 the	 purpose	 of	 conducting	

Interim	Audit?

5.	What	is	Balance	sheet	Audit?
6.	Who	is	a	Sole	proprietor?
7.	Why	 audit	 of	 Joint	 Stock	 Companies	

made	compulsory?

III. Short answer Questions

1.	 State	the	features	of	Continuous	audit?

2.	 Summarise	the	benefits	and	drawbacks	
of	Annual	audit?

3.	Explain	 the	 scope	 and	 characteristics	
of	Interim	audit?

4.	What	 are	 the	 disadvantages	 of		
Interim	Audit?

5.	What	 are	 the	 advantages	 of	 auditing	
the	accounts	of	a	Sole	proprietor?

6.	Explain	 briefly	 as	 how	 an	 auditor	
verifies	his	appointment.

IV. Essay Type Questions.

1.	Explain	 briefly	 the	 various	 kinds		
of	Audit?

2.	What	 do	 you	 understand	 by	
Continuous	 Audit?	 Explain	 its	
advantages	and	disadvantages.

3.	What	do	you	understand	by	the	term	
Annual	 Audit?	 State	 the	 advantages	
and	disadvantages.

4.	What	 do	 you	 understand	 by	 Interim	
Audit?	Discuss	its	merits	and	demerits.

5.	Write	 explanatory	 note	 on:	
(a)	 Balance	 sheet	 Audit	
(b)	Standard	Audit

6.	Write	an	explanatory	note	on	the	audit	
of	specific	entities.

7.	Distinguish	between	Continuous	audit	
and	Annual	or	Periodical	audit.

8.	Bring	 out	 the	 differences	 between	
Interim	audit	and	Continuous	audit.

9.	What	 are	 the	 advantages	 of	 auditing	
the	accounts	of	a	partnership	firm?

10.	Discuss	 the	 principal	 objects	 of	
audit	 of	 accounts	 of	 the	 following:	
(a)	 Partnership	 firm	 (b)	 Joint	 Stock	
company	(c)	Sole	proprietor

[Answers: 1.(c),  2.(b),  3.(b),  4.(a),  5.(a),  6.(d),  7.(c),  8.(d),  9.(b),  10.(b)  



39Classification of Audit

References
1.	Practical	Auditing	–	Dr.G.Anitha	&	Dr.J.Sankari,	Sai	Selva	Publishers	Distributors.
2.	Practical	Auditing	–	Dr.Radha,	Prasanna	Publishers	&	Distributors
3.	uditing	Principles	and	Practices	–	Pradeepkumar,	Baldev	Sachdeva	&	Jagwant	Singh,	

Kalyani	Publishers.
4.	Principles	and	Practice	of	Auditing	-	Dinkar	Pagare,	Sultan	Chand	&	Sons.
5.	Practical	Auditing	-	K.Sundar	&	K.Pari.

11.	Write	 a	 short	 note	 on:	 (a)	 Audit	 of	
partnership	 firm,	 (b)	 Audit	 of	 Joint	
Stock	Company.	

12.	Briefly	explain	the	benefits	of	auditing	
the	accounts	of	a	Joint	Stock	company.

13.	“An	auditor	is	expected	to	study	various	
documents	 before	 commencing	 an	
audit	of	a	company”	-	Discuss.

14.	Explain	 the	 general	 procedure	 and	
preparation	of	an	audit.



•	 To	 understand	 the	 meaning,	 benefits	 and	 factors	 af-
fecting	audit		planning.

•	 To	 understand	 the	 meaning,	 features,	 objectives,	 con-
tents,	advantages	and	disadvantages	of	audit	programme.

•	 To	understand	 the	meaning,	 advantages	 and	disadvan-
tages	of	auditing	in-depth.

•	 To	understand	 the	meaning,	 applicability,	 factors	 to	be	
considered,		advantages	and	disadvantages	of	test	check-
ing.

•	 To	understand	the	auditor’s	duty	regarding	test	checking.

Chapter AUDIT PLANNING 

 3.1  Audit Planning 

  3.1.1 Introduction

An	 audit	 is	 a	 professional	 service	 to	 a	
client.	The	review	of	accounting,	financial	
and	 other	 operations	 form	 a	 basis	 of	
such	 service.	 Before	 commencing	 audit,	
an	 auditor	 must	 prepare	 himself	 well.	
Preparation	 for	 an	 audit	 relates	 to	 audit	
planning,	 preliminary	 preparations	 by	
the	 auditor,	 audit	 programme,	 audit	
note	 book,	 audit	 working	 papers,	 audit	
evidence,	commencement	of	a	new	audit,	
test	checking,	and	routine	checking.	

   3.1.2 Meaning of Audit 
Planning

Planning	is	required	to	complete	the	audit	
effectively	within	the	specified	time.	Audit	
planning	is	a	process	of	deciding	in	advance	
what	is	to	be	done,	who	is	to	do	it,	how	it	
is	to	be	done	and	when	it	is	to	be	done	by	
the	 auditor	 in	 order	 to	 have	 efficient	 and	
effective	completion	of	work.

Audit	planning	can	be	done	only	when,	the	
auditor	is	having	knowledge	of	the	business	
of	the	client.	It	helps	in	accomplishment	of	
objectives	of	audit	and	enables	the	auditor	

Learning Objectives
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TO BE RECALLED

In	the	previous	lesson,	we	have	studied	meaning,	features,	advantages	and	
disadvantages	of	various	types	of	audit.

40 Audit Planning
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•	 Size	 of	 the	 company	 and	 nature	 of	 its	
operations.

•	 Accounting	 system,	 internal	 control	
and	adherence	to	standard.

•	 Environment	 in	 which	 the	 company	
operates.

•	 Previous	experience	with	the	client;	and
•	 Knowledge	of	client’s	business.

 3.2  Audit Programme

  3.2.1 Meaning

An	 audit	 programme	 is	 a	 detailed,	
written	statement	designed	by	the	auditor	
indicating	 the	 work	 to	 be	 performed	 by	
the	 audit	 assistants,	 specifying	 the	 time	
limit	for	completion	of	work,	instructions	
and	guidance	 to	 the	 audit	 staff.	 In	 short,	
it	 is	 a	 tool	 for	 planning,	 directing	 and	
controlling	the	audit	work.	

An	audit	programme	is	a	detailed	plan	
of	 the	 auditing	work	 to	 be	 performed.	 It	
specifies	the	procedures	to	be	followed	in	
the	conduct	of	audit	more	efficiently.	The	
auditor	 outlines	 the	 whole	 procedure	 of	
audit	 from	beginning	 till	 the	 finalization	
of	 audit	 report.	 Audit	 programme	 is	
generally	contained	in	the	audit	notebook.

   3.2.2 Definition

Prof. Meigs	defines	an	audit	programme	as,	
“an	audit	programme	is	a	detailed	plan	of	the	

to	cover	different	aspects	of	audit	work	in	
a	systematic	manner	within	a	preset	time	
frame.	 It	 enhances	 the	 quality	 of	 audit	
work.	Audit	plans	should	cover	knowledge	
about	 client’s	 accounting	 systems	 and	
policies,	 internal	 control	 procedures	 and	
coordinating	 the	 work	 to	 be	 performed.	
Plans	 should	 be	 flexible	 so	 that	 they	 can	
be	 developed	 or	 revised	 as	 and	 when	
required	by	the	auditor.		

    3.1.3 Benefits or Advantages 
of Audit Planning

An	 efficient	 and	 effective	 audit	 plan	
provides	the	following	benefits:
1. Accomplishment of Objectives:	 Audit	

plan	ensures	that	it	provides	right	means	
to	 accomplish	 audit	 objectives.	 Further	
it	also	ensures	that	appropriate	attention	
is	devoted	to	important	areas	of	audit.

2. Identification of Problems:	 A	 well	
drawn	and	established	audit	plan	helps	
in	identifying	potential	problems.

3. Timely Completion of Work:	It	ensures	
that	 work	 is	 completed	 properly	 within	
the	specified	time	and	no	important	area	
is	left	out.	It	also	ensures	that	all	important	
areas	of	management	receive	attention.

4. Facilitates Coordination:	 It	 facilitates	
coordination	of	the	audit	work	done	by	
auditors	and	other	experts.

5. Better Audit Work:	 It	 helps	 in	
improving	the	quality	of	audit	work	and	
provides	promptness	and	perfection	in	
audit	performance.

    3.1.4  Factors affecting 
Audit Planning

The	 following	 factors	 should	 receive	 due	
consideration	while	planning:
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6.	To	 serve	 as	 a	 guide	 for	 planning	 the	
audit	work	in	future.

7.	 To	serve	as	evidence	in	future	showing	the	
date	of	completion	of	audit	work,	methods	
or	procedures	undertaken,	persons	involved	
in	completion	of	audit	work	etc.	

    3.2.5 Contents of an Audit 
Programme

The	 following	 are	 the	 details	 of	 an	 audit	
programme:
1.	 Name	of	the	client.
2.	 Nature	of	operations	and	business	of	client.
3.	 Review	of	system	of	internal	check.
4.	 Date	of	commencement	of	audit	work.
5.	 Duration	of	audit	work.
6.	 Accounting	 system	 followed	 in	 client	

organization.
7.	 Review	the	report	of	the	previous	auditor.
8.	 Review	 the	 remarks,	 instructions	 or	

objections	raised	in	the	previous	audit	
report.

9.	 Examine	 the	 various	 ledger	 accounts	
and	subsidiary	books.

10.	Examine	 the	 statutory	 books	 and	
registers,	profit	and	loss	account,	and	
balance	sheet.

auditing	work	 to	 be	 performed,	 specifying	
the	procedures	to	be	followed	in	verification	
of	 each	 item	 and	 the	 financial	 statements	
and	giving	the	estimated	time	required.”

    3.2.3  Features or 
Characteristics of an Audit 
Programme

The	 features	 of	 an	 audit	 programme	 are	
as follows:

1.	 It	is	a	set	of	procedures	to	be	adopted	to	
conduct	the	audit	more	efficiently.

2.	 It	 is	 a	written	 scheme	designed	by	 the	
auditor.

3.	 It	is	a	blue	print	of	the	audit	work.
4.	 It	 facilitates	 delegation	 of	work,	 based	

on	the	capabilities	of	audit	staff.
5.	 It	acts	as	evidence	in	future	for	the	audit	

work	being	performed.
6.	 It	specifies	the	work	to	be	done	by	the	

audit	 staff,	 the	manner	 and	 time	 limit	
for	completion	of	the	work.

    3.2.4 Objectives of Audit 
Programme

The	 following	 are	 the	 objectives	 of	 audit	
programme:

1.	To	 provide	 clear	 instructions	 to	 the	
audit	 assistants	 specifying	 the	 nature	
of	work	to	be	performed	and	fixing	the	
time	span	for	completion	of	each	work.

2.	To	 facilitate	 coordination	 among	
various	parts	of	audit	work.

3.	To	ensure	uniformity	in	the	performance	
of	audit	work	and	to	avoid	duplication	
and	repetition	of	work.

4.	To	 attain	 a	 fair	 allocation	 of	 work	
among	the	audit	team.

5.	To	fix	responsibility	and	accountability	
of	each	audit	assistant.

    3.2.6 Types of Audit 
Programme

1. General or Fixed Audit Programme:	
It	 refers	 to	an	audit	programme	which	
contains	 general	 guidelines	 common	
for	all	audits.

2. Specific or Flexible Audit Programme: 
It	 refers	 to	 an	 audit	 programme	
designed	for	certain	specific	functional	
areas	 like	 purchases,	 stores,	 inventory	
control,	production	control	etc.
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    3.2.8 Disadvantages of an 
Audit Programme

The	disadvantages	that	may	be	experienced	
by	conducting	audit	as	per	predetermined	
audit	programme	are	-	

1. Mechancial:	 When	 audit	 work	 is	
conducted	 mechanically	 every	 year	
based	on	the	audit	programme,	it	causes	
monotony	and	boredom	to	the	auditor	
and	audit	staffs.	

2. No Quality in Work:	 The	 audit	 staff	
will	be	more	interested	to	complete	the	
work	 in	 time	 rather	 than	 to	 maintain	
any	standard	in	the	work.

3. Loss of Initiative: Audit	 staff	
cannot  take	 their	 own	 decisions	 and	
they  are	 compelled	 to	 comply	 with	
the	 audit	 programme.	 Hence,	 an	
efficient	 audit	 clerk	 loses	his	 initiative	
and	 interest	 as	 he	 cannot	 make	 any	
suggestions.	

4. Rigidity: A	 rigid	 and	 inflexible	 audit	
programme	cannot	be	laid	for	all	types	
of	business.	During	the	course	of	audit,	
new	 areas	 to	 be	 verified	may	 come	 to	
the	notice	of	the	audit	staff.	Unless	the	
audit	programme	is	revised,	such	areas	
may	escape	from	auditing.

5. Shelter for Inefficient Staff: Inefficient	
audit	 staffs	 conceal	 their	 mistakes	
or	 weakness	 on	 the	 basis	 of	 audit	
programme.	Hence,	 it	provides	 shelter	
for	inefficient	audit	staff.

6. Unsuitable: Pre-determined	 audit	
programme	 is	 not	 suitable	 for	 small	
business	organizations.

    3.2.7 Advantages of an 
Audit Programme

An	 audit	 programme	 can	 give	 the	
following	advantages:

1. Helps in Estimation and Division 
of Work: Audit	 Programme	 helps	 in	
estimating	 the	 quantum	of	 audit	work	
in	 advance	 and	 also	 helps	 in	 dividing	
the	 work	 among	 the	 audit	 assistants	
based	on	their	capabilities.	

2. Helps in Fixation of Responsibility:	
It	 enables	 to	 fix	 responsibility	 on	 the	
audit	 assistants	by	 clearly	defining	 the	
scope	of	work.

3. Helps in Future Planning:	 Audit	
programme	serves	as	a	basis	for	planning	
the	audit	work	for	subsequent	year.	

4. Serves as a Guide:	 It	 serves	 as	 a	
valuable	 guide	 for	 the	 audit	 staff	
in	 execution	 of	 the	 audit	 work	 for	
succeeding	years.

5. Valuable Evidence:	 It	 serves	 as	 an	
evidence	 for	 the	work	 done	 as	 initials	
of	 those	who	have	done	 the	particular	
work	 are	 appended	 to	 it.	 The	 auditor	
can	 produce	 the	 audit	 programme	 as	
a	 proof	 when	 a	 charge	 of	 negligence	
being	brought	upon	him.

6. Uniformity:	It	provides	for	uniformity	
in	audit	work	as	the	same	work	will	be	
done	every	year.	

7. Continuity: When	 an	 audit	 staff	 goes	
on	 leave	others	can	continue	 the	work	
by	 referring	 to	 the	 audit	 programme,	
hence,	 audit	 programme	 provides	 for	
continuity	of	work.

8. Coordination: If	facilitates	coordination	
and	helps	in	supervising	the	work	of	the	
audit	staff.
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Summary of Advantages and Disadvantages of Audit Programme

Advantages Disadvantages

1.		Helps	in	estimation	and	division	of	work 1.	Mechanical

2.	Helps	in	fixation	of	responsibility 2.	No	quality	in	work

3.	Helps	in	future	planning 3.	Loss	of	initiative

4.	Serves	as	a	guide 4.	Rigidity

5.	Valuable	evidence 5.	Shelter	for	inefficient	staff

6.	Uniformity 6.	Unsuitable

7.	Continuity

8.	Coordination

Engagement Memo

Entrance Meeting

Testing, Interviews & Analysis
(Audit Program evolves)

Documentation/Workpapers

Observations, Discussion
& Mgt. Agreement

How an audit is conducted

Preliminary Report

Exit Meeting

Final Report

Audit Outline

Preliminary Discussion
= Direct Management Involvement

Engagement Memo

Entrance Meeting

Testing, Interviews & Analysis
(Audit Program evolves)

Documentation/Workpapers

Observations, Discussion
& Mgt. Agreement

How an audit is conducted

Preliminary Report

Exit Meeting

Final Report

Audit Outline

Preliminary Discussion
= Direct Management Involvement
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This	enables	the	auditor	to	have	an	overall	
view	and	evaluate	the	procedures	through	
selected	 transactions.	 In	 other	 words,	 it	
is	 a	 method	 of	 auditing	 under	 which	 a	
few	 selective	 transactions	 are	 thoroughly	
examined	 to	 arrive	 at	 accuracy	 of	 the	
accounting	 data.	 The	 auditor	 adopts	 this	
technique	 to	 evaluate	 the	 operation	 of	
internal	control	and	internal	check	system.

by	him	are	correct	then	no	further	detailed	
checking	is	carried	out.

    3.4.2 Applicability of Test 
Checking

Test	 checking	 can	 be	 applied	 in	 the	
following	situations:
1.	When	 there	 are	 large	 volumes	 of	

identical	or	routine	transactions.	
2.	When	transactions	are	large.	
3.	When	 the	 auditor	 has	 to	 certify	 the	

accounts	 quickly	 after	 the	 close	 of	 the	
accounting	period.	

4.	When	 the	 auditor	 has	 past	 experience	
about	the	nature	of	transactions	of	the	
clients	organisation.

5.	When	a	satisfactory	system	of	 internal	
control	and	check	system	exist.	

 3.3  Auditing in depth

‘Auditing	in	depth’	refers	to	an	examination	
of	 a	 few	 selected	 transactions	 from	 the	
beginning	 to	 the	 end	 through	 the	 entire	
flow	 of	 the	 transaction.	 While	 auditing	
in	 depth,	 the	 auditor	 reviews	 all	 the	
accounting	and	operational	aspects	of	the	
transaction	 from	 the	 origin	 to	 the	 end.	

 3.4   Test Checking

  3.4.1 Meaning

Test	 checking	 is	 a	 process	 of	 selecting	
and	checking	of	a	 few	transactions	 from	a	
large	volume	of	transactions.	If	the	entries	
checked	 are	 found	 to	 be	 correct	 then	 the	
auditor	assumes	that	the	remaining	entries	
are	also	correct.	The	technique	is	based	on	
the	theory	of	sampling	which	is	commonly	
used	as	a	statistical	method.	Checking	each	
and	every	transaction	that	occurs	during	the	
year	 is	 both	 redundant	 and	uneconomical	
for	 the	 auditor.	 Therefore,	 the	 auditor	
verifies	 and	 examines	 a	 few	 representative	
transactions	 in	 order	 to	 obtain	 sufficient	
appropriate	 audit	 evidence	 to	 base	 his	
opinion.	Test	checking	reduces	the	volume	
of	work	of	the	auditor,	 if,	 in	test	checking,	
the	 auditor	finds	 that	 the	 records	 checked	

Summary of Advantages and Disadvantages of Auditing in-depth

Advantages Disadvantages

1.	Quick	completion	of	audit	work 1.	Possibility	of	wrong	selection	of	items

2.	Saves	cost	and	time 2.	Unsuitable	for	small	business	concerns

3.		Safeguards	against	manipulation	of	
accounts

3.	No	objective	method

4.	Helpful	in	planning	the	audit	 4.	Based	on	intuition
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    3.4.4 Disadvantages of  
Test Checking

Test	 checking	 can	 give	 the	 following	
dsiadvantages:
1. No Scientific Approach: It	 is	 a	

traditional	auditing	technique	where	no	
scientific	approach	is	used	in	selecting	
the	samples,	hence	the	results	drawn	on	
it	tends	to	be	incorrect.

2. Risk cannot be measured:	It	is	not	possible	
to	measure	the	amount	of	risk	involved.		

3. Complicated Transactions are not 
Checked:	The	audit	assistants	select	only	
simple	 transactions	 for	 checking	 and	
complicated	transactions	are	left	omitted.

4. Carelessness of the Client’s Staff:	The	
client’s	 staff	 is	 aware	 that	 the	 auditor	
will	not	check	all	their	work	hence	they	
become	careless.

5. Possibility of Errors and Frauds Remain 
Undetected:	When	test	check	is	adopted	
by	 the	 auditor	 there	 are	 possibility	 of	
errors	and	frauds	left	undetected.

6. Unsuitable when there is no System of 
Internal Check:	The	auditor	cannot	adopt	
test	check	when	there	is	no	proper	system	
of	Internal	check	and	control	in	operation.

7. Unsuitable for Small Business 
Concerns:	Test	checking	is	not	suitable	for		
small	business	concerns	as	the	number	of	
transactions	involved	is	not	large.

    3.4.3 Advantages of  
Test Checking

Test	 checking	 can	 give	 the	 following	
advantages:
1. Reduces Volume of Work:	The	work	of	

an	auditor	is	reduced	considerably	as	he	
checks	only	few	transactions,	extra	time	
available	can	be	utilised	for	concentrating	
on	areas	of	considerable	importance.

2. Reduces Time and Cost:	Test	checking	
is	 one	 of	 the	 technique	which	 reduces	
time,	 cost	 and	 energy	 of	 both	 the	
auditor	and	the	client.

3. Quick Completion of Audit Work:	Test	
check	 enables	 the	 auditor	 to	 complete	
the	work	quickly	as	the	auditor	checks	
only	a	few	or	limited	transactions.

4. Effective means of Checking:	Test	checking	
can	 be	 effective	 if	 the	 auditor	 selects	 the	
transaction	to	be	checked	carefully.

5. Scientific Assessment of Risk:	The	risk	
of	material	misstatement	in	the	financial	
statement	is	assessed	by	the	auditor	in	a	
scientific	 manner	 by	 drawing	 samples	
and	studying	them	in	detail.

6. Serves as a Guide:	It	serves	as	a	guide	
for	 the	 auditor	 to	 arrive	 at	 conclusion	
regarding	the	true	and	fair	view	of	the	
state	of	affairs	of	business.

Summary of Advantages and Disadvantages of Test Checking
Advantages Disadvantages

1.	Reduces	volume	of	work 1.	No	scientific	approach
2.	Reduces	time	and	cost 2.	Risk	cannot	be	measured
3.	Quick	completion	of	audit	work 3.		Complicated	transactions	are	not	checked
4.	Effective	means	of	checking 4.	Carelessness	of	the	client’s	staff
5.	Scientific	assessment	of	risk 5.		Possibility	of	errors	and	frauds	remain	undetected
6.	Serves	as	a	guide 6.		Unsuitable	when	there	is	no	proper	system	of	

internal	check
7.	Unsuitable	for	small	business	concerns
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by	 applying	 his	 intelligence	 and	
professional	skill.

4.	Test	 check	 should	 not	 be	 adopted	 in	
vouching	 the	 entries	 in	 the	 cash	Book	
and	bank	Pass	book.

5.	The	 auditor	 should	 not	 adopt	 test	
check	while	checking	the	entries	of	first	
and	last	month	of	the	year	and	all	 the	
entries	must	be	thoroughly	checked.

6.	Test	check	should	be	so	devised	 that	a	
sizeable	 portion	 of	 the	 work	 done	 by	
each	employee	is	checked.

7.	Auditor	 should	 consider	 his	 past	
experiences	in	selecting	the	nature	and	
size	of	the	samples	for	checking.

    3.4.5 Auditor’s duty 
regarding Test Checking

The	 following	 are	 the	 auditor’s	 duty	 or	
precautions	 to	 be	 taken	 by	 an	 auditor	
while	adopting	test	check:

1.	Entries	selected	for	test	checking	must	
be	 representative	 of	 all	 transactions	
and	entries	on	random	basis	should	be	
selected	for	checking.

2.	Auditor	 should	 select	 the	 test	
independently	 without	 regard	 to	 the	
suggestions	of	the	client’s	staff.

3.	Entries	 selected	 for	 test	 check	 should	
be	 chosen	 by	 the	 auditor	 cautiously	

•	 Audit Planning	 –	 The	 audit	 plan	 is	 the	 description	 of	 the	 activities	 and	
arrangements	for	an	audit.

•	 Audit Program	 –	 An	 audit	 program	 includes	 all	 the	 activities	 necessary	 for	
planning,	organizing,	and	conducting	audits.	The	program	typically	includes	an	
annual	schedule	of	audits.

•	 Auditing in-depth	–	Audit	in	depth	implies	a	detailed	and	step	by	step	examination	
of	transactions	through	its	process	of	the	activity	from	origin	to	conclusion.

•	 Test Checking (or Selective Verification) –	Test	checking	is	a	substitute	for	detailed	
checking.	It	involves	only	a	partial	checking,	verifying	the	entries	at	random.

KEY TERMS

•	 Audit Planning	enables	an	auditor	to	cover	different	aspects	of	audit	work	in	a	
systematic	manner	within	a	preset	time	frame.

•	 Good planning	brings	promptness	and	perfection	in	audit	performance.
•	 Audit Programme is	a	written	scheme	prepared	by	the	auditor	to	distribute	work	

to	be	followed	during	the	audit.
•	 Auditing in-Depth is	a	technique	which	facilitates	test	checking.
•	 Test Checking is	examining	a	selected	number	of	 items.	 It	 is	based	on	 the	Law	

of	Statistical	Inertia	which	means	the	selection	and	checking	of	a	representative	
number	of	entries	for	each	class	of	transaction.

SUMMARY
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I. Multiple Choice Questions:

1.	Which	of	 the	 following	 is	 considered	
as	 a	 blue	 print	 for	 the	 process	 of	
carrying	out	the	audit.
a.	 Audit	note	book
b.	Audit	memorandum
c.	 Audit	planning
d.	Audit	programme

2.	A	written	 plan	 containing	 the	 details	
regarding	 the	 conduct	of	 a	particular	
audit	is	known	as	_______________________ .
a.	 Audit	programme
b.	Audit	note	book
c.	 Audit	working	papers
d.	Audit	evidence

3.	 A	sample	of	transactions	of	representative	
character	is	checked	under	_______________.
a.	Walk	through	test
b.	Rotational	test
c.	 Test	checking
d.	Routine	checking

4.	 Drawing	conclusion	about	the	universe/
population	by	testing	a	few	transactions	
of	representative	character	is
a.	 Assumption
b.	 Sampling
c.	 Inference
d.	Prediction

5.	 What	is	the	name	of	process	of	examining	
a	 few	 transactions	 of	 representative	
character	to	arrive	at	conclusion	________ .
a.	 Test	checking
b.	Routine	checking
c.	 Sample	checking
d.		In-depth	checking

6.	 Which	document	
discloses	the	detailed	
plan	of	work,	auditing	techniques	and	
procedures	to	be	applied	to	a	given	audit?
a.	 Audit	file
b.	Audit	planning
c.	 Audit	note	book
d.	Audit	programme

7.	Audit	programme	is	prepared	by	_______ .
a.	 the	auditor	
b.	 the	client	
c.	 the	audit	assistants	
d.	the	auditor	and	his	audit	assistants

8.	Typically,	 an	 audit	 planning	
memorandum	 would	 contain	 the	
following	sections	except:
a.	 Objective	of	the	audit
b.	Audit	approach
c.	 Background	information
d.	Assessment	of	business	risk.

9. ________	is	a	plan	of	action	of	an	Auditor.
a.	 Audit	Programme
b.	Audit	Working	Papers
c.	 Audit	note	book
d.	Audit	files.

10.	Test	checking	is	also	known	as	______.
a.	 Sampling	process
b.	 Selective	process
c.	 Verification
d.	Both	(a)	and	(b)

[Answers: 1.(c), 2.(a), 3.(c), 4.(b), 5.(a), 
6.(d), 7.(d), 8.(d), 9.(a), 10.(d)]

 EVALUATION 
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II. Very Short answer Questions

1.	What	is	audit	planning?

2.	What	is	audit	programme?

3.	What	is	auditing	in	depth?

4.	What	is	test	checking?

5.	 State	the	types	of	audit	programme?

III. Short answer Questions

1.	 State	the	factors	influencing	audit	
planning.

2.	Bring	out	the	objectives	of	audit	
planning.

3.	Outline	the	salient	features	of	audit	
programme.

4.	 State	the	objectives	of	audit	
programme.

5.	Point	out	the	contents	of	audit	
programme.

6.	 Indicate	the	cases	where	test	checking	
is	applied.

7.	Write	an	note	fixed	and	flexible	audit	
programme.

IV. Essay Type Questions.

1.	Discuss	the	benefits	of	audit	planning.
2.	 Explain	 the	 advantages	 and	

disadvantages	of	audit	programme.
3.	Discuss	 the	 advantages	 and	

disadvantages	of	auditing	in	depth.

4.	What	 is	 test-	 checking?	What	 are	 its	
advantages	and	disadvantages?	



After going through this unit, the students will be able to,
•	 State the meaning and importance of documentation
•	 Explain the meaning and advantages of audit note book
•	 State the meaning and importance of Audit working 

papers

 4.1  Introduction 

   4.1.1 Documentation – 
Meaning

In the process of audit, the auditor should 
document matters which are important 
in providing sufficient evidence that 
the audit was carried out in accordance 
with the basic principles governing 
an audit. The records maintained and 
preserved in the audit process are called 
as Documentation. Documentation in 
this connection refers to audit note book 
and audit working papers. Working 
papers are prepared or obtained by 
the auditor. It may be in the form of 
extracts, photocopy of documents, 
representation and explanation from 
the management. 

   4.1.2 Importance of 
Documentation

Documentation is important in the course 
of audit work due to the following: 
1. Fixation of Responsibility and 

Accountability: Documentation helps 

Learning Objectives

4 DOCUMENTATION Chapter

TO BE RECALLED

•	 Audit procedures
•	 Audit program
•	 Works entrusted to audit staff
•	 Period allotted for completion of audit work

Audit Documentation includes:

1. Audit Programme
2. Analysis
3. Issues memorandum
4. Summaries of significant matters
5. Letters of confirmation and 

representation 
6. Checklists 
7. Correspondendces concerning 

significant matters.
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 4.2  Audit Note Book
  4.2.1 Meaning

Audit Note Book is a register maintained 
by the audit staff to record important 
points observed, errors, doubtful queries, 

in determining and fixation of 
responsibility among the audit staff. 
It further creates accountability for 
the work performed by the audit 
staff.

2. Permanent Record: Documentation is 
a permanent record, it acts as a manual 
of reference for planning the audit for 
future and also in similar types of new 
audit engagements.

3. Documentary Record: Documentation 
acts as documentary evidence when a 
charge of negligence is charged against 
the auditor. 

4. Helps in Preparing Audit Report: 
Adequately documented plan and 
control of audit work evidences 
the practices, procedures followed 
in audit and important things. It 
further helps in preparation of audit 
report.

SA-230 on Audit Documentation 
issued by ICAI state the factors that 
determine Audit Documentation

1. The size and complexity of the entity.
2. Nature of audit procedures to be 

performed.
3. The identified risks of material 

misstatement.
4. The significance of the audit evidence 

obtained.
5. The audit methodology and tools 

used. 

Conducting audit

Conducting document review

Planning and scheduling audit

Overview of audit activities

Preparing for on-site activities

Prepare audit report

Conducting follow-up
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   4.2.2 Contents of Audit 
Note Book

The following matters should have been 
incorporated in an Audit Note Book.

 1. A list of the account books normally 
used and maintained.

 2. Names of the principal officers, their 
duties and responsibilities.

 3. Nature of business carried on and 
important documents relating to 
the constitution of business like 
Memorandum of Association, Articles 
of Association, Partnership deed etc.,

 4. Extracts of minutes and contracts 
affecting the accounts.

 5. Extracts of correspondence with 
statutory authorities.

 6. Copy of audit programme.
 7. Accounting methods, internal control 

and internal check system in operation.
 8. Routine queries like missing receipts 

and vouchers etc.
 9. Details of errors and frauds discovered 

during the course of audit.
10. Points to be included in audit report.
11. Details of all important information to 

be used as reference for future audits.
12. Date of commencement and 

completion of audit.

explanations and clarifications to be received 
from the clients. It also contains definite 
information regarding the day-to-day work 
performed by the audit clerks. In short, audit 
note book is usually a bound note book in 
which a large variety of matters observed 
during the course of audit are recorded. The 
note book should be maintained clearly, 
completely and systematically. It serves as 
authentic evidence in support of work done 
to protect the auditor against any legal charge 
initiated against him for negligence. It is of 
immense help to the auditor in preparing 
audit report. It also acts as a valuable guide 
for conducting future audits.

Voucher Account Debited Amount ₹ Query Solution to Query
75 Advertisement 3,50,000 Managing directors 

sanction required
Sanction obtained

170 Rent 22,000 Rent bill and receipt 
required

Receipt and bill 
obtained

98 Stores 58,375 Invoice required Copy of invoice 
obtained

245 Machinery 7,28,000 Board sanction 
required

Sanction obtained 
verified with minutes 
of meeting

SPECIMEN OF ENTRIES IN AUDIT NOTE BOOK

Example: 

Following are the queries made in the 
Audit Note Book:
20.7.2017: Entry is Cash Book Folio 45 
for ₹.500/- wrongly debited to Freehold 
land and building instead of Leasehold 
Improvement.
24.7.2017: Receipt for ₹.1000/- Paid 
to M/S. XYZ vide CB Folio 49, not 
available.
12.8.2017: Receipt for ₹.1000/- paid to 
M/S.XYZ. Seen and canceled.
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   4.2.4 Disadvantages of 
Audit Note Book

1. Fault-finding Attitude: It leads to 
development of a fault-finding attitude 
in the minds of the staff.

2. Misunderstanding: Very often 
maintenance of audit note book creates 
misunderstanding between the client’s 
staff and the audit staff.

3. Improper Preparation: Since it serves 
as evidence in the court of law, it needs 
to be prepared with great caution. When 
the note book is prepared without due 
care it cannot be used as evidence 
against the auditor for negligence.

4. Adverse Effects on Subsequent 
Audits: Since audit note book is used 
in performing subsequent audits, any 
mistakes in the note book may have 
adverse impacts on the next audit.

   4.2.3 Advantages of Audit 
Note Book

1. Facilitates Audit Work: It facilitates 
the work of an auditor as all important 
details about the audit are recorded in 
the note book which the audit clerk 
cannot remember everything at all 
the time. It helps in remembering and 
recalling the important matters relating 
to the audit work.

2. Preparation of Audit Report: Audit 
note book helps in providing required 
data for preparing the audit report. An 
auditor examines the audit note book 
before preparing and finalizing the audit 
report. 

3. Serves as Documentary Evidence: 
Audit note book serves as a documentary 
evidence in the court of law when a 
suit is filed against the auditor for his 
negligence. 

4. Serves as a Guide: When a audit 
assistant is changed before the 
completion of audit work, audit note 
book serves as a guide in completion of 
balance work. It also acts as a guide for 
carrying on subsequent audits.

5. Evaluating Work of Audit Staff: It 
helps to assess the work performed by 
the audit staff and helps in evaluating 
their level of efficiency.

6. Fixation of Responsibility: Audit note 
book helps in fixing responsibility on 
concerned clerk who is responsible for 
any undetected errors and frauds in the 
course of audit.

7. No Dislocation of Audit Work: An 
audit note book contains all important 
details about audit hence any change 
in the audit staff will not disturb or 
dislocate the audit work.

Guidelines and Standards issued 
by The Institute of Chartered 
Accountants of India (ICAI)

1. AS – Accounting Standards
2. AAS – Auditing and Assurance 

Standards
3. International Standards on Auditing 

(ISA) was issued by the International 
Auditing and Assurance Standards 
Board (IAASB) which was later 
modified as Standard Auditing 
Practices (SAP) by the Institute of 
Chartered Accountants of India.

 4.3   Audit Working Papers

  4.3.1 Meaning

Papers and documents which contain 
important facts about accounts which are 
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parties, certificates issued by the 
management, banks, etc.,’ .

•	 Prof. Meigs, “the term working paper 
is a comprehensive one and includes 
all the evidences gathered by the 
auditor to show the work he has done, 
the methods and procedures he has 
followed and the conclusions he has 
developed”. 

under audit are called as Audit Working 
Papers. Working papers provide the basis 
of conclusions and summarizations of 
the report prepared by the auditor at the 
end of the audit work. As per SA-230 
“Audit Documentation” audit working 
paper refers to the documents prepared 
or obtained by the auditor and retained by 
him in connection with the performance of 
his audit.

The term ‘audit working paper’ mean 
the written paper and document containing 
details about accounts which are under 
audit, analysis, summaries and comments 
built up by an auditor during the course of 
a particular audit engagement.

Thus, all the documents gathered or 
prepared by auditors during the course of 
an audit constitute audit working papers, 
but broadly these are two types:

•	 Working papers prepared by the 
auditor himself, like audit note book, 
audit program, details of queries made 
and their explanations thereof.

•	 Working papers collected by the 
auditor from the client, like schedule 
of debtors and creditors, management 
representations, confirmations etc.,

   4.3.2 Definition

•	 Institute of Chartered Accountants 
of India defines audit working paper 
as, ‘working paper must include audit 
program, queries, explanations given 
for the queries, schedules for the 
important items like depreciation, 
inventories, confirmation from third 

Guidelines of Audit working Papers 
as specified in SA-230, Audit 
Documentation

Working Papers prepared or obtained 
by the auditor in connection with the 
performance of audit are the property of 
auditor and it is the duty of the auditor 
to retain and preserve the working 
papers for a period of  minimum seven 
years from the date of Auditors report.

   4.3.3 Contents of Audit 
Working Papers

The documents obtained in the conduct 
of audit constitute the audit working 
papers. The content of audit working 
papers varies depending on the type and 
scope of audit. Auditing and Assusrance 
Statndards (AAS 3) issued by the Institute 
of Chartered Accountants of India 
states working papers should record the 
auditors plan, the nature, timing and 
extent of the audit procedure performed 
and the conclusions obtained from the 
evidence.
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the audit staff so that each staff is 
responsible for his work to the auditor. 

4. Use as a Permanent Record: Working 
papers are the permanent record of the 
auditing procedure employed and the 
financial records examined during the 
conduct of audit.

5. Basis for Evaluation and Training of 
Audit Staff: Working papers provide a 
means to test whether the auditor and 
his staff have done their job as per the 
standards. Training to the staff can be 
provided by reviewing the working 
papers of previous years. 

   4.3.5 Importance or 
Advantages of Audit 
Working Papers

1. Planning the Audit Work: It acts as 
the process of planning for the auditor 
so that he can estimate the time that is 
required for conducting the audit work.

2. Helps in Fixing Responsibility: It helps in 
fixing responsibility and to measure the work 
being performed by the audit assistants. 

3. Helps in Drawing Conclusions: 
Working papers are necessary to 
draw conclusions from the evidence 
obtained.

4. Helps in Preparing Audit Report: 
The auditor prepares and finalises the 
audit report taking into account the 
informations or extracts contained in 
the working papers.

5. Documentary Evidence: It is a valuable 
documentary evidence in the Court 
or Tribunal of law when a charge of 
negligence is brought against the auditor. 

6. Permanent Record: Working papers 
are the permanent record of the work 
done by the auditor during a particular 
period of time.

In general audit working papers 
consists of the following:
 1. Schedule of Debtors, Creditors and 

bank statement.
 2. Correspondences and balance 

confirmations from Debtors, Creditors 
and bankers.

 3. Correspondences from legal advisors 
and statutory authorities.

 4. Certificates of officials with regard to 
bad debts.

 5. Certificate from valuers for valuing 
stock-in-trade and investments.

 6. Certificate confirming cash balance.
 7. Certificate from authorized person 

with regard to outstanding assets 
and liabilities, contingent assets and 
liabilities etc.

 8. Bank Reconciliation statement.
 9. Adjusting entries.
10. Copies of the minutes of the meeting 

of directors and shareholders.

   4.3.4 Objectives of Audit 
Working Papers

1. Planning and Organizing Audit Work: 
Working papers provide a means of 
planning, organizing and reviewing the 
audit work. They are the evidence for 
conducting the audit work against the 
generally accepted Auditing Standards 
and Practices. 

2. Support for Auditor’s Opinion: 
Working papers provide support for 
the report of the auditor. When the 
auditor’s opinion on financial statement 
or recommendations given by the him is 
questioned, working papers support the 
opinion or recommendations given by 
the auditor. 

3. Division of Labour: Working papers 
help in dividing the audit work among 
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Ownership of Audit Working Papers
In the case of Sockockinsky vs. Bright Grahm and Co. (1938) in England and 
Chantrey Martin & Co. Vs. Martin (London1953), whether the auditor has a right 
to retain the working papers as his own property even after payment of audit fee. 
The Court gave judgement in favour of the auditors on the ground that the auditors 
conduct audit on his independent capacity and not as an agent of the client. Hence, 
it is considered that the working papers prepared by the auditor or his assistants to 
carry on the audit work are the property of the auditor and the client has no claim 
on the papers.

FORMAT OF AUDIT WORKING PAPER
XYZ & Co.

Chartered Accountants
AUDIT WORKING PAPER

Page No………….

CLIENT  ...........................................................................................................................

ACCOUNTING YEAR  ..................................................................................................

WORKING PAPER TITLE/HEAD OF ACCOUNT  ....................................................

SAMPLE/DATA CHECKED  ..........................................................................................

AUDIT TESTS DONE  ....................................................................................................

AUDIT QUERIES  ...........................................................................................................

AUDIT FINDINGS .........................................................................................................

  ...........................................................................................................................................

............................................................................................................................................

CONCLUSION  ................................................................................................................

RECOMMENDATION  ...................................................................................................

............................................................................................................................................

SIGNATURE OF THE AUDITOR REVIEWED BY
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CASE STUDY

M/s. Health Zone, a partnership firm, running a nursing home have decided to discontinue 
you as an auditor for the next year and requests you to handover all the relevant working 
papers of the previous year.

Analysis: The working paper being the property of auditor he is under no obligation to 
hand them over to M/s. Health Zone. However the auditor may at his discretion, make 
proportions of working paper available to M/s. Health Zone.

1. Documentation: Preserving the Documents.

KEY TERMS

I. Multiple Choice Questions:

1. A written plan prepared by the auditor 
to determine the period, distribution of 
work among the audit staff etc., is named 
as ________________________________ .
a. Audit Programme
b. Audit Note Book
c. Schedule
d. Audit Plan.

2. The book which helps the auditor, for 
conducting his audit work is ___________ .

a. Audit Note Book
b. Audit Working Plan
c. Audit Plan
d. Audit Report.

3. The reports, queries made and 
explanations received during the audit 
are called ________________________________ .

a. Audit Report
b. Audit Working Papers
c. Audit Note Book
d. Audit Program

4. Records maintained and preserved in the 
audit process is called ____________ .
a. Audit Program
b. Audit Note Book
c. Audit Working Papers
d. Documentation

 EVALUATION 

1. Document: Important papers related to auditing
2. Documentation: Preserving documents for reference.
3. Audit Note book: Book maintained for recording the audit remarks.
4. Working Papers: Summaries of audit works, statements and reports collected 

from the client.

SUMMARY
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5. Trial balance, statement of debtors and 
creditors, list of investments etc., obtained 
from the client are examples of ____________

___________________________ .
a. Audit Program
b. Audit Note Book
c. Audit Working Papers
d. Audit Report

6. The document which can be produced as 
evidence ____________________________ .
a. Audit Program
b. Audit Note Book
c. Audit Working Papers
d. Both (b) and (c)

7. Audit working papers are to be preserved 
for a period of __________ by the auditor.
a. 2 years
b. 4 years
c. 8 years
d. 7 years

8. The period of commencement and 
completion of audit are specified in  
___________________________.
a. Audit Note Book
b. Audit Working Papers
c. Audit Report
d. Audit Program

9. The owner of working paper is _______ .
a. Client
b. Auditor
c. Audit staff
d. None of the Above

10. This book helps in evaluating the 
efficiency of audit staff ___________ .
a. Audit Note Book
b. Audit Working Papers
c. Audit Report
d. Audit Program

[Answers: 1.(a),  2.(a),  3.(b),  4.(d),  5.(c),  
6.(d),  7.(d),  8.(a),  9.(b),  10.(a)]

II. Very Short answer Questions

1. What is a document? 2. What do you mean by documentation?

III. Short answer Questions
1. What is audit note book?
2. What do you understand by audit working 

papers?

3. State the contents of an audit note book?
4. What are the advantages of audit working 

papers?

IV. Essay Type Questions.
1. Prepare a model audit note book. 2. As an auditor comment on audit working 

papers. 
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•	 To	understand	the	meaning	and	definition	of	vouching
•	 To	be	acquainted	with	the	meaning	of	vouchers	and	its	types.
•	 To	acquire	knowledge	on	the	objectives	of	vouching
•	 To	 explain	 the	 procedure	 in	 regard	 to	 vouching	 cash	

	receipts	or	debit	side	of	the	cash	book
•	 To	enlighten	on	some	aspects	of	vouching	of		cash	transactions

Chapter
VOUCHING OF CASH  

RECEIPTS

 5.1  Vouching

  5.1.1 Meaning 

The	process	of	examining	the	documentary	
evidence	 to	 ascertain	 the	 accuracy	 and	
authenticity	 of	 entries	 in	 the	 books	
of	 accounts	 by	 the	 auditor	 is	 called	 as	
‘Vouching’.	 Vouching	 means	 a	 careful	
inspection	 of	 all	 original	 evidences	
supporting	 the	 transaction	 e.g.	 invoices,	
statements,	 receipts,	 etc.,	 in	 order	 to	
ascertain	 the	 real	 accuracy,	 authenticity	
and	validity	of	the	transactions.	It	confirms	
that	 the	 amount	 specified	 in	 the	 voucher	
has	been	posted	to	an	appropriate	account	
which	 will	 disclose	 the	 nature	 of	 the	
transaction.	Therefore,	vouching	is	referred	

as	the	very	essence	of	auditing.	It	helps	an	
auditor	in	establishing	the	truth	of	entries	
appearing	in	the	books	of	accounts.

   5.1.2 Definition

•	 According	 to	 Ronald A Irish	 –	
“Vouching	 is	 a	 technical	 term	 which	
refers	to	the	inspection	of	documentary	
evidence	supporting	and	substantiating	
a	transaction”.

•	 According	 to	 J.R. Batliboi	 –	 “Vouching	
means	 testing	 the	 truth	 of	 the	 terms	
appearing	in	the	books	of	original	entry”.

•	 Dicksee	 defines	 vouching	 “as	 an	 act	
of	 comparing	 entries	 in	 the	 books	 of	
accounts	 with	 documentary	 evidence	
in	support	thereof ”.

Learning Objectives

5Chapter

TO BE RECALLED

From	the	previous	unit,	the	following	can	be	understood
•	 Meaning	of	Documentation.
•	 Importance	of	Documentation
•	 The	meaning	of	Audit	Note	Book
•	 Advantages	of	Audit	Note	Book
•	 Meaning	and	importance	of	Audit	Working	Papers.
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correspondences,	agreements,	resolutions	
passed	 in	 the	meeting	 etc.	Voucher	gives	
information	about	 the	nature	 and	 source	
of	the	transaction,	its	value	and	authority.	
It	 substantiates	 the	 entries	 in	 the	 book	
of	 accounts	 and	 confirms	 the	 genuiness	
of	 the	 transaction.	 All	 vouchers	 relating	
to	 the	 business	 transactions	 should	 be	
carefully	preserved	and	properly	filed.

  5.2.2 Types of Voucher

There	are	two	types	of	Voucher,	They	are:
1.	Primary	Voucher
2.	Collateral	Voucher
1.	Primary Voucher:	 Primary	 voucher	

refers	 to	 the	 written	 evidence	 in	
original.	Examples	of	primary	voucher	
are	 purchase	 invoice,	 cash	 memo,	
bills,	 confirmation	 of	 balances,	 bank	
statements,	contracts,	etc.

2.	 Collateral Voucher:	 When	 the	 original	
voucher	is	not	available,	copies	thereof	are	
produced	 in	 support	 or	 as	 subsidiary	 to	
remove	suspicion	and	to	satisfy	the	auditor,	
such	 a	 voucher	 is	 known	 as	 Collateral	
Voucher.	 Examples	 of	 collateral	 voucher	
are	copies	of	sales	invoice,	receipts,	copy	of	
resolution	passed	in	a	meeting	etc.

    5.1.3 Objectives of Vouching
The	main	objectives	of	vouching	are:
1.	To	 examine	 that	 all	 transactions	 and	

entries	 have	 been	 properly	 accounted	
for	in	the	appropriate	books	of	accounts.

2.	To	 ensure	 that	 adequate	 documentary	
evidence	exist	to	all	the	transactions.

3.	To	 ensure	 that	 the	 transactions	 and	
entries	relate	to	the	business	and	to	the	
period	under	audit.

4.	To	ensure	 that	 there	 is	no	omission	of	
any	record.

5.	 To	 evaluate	 the	 collected	 evidence	 and	
vouchers	by	determining	the	authenticity	
and	validity	of	the	documentary	evidence.

6.	To	 ensure	 that	 the	 transactions	 and	
entries	 are	 properly	 authenticated	 by	
the	responsible	officer.

Hence,	vouching	is	called	as	backbone	of	
auditing.

5.2 Voucher

  5.2.1 Meaning 

Documentary	evidence	in	support	of	any	
business	transaction	is	called	as	a	Voucher.	
It	may	be	a	receipt,	invoice,	bill,	cash	memo,	
bank	pay-in-slip,	counterfoil	of	a	cheque,	

 Voucher 
XY Pvt. Ltd.,

Canal Bank Road, Adayar, Chennai.

Voucher No. ________________ Date: _________________

Particulars Amount (₹)
Credit:
Being	the

Total

					Sd/-																																																																																																																										Sd/-
Manager	 Accountant
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5.4  Vouching of Cash 
Transactions

All	transactions	whether	it	is	cash	receipts	
or	payments	should	be	accounted	in	the	
cash	 book.	 It	 is	 an	 important	 financial	
book	 of	 a	 business	 concern.	 While	
vouching,	 the	 auditor	 should	 verify	
and	satisfy	himself	 that	vouchers	 in	the	
form	 of	 receipts,	 bills,	 invoices,	 cash	
memos	etc.,	correspond	with	the	entries	
in	 the	 cash	 book.	 	 Further,	 he	must	 go	
behind	the	books	and	establish	accuracy	
and	 correctness	 of	 the	 entries	 after	
thoroughly	 examining	 all	 the	 original	
documentary	 evidences.	 Therefore,	 the	
auditor	 should	 ensure	 that	 all	 receipts	
have	 been	 recorded	 in	 cash	 book	 and	
no	 fictitious	 payments	 appear	 on	 the	
payment	side	of	cash	book.

    5.4.1 Auditors Duty in 
Vouching Cash Transactions

The	 procedures	 in	 regard	 to	 vouching	
the	 transactions	 of	 various	 items	 which	
appear	in	the	debit	side	of	the	cash	book	
are	discussed	below:

1.	 Auditor	 should	 see	 that	 all	 the	
vouchers	 are	 properly	 filed,	 serially	
numbered	and	arranged	date	wise.	He	
should	also	obtain	duplicates	of	lost	or	
missing	vouchers.

2.	 He	should	pay	attention	to	 the	dates,	
which	must	correspond	with	the	cash	
book,	name	of	the	party	to	whom	the	
voucher	 is	 issued,	 the	 name	 of	 the	
party	 issuing	 the	 voucher	 and	 the	
amount,	etc.

3.	 The	transactions	must	be	in	conformity	
with	the	nature	of	the	client’s	business.	

Examples of Vouchers

The	 following	 are	 some	 of	 the	
examples	of	vouchers.

Cash Receipts:	 Vouchers	 regarding	
cash	receipts	 include	-	carbon	copies	
of	 receipts,	 contracts,	 minutes,	
correspondences,	counterfoils,	etc.

Cash Payments:	 Vouchers	 in	
connection	 with	 cash	 payments	
include	 -	 invoices,	 bills,	 demand	
notes,	 wage	 sheets,	 salary	 register,	
counterfoils,	agreements	etc.

Purchases:	 Invoices,	 Goods	 inward	
book,	 Copies	 of	 orders	 placed,	
Correspondence,	 etc.	 can	 be	 cited	 as	
examples	of	vouchers	for	purchases.	

Sales:	 	 Copies	 of	 invoice,	 Orders	
received,	 Goods	 Outward	 Book,	
Correspondence,	etc.,	are	some	of	the	
examples	of	vouchers	related	to		sales.

5.3 Missing Vouchers

While	 vouching	 vouchers	 or	 supporting	
documentary	evidences	are	not	available	
for	 the	 entries	 made	 in	 the	 books	 of	
accounts,	 such	 non-availability	 of	
vouchers	 is	 called	 as	 missing	 vouchers.	
It	 may	 be	 deliberate	 (purposeful	 or	
indicative	 of	 a	 big	 fraud)	 or	 accidental	
(innocent	misplacement).

In	this	case,	the	auditor	should	obtain	
proper	 explanation	 and	 enquire	 reasons	
for	missing	vouchers.	If	he	is	not	satisfied	
with	 the	 explanation,	 he	 should	mention	
the	 fact	 in	his	 report.	 Further,	he	 should	
obtain	 a	 certificate	 from	 the	 competent	
official	stating	all	the	missing	vouchers.	
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LEGAL DECISIONS

•	 In	 a	 case	 between	 Leeds	 Estate	
Building	 &	 Investment	 Co.	 Vs.	
Shepher,	it	was	held	that	the	auditor	
was	 liable	 for	 negligence	 for	 not	
verifying	 the	 true	 and	 fair	 view	
of	 Balance	 Sheet	 and	 accurate	
representation	 of	 affairs	 of	 the	
company.

•	 In	 a	 case	 between	 London	 Oil	
Storage	 Co.	 Ltd.	 Vs.	 Sears,	
Hasluck	 &	 Co.,	 it	 was	 held	 that	
the	 auditor	 is	 liable	 for	 any		
damage	sustained	because	of	his	
omission	 to	 verify	 the	 existence	
of	 assets	 stated	 in	 the	 Balance	
Sheet	of	a	company.

5.5  Vouching of Cash 
Receipts or Debit Side 
of the Cash Book

Cash	 book	 is	 one	 of	 the	most	 important	
books	 of	 accounts.	 The	 auditor	 has	
to	 ensure	 that	 all	 receipts	 have	 been	
accounted	 for.	 Errors	 and	 frauds	 usually	
arise	 in	 connection	 with	 cash	 receipts.	
Hence,	 the	 auditor	 should	 vouch	 all	 the	
cash	 transactions	 as	 far	 as	 possible	 and	
should	 ensure	 that	 all	 receipts	have	been	
accounted.	 He	 has	 to	 ensure	 that	 there	
are	no	omissions	of	cash	receipts	and	the	
auditor	 has	 to	 rely	 considerably	 on	 the	
internal	check	system	in	operation.	Some	
of	 the	 important	 cash	 receipts	 which	
usually	 appear	 on	 the	 debit	 side	 of	 the	
cash	 book	 and	 the	 duty	 of	 an	 auditor	 in	
that	connection	are	given	below:

All	 unusual	 transactions	 must	 be	
carefully	enquired	into.

4.	 Missing	 vouchers	 should	 be	 carefully	
noted	 and	 brought	 to	 the	 knowledge	
of	the	owner	of	the	business.

5.	 All	 vouchers	 must	 be	 checked	
and	 passed	 for	 payment	 by	 some	
responsible	 official.	 Similarly	 any	
alteration	in	the	vouchers	must	also	be	
supported	by	a	responsible	official.

6.	 All	 the	 receipts	 of	 the	 day	 should	 be	
deposited	in	the	bank	at	the	end	of	the	
day	or	the	next	morning.

7.	 Bank	 reconciliation	 statement	
should	be	prepared	frequently	by	the	
cashier	 to	 verify	 the	 bank	 balance	
with	 cash	 book	 and	 pass	 book.	 He	
should	 also	 examine	 the	 reasons	
for	 the	difference	between	the	bank	
balance	as	per	pass	book	and	that	in	
the	cash	book.	

8.	 All	payments	as	far	as	possible,	except	
for	 petty	 cash,	 should	 be	 made	 by	
cheques	 or	 online.	 If	 large	 amounts	
appear	 to	 have	 been	 paid	 in	 cash,	
contrary	 to	 the	 usual	 practice	 of	 the	
business,	 auditor	 must	 ascertain	
the	 circumstances	 in	 which	 it	 was	
considered	necessary.

9.	 Auditor	 should	 ascertain	 that	 the	
vouchers	 have	 been	 correctly	 posted	
to	 the	 appropriate	 accounts	 and	
distinction	 has	 thoroughly	 been	
observed	between	capital	and	revenue	
expenditure.

10.	Auditor	 should	 ascertain	 that	 the	
cashier	do	not	sanction	any	payments	
of	 special	 nature	 without	 proper	
approval	from	the	directors.	
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sheet	 of  the	 previous	 year.	 This	 is	 done	
to	 ensure  that	 actual	 balance	 has	 been	
brought	down.

Documents to be Vouched:	Audited	
Balance	Sheet	of	last	year.

   5.5.1 Opening balance  
of Cash

Opening	 balance	 of	 the	 current	 year	
refers  to	 the	 closing	 balance	 of	 last	 year.	
It	 should	 be	 compared	 with	 the	 balance	
shown	 in	 the	 duly	 audited	 balance	

Example: 
An	auditor	should	vouch	Opening	Cash	balance	in	the	following	manner:
1.	 Balance	Sheet	of	last	or	previous	year,	and
2.	 Cash	account	for	the	current	year.

Balance Sheet as on 31.3.2016

Liabilities Amount ₹ Assets Amount ₹
Cash	Balance 10,000

Cash Account
(for the year 2016–2017)

Dr.	 	 	 	 	 	 	 	 	 	 	 										Cr.
Date Particulars J.F Amount ₹ Date Particulars J.F Amount ₹

2016
Apr	4 To	Balance	b/d

(ope.	balance)

10,000

Cash Receipt
 Receipt	Number	______________
	 Date	__________________________

Received	From	_________________________	the	amount	of	₹__________________________
For	__________________________________________________________________________________

Current	Balance:	₹___________
Payment	Amount:	₹___________
Balance	Due:	₹_______________
	 	 	 	 	

													Received	By:	________________________
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that	 all	 cash	 received	on	 account	of	 cash	
sales	is	deposited	in	the	bank	on	the	next	
day	itself.	Fraud	may	take	place	in	respect	
of	 cash	 sales,	 when	 salesmen	 sell	 goods	
and	do	not	make	entries	in	the	cash	book	
and	misappropriate	 the	 money.	 In	 order	
to	overcome	such	type	of	fraud,	salesmen	
should	 be	 instructed	 not	 to	 receive	 cash	
from	 customers.	 The	 auditor	 should	
compare	 the	 dates	 on	 the	 cash	 memos	
and	 the	 cash	 book.	 If	 cash	 discount	 has	
been	allowed	on	sales,	he	should	see	that	
a	uniform	policy	and	rate	of	discount	has	
been	followed.

Documents to be Vouched: Sales	
Invoice,	 Duplicate	 cash	 Memo,	
Summary	 of	 daily	 cash	 sales,	 Rough	
cash	book	and	main	cash	book.

   5.5.2 Vouching of Revenue 
Receipts

  (i)  Cash Sales
The	 auditor	 should	 be	 very	 careful	 in	
verifying	 cash	 sales	 as	 there	 are	 greater	
chances	 of	 fraud.	 Firstly,	 the	 auditor	
should	 verify	 the	 system	of	 internal	 check	
in	 operation	 with	 regard	 to	 cash	 sales.	
Secondly,	 he	 should	 verify	 cash	 sales	
invoices	 with	 the	 entries	 in	 the	 summary	
of	 daily	 cash	 sales	with	 regard	 to	 name	 of	
the	customer,	date,	quantity,	rate,	discount,	
tax,	rounding	off	etc.	Thirdly,	the	summary	
of	daily	cash	sales	should	be	compared	and	
tallied	with	the	sales	which	are	accounted	in	
the	cash	book.	Fourthly,	the	auditor	should	
counter	check	the	entries	of	cash	sales	in	the	
cash	 book	 with	 the	 carbon	 copies	 of	 cash	
memos.	 Lastly,	 the	 auditor	 should	 ensure	

Example: 
On	10.4.16,	XY	Co.	sold	goods	worth	Rs.60,000	for	cash.

Vouching of Cash Sales:
Auditor	should	vouch	the	genuiness	of	the	transaction	in	the	following	manner:
1.	 	Verify	Sales	Invoice	with	regard	to	date	of	sale	and	sale	value.
2.	 	Verify	entry	in	Cash	Book	with	respect	to	date	and	amount.
3.	 	Verify	entry	in	Sales	Account	with	respect	to	date	and	amount.

Sales Invoice
XY Co.

Dealers in Textiles
Golden Plaza, Ring Road, Chennai.

Invoice Number: Date: 10/4/16
Particulars Quantity Rate ₹ Amount ₹
Sarees 48 1250 60,000

Total 60,000
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Cash Book
Dr.	 	 	 	 	 	 	 	 	 	 																		Cr.
Date Particulars L.F Amount 

₹
Date Particulars L.F Amount 

₹
2016
Apr	10 To	Sales	a/c 60,000

Sales Account
Dr.	 	 	 	 	 	 	 	 	 	 	 			 Cr.
Date Particulars J.F Amount

₹
Date Particulars J.F Amount

₹
2016
Apr	10 By	Cash	a/c 60,000

   (ii)  Receipts from Debtors

When	 cash	 is	 received	 from	 customers,	 a	
cash	memo	is	issued	to	the	customer	and	a	
carbon	copy	of	cash	memo	is	retained	by	the	
clerk.	 Fraud	 can	 take	 place	 by	 accounting	
lesser	amount	than	what	is	actually	received.	
Sometimes,	fraud	may	occur	when	payment	
received	from	a	customer	is	misappropriated	
without	 making	 entry	 in	 the	 account	 and	
later	on	when	cash	is	received	from	another	
customer.	This	practice	is	called	as	“Teeming	
and	Lading	of	Fraud.”

Auditor	 to	 overcome	 such	 type	 of	
fraud,	 he	 should	 verify	 the	 sales	 invoices	
and	 counterfoils	 of	 the	 receipt	 to	 ensure	
the	 amount	 received	 against	 the	 invoice.	

Cash	 received	 from	 a	 customer	 should	
be	 compared	 with	 the	 entries	 in	 the	 cash	
book	 and	 in	 the	 customers	 account.	 At	
frequent	intervals,	the	auditor	should	obtain	
statement	of	 accounts	 and	confirmation	of	
balances	 from	the	debtors	and	cross	check	
with	the	entries	and	balances	in	the	debtors	
account.	He	should	also	ensure	that	all	cash	
received	on	account	of	cash	sales	should	be	
deposited	in	the	bank	on	the	next	day.

Documents to be Vouched: Sales	
invoices,	Counterfoils	of	cash	receipts,	
Statement	 of	 accounts	 from	debtors,	
Correspondences	 and	 confirmations	
from	the	debtors	and	bank	statement.

Example: 
On	25.10.2016,	Received	cash	from	Gopal	Bros.	 for	₹25,000	towards	sale	made	on	
20.10.2016.
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Vouching of Cash received from Debtors.
Auditor	should	vouch	the	transaction	in	the	following	manner:
1.	 	Verify	Cash	receipt	or	memo	with	respect	to	date	of	receipt,	amount	and	name	of	

customer	from	whom	received.
2.	 	Verify	entry	in	Cash	Book	with	reference	to	date,	name	of	debtor	or	customer	and	

amount.
3.	 	Verify	entry	in	Debtor	or	Customers	Account	with	reference	to	date	and	amount.

Specimen of Cash Receipt
ABC Ltd.,

Paper Mills Road, Chennai.
Receipt No. 1513        Date: 25.10.2016

Received with thanks from Gopal Bros., a sum of ₹25,000\- (Rupees Twenty five 
thousand only) by cash on account of Invoice No.216 dated 20.10.2016.

          Authorised Signatory

Dr. Cash Book Cr.
Date Particulars L.F Amount

₹
Date Particulars L.F Amount

₹
2016

Oct	25 To	Gopal	Bros. 25,000

Gopal Bros. Account
(Debtors/Customers )

Dr.                   Cr.
Date Particulars J.F Amount

₹
Date Particulars J.F Amount

₹
2016

Oct	25 By	Cash	a/c 25,000

  ( iii)  Other Revenue Receipts 
(a)Interest Received 

Interest	 income	 may	 arise	 from	 loans	
granted,	 bills	 of	 exchange	 accepted	 by	
customers,	 debentures,	 deposits,	 bonds	
and	other	investment	securities.	Vouching	
of	 interest	 received	 should	 be	 from	
instruments	 carrying	 interest	 bearing	

obligation.	The	auditor	should	ensure	that	
accrual/receipt	of	interest	is	in	accordance	
with	 terms	of	 the	 instrument	 concerned,	
and	 properly	 recorded	 in	 the	 books	 of	
accounts.	 For	 example,	 interest	 received	
on	account	of	Fixed	Deposits	in	the	bank	
should	 be	 vouched	 with	 the	 Bank	 Pass	
book.	He	should	also	verify	 the	accuracy	
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(c)Others
The	 auditor	 should	 vouch	 the	 receipt	
of	 other	 receipts	 like	 rent	 received	
from	 building,	 commission	 received,	
Subscription	 received,	 sale	 of	 old	 news	
papers,	 Ground	 rent	 received,	 Royalty	
received.	 Receipts	 from	 Bills	 receivable	
,	 Insurance	 claims	 received,	 Bad	 Debts	
recovered	etc.,He	has	to	check	by	referring	
related	 Vouchers,	 documents,	 Bank	
Statements,	 Insurance	 Policy,	 statements	
of	accounts	and	other	correspondences.	

 

   5.5.3 Vouching of Capital 
Receipts

(i) Sale of Investments
The	 amount	 received	 on	 account	 of	

the	sale	of	 investments	should	be	vouched	
with	broker's	sold	note.	When	investments	
are	 sold	 through	 bank,	 then	 bank	 advice	
should	be	verified.

Documents to be Vouched:	 	 Bank	
advice	and	Broker’s	Sold	note.

(ii) Sale of Fixed Assets
The	 auditor	 should	 verify	 the	 sale	

agreement	 and	 correspondences	 and	
ascertain	the	sale	value	of	fixed	assets.	He	
should	 verify	 the	 calculation	 of	 profit	 or	
loss	 on	 sale	 of	 fixed	 assets	 and	 that	 the	

of	 the	 interest	 calculation.	 Vouching	 of	
interest	 received	 on	 securities	 should	 be	
vouched	 from	 the	 securities	 or	 from	 the	
Investment	 ledger	 as	 to	 the	 date	 of	 the	
receipt	of	interest,	amount,	rate	of	interest	
etc.	 Interest	 received	 for	 any	 particular	
fund	 like	 Provident	 Fund	 should	 be	
credited	to	that	fund	and	not	to	the	revenue	
account.	 Further,	 the	 auditor	 should	
obtain	 confirmations	 from	 the	 parties	
owing	interest	payment	and	should	check	
with	 the	 entries	 in	 the	 interest	 received	
account	and	cash	book.

Documents to be Vouched: Loan	
agreement	 or	 Fixed	deposit	 receipts,	
Counterfoil	 of	 cash	 receipts,	 Bank	
pass	book.

(b)Dividend Received 
Vouching	 of	 dividends	 should	 be	 done	
by  referring	 the	 relevant	 dividend	
warrants,  shares,	 and	 securities.	 The	
auditor	 should	 ensure	 that	 the	 client	 has	
indeed	 received	 and	 properly	 recorded	
all  dividends	 that	 are	 due	 to	 it.	 When	
dividend	 is	 collected	 through	 bank,	
amount	 received  should	 be	 verified	
with  the	 bank	 pass	 book.	 He	 should	
check  the	 rate	 of	 dividends,	 amount	
of	 gross	 and	 net	 dividends	 and	 the	 tax	
deducted	at	source.	He	should	also	check	
the	 actual	 receipts	 either	 from	 the	 cash	
book	or	bank	pass	book.

Documents to be Vouched: Dividend	
warrants,	 Counterfoils	 of	 cash	
receipts	and	Passbook.

Documents to be Vouched:		
Documents,	 Bank	 Statements,	
Insurance	 Policy,	 statements	 of	
accounts	and	other	correspondences.
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amount	 is	 treated	as	 capital	profit	 and	 is	
transferred	to	capital	reserve.

Documents to be Vouched:	 	 Sale	 deed	
or	agreement,	Minute	book	of	directors,	
Fixed	 Assets	 Register,	 Bank	 statement,	
Auctioneer’s	 sold	 note	 or	 broker's	 sold	
note	and	correspondences.

(iii) Other Capital Receipts
Legacy	 ,life	 	 membership	 fees,	 patron		
fees,	specific	donation	and	other	like	items	
by	refering	related	voucher		and	documents

Documents to be Vouched:	 	 Trust	
deed	 ,	 Minute	 books,	 and	 other		
correspondences.

Example
On	 12th	 December	 2016,	 sold	 office	 furniture	 for	 ₹11,000	 for	 cash	 which		
costs	₹96,000.

Vouching of Sale of Fixed Assets.
Auditor	should	vouch	the	transaction	in	the	following	manner:
1.	 	Verify	entry	in	Cash	Book	with	reference	to	date,	amount	and	nature	of	asset	sold.
2.	 Verify	entry	in	Asset	Account	with	respect	to	date	and	sale	amount.
3.	 	Verify	entry	in	Fixed	Assets	Register	with	respect	to	date,	invoice	number,	cost,	

rate	of	depreciation	and	specification	or	description	of	asset	sold.

Cash Account
Dr.	 	 	 	 	 	 	 	 	 	 	 					Cr.
Date Particulars L.F. Amount

₹
Date Particulars L.F Amount

₹
2016

Dec	12 To	Office	
Furniture	a/c 11,000
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Office Furniture Account
Dr.	 	 	 	 	 	 	 	 	 	 	 	 					Cr.
Date Particulars J.F Amount 

₹
Date Particulars J.F Amount 

₹
2016		
Dec	12 By	Cash	a/c 11,000

Fixed Assets Register

Name of 
the Asset

Date of Sale Invoice 
No.

Quantity Rate of 
Depreciation

Cost ₹ Sale 
Price ₹

Specification

Office	
Furniture

12.12.2016 356 12 5% 96,000 11,000

•	 Missing Vouchers	 –	 While	 vouching	 if	 a	 number	 of	 vouchers	 or	 supporting	
documentary	 evidences	 are	 not	 available	 for	 the	 entries	made	 in	 the	 books	 of	
account,	such	non-availability	of	vouchers	is	called	as	missing	vouchers.	

•	 Vouching	 –	 It	 is	 the	 technique	 used	 by	 the	 auditor	 to	 examine	 documentary	
evidence	to	ascertain	the	authenticity	of	entries	in	the	books	of	accounts.	

•	 Voucher	–	Documentary	evidence	in	support	of	any	business	transaction	disclosing	
the	nature,	source,	its	value	and	authority.	It	may	be	in	the	form	of	a	receipt,	bill,	
invoice,	counterfoils,	memos,	agreements	or	resolutions	of	a	meeting.

•	 Vouching of Cash Book	–	All	transactions	whether	it	is	cash	receipts	or	payments	
should	be	accounted	in	the	cash	book.	The	auditor	should	verify	the	correctness	
of	 the	entries	by	examining	the	original	documentary	evidences.	Therefore,	 the	
auditor	should	ensure	 that	all	 receipts	have	been	recorded	 in	cash	book	and	no	
fictitious	payments	appear	on	the	payment	side	of	cash	book.	

•	 Vouching Receipts Side of Cash Book	–	Errors	and	frauds	usually	arise	in	connection	
with	cash	receipts.	Hence,	the	auditor	should	vouch	all	the	cash	transactions	as	possible	
and	should	ensure	that	all	receipts	have	been	accounted.	The	receipt	side	or	debit	side	
of	cash	book	contains	transactions	such	as	opening	balance,	cash	sales,	cash	received	
from	debtors,	interest	and	dividend	received,	sale	of	fixed	assets	and	investments.

SUMMARY
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I. Multiple Choice Questions:

1.	 Vouching	_________________________	.
a.	 Involves	verification	of	transactions		
b.	Unearths	fraud
c.	 Examines	the	documentary	

evidence	in	support	of	the	
transactions	

d.	All	the	above
2.	 _________	 is	a	documentary	evidence	

in	support	of	a	transaction.
a.	 Vouching	 b.	 Voucher
b.	Verification	 d.	 All	the	above

3.	 Routine	checking	is	a	part	of	______	
a.	 Vouching
b.	Documentation
c.	 Application	of	knowledge
d.	Verification	of	transactions

4.	 Vouchers	 are	 of	 two	 types,	 namely		
______________________
a.	 Primary	and	duplicate
b.	Primary	and	Collateral
c.	 Collateral	and	Secondary
d.	None	of	the	above

5.	 Voucher	 which	 is	 produced	 in	
support	 of	 entries	 in	 the	 absence	 of	
an	 original	 Voucher,	 is	 called	 as	 a	
______________________
a.	 Primary	Voucher
b.	Collateral	Voucher
c.	Missing	Voucher
d.	Valid	Voucher

6.	 Voucher	which	denotes	written	evidence	
in	original	is	known	as	____________

a.	 Primary	Voucher
b.	Collateral	Voucher
c.	Missing	Voucher
d.	Valid	Voucher

7.	 While	 vouching,	 if	 a	 number	 of	
vouchers	or	supporting	documentary	
evidences	 are	 not	 available	 for	 the	
entries	made	in	the	books	of	account,	
such	 non-availability	 of	 vouchers	
called	______________________
a.	 Primary	Voucher
b.	Collateral	Voucher
c.	Missing	Voucher
d.	Valid	Voucher

8.	 Vouchers	to	be	vouched	in	case	of	sale	
of	fixed	assets	are	
a.	 Counterfoil,	 Dividend	 warrants	

and	Passbook
b.	Counterfoils,	Correspondence,	etc
c.	 Bank	 Advice	 and	 broker’s	 Sold	

Note
d.	Pass	 Book,	 Agreement,	 and	

Counterfoils	
9.	Vouchers	 to	 be	 vouched	 in	 case	 of	

income	 from	 dividend	 warrants	
______________________	
a.	 Counterfoil,	 Dividend	 warrants	

and	Passbook	
b.	Counterfoils,	Correspondence,	etc
c.	 Bank	 Advice	 and	 broker’s	 Sold	

Note
d.	Pass	 Book,	 Agreement,	 and	

Counterfoils	

 EVALUATION 
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10.	Vouchers	 to	 be	 vouched	 in	 case	 of	
receipts	from	debtors	
a.	 Counterfoil,	 Dividend	 warrants	

and	Passbook	
b.	Counterfoils,	Correspondence,	etc

c.	 Bank	 Advice	 and	 broker’s	 Sold	
Note					

d.	Pass	 Book,	 Agreement,	 and	
Counterfoils	

[Answers: 1.(d),  2. (b),  3.(a),  4.(b),  
5.(b),  6.(a),  7.(c),  8.(c),  9.(a),  10.(b)]

II. Very Short Answer Questions

1.	Define	Vouching.
2.	What	is	a	Voucher?
3.	What	is	a	Missing	Voucher?

4.	What	is	a	Primary	Voucher?
5.	What	is	a	Collateral	Voucher?

III. Short Answer Questions:

1.	 What	do	you	mean	by	Vouching?
2.	 What	are	the	objectives	of	Vouching?
3.	 Write	 short	 notes	 on	 vouching	 of	

cash	transactions.

4.	 Why	 Vouching	 of	 cash	 receipts	 is	
necessary?	Illustrate.

IV. Essay Type Questions

1.	Define	 Vouching.	 What	 are	 its	
Objectives?	

2.	 Explain	 the	 procedure	 with	 regard	 to	
vouching	debit	side	of	the	cash	book.

3.	As	 an	 auditor	 of	 a	 business	 concern,	
how	will	you	vouch	cash	receipts.	

4.	Write	 a	 note	 on	 (i)	 Vouching		
(ii)	Vouchers	(iii)	Missing	vouchers.

5.	How	would	you	vouch	the	following?	
(a)	 Sale	 of	 investments	 (b)	 Interest	
received	(c)	 Dividend	received	

References
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3.	Practical	Auditing	–	Dr.	G.Anitha	&	Dr.J.Sankari,	Sai	Selva	Publishers	Distributors.



Chapter
VOUCHING OF CASH  

PAYMENTS 6

After going through this unit the students will be able 
to describe the procedure in regard to vouching the 
cash payments or credit side of the cash book.

Learning Objectives

6.1  Vouching of Cash 
payments or Credit 
Side of the Cash Book 

The auditor vouches cash payments with an 
objective to ensure that all cash payments 
pertaining to business activities are genuine 
and properly authorized. The auditor in 
vouching cash payments or credit side of 
Cash Book should ensure that payments are 
made for the purpose of business, payment 
relates to the period under audit, payment is 
properly sanctioned and recorded, payment 
has been made to the right person, and 
payment is properly supported by a voucher 
and same as entered in Cash Book.

6.2  Auditors Duty in 
Vouching Cash Payments

The auditor should pay special attention 
to the following points while vouching 
cash payments.

1. The auditor should evaluate the 
effectiveness of Internal check and 
Internal control system for cash 
payments.

2. He should ensure that all the vouchers are 
made in the name of the business concern 
and payments are made pertaining to 
business. 

3. He should ensure that vouchers have 
been correctly posted to the appropriate 
accounts and properly distinguished 
between capital and revenue expenditure.

4. He should ensure that all cash payments 
are within the period under audit.

5. When cash payments are made in excess 
of `10,000 the auditor should ensure  
the same made through electronic 
mode.

6. Auditor should verify that all payments 
are recorded as per the provisions of 
Companies Act, 2013.

TO BE RECALLED

In the previous lesson, we have studied the meaning of vouching and voucher, and 
procedure in regard to vouching the debit side of the cash book. The debit side 
items such as Opening balance, cash sales, receipts from debtors, income from 
interest and dividend, sale of investments and sale of fixed assets have been dis-
cussed in the previous lesson
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7. He should also compare the rough cash 
book with the cash book to identify the 
fictitious payments.

6.3  Vouching of Revenue 
Payments

Revenue expenditure is an expenditure 
which is incurred to maintain the revenue 
earning capacity of the business. Expense 
which are incurred in day – to – day running 
of the business and which does not increase 
the earning capacity of the business are 
called revenue expenditure.

The Procedure in vouching the various 
items of Revenue Payments are as follows :

6.3.1  Cash Purchase:

•	 The Auditor should check the entries 
in the cash book with cash memo or 
Invoices issued by the suppliers.

•	 The Auditor should compare the entries 
in the cash book with the Goods Inward 
Book.

•	 The Auditor should ensure that the 
cash purchases are made after obtaining 
proper authorization from a responsible 
officer.

•	 Auditors should also check that only 
net amounts are paid.

6.3.2  Cash Paid to 
Creditors

While vouching cash payment to creditors, 
the auditor should examine the system of 
internal control in existence. He should 
check the entries in the cash book with the 
receipts issued by creditors or counterfoils 
of cheque book and bank statement. He 
should compare the ledger balances of 
creditor with statement of account sent 
by them. Further, the auditor should 
ensure that all payment made to creditors 
are properly authorized by a responsible 
official. When payment was made as full 
and final settlement, auditor should verify 
whether the company has been availed any 
discount and is accounted as discount received.

Documents to be Vouched: 

Receipts issued by creditors, Invoices, 
Statements of accounts of creditors, 
Bank statement.

Documents to be Vouched: 

Cash memo or Invoice issued by the 
supplier. 

Goods Inwards Book and Bank 
statement.

LEGAL CASE STUDIES

•	 In a case between Irish Woollens 
Co. Ltd. Vs. Tyson and others, 
it was held that auditor was 
negligent for not verifying the 
liabilities. He was liable to pay 
damages for the loss suffered by 
the client. 

•	 In another case, Arthur E. Green 
& Co. Vs. General Advance and 
Discount Corporation, it was 
held that the auditor was liable for 
accepting the schedule of debtors 
without verifying thereof.
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Documents to be Vouched:
Bills payable book, pass book and  
Receipts

 6.3.3  Cash Paid To Bills 
Payable

The auditor should vouch the entries in the 
Bills Payable Book and the Bank Pass Book 
if payment is made by bank. He should 
ensure that bills when honored on the date 
of maturity and returned by the payee after 
receiving the payment should be properly 
canceled after payment.

Example
On 12.3.17, Paid cash to Rakesh Rs.22,000 being supplier of goods.

Vouching of Cash paid to Creditors.
Auditor should vouch the transaction in the following manner:
1. Verify entry in Cash Book with respect to date, name of creditor or supplier and 

amount paid.
2. Verify entry in Creditor or Supplier Account with reference to date and amount.

Cash Book
Dr.             Cr.

Date Particulars L.F. Amount
₹

Date Particulars L.F. Amount
₹

2017
Mar 12 By Rakesh a/c 22,000

 Rakesh (Creditors) Account
Dr. Cr.

Date Particulars J.F Amount
₹

Date Particulars J.F Amount
₹

2017
Mar 12 To Cash a/c 22,000
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 6.3.4  Cash Paid To Wages 
And Salaries

Vouching of payment of wages and salaries 
is an important duty of an auditor as there 
are many chances of misappropriation 
of cash. The following are some of the 
duties of an auditor in vouching wage and 
salaries payments.

(i)Wages

1. The auditor should verify the 
effectiveness of the system of internal 
check in operation with regard to the 
preparation of wage sheet, maintenance of 
records and payment of wages. 

2. He should verify the arithmetical 
accuracy in calculation of wages.

3. He should verify the attendance register 
of the employees and vouch it with the 
wage sheet to ensure that the wages has 
been correctly calculated only for the days 
worked by the employee.

4. Auditor should carefully scrutinize the 
wage sheet to identify that no dummy 
workers or ex-employees are included in 
the wage sheet.

5. Auditor should vouch the entries in the 
cash book with the wage sheet. He should 
also vouch the entries in the cash book 
with the bank statement to ensure that 
correct amount is withdrawn for payment 
of wages.

6. The auditor should compare the signature 
or thumb impression of the workers with 
previous months to check the genuineness 
of the person receiving the payment.

7. He should ensure that unclaimed or 
unpaid wages has been deposited in the 
bank. He should vouch the unpaid amount 
in the wage sheet with the entry in the 
bank statement. Payment for unpaid wages 
should be made only against authorization 
signed by a responsible official.

8. Auditor should verify that there is a 
proper system of wage payment to casual 
laborers.

Documents to be Vouched:
Attendance register Time or piece 
records, Leave register, Overtime 
register, Wage sheet, Bank statement, 
Register of casual labourers

Example:
On 5/7/2016, Paid wages by cash for ₹8,000.
Vouching of Payment of Wages
Auditor should vouch the transaction in the following manner:
1. Verify entry in Cash Book with respect to wages paid amount and date of payment.
2. Verify entry in Wages Account with regard to date and amount of payment.
3. Verify entries in Wage Sheet.
4. Verify entries in Pay Roll.
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Cash Account
Dr.  Cr.
Date Particulars L.F Amount

₹
Date Particulars L.F Amount

₹
2016
July 5 By Wages a/c 8,000

Wages Account
Dr.  Cr.

Date Particulars J.F Amount
₹

Date Particulars J.F Amount
₹

2016
July 5 To Cash a/c 8,000

Specimen of Wage Sheet

No.--------------                Week ending -------------
Job No.10 Job No.11 Job No.12 Job No.13

Clock 
No.

Hrs. Amt.

₹
Clock 
No.

Hrs. Amt.

₹
Clock 
No.

Hrs. Amt.

₹
Clock 
No.

Hrs. Amt.

₹

Total Total Total Total
Prepared By ----------------          Checked By ---------------

Specimen of Payroll
Name No. of 

worker
Rate Total 

Hrs.
OT 
Hrs.

Wages DA Gross 
Wages

Deductions Total 
Deductions

Net 
WagesESI PF IT Others

₹ ₹ ₹ ₹ ₹ ₹ ₹ ₹ ₹ ₹

Total
Prepared By ----------------     Checked By ---------------
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(ii)Salaries

1. Auditor should check the system of 
internal check in maintenance of attendance 
of the employees, preparation of salary bills, 
disbursement of salary.

2. He  should check the calculations in the 
salary register.

3. He should ensure that salary has been 
paid only after obtaining sanction and in 
the presence of a responsible officer.

4. He should compare the salary bill of the 
current month with previous month.

5. He should verify deductions with regard 
to provident fund, income tax, insurance 
and repayment of advance etc.,

Documents to be Vouched: Salary 
register, Attendance register, bank 
Statement.

6.3.5  Directors Fees

Directors of a company are paid fees for 
attending the Board meetings, they are 
known as Directors fees or Sitting fees. 

Directors are entitled to get remuneration 
only when the Articles of Association of 
the company provide. Hence the auditor 
should examine the Articles and the 
resolution passed by the shareholders in 
the general meeting. Auditor should check 
the attendance register which will provide 
the name of directors who attended the 
board’s meetings and the minutes of the 
Board meeting to confirm the presence of 
the directors for payment of remuneration. 
He should ensure that amount paid towards 
fees or remuneration to directors is shown 
separately in the Profit and Loss account.

Documents to be Vouched: 
Articles of association, Minutes 
book, Attendance register, Resolution 
passed by shareholders.

 

6.3.6  Other Revenue  
Expenses:

(i) Rent Paid 

1. Auditor should verify the rental 
agreement and receipt given by the Land 
Lord in connection to the Rent Paid.

DEBIT OR PAYMENT VOUCHER

Vinodh & Sons (P) Ltd.,
Gandhi Road, Chennai.

Voucher No. ________________ Date: _________________

Particulars Amount ₹
Debit Account:
Being the

Total

     Sd/-                                                                                                                          Sd/-
Manager  Accountant
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4. When the company has many insurance 
policies, the auditor should verify all 
the policies.

Documents to be Vouched: Insurance 
Policy, Receipt issued by insurer, Bank 

Statement.

6.4  Vouching Of Capital 
Payments

Capital expenditure is an expenditure 
which is incurred in the acquisition or 
improvement of a permanent fixed asset 
for the purpose of earning revenue.

6.4.1  Purchase Of Land And 
Buildings

Auditor should examine the title deeds 
and sale agreements of the property 
purchased. When assets are purchased on 
leasehold basis, lease agreement should 
be verified with regard to lease rent, 
period, terms and conditions. In case 
of purchase of freehold asset, auditor 
should examine the correspondence 
directly from the seller. He should ensure 
that all expenses incurred in connection 
with purchase of a asset like auctioneers 
commission, brokerage, architects fees, 
registration fees and legal charges, are 
capitalized. He should also vouch all 
such payments with reference to receipts. 
When asset is purchased through 
broker, the auditor should verify the 
brokers note. When asset is purchased 
in auction, the account submitted by 
the auctioneer should be examined. 
Similarly, auditor should ensure that all 
expenses incurred in connection with 

2. Auditors should verify whether rent is 
authorized for payment by a responsible 
person.

3. Entries with regard to outstanding and 
prepaid rent should be checked with the 
entries in the books. 

Documents to be Vouched: Rental 
Agreement, Receipt given by the 

Landlord

(ii)Interest Paid :

1. When interest is paid on loan, the 
auditor should examine the loan 
agreement.

2. Auditor should check that all interest 
payments are supported by vouchers 
and receipts.

3. When interests in paid on debentures, 
debentures interest book should be 
checked with the entries in the cash 
book.

Documents to be Vouched: Loan 
agreements, Debenture Interest book, 

Bank Statement.

(iii) Insurance Premium 

1. Auditor should carefully examine the 
Insurance Policy and check the policy 
amount, date of maturity,  premium 
amount etc.,

2. Insurance premium paid should be 
vouched with the receipts issued by the 
Insurance Company.

3. Auditors should ensure that proper 
entries are recorded in the books 
of accounts with regard to prepaid 
insurance premium.
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Documents to be Vouched: (1) Title 
deeds, sale Agreements, (2) Lease 
Agreement, (3) Correspondences with 
Seller, (4) Auctioneers Statement, (5) 
Architects Certificate, (6) Contractors 
Agreement, (7) Receipts

construction of a building like materials 
purchased, wages paid, cartage has been 
capitalized. In case of construction of 
a building, auditor should examine the 
construction contracts and architects 
certificate.

Example
On 20th April 2016, purchased a piece of land for Rs.1,00,000 and paid cash.

Vouching of Purchase of Land and Buildings
Auditor should vouch the transaction in the following manner:
1.  Verify entry in Cash Book with respect to date of purchase, cost and nature of asset 

purchased.
2.  Verify entry in Land and Buildings Account with regard to date and amount of 

purchase.
 Cash Account

Dr. Cr.
Date Particulars L.F Amount ₹ Date Particulars L.F Amount 

₹
2016
Apr 20 By Land and 

Buildings a/c 1,00,000

Land and Buildings Account

Dr. Cr. 

Date Particulars J.F Amount
₹

Date Particulars J.F Amount
₹

2016
Apr 20 To Cash a/c 1,00,000
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6.4.4   Purchase of 
Investments

Auditor should vouch payments made 
for purchase of investments with the 
Brokers Bought Note. He should verify 
that investments purchased are properly 
authorized and registered in the name 
of the company. He should physically 
examine the actual investment held by 
the company. In case of new issue of 
securities, auditor should examine letters 
of allotment, bank receipt for installments 
paid, share certificates etc. If investments 
are purchased cum-dividend, auditor 
should verify that the expenditure has 
been properly apportioned between 
capital and revenue. In case of inscribed 
stock, certificate from the bank in whose 
books the stock is inscribed should be 
obtained.

Documents to be Vouched: (1) 
Brokers bought note, (2) Schedule of  
Investments, (3) Share certificate, (4) 
letters of Alloment and Bank Receipt, 
(50 Bank Certificate fo inscribed 
Stock.

6.4.5   Purchase of Patents 
and Copyrights

Patent is an exclusive right or privilege to 
make or produce something and copyright 
is a right to produce an item of a particular 
design. In case of purchase of patents 
and copyrights, auditor should obtain 
the patents and copyrights list from the 
client and examine it with reference to 

6.4.2   Purchase of Plant and 
Machinery / Furniture and 
Fixtures

When plant and machinery are purchased, 
auditor should vouch the invoices and receipts 
received from the vendors. He should ensure that 
all incidental charges connected with the asset 
are capitalized and added with the cost of asset. 
He should also carefully scrutinize that expenses 
in connection with repairs and maintenance are 
not capitalized. When the asset is purchased on 
hire purchase, he should verify the hire purchase 
agreement and related vouchers. When the 
asset is purchased on auction, auctioneers 
statement of account should be verified. In case 
of purchase of imported machinery, any import 
duty and clearing charges should be debited to 
asset account.

Documents to be Vouched: (1) 
Invoice from Vendors, (2) Receipts, (3) 
Auctioneers Statement of Accounts, 
(4) Hire Purchase Agreement

6.4.3   Purchase of Motor 
Vehicles

Contract of purchase, invoice, broker’s 
note, payee’s acknowledgement, asset 
receiving report and the registration book 
showing the ownership in the name of the 
client should be examined.

Documents to be Vouched: (1) 
Invoice, (2) contract of purchase, (3) 
Registration boook, (4) Brokers note 
and (5) Payees acknowledgement



registration number, date, name of the seller, 
consideration paid etc. He should verify 
the registration certificates, certificates for 
grant of patent, documents of assignment, 
copyright agreements and receipt for 
renewal fees. When patent is purchased 
through broker, brokers commission 
should be accounted as capital expenditure 
and should be included in the cost of 
patent. Similarly, when patents are received 
through research, research expenses should 
also be capitalized. On the other hand, he 
should ensure that renewal fees paid should 
be not be capitalized but instead should be 
treated as revenue expenditure. He should 
also ensure that lapsed patents have been 
written off from the books of accounts.

Documents to be Vouched: (1) 
list of patents and Copyrights, (2) 
patent and Copyright Agreement, 
(3) Registration Certificates, (4) 
document of Assignment, (5) Receipts

6.4.6 Other Capital 
Expenditures
(i).Preliminary Expenses :

a. The Auditor should check the 
correctness of items which are included in 
the preliminary expenses.

b. The Auditor should check the 
preliminary expenses amount as stated in 
the balance  sheet.

c. Auditor should examine the vouchers 
relevant to preliminary expenses

(ii). Expenses on issue of debentures :.

a. The auditors should verify the 
payment made towards commission and 
brokerage on issue of debentures.

b.  He should verify the agreement 
made with the under writers and brokers 
and ensure whether it is authorized by the 
Articles of Association.

6.5 Closing Balance of Cash:

a. The auditor should  verify the 
closing balancing of cash by comparing 
cash book, Bank Statement and Other 
Sources.

b. Auditor should verify closing 
balance of cash with cash book and 
balance as shown in assets side of balance 
sheet.

c. He should also check physical 
cash denominations at the end of the 
accounting period
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Vouching of Cash Payments
•	 Cash Payments should be vouched to ensure that the payments made were 

exclusively and wholly for the business and are a proper business charge.

Auditors Duty
•	 Vouching of cash payments should be made to determine that the payments are 

supported by the required documentary evidence. The name of client, date in 
the payee’s acknowledgement, authorization by competent person, revenue stamp 
should be verified with respect to cash payments.

Cash Paid to Creditors
•	 The Cash Paid to Creditors should be vouched referring statement of accounts, 

receipts issued by creditors, invoices and goods inward book.

Wages
•	 Wages should be vouched referring wage book, wages sheets, wage records, job cards, etc.

Salary
•	 Salary should be vouched referring Salary Register, employees Attendance Register 

and deduction of Income Tax, Provident Fund, etc.,
Capital Expenditure
•	 Capital Expenditure should be vouched by verifying invoice, agreements, letter of 

contract, receipts, etc.

Bills Payable
•	 Bills Payable should be verified referring bills payable register, payee’s 

acknowledgement and pass book.

Directors' Fees
•	 Directors’ Fees should be verified referring Articles of Association, receipts, 

minutes book, special resolution and attendance register.

SUMMARY

KEY TERMS

•	 Bills Payable: Payable against goods or services received on credit.
•	 Bills Receivable: Receivable against sale of goods/service provided to the customer.
•	 Capital Expenditure: Money spent by a business or organization on acquiring or 

maintaining fixed assets, such as land, buildings, and equipment.
•	 Cash Payments: Payments made in cash for various business transactions.
•	 Creditors: The person or a company to whom the money is owed.
•	 Director’s fees: Fees paid to the Company Director for attending the meeting.
•	 Wages: Remuneration paid by the employer to the worker for the work done.
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I. Multiple Choice Questions.

1. Vouching implies ____________
a. Inspection of receipts
b. Examination of vouchers to check 

authenticity of records
c. Surprise checking of accounting 

records
d. Examining the various assets

2. Payment for goods purchased 
should be vouched with the help of 
____________
a. Creditors statement  
b. Correspondence with suppliers
c. Cash memos   
d. Ledger accounts

3. Payment for wages should be vouched 
with the help of _____________
a. Working hours statement 
b. Wage sheets
c. Minutes book   
d. Bank pass book

4. Payment for building purchased 
should be vouched with the help of
a. Title deed   
b. Correspondence with Brokers
c. Building account  
d. Cash book

5. Process of checking the evidence of 
the entries called _____________. 
a. Verification    
b. Observation  
c. Vouching    
d. Inspection

6. Voucher should be addressed to the 
____________. 
a. Auditor   
b. Client 
c. Employee    
d. Worker

7. Serial number of vouchers should be 
____________. 
a. Colored    
b. Continuous 
c. Even number   
d. Odd number

8. Which of the point is not to be 
considered while checking a 
voucher? 
a. Name of party   
b. Serial number of voucher 
c. Credit period of payment  
d. Accounting entry

9. Checking the date of voucher helps 
the auditor to obtain evidence that 
_____________. 
a. The transaction relates to current year 
b. The transaction has taken place
c. The transaction is genuine  
d. The transaction is legal.

 EVALUATION 
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10.  The auditor does not check the 
following while auditing wages: 

 (a) Calculation of the salary 
 b.  Whether the calculation was 

verified by department heads

 c.  Whether dues like PF, PT, TDS 
have been deducted and deposited 

 d.  Payment has been made to all the 
employees on first of the month

[Answer: 1(b); 2(a); 3(b); 4(a);  5(c); 6(b); 7(b); 8(c); 9(a); 10 (d)]

II. Very Short Answer Questions.

1. What do you mean by vouching of 
bills payable?

2. What are the documents to be verified 
while vouching wages?

3. What are the important items covered 
under capital expenditure?

4. What is meant by patent?
5. How the vouching of motor vehicle 

purchases can be made?
6. what is meant by Revenue Expenditure?
7. what is meant by Capital Expenditure?

III. Short Answer Questions.

1. Discuss the objects of vouching cash 
payments.

2. What are the points to be carefully 
considered while examining the 
evidence of payments?

3. How the vouching of payments to 
creditor can be made?

4. What are the steps to be followed in 
vouching the director’s fee?

5. Explain in short the procedure for 
vouching bills payable?

IV. Essay Type Questions.

1.  Explain the procedure for  
vouching of wages and salaries.

2. Discuss the steps involved in vouching 
capital expenditure.

3. Discuss the duties of an auditor and 
steps to be taken while vouching the 
cash payments.



Chapter 7 VOUCHING OF TRADING  
TRANSACTIONS

•	 After	 going	 through	 this	 unit	 the	 students	will	 be	 able	 to	 describe	 the	
procedure	with	regard	to	vouching	of	credit	purchases,	credit	sales	and	
goods	sent	on	sales	or	return	system	and	goods	maintained	in	stores.

Learning Objectives

7.1  Vouching of Trading 
Transactions - 
Introduction

After	having	completed	the	vouching	of	cash	
transactions,	the	auditor	should	proceed	to	
examine	the	trading	transactions.	Trading	
is	 a	 business	 process	 starting	 with	 the	

purchase	of	goods	and	ending	with	sales.	The	
major	 trading	 transactions	 are	 purchases,	
purchase	 returns,	 sales	 and	 sales	 returns.	
The	 main	 objective	 of	 vouching	 trading	
transactions	 is	 to	detect	misappropriation	
of	goods.	Therefore,	the	auditor	should	take	
great	care	in	vouching	trading	transactions	
to	prevent	misappropriation	of	goods.	

TO BE RECALLED

The	 students	 learnt	 the	 auditing	 procedure	 with	 regard	 to	 vouching	 of	 cash	
payments	i.e.	payment	to	creditors,	wages,	capital	and	revenue	payments,	bills	
payable,	and	director’s	fee	from	the	previous	lesson.

AUDIT COMMITTEE

WE WANT TO
MAKE SURE YOU’RE

FIT FOR PURPOSE

87Vouching of Trading Transactions
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2.	The	auditor	should	vouch	the	entries	in	
the	 Purchases	 Book	with	 the	 invoices,	
copies	of	orders	placed,	Goods	Inward	
Book	and	delivery	notes.

3.	He	 should	 ensure	 that	 only	 credit	
purchases	are	recorded	in	the	Purchases	
Book.

4.	He	 should	 also	 ensure	 that	 purchase	
of	capital	goods,	 i.e.,	purchase	of	plant	
and	machinery	or	any	capital	asset	are	
not	entered	 in	Purchase	Book.	 Instead	
they	should	be	accounted	in	fixed	assets	
account.

5.	Auditor	 should	 check	 the	 totalling	
and	casting	of	the	purchases	book	and	
ensure	that	all	taxes,	octroi	and	freight	
are	 added	 to	 the	 purchases	 and	 trade	
discount	allowed	are	deducted.

6.	When	 directors	 or	 partners	 purchase	
goods	for	personal	use,	auditor	should	
ensure	that	such	purchases	are	charged	
to	their	personal	accounts.

7.	Auditor	 should	 compare	 the	
Gatekeepers	 Goods	 Inward	 Book	 and	
the	 stock	 sheets	 with	 the	 purchases	
book	 to	 ensure	 that	 all	 goods	 taken	
into	 stock	 have	 been	 entered	 in	 the	
purchases	book.

Books and Documents to be Vouched:	
(1)	 Purchase	 Invoice	 (2)	 Purchase	
Book	 (3)	Suppliers	 ledger	 account	
(4) Gatekeepers	Goods	Inward	Book.

7.2  Vouching of Credit 
Purchases

Transactions	 relating	 to	 credit	 purchases	
of	 goods	are	 recorded	 in	Purchase	Book.	
The	main	objective	of	vouching	purchase	
book	 is	 to	 ensure	 that	 all	 the	 goods	
purchased	 during	 the	 year	 are	 being	
received	 and	 the	 client	 makes	 payment	
only	for	the	goods	being	delivered	by	the	
supplier.	 The	 auditor	 before	 vouching	
the	purchase	book	 should	 satisfy	himself	
about	 the	 effectiveness	 of	 the	 Internal	
check	and	Internal	control	system	relating	
to	purchases.

 Auditors Duty

While	vouching	purchase	book	the	auditor	
should	consider	the	following	points:

1.	The	auditor	should	carefully	check	the	
entries	in	the	Purchase	Book	with	the	
purchase	 invoices.	 While	 examining	
the	 purchase	 invoice	 the	 auditor	
should	 pay	 attention	 to	 the	 following	
points:-
a.	 Invoices	are	in	the	name	of	the	client.

b.	The	date	of	the	invoice	should	relate	
to	the	period	under	audit.

c.	 The	 name	 of	 the	 creditor	 in	 the	
invoice	agrees	with	the	name	entered	
in	the	purchases	book.

d.	Orders	 should	 be	 placed	 by	 a	
responsible	officer	and	there	should	
be	 another	 responsible	 officer	 to	
pass	the	invoice	for	payment.

e.	 Invoice	 should	 be	 initialed	 by	 the	
Invoice	clerk	as	being	checked.
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Example:
On	 5.1.2017,	 X	 Ltd.	 purchased	 30	 cotton	 shirts	@	Rs.150	 each	worth	 Rs.4,500	 from	
Goyal	Mills,	Ahmedabad	on	credit.

Vouching of Credit Purchases 
Auditor	should	vouch	the	transaction	in	the	following	manner:
1.	Verify	entry	in	Purchase	Day	Book	with	respect	to	date	of	purchase,	invoice	number,	

name	of	supplier	and	amount	of	purchase.
2.	Verify	entry	in	Suppliers	Account	with	regard	to	date	and	amount	of	purchase.

Purchase Day Book

Date Purchase 
Invoice No.

Name of the Customer L.F. Details 
Qty

Amount 
₹

2017 
Jan. 5 210 Goyal Mills, Ahmedabad 30 4,500

Goyal Mills (Creditor/Supplier), Ahmedabad Account

Dr.                   Cr.
Date Particulars J.F Amount

₹
Date Particulars J.F Amount

₹
2017 
Jan. 5 By	Purchases 4,500

 7.3  Vouching of Credit 
Sales

In	 Sales	Book,	 only	 credit	 sales	 of	 goods	
are	recorded.	Auditor	before	vouching	the	
sales	book	should	check	the	effectiveness	
of	the	system	of	internal	check	and	Internal	
control	in	operation.

 Auditors Duty

The	auditor	should	carry	out	vouching	of	
credit	sales	in	the	following	manner:

1.	 The	auditor	should	verify	the	efficiency	of	
the	system	of	Internal	check	in	operation	by	
test	checking	the	transactions.

2.	Auditor	 should	 vouch	 Sales	 Book	
with	 the	 copy	 of	 the	 invoices,	 Orders	
Received	 Book	 and	 Goods	 Outward	
Book	and	ensure	that	all	sales	made	are	
accounted.

3.	He	should	check	the	casts,	postings	and	
carry	forwards	of	the	Sales	Book.

4.	He	 should	 see	 whether	 there	 is	 any	
omission	or	inflation	of	sales.
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9.	Auditor	 should	 carefully	 vouch	 the	
entries	 made	 in	 the	 sales	 book	 of	 the	
last	few	weeks	to	ensure	sales	related	to	
the	next	financial	period	are	not	treated	
as	current	year’s	sales	or	fictitious	sales	
not	being	recorded	in	the	books	which	
will	inflate	the	profit.

Books and Documents to be 
Vouched: (1)	 Sales	 Invoice,	 (2)	 Sales	
Book,	 (3)	Customers	 ledger	 account,	
(4)	Goods	Outward	Book.

5.	Auditor	should	ensure	that	sale	of	capital	
assets	 are	 not	 considered	 as	 ordinary	
sales	and	accounted	in	Sales	Book.

6.	Trade	 discounts	 allowed	 to	 customers	
should	 be	 checked	 and	 differences	 if	
any	observed	should	be	enquired.

7.	Auditor	 should	 check	 that	 cancelled	
invoices	 are	 properly	 cancelled	 and	
kept	separately.

8.	To	 detect	 fraud,	 the	 auditor	 should	
prepare	a	 statement	of	accounts	of	 the	
customers	and	send	it	to	the	customers	
to	confirm	the	accuracy	of	the	balance.

Example:
On	5.2.2017,	X	Ltd.	sold	20	shirts	for	Rs.200	each	to	Ram	&	Co.,	Bangalore	on	credit.

Vouching of Credit Sales 
Auditor	should	vouch	the	transaction	in	the	following	manner:
1.	Verify	entry	in	Sales	Day	Book	with	respect	to	date	of	sale,	invoice	number,	name	

of	customer	and	sale	amount.
2.	 Verify	entry	in	Debtors	or	Customers	Account	with	regard	to	date	and	amount	of	sale.

Sales Day Book

Date Sales 
Invoice No. Name of the Customer L.F. Details 

Qty
Amount

₹
2017 
Feb. 5 112 Ram	&	Co.,	Bangalore 20 4,000

Ram & Co. (Debtors / Customers) Account

Dr.             Cr.

Date Particulars J.F Amount
₹ Date Particulars J.F Amount

₹
2017 
Feb. 5 To	Sales	A/C 4,000
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7.4  Goods Sent on ‘Sale or 
Return Basis’

When	goods	are	delivered	to	a	customer	on	
condition	 that	 if	 goods	 are	not	 	 approved	
within	 a	 particular	 period	 the	 customer	
can	 return	 the	 goods.	 Such	 a	 type	 of	 sale	
is	called	as	Goods	on	‘sale	or	return’	basis.

Auditors Duty

The	auditor	should	vouch	 ‘sale	or	return’	
basis	by	considering	the	following	points:

1.	Auditor	 should	 verify	 that	 a	 separate	
sale	 or	 return	 journal	 with	 necessary	
columns	for	sale	price	of	goods,	value	of	
goods	 returned	and	 retained	 should	be	
maintained.

2.	Auditor	 should	 vouch	 the	 goods	 on	
‘sale	 or	 return’	 journal	 with	 invoices,	
correspondences	 with	 the	 client	 or	
other	documentary	evidences	available	
with	the	client.

3.	The	 auditor	 should	 ensure	 that	 goods	
sold	on	approval	should	not	be	treated	
as	 complete	 sale	 unless	 the	 customer	
approves	the	sale.

4.	He	 should	 check	 that	 until	 the	 goods	
are	 approved	 it	 should	 be	 shown	 as	
goods	with	customers	 in	closing	stock	
in	Balance	Sheet.	If	this	is	not	done,	the	
profit	 of	 the	 concern	 will	 be	 inflated	
and	will	not	show	the	correct	financial	
position.

Vouching of Goods Sent on Sale or Return Basis 

Auditor	should	vouch	the	transaction	in	the	following	manner:
1.	Verify	entries	in	the	Goods	sent	on	‘sale	or	return’	basis	with	respect	to	date,	invoice	

number,	name	of	customer	and	amount	at	which	goods	are	sent	for	sale.
2.	Verify	entries	in	Goods	Inward	Book	with	regard	to	date	and	value	of	goods	returned	

and	retained.
3.	Verify	entries	in	Goods	on	‘sale	or	return’	Account	with	regard	to	date	and	amount	

of	goods	returned	and	retained.

Goods Sent on ‘sale or return’ Book

Date Invoice No. Name of Customer L.F Amount
₹
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while	vouching	goods	maintained	 in	stores.	
the	auditor	should	bear	in	mind	the	following

1.	Location of Stores: Stores	 should	 be	
located	at	a	convenient	place	and	should	
have	proper	facilities	so	that	goods	may	
not	be	misplaced,	misused	or	wasted.

2.	Receipt of Stores: The	Stores	Department	
on	 receiving	 the	goods	 in	 stores	 should	
prepare	 a	 Goods	 Received	 Note	 in	
triplicate.	One	copy	of	the	note	should	be	
sent	to	the	Purchase	Department,	second	

7.5  Vouching with regards 
to Stores

Stores	 is	 a	 place	where	 different	 kinds	 of	
materials,	 consumables,	 spare	 parts	 are	
kept	under	the	control	of	a	person	known	
as	storekeeper.	The	storekeeper	maintains	
and	has	control	over	the	materials	kept	in	
stores.	 He	 maintains	 a	 ledger	 known	 as	
Stores	Ledger	where	he	accounts	quantity	
and	value	of	materials	 received,	 issued	 to	
production	 department	 and	 maintains	
balance	of	materials	left	in	the	stores.	Every	
organization	has	to	maintain	the	stores	of	
different	 kinds	 of	 materials	 like,	 finished	
goods,	 semi-finished	 goods	 and	 raw	
materials	 in	a	proper	way.	Stock	of	goods	
kept	 in	 the	 Stores	Department	 should	 be	
properly	protected	 against	pilferage,	 theft	
or	 misappropriations.	 Hence	 a	 proper	
system	 of	 internal	 check	 in	 relation	 to	
stores	must	be	given	careful	attention.

Goods on Return Inward Day Book

Date
Proforma 

Credit
Name of Customer L.F. Retained 

₹
Retained 

₹

Goods on Sale or Return Account

Dr.                 Cr.

Date Particulars J.F Amount
₹ Date Particulars J.F Amount

₹
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copy	 to	 the	 Accounts	 Department	 and	
the	 third	 copy	 will	 be	 retained	 by	 the	
Stores	 Department.	 The	 particulars	 of	
the	goods	received	should	be	entered	in	
the	note.

3.	Preservation of Stores: Stores	 should	
be	properly	preserved	the	following	are	
the	points	to	be	noted	in	this	regard.

•	 A	separate	place	should	be	earmarked	
for	each	type	of	stores.

•	 All	 items	 in	 stores	 should	be	 serially	
numbered	and	the	place	where	they	are	
to	be	kept	also	should	be	numbered.

•	 Entries	 relating	 to	 stores	 such	 as,	
receipts,	 issues	 and	 balance	 of	 stores	
should	 be	 recorded	 in	 the	 bin	 cards.	
Such	bin	cards	should	be	kept	hanging	
on	the	places	where	stores	are	reserved.

•	 A	 responsible	 officier	 at	 frequent	
intervals	should	check	the	stores	and	
should	 also	 compare	 the	 bin	 cards	
with	the	stores	ledger.

•	 At	 regular	 intervals	 stock	 taking	
should	 be	 conducted.	Differences	 if	
any	noticed	between	the	actual	stock	
and	 the	 balance	 of	 stock	 as	 shown	
by	 the	 books	 should	 be	 properly	
adjusted	 after	 obtaining	 sanction	
from	the	higher	officials.

4.	 Issue of Stores: The	 following	 system	
should	be	adopted	for	issuing	stores:

•	 Stores	should	be	issued	only	against	
proper	requisition	slip	received	from	
the	department.	The	requisition	slip	

should	be	 signed	by	 the	 responsible	
person	of	the	department.

•	 Issue	of	 stores	 should	be	made	only	
by	an	authorized	person.	The	Stores	
officer	should	be	seated	near	the	

•	 so	that	all	the	issues	should	be	made	
under	his	supervision.	

•	 When	 materials	 or	 stores	 are	
returned	from	the	job	or	department,	
it	 should	 be	 properly	 accounted	 in	
the	Materials	Return	Note.

•	 When	 materials	 or	 stores	 are	
transferred	from	one	department	or	
job	to	another	entry	should	be	made	
through	the	Materials	Transfer	Note.

•	 Proper	 instructions	 should	 be	 given	 to	
the	gate-keeper	not	to	allow	any	materials	
out	 of	 the	 factory	 without	 obtaining	
permission	from	the		storekeeper.

5.	Recording: When	materials	are	 issued	
under	 the	 Material	 Requisition	 Slip	
from	 the	 department,	 the	 requisition	
slip	 should	 be	 sent	 to	 the	 stores	
accounts	 section	 for	 recording.	 At	
frequent	intervals	the	bin	cards	should	
be	 checked	 and	 compared	 with	 the	
entries	in	the	stores	records.

Books and Documents to be Vouched:	
(1)	 Bin	 Card	 (2)	 Stores	 Ledger	 (3)	
Goods	 Received	 Note	 (4)  Material	
Requisition	Slip	(5) Material	Transfer	
Note	(6)	Material	Return	Note.	
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•	 Trading	transactions	include	credit	purchases	and	credit	sales.	The	main	objective	
of	 vouching	 trading	 transactions	 is	 to	 detect	 misappropriation	 of	 goods.	 The	
following	 are	 some	 of	 the	 books	 vouched	 under	 audit	 of	 trading	 transactions	
namely,	purchases	book,	sales	book,	goods	sent	on	‘sale	or	return’	basis	and	stores	
ledger.	Vouching	of	such	transactions	 involves	scrutinizing	the	efficiency	of	 the	
internal	check	system	to	be	 followed	by	 the	client	 in	respect	of	 these	 items	and	
examining	the	relevant	vouchers,	correspondences	etc.

•	 While	 vouching	 the	 credit	 purchases	 the	 auditors	 have	 to	 carefully	 examine	 the	
invoices,	and	the	goods	received	books	and	ensure	that	correct	entries	have	been	made	
in	the	purchase	book.	Similarly,	while	vouching	the	credit	sales	he	must	examine	the	
orders	received	book,	the	invoice	book,	the	goods	outwards	book	and	the	sales	book.	

SUMMARY

Records to be verified by the Auditor
Auditor	should	check	entries	relating	to	stores	with	the	following	records:
1.	Bin	Card:	Maintained	by	the	Storeskeeper	in	Stores	Department.
2.	 Stores	Ledger	Account:	Maintained	by	Accountant	in	Accounts	Department.

Example
On	5th	July	2016,	received	1000	units	at	Rs.10	each	vide	Goods	Received	Note	No.121
On	15th	July	2016,	issued	100	units	vide	Material	Requisition	No.78

BIN CARD
ABC Company

Receipts Issues Balance Remarks
Date GRN No. Qty. Date MR No. Qty. Qty.
2016  
Jul. 5 121 1000 - - - 1000

- - - 2016  
Jul. 15 78 100 900

STORES LEDGER
ABC Company

Date Particulars Receipts Issues Balance
Qty. Rate 

₹
Amt. ₹ Qty. Rate 

₹
Amt.  

₹
Qty. Rate 

₹
Amt.

₹
2016  
Jul. 5

GRN		
No.121 1000 10 10,000 - - - 1000 10 10,000

2016  
Jul. 15 MR	No.78 - - - 100 10 100 900 10 9,000
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I. Multiple Choice Questions:

1.	 Purchases	book	records	__________
(a)	Credit	purchases	only
(b)	cash	purchases	only	
(c)	both	cash	and	credit	purchases	
(d)	none	of	the	above

2.	 Sales	book	records	__________
(a)	Credit	sales	only
(b)	Cash	sales	only
(c)	Both	cash	and	credit	sales
(d)	None	of	the	above

3.	 Payment	for	goods	purchased	should	
be	vouched	with	the	help	of	_______
(a)	Creditors	statement
(b)	Correspondence	with	suppliers

(c)	Cash	memos
(d)	Ledger	accounts

4.	 Verification	refers	to	
(a)	Examination	of	journal	and	ledger
(b)	Examination	of	vouchers	related	to	

assets
(c)	Examining	the	physical	existence	

and	valuation	of	assets
(d)	Calculation	of	value	of	assets

5.	 Which	 of	 the	 following	 statements	 is	
correct?
(a)	Valuation	is	a	part	of	verification
(b)	Verification	is	a	part	of	valuation

 EVALUATION 

•	 Purchase Book: Transactions	 relating	 to	 credit	 purchases	 are	 recorded	 in	
Purchase	Book.	The	main	objective	of	vouching	purchase	book	is	to	ensure	that	
all	the	goods	purchased	during	the	year	are	being	received	and	the	client	makes	
payment	only	for	the	goods	being	delivered	by	the	supplier.

•	 Sales Book: Transactions	relating	to	credit	sales	are	recorded	in	Sales	Book.
•	 Purchase Invoice: Document	containing	description	of	goods	purchased,	quality,	

rate,	amount	payable,	name	of	the	supplier,	date	of	purchase	etc.
•	 Sales Invoice:	 Document	 containing	 description	 of	 goods	 sold,	 quantity,	 rate,	

amount	receivable,	name	of	the	customer,	date	of	sale	etc.
•	 Goods Sent on ‘sale or Return’ Basis: When	goods	are	delivered	to	a	customer	on	

condition	that	if	goods	are	not	approved	within	a	particular	period	the	customer	
can	return	the	goods.	Such	a	type	of	sale	is	called	as	Goods	on	‘sale	or	return’	basis.	

•	 Stores Ledger: Stores	is	a	place	where	different	kinds	of	materials,	consumables,	
spare	parts	 are	kept	under	 the	control	of	 a	person	known	as	a	 storekeeper.	The	
storekeeper	maintains	a	ledger	known	as	Stores	Ledger	where	he	accounts	quantity	
and	 value	 of	 materials	 received,	 issued	 to	 production	 department	 and	 balance	
quantity	of	materials	remains	in	the	stores.

KEY TERMS
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(c)	Valuation	has	nothing	to	do	with	
verification	

(d)	Auditor	is	a	valuer

6.	 The	 store	 keeper	maintains	 a	 ledger	
called	__________________________
(a)	Store	ledger
(b)	Stock	ledger
(c)	Materials	ledger	
(d)	Materials	issued	ledger

7.	 Materials	 transformed	 from	 one	
department	to	another	department	is	
entered	through	the	document	called	

(a)	Materials	transfer	Note
(b)	Materials	received	Note
(c)	Goods	inward	Register		
(d)	Goods	outward	Register

II. Very Short answer Questions

1.	Explain	the	auditor’s	duty	with	regard	
to	credit	purchases?

2.	How	will	you	vouch	sales	day	book?
3.	What	is	Purchase	invoice?

4.	What	is	sales	invoice?
5.	Who	is	a	Storekeeper?
6.	What	is	meant	by	Stores	ledger?

III. Short Answer Questions

1.	As	an	auditor	of	a	company	explain	in	
detail	 as	 to	 how	 your	 will	 vouch	 the	
purchases	book?

2.	Explain	the	points	you	would	keep	in	
view	while	vouching	credit	sales?

3.	How	would	you	vouch	goods	sent	on	
sales	or	return	basis?

IV. Essay Type Questions

1.	Explain	the	points	you	would	keep	in	
view	 while	 auditing	 credit	 purchase	
and	credit	sales?

2.	Write	a	note	on	vouching	with	regard	
to	stores	ledger?

[Answers: 1.(a), 2.(a), 3.(a), 4.(b), 5.(a), 6.(a), 7.(a)
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8.1 Meaning

Electronic Data Processing (EDP) or 
Information Systems (IS) Audit refers to 
the examination and validation of systems 
which are used to process the data. In EDP 
audit data’s are processed by the computer 
and its program in an environment involving 
electronic communication. The managements 
are now installing new electronic devices 
in accounting system. This will create new 
opportunities and reduce the cost.

The work of recording the transactions 
and preparation of accounts can be done with 

greater speed under the new mechanized 
device. Arithmetical and manual errors are 
much reduced. The mechanized system of 
accounting is much helpful to find statistical 
data. This is much helpful for the management 
in decision making. The basic information is 
fed into the computers and it can be arranged 
in different ways. There are many types of 
accounting packages available. The accounting 
packages are much useful and processed 
whenever required. The usage of computer in 
accounting system improves the function of 
management.

ELECTRONIC DATA PROCESSING AUDIT8Chapter

•	 After going through this unit, the students will be able to know the meaning, 
characteristics, approaches, advantages and disadvantages of EDP audit.

•	 Students will know the differences between manual accounting and com-
puterised accounting system.

Learning Objectives

TO BE RECALLED

The students learnt the meaning of trading transactions and auditors duty in vouch-
ing credit purchases, credit sales, “Goods sent on sale or return basis” and stores.
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3. Quick Records: In a computerized 
environment auditor can get statements, 
reports, extracts and other financial 
informations in various ways, which 
makes work a pleasure.

4. Storage of Voluminous Transactions: In 
computerised environment auditor gets 
the ability to handle huge and large volume 
of transactions of business organization 
without compromising on speed or 
efficiency.

5. Quick Decision-making: Generation 
of real time data’s and management 
information reports enables auditor to 
take quick decisions.

8.2  Features or 
Characteristics of EDP 
Audit

1. Simple and Integrated: Computerized 
audit is designed to integrate all the 
business operations such as purchase, 
sales, finance, inventory, payroll etc. 
Hence, verification of accounts and 
records by an auditor in computerised 
environment is faster and simple.

2. Accuracy of Transactions: Use of 
computerized template provides accurate 
data entry of the transactions. All 
documents and records can be generated 
automatically by click of a button.

8.3  Manual Accounting System Vs. Computerized 
Accounting System

Basis of Difference Manual Accounting Computerized Accounting
1. Meaning It is an accounting system in which 

physical register of journal and 
ledger for keeping record of the 
transactions.

It is an accounting system in 
which computer and accounting 
softwares are used for digital 
record of the transactions.

2.  Maintenance of 
Books

In manual accounting books, 
records, vouchers and documents 
are physically maintained

In computerized accounting, 
there is no physical existence of 
books, records, vouchers and 
documents. All transactions are 
recorded in computer hard disk.

3. Accounting System In manual accounting, based on 
accounting principles transactions 
are journalised and later posted in 
books of accounts.

In computerized accounting, 
after entry of a particular 
transaction system automatically 
posts respective transactions in 
related books of accounts based 
on accounting principles. 

4. Calculations In manual accounting, all 
arithmetical calculations are done 
manually.

In computerized accounting, all 
calculations are done by computer 
system, only entry of a transaction 
should be done by an accountant.
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5. System of Audit In the manual system of 
accounting the auditor verifies 
each and every transaction in the 
books with related documents, 
supporting vouchers, invoices 
etc. and traces the transaction to 
the end of the accounting process.

In computerized accounting, 
an auditor verifies accounting 
of a transaction with related 
documents, invoices, vouchers 
etc simultaneously.

6.  Verification of 
Books of Accounts

In a manual accounting system, 
the processing of accounting 
entries in the books of accounts 
and the accounting information 
are transparent and can be 
observed by the auditor.

In an EDP environment, 
the auditor can access the 
accounting entries and 
records only when printouts 
are taken.

8.4  Approaches to EDP 
Audit

1. Auditing Around the Computer: It is the 
type of auditing done in a traditional method. 
The auditor summarizes the input data and 
ignores the computer’s processing but ensures 
the correctness of the output data generated 
by the computer, this approach is generally 
referred to as “auditing around the computer”. 
This methodology was primarily focused on 
ensuring that source documentation was 
correctly processed and this was verified by 
checking the output documentation to the 
source documentation.

2. Auditing with the Computer
The utilization of computer by the 

auditor for some audit work and he uses 
some general software for the purpose 

of calculating depreciation, growth rates, 
percentages, printing letters and duplicate 
checking and comparison of datas.  The 
computer is used as a supporting tool in 
the manual audit environment. 

31 Best Accounting Software List for 
Small Business in 2022

Here’s the list of top 30 accounting 
software for small business to ensure 
smooth and efficient accounting 
transactions.

Tally.ERP 9, Ezy Rokad, Profitbooks, 
PEASx GST Inventory & Accounting 
Software, Busy Accounting, Software, 
Marg Accounting Software, Saral 
Accounting Software, Zoho Books, 
MProfit, Quickbooks, Wave Accounting, 
Zoho Expense, FreshBooks, NetSuite 
ERP, FreeAgent, Vyapar, HDPOS 
Smart Accounts & Billing, Xero, Giddh 
Accounting Software, Reach Accountant, 
Book Keeper, SlickAccount, Reeleezee 
for Accounting, myBooks, Logic ERP, 
Horizon ERP, Billing 360 Accounting 
Software, CraveInvoice, AlignBooks, 
Fraxinus Books, ZipBooks Computer 
Accounting System

(inputs) (processing)
can't see through
Block box

Around the
Computer
Process

Financial
Reports
(Output)

source  
documents



100 Introduction to AuditElectronic Data Processing Audit

•	 Verify the procedure of initiation, 
execution and recording of a transaction  

•	 Verify the controls that are incorporated 
in software.

What is r̔eal-time’ in Computer 
environment?
There is only a very short time 
between a computer system 
receiving information and dealing 
with in.

8.5  Auditors duty in EDP 
Audit

The auditor has to bear in mind the 
following points while auditing accounts 
in an EDP environment.

1. Possibilities of errors and frauds: 
In EDP environment processing is 
highly decentralized. The possibilities 
of errors and frauds may occur in a 
decentralized EDP environment. The 
auditor has to bear this in mind while 
auditing accounts.

2. Knowledge about software: The 
auditor should possess knowledge 
about software like Computer Aided 
Software Engineering and Data Base 
Management System (DBMS)

3. Reduction of audit evidences: 
The linkage of networking within 
the branches due to electronic data 
interchanges (EDI) has reduced paper 
work. This has reduced the availability 
of audit evidences.

4. Audit Techniques: In an EDP 
environment the auditor has to change 
his audit techniques and method of 

3. Auditing Through the Computer: Due 
to the “real time” computer environments 
and  limited use of source documentation 
or paperwork, the auditor may employ an 
approach known as “Auditing Through the 
Computer”. In this EDP environment, an 
auditor appraises the internal control and 
determines the nature, timing and extent 
of audit. The auditor verifies and analyses 
the reliability and accuracy of the results 
through the computer. 

Auditor has to ensure the following 
in conducting auditing through the 
computer:

•	 Verify the logic and syntax of software
•	 Verify the output generated by the 

system
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management quickly which enables the 
management to take decisions.

6. Audit Testing: Computerised accounting 
helps the auditor in audit testing. The 
auditor can use “test packs” to determine 
whether the clients programme controls 
are working efficiently.

7. Reduction of Paper Work: The usage 
of Electronic Data Interchange and 
other computer hardware and software 
systems have reduced the paper work to 
a very great extent.

8. Reduction of Errors and Frauds: The 
possibility of errors and frauds in an 
computerized environment are much less 
due to the usage of electronic devices like 
scanners,voice recognizing systems etc.

8.7  Disadvantages of EDP 
Audit

1. No Proper Authorisation: In a computerized 
environment, transactions are fed into the 
computer without, proper authorization in 
a conventional form. This creates suspicion 
and difficulties in checking from outside 
what and how they are recorded.

2. Loss of Storage Devices: Data and 
programme are stored in hard disks and 
other storage devices like disks, thumb 
nails, floppy etc. There are chances that 

collecting evidences due to introduction 
of electronic devices like scanners, 
voice recorders etc.

8.6  Advantages of EDP 
Audit

1. Availability of Detailed Records: In 
computerized accounts detailed and 
up to date records are readily available 
for accounting purposes. This 
improves the overall control of the 
management and assists the auditor in 
verifying the transaction and records.

2. Saves Time: Computerized accounts save 
time and involvement of labor to a great 
extent. It further saves time and money in 
documenting and processing the accounts.

3. Less Testing: Computerized accounts 
have a high degree of mechanical ability 
when compared to manual system of 
accounting. Therefore,computerized 
accounts require less testing.

4. Facilities for Frequent Reconciliations: 
The computer offers the facilities of more 
regular and frequent reconciliations, like, 
reconciling the bank balance, stock levels, 
customers and suppliers balance etc.

5. Quick Information to Management: 
In a computerized environment, data 
or information can be provided to the 
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5. Lack of Physical Accessibility: In a 
computerized system of accounting, the 
auditor cannot have physical accessibility 
of scrutinizing the entries, books, records 
etc. Unless printouts are taken.

these storage devices can be stolen, lost 
or may be infected due to computer virus.

3. Exposed to Computer Virus: Computer 
Virus is a programme that affects the 
working of target area of the computer. 
It enters computer in many ways. One 
major problem in using computer is the 
infection of computer virus. The virus 
infected in a computer can slowdown the 
programme or make the system dead.

4. Computer Frauds: Fraud in 
computerized environment may arise 
due to unauthorized use of computers 
physical manipulation of framework 
of system, theft of confidential output, 
editing final output etc. Hence, it 
is difficult to ensure accuracy and 
reliability of information.

•	 EDP Audit refers to examination and validation of systems which are used to 
process the data.

•	 Auditing Around the Computer: The auditor views the computer as a black box, 
as the application system processing is not examined directly. 

•	 Auditing Through the Computer: In this approach, the auditor examines the 
system and the software which is used to process the data. This is also known as 
White Box approach.

•	 Audit Trial means tracing of the transaction in sequence through the system from 
the beginning source to completion and vice versa.

SUMMARY

•	 EDP Audit – Electronic Data Processing Audit
•	 Real Time – Short time between a computer system receiving information and 

dealing with in
•	 Computer Aided Software Engineering and Data Base Management System 

(DBMS) – It is a software
•	 Test Packs – It is collection of tests that evaluate a coherent set of device capablities

KEY TERMS
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I. Multiple Choice Questions

1. Examination and validation of 
systems which are used to process the 
data is ___________

a. Audit
b. Internal Audit
c. Statutory Audit
d. EDP or Computerized Audit

2. Which approach uses the computer 
as a book-keeping device,

a. Auditing with computer
b. Auditing through computer
c. Auditing around computer
d. All of the above

3. Audit software were used to make 
different calculation as a supporting 
device under ____________ 
approach.

a. Auditing with computer
b. Auditing through computer

c. Auditing around computer
d. Computerized Audit

4. Tracking the data from initiation to 
end in Computerized environment is 
__________

a. Audit Trial
b. Test Trial
c. Transaction control
d. None of the above

5. Data taken from the bulk of data for 
testing the efficiency of a transaction 
is called as _____________

a. Input data
b. Output data
c. Test data
d. Data control

[Answers: 1. (d); 2. (c); 3. (a); 4. (a);  
5. (c)]

II. Very Short Answer Questions.

1. What is meant by EDP Audit.
2. What is meant by Audit Trial.

3. State the approaches of EDP Audit.

 EVALUATION 

III. Short Answer Questions.

1. State the key difference between 
Manual and Computerized 
Accounting.

2. Write a very brief  note on Auditing 
through Computer

3. Explain the concept of Auditing with 
Computers.

4. State any two duties of an auditor in a 
computerized environment.

5. State any two advantages of EDP 
Audit.
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IV. Essay Type Questions.

1. Discuss the salient features of EDP 
Audit.

2. Write a note on Auditors duty in EDP 
Audit.

3. Differentiate Manual Accounting and 
Computerized Accounting.

4. Discuss the advantages and limitations 
of EDP Audit.

5. Explain in detail the process of EDP Audit.
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•	 Enable	the	students	to	gain	knowledge	about	IT	&	ITes,	that	performing	
in	Business	Operations.

•	 To	acquire	knowledge	about	various	IT	applications	used	now-a-days.
•	 Students	learn	about	keyboard	techniques,	ergonomics,	fingering	charts	

and	pointing	devices.
•	 Students	 will	 self	 guard	 by	 learning	 to	 maintain	 healthy	 and	 safety	

	measures.	

Learning Objectives

9.1  Introduction - IT & 
ITes

Information	 and	 communication	
technology	 (ICT)	 has	 become	 one	 of	 the	
inevitable	 requirements	of	 the	day	 to	day	
activities	 of	 our	 modern	 society.	 Daily	
usage	of	mobile	phones,	laptops,	electronic	
gadgets	 brings	 a	 lot	 of	 benefits	 to	 the	
common	people	and	also	to	the	industries	

those	who	are	engaged	in	various	fields	of	
expertise.	 Information	Technology	(IT)	 is	
one	of	the	world’s	fastest	growing	economic	
activities,	 which	 envisages	 easier	 flow	 of	
information	at	various	levels	in	the	desired	
pattern.	 The	 Information	 Technology	
enabled	 services	 (ITeS)	 sector	 has	 also	
made	 significant	 contributions	 to	 the	
growth	and	development	of	our	Country.	

Chapter IT-ITeS & KEYBOARDING TECHNIQUES9Chapter

Information Technology
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operations	 through	 an	 outside	 service	
provider.	 BPO	 also	 comes	 under	 IT	
services	 as	 IT	 plays	 a	 very	 useful	 role	 in	
optimising	the	business	performance.	

Business Process Outsourcing

   9.2.1 Some important BPO 
Services:

(i)		 Financial	and	Accounting	services
(ii)	 Taxation	and	Insurance	services
(iii)	 E-Publishing	and	Web	Promotion
(iv)	 Legal	Services	and	Content	Writing
(v)	 Multimedia	and	Design	Services
(vi)	 Health	care	Services

   9.2.2 Advantages of BPO 
Services:

Some	 of	 the	 important	 benefits	 or	
advantages	of	BPO	services	as	follows:

(i)		 	Decreased	 Costs:	 Outsourcing	
reduces	 costs	 for	 labour,	 generally	
when	 it	 comes	 to	 staffing	 and	
training	

(ii)	 	Able	 to	 concentrate	 on	 core	
competencies	

(iii)	 Increased	flexibility
(iv)	 Expand	Global	Presence	
(v)	 Improved	speed	and	efficiency
(vi)	 Security	issues
(vii)	 Communication	issues

   9.1.1 Meaning

Information	 technology	 (IT)	 means	
creating,	 managing,	 storing	 and	 exchanging	
information.	It	includes	all	types	of	technology	
used	to	deal	with	information,	such	as	computer	
hardware	 and	 software	 technology	 used	 for	
creating,	storing	and	transferring	information.	
Computer	takes	data	as	input	and	processes	it	
and	produces	the	results	as	output.	

Information	 Technology	 that	 enables	
the	 business	 by	 improving	 the	 quality	
of	 service	 is	 Information	 Technology	
enabled	services	(ITeS)	is	also	called	web-
enabled	 services	 or	 remote	 services	 that	
cover	the	entire	operations	which	exploit	
Information	 Technology	 for	 improving	
the	efficiency	of	an	organisation.	

Information Technology Enabled Services

9.2  Business Process 
Outsourcing (BPO) 
Services

Business	 Process	 Outsourcing	 (BPO)	
services	 means	 performing	 business	
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complex	 tasks	 like	 writing	 legal	
agreements,	doing	legal	research,	and	
drafting	patent	applications.

(iv)		RPO	 (Requirement	 Process	
Outsourcing)	 -	 RPO	 deals	 with	
processes	 like	 data	 analysis	 and	
research	 processes.	 The	 services	 it	
offers	 include	 investment	 research,	
data	analytics,	and	market	research.

   9.2.5 Adavantages of BPO 
SERVICES INDUSTRIES

	(i)	 	BPO	service	providers	in	India	invest	
in	hi-tech	hardware	and	software	to	
deliver	 the	 best	 of	 services.	 They	
follow	quality	checks	to	ensure	error	
free	and	exceptional	service.

(ii)	 	Government	of	India	is	encouraging	
the	 BPO	 Industry	 in	 India	 by	
providing	necessary	 Infrastructure	
and	logistical	support.

(iii)	 	BPO	 Industry	 in	 India	 is	 highly	
developed	and	capable	of	delivering	
numerous	types	of	BPO	services	in	
exceptional	quality.

9.3  Business Process 
Management (BPM) 
Industry in India

The	 IT	 BPM	 (Business	 Process	
Management)	 industry	 has	 been	
fuelling	 India’s	 growth.	 In	 addition	 to	
contributing	towards	the	country’s	Gross	
Domestic	 Product	 (GDP)	 and	 exports,	
the	 growth	 of	 the	 IT	 BPM	 industry	
has	 provided	 India	 with	 a	 wide	 range	
of	 economic	 and	 social	 benefits	 which	
includes	 creating	 employment,	 raising	
income	 levels,	 and	 promoting	 exports.	
It	has	placed	India.	

   9.2.3 BPO Services in 
India

Business	 process	 outsourcing	 or	 BPO	
service	in	India	refers	to	tasking	out	certain	
functional	 tasks	 to	 a	 third-party	 service	
provider.	Internal	business	functions	such	
as	billing	and	purchasing	are	outsourced,	
while	 front-of-house	 functions	 including	
customer	support,	marketing,	and	product	
customization	 are	 outsourced.	 All	 you	
need	to	do	is	to	understand	what	services	
you	 wish	 to	 outsource	 and	 services	 you	
want	to	keep	in-house.	

BPO	 services	 in	 India	 are	 growing	
at	 a	 fast	 pace	 and	 expanding	 to	 assist	
with	 services	 like	 conventional	 back	
and	 front	 office	 functions	 to	 services	
like	 digital	 marketing	 services	 and	
social	media	marketing.	Moreover,	BPO	
services	 can	 help	 you	 save	 big	 on	 cost,	
offer	 flexibility,	 agility,	 and	 access	 to	
tools	and	processes.

   9.2.4 CLASSIFICATIONS OF 
BPO SERVICES IN INDIA

(i)					ITES	 (Information	 Technology	
enabled	services)	-	It	is	a	type	of	BPO	
service	 that	manages	and	handles	 IT	
solutions	over	the	internet.	It	involves	
handling	 IT	 services	 like	 technical	
support,	production	 support	 analyst,	
and	service	desk	analyst.

(ii)			KPO	(Knowledge	Process	Outsourcing)	-		
In	this	type	of	outsourcing,	the	service	
provider	 offers	 advanced	 expertise	 for	
any	particular	business	process.

(iii)		LPO	(Legal	Process	Outsourcing)	 -	 It	
offers	 services	 related	 to	a	high	 level	
of	 legal	 work.	 They	 also	 perform	
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outside	 India	 but	 operate	 in	
multiple	 locations	 worldwide	
including	those	in	India.	They	cater	
to	 external	 clients	 (both	 domestic	
and/or	global).

(ii)	 	Indian	 Service	 Providers	 (ISPs):	
ISPs	started	with	their	operations	in	
India.	Most	 of	 these	 organisations	
have	 their	 headquarters	 in	 India.	
While	 having	 offices	 in	 many	
international	locations.	While	most	
have	 a	 client	 base,	which	 is	 global	
as	well	as	domestic,	there	are	some	
that	have	focussed	on	serving	only	
the	Indian	clients.

(iii)	 	Global	In-house	centres	(GIC):	GIC	
organisations	cater	 to	 the	needs	of	
their	parent	 company	only	 and	do	
not	serve	external	clients.

(iv)	 	The	 Indian	 IT	 industry	 has	 more	
than	 16,000	 registered	 companies	
in	 the	 sector	 across	 GIC,	 MNC	
and	 SME	 categories	 as	 of	 2016.	
Concentration	 Ratio	 in	 the	 IT-
BPM	industry	is	very	high	with	11	

On	the	world	map	with	an	image	of	a	
technologically	advanced	and	knowledge-
based	 economy.	 This	 sector	 attracts	
amongst	 the	 largest	 investments	 by	
venture	 capitalists	 and	has	 been	 credited	
with	enabling	the	entrepreneurial	ventures	
of	 many	 in	 the	 country.	 The	 IT-BPM	
industry	 has	 almost	 doubled	 in	 terms	 of	
revenue	 and	 contribution	 to	 India’s	GDP	
over	the	last	decade	(2008–18).

   9.3.1 Definition

Business	 process	 management	 (BPM)	
is	 “an	 organizational	 discipline	 where	 a	
company	takes	a	step	back	and	looks	at	all	
of	these	processes	in	total	and	individually.	
It	analyses	the	current	state	and	identifies	
areas	 of	 improvement	 to	 create	 a	 more	
efficient	and	effective	organization.”

9.4  Structure of the IT-BPM 
Industry

	(i)	 	Multinational	Companies	(MNCs):	
MNCs	 have	 their	 headquarters	

Business Process Management 
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9.5  Various IT Applications

The	various	application	areas	are	business,	
banking,	insurance,	education,	marketing,	
and	 health	 care,	 engineering	 design,	
military,	 communication,	 animation,	
research,	 agriculture	 and	 government	
In	 technologically	 developed	 nations,	
Information	 Technology	 has	 become	
a	 part	 of	 everyday	 life.	 For	 a	 user,	 a	
computer	is	a	tool	that	provides	the	desired	
information,	 whenever	 needed.	 The	 use	
of	computer	and	Information	Technology	
can	 be	 observed	 at	 home,	 workplace,	 in	
the	 modern	 service	 industry	 and	 in	 all	
aspects	of	our	life.	It	includes	listening	to	
music,	 watching	 movies,	 playing	 games,	
doing	 office	 work,	 chatting	 and	 sending	
messages,	managing	daily	planner,	reading	
books,	paying	utility	bills,	booking	tickets	
to	travel,	bank	operations,	etc.	Computers	
and	ICT	are	used	in	industries,	in	offices,	
and	in	houses	also.	.

players	 contributing	 to	more	 than	
40%	of	the	revenue.	

The	Indian	IT-BPM	sector	is	home	to	
the	world’s	3rd	largest	start-up	community	
with	 more	 than	 2000	 start-ups	 across	
e-Commerce,	 aggregator	 platforms,	
analytics,	consumer	services	and	IT	alone.

   9.4.1 Parameters of  
IT-BPM Industry

The	 organisations	 within	 the	 IT-BPM	
industry	 are	 categorised	 along	 the	
following	parameters:

•	 Sector	the	organisation	is	serving
•	 Type	 as	 well	 as	 range	 of	 offering	 the	

organisation	provides
•	 Geographic	spread	of	operations
•	 Revenues	and	size	of	operations

Various IT Applications
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9.6  Introduction to Typing

Typing	 is	 the	 art	 and	 technique	 of	 using	
letters	and	characters	in	a	readable,	legible	
and	appealing	format	when	displayed.	The	
arrangement	 of	 type	 involves	 selecting	
typefaces,	 point	 sizes,	 line	 lengths,	 the	
spacing,	 letter	 spacing	 and	 adjusting	 the	
space	between	pairs	of	letters.

   9.6.1 Keyboarding Skills

Keyboard	is	the	most	common	text-based	
input	 device.	 Computer	 keyboards	 are	
similar	to	electronic	typewriter	keyboards	
with	additional	keys.	A	keyboard	generally	
has	more	than	100	keys.

  Points to be Remembered

(i)	Information	technology	means	creating,	
managing,	 storing	 and	 exchanging	
information.

(ii)		IT	 that	 enables	 the	 business	 by	
improving	 the	 quality	 of	 service	 is		
ITeS.

(ii)		BPO	 means	 performing	 business	
operations	 via	 an	 outside	 service	
provider.

(iv)		The	IT	BPM	industry	provides	India,	
wide	 range	 of	 social	 and	 economic	
benefits.

(v)		MNC,	ISP	and	GIC	are	the	structure	of	
the	IT	–	BPM	Industry.

Keyboarding Techniques

Keyboarding Techniques
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•	 Delete key:	 The	 Del	 key	 deletes	 the	
character	at	the	current	cursor	position,	
or	 the	 selected	 object,	 but	 does	 not	
move	 the	 cursor.	 For	 graphics-based	
applications,	 the	delete	key	deletes	 the	
character	 to	 the	 right	 of	 the	 insertion	
point.	

•	 Enter key or Return key:	 It	 is	used	 to	
enter	commands	or	to	move	the	cursor	
to	the	beginning	of	the	next	line.

•	 Esc key:	The	Escape	key	is	used	to	send	
special	codes	to	devices	and	to	exit	(or	
escape)	from	programs	and	tasks.	

•	 Function keys:	 Special	 keys	 labelled	
F1	 to	 F12.	 These	 keys	 have	 different	
meanings	depending	on	which	program	
is	running.

   9.6.3  Typing and Deleting 
Text

For	 typing	 text	 in	 a	 document	 you	
should	

•	 Click	on	the	letters	on	the	keyboard.	

For	 deleting	 text	 in	 a	 document	 you	
should	

•	 Use	the	backspace	key	or	the	delete	key.

9.7 Fingering Charts:

Keyboard	 finger	 charts	 left	 and	 right	
finger,	include	home	row	keys,	for	lessons,	
to	 improve	 or	 learn	 how	 to	 type	 faster.	
Each	 finger	 rests	 on	 a	 particular	 key	 in	
the	home	 row	of	 the	keyboard	when	not	
typing.

   9.6.2 Types of Keys

Though	there	are	several	input	devices	viz.	
mouse,	 touch	 screen,	 character	 or	 voice	
recognition,	etc.,	used	for	giving	input	to	
the	 computer,	 yet	 the	 use	 of	 keyboard	 is	
the	 most	 common	 method	 adopted	 for	
input	of	data	into	a	computer.	A	computer	
keyboard	 contains	 the	 following	 types	of	
keys:

•	 Alphanumeric keys:	 All	 of	 the	
alphabet	 (A-Z)	 and	 numbers	 (0-9)	 on	
the	keyboard.

•	 Punctuation keys:	 All	 of	 the	 keys	
associated	 with	 punctuation,	 such	 as	
the	 comma	 (,),	 period	 (.),	 semicolon	
(;),	 brackets	 ([]),	 and	 parenthesis	 ({	 })	
and	so	on.	Also,	all	of	the	mathematical	
operators	 such	 as	 the	 plus	 sign	 (+),	
minus	sign	(-),	and	equal	sign	(=).	

•	 Alt key:	Short	for	Alternate,	this	key	is	
like	a	second	control	key.

•	 Arrow keys:	There	are	four	arrow	keys	
to	move	the	cursor	(or	insertion	point)	
up	(↑),	down	(↓),	right	(→),	or	left	(←).

•	 Shift or Alt keys:	To	move	 the	 cursor	
in	more	than	one	position	at	a	time.	

•	 Backspace key:	 Deletes	 the	 character	
just	to	the	left	of	the	cursor	(or	insertion	
point)	 and	 moves	 the	 cursor	 to	 that	
position.

•	 Caps Lock key:	It	is	a	toggle	key,	which	
when	 activated,	 causes	 all	 alphabetic	
characters	to	be	uppercase.	

•	 Ctrl key:	 The	 control	 key	 is	 used	 in	
conjunction	with	other	keys	to	produce	
control	 characters.	 The	 meaning	 of	
each	 control	 character	 depends	 on	
which	program	is	running.
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Mouse

The	 common	 mouse	 actions	 are	 as	
follows:

(a)	  Click or left click:	It	is	used	to	select	
an	item.	Press	down	once	on	the	left		
button	with	your	index	fi	nger.	

1st	Row	 1	2	3	4	5	6	7	8	9	0

2nd	Row	 Q	W	E	R	T	Y	U	I	O	P

3RD	Row	 A	S	D	F	G	H	J	K	L	;

4TH	Row	 z	x	c	v	b	n	,	.	-

Left	 hand	 covers	 the	 “ASDF”	 in	 the	
home	row	keys	while	the	right	hand	covers	
the	“JKL,”	and	the	thumb	covers	the	space	
bar.

9.8 Pointing Device 

Mouse

Mouse	 is	a	pointing	device	used	 to	point	
a	particular	place	on	the	screen	and	select	
to	perform	one	or	more	actions.

Fingering Chart
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Stage one	 of	 the	 process	 begins	 with	
learning	 the	Home	Row	of	 the	 keyboard	
(the	 row	 beginning	 with	 the	 Caps	 Lock	
key).	 Looking	 at	 the	 keyboard	 is	 strictly	
forbidden.	This	is	followed	by	learning	the	
lower	 and	upper	 rows,	 the	numbers	 row,	
uppercase	letters	and	special	symbols.

Stage two	 involves	 memorising	
frequently	used	syllables	and	typing	words	
containing	these	syllables.	

Stage three	involves	typing	actual	text	
to	perfect	the	skills	acquired.

9.11  Calculating Typing 
Speed

The	 typing	 speed	 can	 be	 measured	
with	different	accuracies,	such	as	

•	 How	many	words	are	typed	for	a	certain	
time	period	(the	least	accurate)?	

•	 How	 many	 characters	 are	 typed	 for	 a	
certain	time	period?	

•	 How	many	 keystrokes	 are	 made	 for	 a	
certain	time	period	(the	most	accurate)?	
Also	there	are	

•	 Simple	speed	(Gross	speed)	
•	 Net	 speed	 (takes	 into	 account	 the	

errors)

(b)	 	Double click:	 It	 is	 used	 to	 start	 a	
program	or	open	a	file	or	trigger	an	
action.	

(c)	  Right click:	 It	 is	 used	 to	 display	
a	 set	 of	 commands	 and	 available	
options.	Move	the	mouse	pointer	to	
the	desired	position;	position	your	
middle	 finger	 on	 the	 right	 mouse	
button,	 keeping	 the	 mouse	 still,	
and	click	lightly.

(d)	  Drag and drop:	 It	allows	selecting	
and	 moving	 an	 item	 from	 one	
location	 to	 another.	 Position	 the	
mouse	on	an	object,	hold	down	the	
left	side	of	the	mouse,	and	drag	the	
object.	

(e)	  Scroll:	Instead	of	using	page	down	
key	or	arrow	keys,	one	can	use	the	
scroll	key	of	a	mouse	to	scroll	up	or	
down.	

9.9 Typing Ergonomics

Typing	 ergonomics	 provides	 the	 logistic	
support	 for	 efficient	 and	 effective	
typewriting.	They	are	important	to	attain	
and	maintain	accuracy	and	speed.	Some	of	
these	factors	included	are	as	given	below.

•	 Sitting	posture
•	 Position	of	hands
•	 Monitor	placement
•	 Mouse	and	keyboard	placement
•	 Chair	and	table	placement
•	 Placement	of	matter	to	be	typed

9.10  Touch Typing 
Technique

Touch	 typing	 improves	 typing	 speed	 and	
accuracy.	Touch	typing	can	be	learned	by	
performing	special	exercises.	
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   9.12.2 Ventilation

Ventilation	 in	 the	 office	 refers	 to	 the	
supply	of	 clean	and	 fresh	air	 in	 the	 right	
amount,	 at	 the	 right	 temperature	 and	 of	
the	 right	 humidity.	 Proper	 ventilation	
is	 an	 important	 aspect	 of	 the	 office	
environment.	Fresh	air	must	pass	through	
the	 office	 regularly.	 Arrangements	 of	
rooms	and	partitions	should	be	such	as	to	
allow	free	circulation	of	fresh	and	dustless	
air.	 The	 following	methods	 are	 generally	
used	to	maintain	proper	ventilation:

(i)  Natural Ventilation
(ii) Artificial Ventilation

   9.12.3 Temperature and 
Humidity 

Temperature	 and	 humidity	 are	 two	 vital	
factors	 in	the	offices	that	exercise	a	great	
influence	 over	 the	 worker	 and	 their	
output.	Temperature	and	humidity	in	the	
rooms	 should	 be	maintained	 at	 a	 proper	
level.	

   9.12.4 Freedom from 
Noise

A	noisy	place	 is	never	an	efficient	office.	
Noise	 is	 one	 of	 the	 great	 disturbances.	
Noiseless	and	quiet	atmospheres	are	must	
for	an	office	to	maintain	the	efficiency	of	
the	employees	at	a	high	level.	

   9.12.5 Cleanliness

A	clean	and	 tidy	office	 is	 important	as	 it	
offers	the	following	advantages:

Example
A	student	typed	240	characters	per	
2	min	with	errors	in	20	characters.	
Simple	 speed	 =	 240	 characters	 /	 2	
min	=	120	cpm	
Net	speed	=	120	cpm	-	(20	errors	/	
2	min)	=	110	net	cpm

9.12  Maintaining Healthy 
and Safety of Office 
Equipments

Office	 environment	 has	 an	 important	
bearing	on	the	efficiency	of	employees.		It	
is	a	common	experience	that	people	work	
better	 if	 they	 are	 given	 the	 surroundings	
and	equipment	appropriate	to	their	work.

According	 to	 Terry,	 “an	 individual’s	
performance	 is	 significantly	 familiarized	
by	the	environment	in	which	he	works”.

   9.12.1 Lighting 

Lighting	 is	 the	most	 important	of	 all	 the	
physical	 conditions	 in	 the	 office.	 Proper	
lighting	is	important	because	it	offers	the	
following	advantages:

•	 Increased	productivity
•	 Better	quality	of	work
•	 It	results	in	fewer	errors
•	 Reduction	 in	 eye	 strain	 and	 mental	

fatigue
•	 Better	employee	morale

•	 Quantity	of	Light	
•	 Brightness	of	Light
•	 Diffusion	of	Light
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Toilets	should	be	conveniently	located	
with	adequate	numbers.	

How	 do	 you	 maintain	 healthy	 and	
safety	in	workplace

(i)		 Train	employees	well.	
(ii)	 Reward	employees	for	safe	behavior.
(iii)	 	Partner	 with	 occupational	

clinicians.	
(iv)	 Use	labels	and	signs.
(v)	 Keep	things	clean.	
(vi)	 	Make	sure	employees	have	the	right	

tools	 and	 have	 regular	 equipment	
inspections.	

(vii)	 Encourage	stretch	breaks.	

(i)		 	It	 is	 healthier	 as	 a	 workplace	 for	
different	types	of	office	workers.

(ii)	 	Since	 people	 react	 to	 their	
surroundings,	 a	 clean	 and	 healthy	
office	 contributes	 to	 accuracy	 and	
efficiency

(iii)	 	A	clean	and	tidy	office	also	projects	
a	good	image	of	the	organization	in	
the	eyes	of	the	people	who	visit	it.

   9.12.6 Disposal of Waste

Proper	Disposal	of	Waste	and	Waste	Paper	
is	Very	Essential.

Toilets:	Proper	provision	of	toilets	and	
their	proper	cleanliness	are	important.

Pandemic Safety Guidelines

9.13  Safety Measures at 
Workplace 

One	 of	 the	 vital	 functions	 of	 a	 modern	
office	 is	 to	keep	and	preserve	documents	
and	 records	 for	 future	 guidance	 or	
reference.	 All	 documents	 or	 records	 of	

office	 should	 therefore	 be	 kept	 under	
proper	security.	The	following	precautions	
should	be	taken	to	secure	documents	and	
employees:

(i)   Fire Precautions:	 Adequate	 fire	
precautions	 should	 be	 taken	 for	
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Safety Equipments

First Aid Kit 

9.14  Accidents and 
Emergencies

An	accident	is	an	unplanned,	uncontrolled	
or	unforeseen	event	resulting	in	injury	or	
harm	to	people	and	damages	to	goods.		For	
example,	a	person	falling	down	and	getting	
injured	 or	 a	 glassware	 item	 that	 broke	
upon	 being	 knocked	 over.	 	 Emergency	
is	 a	 serious	 or	 crisis	 situation	 that	 needs	
immediate	attention	and	action.	

9.15 Workplace Safety

Workplace	 safety	 refers	 to	 the	 working	
environment	 at	 a	 company	 and	
encompasses	 all	 factors	 that	 impact	 the	

the	 preservation	 of	 office	 records	
and	 documents,	 machines	 against	
risk	 of	 loss	 or	 destruction	 by	 fire.	
Similarly	 precautionary	 measures	
to	 safeguard	 the	 employees	 in	 the	
office	 should	 also	 be	 provided	 in	
the	 office.	 Fire	 alarms	 should	 be	
fixed	 in	 conspicuous	 places.	 Such	
appliances	 should	 be	 regularly	
inspected	to	ensure	that	they	are	in	
working	order.

(ii)  Accident Prevention:	 Most	
accidents	 occur	 due	 to	
overcrowding	 in	 the	 office;	 use	 of	
obsolete	machines	and	equipment,	
improper	 and	 careless	 handling	
of	 machines	 etc.	 Hence	 Adequate	
precautionary	 steps	 to	 prevent	
accidents	 should	 be	 taken	 in	 the	
office.

(iii)  Provision of Safe Working Place:
	 	 	Arrangements	 should	 be	 made	 to	

provide	a	safe	working	place	for	the	
employees.	 Shape	 and	 size	 of	 the	
office	 rooms,	 location	 and	 size	 of	
doors,	gangways,	etc.,	must	be	such	
as	to	eliminate	hazards	of	accidents.		

(iv)  Provision of First Aid Service:	
To	 ensure	 immediate	 treatment	 to	
injuries,	there	should	be	a	first	aid	
box	 in	 every	 office	 with	 sufficient	
medicines.

(v)  Safety Education and Training of 
Employees:	Each	employee	should	
be	 made	 thoroughly	 aware	 of	 the	
dangers	of	their	job.	Training	should	
be	 given	 to	 employees	 and	 Safety	
regulations	 should	 be	 carefully	
framed	and	strictly	enforced.
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ii)		 	Type	 the	 following	 line	 50	 times		
(2	days)

Subject:

a	s	d	f	a	s	d	f	a	s	d	f	a	s	d	f	a	s	d	f	a	s	d	f	
a	s	d	f	a	s	d	f	a	s	d	f	a	s	d	f	a	s	d	f	a	s	d	f		f	d	
s	a	f	d	s	a	f	d	s	a	f	d	s	a	f	d	s	a	f	d	s	a	f	d	s	a	
f	d	s	a	f	d	s	a	f	d	s	a	f	d	s	a	f	d	s	a

Result

Left	 hand	 typing	 has	 been	 completed	
successfully.

Experiments – 2:

Right-hand	type	

Objective: 

Students	 will	 be	 able	 to	 type		
left-hand.

Tools Required:

1.	Computer-1
2.	MS	office	2019
3.	Rapid	typing	software

safety,	health	and	wellbeing	of	employees.		
Work	 environment	 is	 the	 basic	 right	 of	
every	worker.

(i)   Responsibilities of employer at 
workplace:

An	employer	should	ensure	a	safe	and	
healthy	workplace	for	their	employees	and	
also	for	any	customers	who	may	visit	 the	
workplace.

(ii)  Training to employees for prevent 
accidents and emergencies:

1.	 Individual	roles	and	responsibilities
2.	Threats,	hazards	and	protective	actions.
3.	Notification,	 warning	 and	

communication	procedures
4.	Means	 for	 locating	 family	members	 in	

an	emergency
5.	Emergency	response	procedures

Experiment: 1

Left-hand	type	

Objective:	

students	will	be	able	to	type	left-hand.

Tools Required:

1.	Computer-1
2.	 	MS	office	2019
3.	Rapid	typing	software

Procedure:

i)	 	 	Open	MS	Office	word	document	or	
Rapid	typing	software
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Subject: 

juut	jut	jute	kiit	kit	kite	juut	jut	jute	kiit	
kit	kite	juut	jut	jute	kiit	kit	kite	jud	judder	
jug	 jugger	 judge	 judged	 juud	 judder	 jug	
jugger	 judge	 judged	 igh	 high	 thigh	 ight	
fight	right	fright	igh	high	thigh	ight	fright	
right	fright

Result:

Both	 your	 hands	 have	 been	 practiced	
successfully.

Experiments – 4:

Practice	 of	 Typing	 in	 Rapid	 typing	
Software.

Objective : 

Students	will	be	able	to	Practice		Rapid	
Typing	Tutor	software.

Tools Required :

1.	Computer-1
2.	Rapid	typing	software

Procedure :

Step 1: Install	 the	 software		
(Rapid	 typing	 tutor	 5.3)	 on	 the		
computer.

Step 2: Open	 Rapid	 typing	 software	
and	click	EN.1	introduction	and	click	the	
1.Basics	lesson	1.

Procedure:

i)	 	 	Open	MS	Office	word	document	or	
Rapid	typing	software

ii)		 	Type	 the	 following	 line	 100	 times		
(4	days)

Subject:

;lkj	 ;lkj	 ;lkj	 ;lkj	 ;lkj	 ;lkj	 ;lkj	 ;lkj	 ;lkj	 ;lkj	
;lkj	;lkj	;lkj	;lkj	;lkj

Result:

Right	hand	typing	has	been	completed	
successfully.

Experiment: 3

Both	your	hands	type

Objective:

Students	will	 be	 able	 to	do	both	 your	
hands.

Tools Required:

Computer-1

MS	office	2019

Rapid	typing	software

Procedure:

i)	 	 	Open	MS	Office	word	document	or	
Rapid	typing	software

ii)		 	Type	 the	 following	 each	 lines		
15	times
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Step 3: Practice	the	Basics	 lesson	1	to	
Basics	lesson	9.

Step 4:	 Take	 the	 screenshots	 of	 the	
result	of	lesson	1	to	lesson	9.

Result :

Thus	 the	 	 lesson	 1	 to	 lesson	 9	
in	 introduction	 has	 been	 viewed	
successfully(In	rapid	typing	software).

How do you maintain healthy and safety in workplace:

•	 Train	employees	well.
•	 Reward	employees	for	safe	behavior.
•	 Partner	with	occupational	clinicians.
•	 Use	labels	and	signs.
•	 Keep	things	clean.
•	 Make	sure	employees	have	the	right	tools	and	have	regular	equipment	inspections.
•	 Encourage	stretch	breaks.
•	 Implement	safety	protocols	from	the	start.

POINTS TO BE REMEMBERED:
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Objective Type: (1 Marks)

I. Choose the correct answer:

1.	 One	 of	 the	 world’s	 fastest	 growing	
economic	activities,	which	envisages	
easier	flow	of	information	at	various	
levels	 in	 the	 desired	 pattern	 in	

a.	 Information	technology
b.	 Informative	theory
c.	 Information	Theory
d.	Internet	Times

2.	 BPO	stands	for	
a.	 Business	Process	Optimization

b.	Business	Process	object
c.	 Business	Process	outsourcing
d.	Business	Programs	office.

3.	 	
is	 one	 of	 the	 advantages	 of	 BPO	
Services.

a.	 Increased	Costs
b.	Decreased	Flexibility
c.	 Decreased	costs
d.	Inefficient.

 EVALUATION 

•	 IT	–	Information	Technology	(IT)	is	one	of	the	world’s	fastest	growing	economic	
activities,	 which	 envisages	 easier	 flow	 of	 information	 at	 various	 levels	 in	 the	
desired	pattern.	The	Information	Technology	enabled	services	

•	 ITes	 –	 ITeS	 sector	 has	 also	made	 significant	 contributions	 to	 the	 growth	 and	
development	of	our	Country.

•	 Information	–	Information	is	processed,	organized	and	structured	data.
•	 Technology	–	Technology	refers	to	methods,	systems,	and	devices	which	are	the	

result	of	scientific	knowledge	being	used	for	practical	purposes
•	 BPM	–	Business	process	management	(BPM)	is	“an	organizational	discipline	where	a	

company	takes	a	step	back	and	looks	at	all	of	these	processes	in	total	and	individually.
•	 Outsourcing	–	Outsourcing	is	 the	business	practice	of	hiring	a	party	outside	a	

company	to	perform	services	or	create	goods	that	were	traditionally	performed	
in-house	by	the	company's	own	employees and staff.

•	 BPO services	–	Business	Process	Outsourcing	(BPO)	services	means	performing	
business	operations	through	an	outside	service	provider.	

•	 Humidity	–	A	quantity	representing	the	amount	of	water	vapour	in	the	atmosphere.
•	 Incandescent	–	Producing	a	bright	light	from	a	heated	filament.
•	 Landscape	 –	 A	 landscape	 includes	 the	 physical	 elements	 of	 landforms	 and	

different	forms	of	land	use,	buildings	and	structures.

KEY TERMS
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4.	 	
_	 is	 the	 type	 of	 outsourcing,	 offers	
advanced	expertise	for	any	particular	
business	process.

a.	 RPO
b.	BPO
c.	 KPO
d.	LPO

5.	 G	D	P	stands	for	
a.	 Gross	Domestic	product
b.	Good	Distribution	Practice
c.	 General	Data	Processor
d.	General	Domestic	Product

6.	 Which	 one	 identifies	 areas	 of	
improvement	 to	 create	 a	 more	
efficient	and	effective	organization?

a.	 Business	process	outsourcing
b.	Business	process	Management
c.	 Information	technology
d.	Level	process	outsourcing

7.	 	
organization	 caters	 to	 the	 needs	 of	
the	 parent	 company	 only	 and	 does	
not	serve	external	clients.

a.	 Indian	service	providers
b.	Global	In	–	house	centres
c.	Multinational	Companies
d.	SME

8.	 Indian	 IT	 Industry	 has	 more	
	 registered	

companies	 in	 the	 sector	 across		
GIC,	MNC	 and	 SME	 categories	 as	 of	
2016.

a.	 18,000
b.	 7,000
c.	 16,000
d.	15,000

9.	 ICT	Abbreviation	is	
a.	 Information	 &	 Communication	

Technology
b.	 Information	&	Computer	Technology
c.	 Information	centre	Technology
d.	International	currency	technologies.

10.	The	 IT	 –	 BPM	 Industry	 has	 almost	
	 in	 terms	 of	

revenue	 and	 contribution	 to	 India’s	
GDP	over	the	last	decade.

a.	 Doubled
b.	 Singled
c.	 Tripled
d.	First

11.	Which	 of	 the	 following	 is	 not	 a	 key	
for	punctuation	marks?	

a.	 comma	(,)	
b.	period	(.)
c.	 semicolon	(;)
d.	equal	sign	(=)

12.	 Which	of	the	following	is	not	an	arrow	key?	
a.	 top	(^)
b.	down	(↓)
c.	 right	(→)
d.	left	(←)

13.	Which	of	the	following	operations	is	
not	performed	by	a	mouse?	

a.	 Left	Click
b.	Right	Click
c.	Middle	Click
d.	Double	Click

14.	Roof	 ventilation	 and	 internal	 tube	
ventilators	 provide	 	
ventilation.

a.	 Natural
b.	Artificial
c.	 Direct
d.	Indirect
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15.	The	 ideal	 office	 temperature	 is	
approximately	 	
Fahrenheit.

a.	 58	degree
b.	 68	degree
c.	 78	degree
d.	48	degrees

16.	The	 cleaning	 work	 should	 be	
undertaken	 	 the	
business	hours	in	the	office.

a.	 During
b.	Before
c.	 After
d.	Either	before	or	after

Part - B

II. Very Short Answer Questions.

1.	 		 Write	important	BPO	Services?
2.	 		 	Write	 any	 5	 advantages	 of	 BPO	

services?
3.	 		 Define	BPM
4.	 		 	What	 are	 the	 various	 IT	

applications	areas?
5.	 		 	What	 are	 the	 parameters	 of	 IT	 –	

BPM	Industry?
6.	 		 	Discuss	 the	 various	 types	 of		

keys	 available	 on	 a	 computer	
keyboard.

7.	 		 	Mention	 the	 finger	 allocation	 of	
keys	 of	 the	 Bottom	 Row	 of	 the	
computer	keyboard.

8.	 		 	A	student	typed	480	characters	per	
4	min	with	errors	in	30	characters.	
Calculate	 Simple	 speed	 and	 Net	
speed

9.	 		 	What	is	artificial	ventilation?
10.	 	How	do	you	prevent	 accidents	 in	

the	workplace
11.	 What	are	safety	measures?
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•	 Enable	the	students	to	understand	the	concept	of	DBMS.
•	 To	know	about	the	steps	to	create	a	table	using	table	wizard	and	to		retrieve	

data	using 	query
•	 To	Know	about	structured	Query	Languages	(	SQL)
•	 To	analyze	and	create	forms	and	reports	using	wizard.

Learning Objectives

10.1  Introduction of Computer Applications

Computers	are	seen	everywhere	around	us,	in	all	spheres	of	life,	in	the	field	of	education,	
research,	 travel	 and	 tourism,	 weather	 forecasting,	 social	 networking,	 e-commerce	
etc.	 Computers	 have	 now	 become	 an	 indispensable	 part	 of	 our	 lives.	 Computers	 have	
revolutionised	 our	 lives	 with	 their	 accuracy	 and	 speed	 of	 performing	 a	 job,	 it	 is	 truly	
remarkable.	 Today,	 no	 organisation	 can	 function	 without	 a	 computer.	 In	 fact,	 various	
organisations	 have	 become	 paperless.	 Computers	 have	 evolved	 over	 the	 years	 from	 a	
simple	calculating	device	to	high-speed	portable	computer.

10.2 Microsoft Office

Microsoft	Office	(or	simply	Office)	is	a	family	of	server	software,	and	services	developed	
by	Microsoft.	It	was	first	announced	by	Bill	Gates	on	August	1,	1988,	in	Las	Vegas.	The	first	
version	of	Office	contained	Microsoft	Word,	Microsoft	Excel,	and	Microsoft	PowerPoint.	
Microsoft	Office	is	a	suite	of	desktop	productivity	applications	that	is	designed	specifically	
to	be	used	for	office	or	business	use.	It	is	a	proprietary	product	of	Microsoft	Corporation	
and	was	first	released	in	1990.	Microsoft	Office	is	available	in	35	different	languages	and	
is	supported	by	Windows,	Mac	and	most	Linux	variants.	It	mainly	consists	of	Word,	Excel,	
PowerPoint,	Access,	OneNote,	Outlook	and	Publisher	applications.

10.2.1 Microsoft Word

Microsoft	 Word	 is	 a	 text	 processing	 application.	 It	 allows	 the	 user	 to	 configure	 the	
attributes	of	a	document,	such	as	layout	and	the	styles	of	content,	and	to	add	their	content	
in	a	variety	of	ways	and	formats	to	produce	documents.

Chapter
AUDITING RELATED  

COMPUTER APPLICATIONS10Chapter
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Proprietary source Word processing software

Package Developer
Microsoft	Word	 Microsoft	Corporation
WPS	Word	 Kingsoft

WordPro	 Lotus	Corporation

Open Source Word processing software

Package Developer

OpenOffice	Writer Apache

LibreOffice	Writer The	document	Foundation

Abiword Abisource

10.2.2 Microsoft Excel

Microsoft	Excel	is	an	application	used	for	creating	and	editing	spreadsheets.	Spreadsheets	
are	commonly	used	 for	working	with	sets	of	data	containing	 text	and	numbers	and	 for	
generating	graphs	and	charts.

 10.2.3 Microsoft Powerpoint

Microsoft	 PowerPoint	 is	 commonly	 used	 to	 create	 presentations	 using	 slides.	 Though	
often	used	to	make	simple,	bullet-pointed	presentations,	it	has	a	range	of	features	that	can	
allow	a	range	of	media	in	your	presentation.	Our	guide	to Presentations takes	you	through	
how	to	use	PowerPoint	effectively.

It	is	also	a	great	tool	for	creating	posters,	as	the	size	of	a	slide	can	be	changed	to	suit	paper	
sizes	and	then	the	image	options	utilised	to	create	posters	without	using	image	software.	
We	will	do	some	of	the	experiments	below	using	MS	Office.

10.3  Arrangements of various gadgets and accessories of 
computer for its operations: 

Objective:

To	learn	the	procedure	of	connecting	and	disconnecting	different	external	Input	and	Output	
devices	with	the	computer.

Operations/Experiments Covered Under the Project:

•• Identification	of	parts	of	computer
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•• Identification	of	ports	in	CPU

•• Connecting	the	devices

Safety Measures:

1.	 Before	placing	your	computer	on	a	desk	or	table	make	sure	it	is	set	up	near	an	electrical	
outlet	and	network/phone	jack.

2.	 The	keyboard	 should	be	 reachable,	 the	CPU	 should	be	well-ventilated,	 the	monitor	
should	be	in	full	view	and	the	mouse	should	be	set	up	depending	on	which	hand	you	
plan	on	using.

3.	 Turn	off	the	power	and	unplug	equipment	before	performing	service.

4.	 Cover	sharp	edges	inside	the	computer	case	with	tape.

5.	 Never	open	a	power	supply	or	a	CRT	monitor.

Tools and Equipment Required: 

Activity Title Sl.No Name of the apparatus/ 
components

Range/Value Quantity

Identification	 of	 parts	 of	
computer

1 Central	Processing	Unit I5-Dual	Core 1
2 Keyboard 108	Keys 1
3 Monitor 14”	LED 1
4 Mouse Optical 1
5 Printer Laser/Inkjet 1

Identification	of	the	ports	
in	CPU

Central	Processing	Unit 15	Dual	core 1

Connecting	the	devices Central	Processing	Unit I5-Dual	Core 1

Keyboard 108	Keys 1

Monitor 14”	LED 1

Mouse Optical 1

Printer Laser/Inkjet 1

Procedure:

Section 1. Identification of Parts:

a)  CPU: The	 Central	 Processing	 Unit	 (CPU),	 also	 called	 as  processor,	 is	 located	 inside	
the computer case on	the	motherboard.	It	is	also	called	the	brain	of	the	computer	and	its	
job	 is	 to	carry	out	commands.	Whenever	you	press	a	key	or	click	 the	mouse	or	start	an	
application	you	are	sending	instructions	to	the	CPU.
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 CPU Monitor

b)  Monitor or Screen:  This	is	the	TV-type	screen	on	which	you	can	see	the	work	you	
are	doing	on	your	computer.

c)  Keyboard: The keyboard is	one	of	the	main	ways	to	communicate	with	a	computer.	
There	are	many	different	types	of	keyboards,	but	most	are very similar and	allow	
you	to	accomplish	the	same	basic	tasks.

	 	

 Keyboard Mouse

d)  Mouse: The mouse is	another	important	tool	for	communicating	with	computers.	
Commonly	 known	 as	 a pointing device. It	 lets	 you  to	point  the	 objects	 on	 the	
screen, to	click on	them,	and move.

Section 2 . Identification of Ports in CPU :

Identification of ports in CPU
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Step	1:	Identify	the	power	connector,	smps	cooling	fan,	CPU	cooling	fan,	switch	and	
screw.

Step	2:	Identify	the	PS/2	port,	USB	port,	Parallel	port,	VGA	port,	Ethernet	port	and	
Audio	jacks	in	CPU.

Step	3:	Identify	the	expansion	slots	and	expansion	cars	in	the	CPU.

Section 3: Connecting the devices:

A) Setting up a Desktop omputer

Step	1:	Unpack	the monitor and computer	case from	the	box.	Remove	any	plastic	cover	
or	protective	tape.	Place	the	monitor	and	computer	case	on	a	desk	or	work	area.

	  

 Desktop computer Ventilated CPU

Be	sure	to	place	your	computer	in	an	area	that	is well	ventilated and	has	good	airflow.	
This	will	help	you	to	prevent	the	computer	from	overheating.

Step	2	:	Locate	the monitor	cable.	There	are	several	types	of	monitor	cables.	The	one	for	
your	computer	may	not	look	a	like	the	other	one	shown	below.

Monitor cable

If	you	are	finding	trouble	with	your	monitor	cable,	refer	to	the	instruction	manual	of	
your	computer.

Step	3	:	Connect	one	end	of	the	monitor	cable	port on	the	back	of	the computer	case and	
the	other	end	to	the monitor.	If	you’re	using	a	VGA	cable	like	the	one	in	the	picture	
below,	you	have	to	tighten	the	screws	on	the	monitor	cable	to	secure	it.

Many	computer	cables	only	fit	in	a	specific	way.	If	the	cable	doesn’t	fit,	don’t	force	it.	It	
might	damage	the	connectors.	Make	sure	the	plug	aligns	with	the	port,	then	connect	it.
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VGA cable  

Step	 4:	 Unpack	 the  keyboard  and	 determine	 whether	 it	 uses	 a  USB  (rectangular)	
connector	or	 a PS/2  (round)	 connector.	 If	 it	uses	 a	USB	connector,	plug	 it	 into	any	
of	the	USB	ports	on	the	back	of	the	computer.	If	it	uses	a	PS/2	connector,	plug	it	into	
the purple keyboard	port	on	the	back	of	the	computer.

USB cable

Step	5:	Unplug	the mouse and	determine	whether	it	uses	a USB or PS/2 connector.	If	it	
uses	a	USB	connector,	plug	it	into	any	of	the	USB	ports	on	the	back	of	the	computer.	If	
it	uses	a	PS/2	connector,	plug	it	into	the green mouse	port	on	the	back	of	the	computer.

PS/2 connector

If	your	keyboard	has	a USB	port,	you	can	connect	your	mouse	to	the	keyboard	instead	
of	connecting	it	directly	to	your	computer.

If	you	have	a wireless mouse	or	keyboard,	you	may	need	to	connect	a	Bluetooth dongle (USB	
adapter)	to	your	computer.	However,	many	computers	have	built-in	Bluetooth,	so	an	
adapter	may	not	be	necessary.
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Step	6: If	you	have external	speakers or headphones,	you	can	connect	them	to	your	
computer’s  audio	 port  (either	 on	 the	 front	 or	 back	 of	 the	 computer	 case).	 Many	
computers	have	colour-coded	ports. Speakers or headphones connect	to	the green port,	
and microphones connect	to	the pink port.	The blue port	is	the line	in,	which	can	be	
used	with	other	types	of	devices.

Colour coded ports

Some	speakers,	headphones,	and	microphones	have USB	connectors instead	of	the	usual	
audio	plug.	These	can	be	connected	to	any	USB	port.	In	addition,	many	computers	have	
speakers	or	microphones	built	into	the	monitor.

Step	7:	Locate	the	two power	supply	cables that	came	with	your	computer.	Plug	the	first	
power	supply	cable	into	the	back	of	the computer	case and	then	into	a surge	protector.	
Then,	using	the	other	cable,	connect	the monitor to	the surge	protector.

 

Power supply cable

You	can	also	use	an uninterruptible	power	supply	(UPS),	which	acts	as	a	surge	protector	
and	provides	temporary	power	if	there	is	a	power	outage.

Step	8	:	Finally,	plug	the surge	protector into	a	wall	outlet.	You	may	also	need	to	turn	on	
the surge	protector if	it	has	a	power	switch.

Surge protector
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If	you	don’t	have	a	surge	protector,	you	can	plug	the	computer	directly	into	the	wall.	
However,	this	is not	recommended because	electrical	surges	can	damage	your	computer.

Step	9: If	you	have	a printer, scanner, webcam	or	other peripherals,	you	can	connect	
them	 at	 this	 point.	Many	 peripherals	 are  plug	 and	 play,	 which	means	 they	 will	 be	
recognized	by	your	computer	as	soon	as	they	are	plugged	in.

Printer

Other	peripherals	may	include software that	needs	to	be	installed	before	you	can	begin	
using	 them.	Use	 the	 instructions	 included	with	 the	 device	 to	 install	 it	 if	 necessary.	
Generally,	peripherals	are optional,	and	you	can	add	new	ones	at	any	time;	you	don’t	
have	to	add	all	peripherals	during	the	initial	setup	of	your	computer.

Costing sheet:

S. 
No

Name of the Equipments/ 
components required

Range/  
Specifications

Quantity Cost  
(approx.)

Value in the 
nearby store

1 CPU i5,	Dual	Core	
MotherBoard,		
500	GB,	4GB

1 17000

2 Keyboard 108	keys 1 1500
3 Monitor 14”	LED 1 7000
4 Mouse Optical 1 400
5 Printer Ink	jet 1 3000

Total
Wages	and	overhead	:	25%	of	Material	Cost
Total	Cost	to	create/service	on	the	product
Selling	price	in	the	market
Profit

Result:

Thus	 the	 procedure	 of	 connecting	 and	 disconnecting	 different	 external	 Input	 and	Output	
devices	with	the	Computer	has	been	learned	successfully.	
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Simple Assessment:

1.	 Connect	the	parts	as	per	this	block	diagram

Block Diagram 

2.	 What	are	the	safety	precautions	to	be	taken	while	assembling	the	computer?

•• Remove	your	watch	and	jewellery	and	secure	loose	clothing.

•• Turn	off	the	power	and	unplug	equipment	before	performing	service.

•• Cover	sharp	edges	inside	the	computer	case	with	tape.

•• Never	open	a	power	supply	or	a	CRT	monitor.

•• Do	not	touch	areas	in	printers	that	are	hot	or	that	use	high	voltage

•• Bend	your	knees	when	lifting	heavy	objects	to	avoid	injuring	your	back

Table showing Video suggestions:

S.No Title/purpose Link
1 Setting	up	a	desktop	computer https://youtu.be/	

KdQeU5QTfYE
GCFLeanaFree.org

2 How	to	Setup	a	Desktop	Computer	at	
Home

https://youtu.be/
avaOf-kdb7w

Palmetto	technology	
group

3 Computer	Fundamentals	-	Setting	Up	
a	Computer	-	How	to	Set	a	Desktop	
Computers	and	How	to	Plug	In	PC

https://youtu.be/
SM0qsvQBEPg

Professor	Adam	
Morgan

Student project Students	are	asked	to	set	up	three	computers.
Guest lecture suggestions Invite	a	computer	field	technician	for	a	guest	lecture.

Invite	an 	IT	engineer	for	a	guest	lecture.
Industrial/ Field visit suggestions A	Visit	to	a	Computer	centre	for	field	visit.

A	Visit	to 	a	software	company	for	industrial	visit.
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1 Word Processing :

Word	Processing	refers	to	the	act	of	using	a	computer	to	create,	edit,	save	and	print	documents.

In	order	 to	perform	word	processing,	 specialized	 software	 (known	as	a	word	processor)	 is	
needed.

Ex:	MS	Word,	Open	Office	Writer	and	Google	Drive	Document.

2 Introduction

Microsoft	Word	(MS	Word)	is	a	popular	commercial	word	processor	created	by	Microsoft.	It	
is	also	one	of	the	widely	used	programs	in	the	suite.

It	is	available	for	both	windows	and	Apple	Operating	Systems	(OS)

Microsoft	Word	 is	 in	 the	Microsoft	 office	 productivity	 package	 and	 is	 also	 available	 as	 a	
standalone	application.

Microsoft	Word	 was	 first	 released	 in	 1983	 and	 has	 seen	 various	 revisions	 since	 then.	 It’s	
compatible	with	both	Windows	and	Mac	computers.

Although	many	other	applications	give	it	a	competition,	nothing	has	defeated	it	to	date.

3 Features of MS WORD:

i.	 It	helps	to	make	professional	write-ups,	editing	and	formatting	the	existing	documents.

ii.	 It	also	helps	in	creating	graphical	documents	comprising	images	and	more.

iii.	Millions	 of	Office	Workers,	 students	 and	 home	 users	 create,	 read	 and	 edit	 documents	
using	this	software	program.

iv.	 MS-Word	not	only	supports	Word	Processing	textures	but	also	DTP	textures.

4 Application – MS – Office:

MS	Office	is	a	powerful	service	and	it	helps	the	worldwide	business	community	to	improve	
their	efficiency	and	productivity.MS	Office	can	be	used	in	different	operating	systems	namely	
Window	OS,	Mac	OS,	Android	ios	etc.,

MS	Office	provides	tools	enabling	businesses	to	be	productive	and	communicate	effectively	
regardless	of	location.

10. 4  Create a MS word documents and its various options

Objectives:

To	create	a	MS	word	documents	and	use	its	various	options.
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Operations / Experiments Covered Under the Project:

1.	 Creating	a	document

2.	 Parts	of	writer	window

3.	 Cursor	and	mouse	pointer

4.	 Text	editing

5.	 Undo	and	redo

6.	 Moving	and	copying	text

7.	 Copy	and	paste

8.	 Selecting	text

9.	 Selecting	a	vertical	block	of	text

10.	Find	and	replace

11.	Using	synonyms	&	the	thesaurus

12.	Save	and	reopen	the	file

Tools and Equipment Required:

S.no Name of the tools/ equipment Range/Value Quantity
1 Computer	or	Laptop I5	processor/4GB	RAM 1
2 Microsoft	office MS	office	2019 1

Shortcut Keys:
Table showing shortcut keys

Sl.no To do this Press
1 Open	a	document. Ctrl+O
2 Create	a	new	document. Ctrl+N
3 Save	the	document. Ctrl+S
4 Close	the	document. Ctrl+W
5 Cut	the	selected	content	to	the	Clipboard. Ctrl+X
6 Copy	the	selected	content	to	the	Clipboard. Ctrl+C
7 Paste	the	contents	of	the	Clipboard. Ctrl+V
8 Select	all	document	content. Ctrl+A
9 Apply	bold	formatting	to	text. Ctrl+B
10 Apply	italic	formatting	to	text. Ctrl+I
11 Apply	underline	formatting	to	text. Ctrl+U
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12 Decrease	the	font	size	by	1	point. Ctrl+Left  bracket ([)
13 Increase	the	font	size	by	1	point. Ctrl+Right bracket (])
14 Center	the	text. Ctrl+E
15 Align	the	text	to	the	left	. Ctrl+L
16 Align	the	text	to	the	right. Ctrl+R
17 Cancel	a	command. Esc
18 Undo	the	previous	action. Ctrl+Z
19 Redo	the	previous	action,	if	possible. Ctrl+Y
20 Adjust	the	zoom	magnifi	cation. Alt+W, Q, then use the Tab key in 

the Zoom dialog box to go to the 
value you want.

21 Split	the	document	window. Ctrl+Alt+S
22 Remove	the	document	window	split. Alt+Shift +C or Ctrl+Alt+S

Procedure:

Section 1. Creating a document:

	 Step	1:	Create	a	new	text	document	by	using	File	→	New	→	Blank	Document.

Create a new document.
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Step	2: 	Now	save	the	fi	le	by	clicking	on	the	File	→	Save.	Give	the	name	of	the	fi	le	(for	
example:report).	By	default,	the	fi	le	is	saved	in	.docx	format.	Diff	erent	fi	le	formats	are	
under	Save	as->Save	as	type->Choose	the	diff	erent	format.

Type fi le name

Save as type 

Step	3:	Saving	the	fi	le	by	another	name

It	is	possible	to	make	another	copy	of	the	fi	le	by	saving	it	with	another	name	using	the	
Save	As	option.	Once	the	user	saves	the	document	by	giving	a	name,	it	is	called	a	‘File’.	
Th	 e	user	can	save	the	fi	le	with	another	name	in	another	location	with	another	format	
using	the	Save	As	option.	Th	 e	user	will	get	two	fi	les:	the	previous	one	and	the	one	with	
the	new	name. 
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Save the fi le

Step	4:	Closing	the	document

Aft	er	fi	nishing	the	work,	close	the	fi	le,	as	too	many	opened	fi	les	will	cause	a	disturbance	
in	working.	To	close	the	fi	le,	select	File	→	Close

Step	5:	Opening	the	document

It	may	further	require	opening	a	fi	le	for	editing.	Select	File	→	Open	(Ctrl+O)	and	the	
document	will	be	open	for	editing.

Open the document.

Section 2. Parts of a Writer Window:

Title bar:	Title	bar	is	located	on	the	top	of	the	Writer	window.	It	shows	the	title	of	the	currently	
opened	document.	Th	 e	name	of	the	document	means	the	fi	le	name	of	the	document	saved	on	
the	disk.	For	a	new	document,	it	shows	the	title	of	the	document	as	Untitled	X,	where	‘X’	is	the	
document	number	Untitled	1,	Untitled	2,	Untitled	3...	etc.,	as	we	go	on	opening	the	new	document
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Menu bar: It	appears	below	the	Title	Bar.	 It	shows	the	menu	items	File,	Edit,	View,	Insert,	
Format,	Tables,	Tools,	Window	and	Help.	On	selecting	a	menu	item,	its	submenu	will	open	
below	the	menu	item.	We	can	select	any	item	in	the	submenu	as	per	the	requirement.	Selecting	
the	File	menu.	The	submenu	item	which	shows	three	dots	 ‘...’	 just	after	the	submenu	name,	
means,	clicking	on	it	will	open	the	dialog	box.	The	submenu	item	which	shows	right	hand	side	
arrows	‘’	just	after	the	submenu	name,	means,	clicking	on	it	will	open	another	submenu.

Toolbars:	The	tool	bar	appears	below	the	Menu	Bar.	By	default,	the	Standard	Tool	Bar	and	
Formatting	ToolBar	will	appear.	The	other	toolbars	can	be	activated	by	clicking	on	the	‘View’	
menu,	and	selecting	the	‘Toolbars’	of	the	submenu.	The	user	can	choose	the	required	toolbars	
by	clicking	on	it.	Standard	toolbar:	It	contains	commands	in	the	form	of	icons.

Formatting toolbar:	It	contains	the	various	options	for	formatting	a	document.	A	graphical	
representation	of	commands	is	shown	in	the	form	of	icons. 

Status bar: This	is	positioned	at	the	left	bottom	of	the	Writer	window	and	displays	the	number	
of	pages,	words,	the	language	used,	zooming,	etc.	It	is	located	at	the	bottom	of	the	workspace. 

Scroll button and Scroll bar:	It	is	used	to	scroll	the	document. 

Zoom: It	allows	you	to	change	the	scale	of	the	text	and	pictures	 in	the	document	only	for	
view.	It	does	not	affect	the	physical	document.	It	is	used	to	check	the	finishing	quality	of	the	
document.	To	know	the	meaning	of	other	tools,	position	the	mouse	pointer	on	the	tool	and	
see	the	Tool	Tip.

Part of writer windows.

Section 3. Cursor and Mouse Pointer:

Text Cursor:	The	Text	Cursor	is	a	flashing	vertical	line	in	the	body	of	the	text.	The	4	arrow	
keys	(←↑↓→)	on	the	keyboard	are	called	as	cursor	control	keys
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Text cursor

Mouse Pointer:

Th	 is	is	the	mouse	pointer.	It	takes	the	pointer	shape	while	moving	it	around	the	screen.	Th	 e	
mouse	pointer	changes	to	I	shape,	when	moved	over	the	text	in	a	document.	Moving	the	‘I’	
shaped	mouse	pointer	over	the	text	and	clicking	on	the	desired	text,	helps	to	get	the	text	cursor	
while	editing	the	document.	Th	 us,	the	mouse	is	used	to	control	the	Text	Cursor	location.

Section 4. Text Editing:

Step	1:	Click	Home	Button

Step	2:	Select	the	text	that	you	want	to	edit.

Step	3:	Using	the	tools	 in	the	edit	 toolbar,	change	the	required	formatting	 including	
font	style,	paragraph	alignment,	list	formatting,	and	indentation	options. 

Text editing

Section 5. Undo and Redo:

Open	the	existing	fi	le	(For	example,	report.docx)	and	then	start	editing	in	it.	If,	by	mistake,	
you	have	made	some	changes	and	now	you	want	to	erase	the	last	change	done,	then	use	the	
Undo	option.	Aft	er	undo	command,	again	if	you	want	to	go	back	then	use	the	Redo	option. 

Undo and Redo
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Section 6. Moving and Copying Text from One place to Another:

Select	the	text	and	click	on	Select	the	text →	Right	click	the	mouse	and	select	Cut	option	
or	press	CTRL+X.	Place	the	cursor	where	the	text	has	to	be	moved.	Right	click	the	mouse	
and	select	Paste	options	or	press	CTRL+V.

Copying, pasting the text

Section 7. Copy and Paste:

Step	1:	Select	the	text. 

Step	2:	right	click	and	select	COPY option	or	press	CTRL+C

Step	3:	Place	the	cursor	where	the	text	has	to	be	duplicated.	Right	Click	and	select	Paste	
option	or	press	CTRL+V 

Section 8. Selecting Text:

The	editing	can	be	done	by	 left	 long	click	and	drag	the	mouse	require	select	 text.	 It	
is	necessary	to	select	the	text	to	perform	copy	and	paste	operation.	The	selected	text	
will	 be	highlighted.	 For	 editing	 the	 text,	 you	must	 first	 select	 the	 required	 text,	 for	
selecting	all	select	press	Ctrl+A.

Section 9. Selecting a Vertical Block of Text:

Step	1:	Press	CTRL+A	for	selecting	all	text.

Step	2:	A	vertical	block	of	text	Press	CTRL+SHIFT+F8,	and	then	use	the	arrow	keys	or	
Use	Alt	key	and	select	the	required	text	for	the	vertical	block	of	text. 

Step	3:	Press	ESC	to	turn	off		the	selection	mode.
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Selecting a vertical block of text

Section 10. Find and Replace:

Step	1:	Click	on Find	&	Replace	option	in	Home	toolbar.

Step	2:	Write	text	under	Search	for	option	and	click	on	Find	button	to	locate	the	entered	
word.	Th	 is	will	select	the	word	which	you	want	to	search	for	text	in	your	document.

Step	3:	Write	the	text	under	Replace	with	option.

Now	click	on	Replace	 if	 you	want	 to	 change	only	 the	fi	rst	 occurrence	of	 it	 and	use	
Replace	All	to	replace	all	the	matching	occurrences. 

Find and replace
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Section 11. Using Synonyms & Thesaurus:

Sometimes	you	may	search	for	a	word	having	a	similar	meaning	to	the	word.	A	word	processor	
helps	to	look	up	synonyms	(different	words	with	the	same	meaning)	and	antonyms	(words	
with	 the	opposite	meaning)	 in	 the	 thesaurus.	The	 list	of	 synonyms	can	be	accessed	 from	a	
context	menu Right-click	on	a	word	and	point	to	Synonyms	on	the	context	menu.	A	submenu	
of	alternative	words	and	phrases	are	displayed.	Click	on	a	word	or	phrase	in	the	submenu	to	
replace	it	with	the	highlighted	word	or	phrase	in	the	document.	Synonyms	are	different	from	a	
dictionary.	A	dictionary	contains	definitions	and	pronunciations,	whereas	thesaurus	will	have	
words	with	similar	meanings	or	opposite	meanings.

Section 12. Save and Ropen the File:

Step	1:	Select	File	→	Save

Step	2:	Select	the	location	on	disk	to	save	the	file

Step	3:	Type	a	suitable	name	for	the	document

Step	4:	Click	on	Save	button. 

Step	5:	Reopen	the	file	by	clicking	the	File	option	and	Click	the	open	option.

Step	6:	Enter	the	name	and	location	of	the	document	and	open	the	document.

Synonyms & Thesaurus
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Result:

Thus	the	MS	word	document	has	been	created	and	its	various	options	are	used	successfully.

Video Suggestions:

S.No Title/Purpose Link

1 Create	a	new	document https://youtu.be/4M5sjPGLZks
2 Parts	of	window	in	MS	word https://youtu.be/COzqY5TBXD8
3 Text	editing	in	MS	word https://youtu.be/nHNTK8QQiUE
4 Undo	and	redo	in	MS	word https://youtu.be/pnMrQ6U_vtA
5 Moving	and	copying	text	in	MS	word https://youtu.be/mGbOlT2cdVU
6 Copy	and	paste	in	MS	word https://youtu.be/sOqaakHHSQY
7 Selecting	text	in	MS	word https://youtu.be/zNXZD0cS0VM
8 Selecting	a	vertical	block	of	text	in	MS	word https://youtu.be/vIbxrddLLj8
9 Find	and	replace	in	MS	word https://youtu.be/8ZSlu4DWJ5k
10 Using	synonyms	&	the	thesaurus,	in	MS	word https://youtu.be/hXhpd0kehfg
11 Save	and	reopen	the	file	in	MS	word https://youtu.be/0rnx5HoxO5s

Simple Assessments:

Student	project 1.	Students	should	create	a	voucher	for	organization.
2.	Should	prepare	an	advertisement	poster	for	a	function.

Guest	lecture	suggestions 1.	Invite	a MS	office	specialist	for	a	guest	lecture.
2.	Invite	a computer	technician	for	a	guest	lecture.
3.Invite	an	office	assistant	working	in	MS	office	platform.

Industrial/	Field	visit	
suggestions

1.A	field	Visit	to	an	office	nearby	the	school.
2.	Visit	nearby	banks	for	field	visits.
3.A	field	Visit	to	the	nearby	auditing	office.

10. 5  Instructions to format the MS word document

Objectives:

To	practice	to	use	formatting	instructions	in	MS	word	document.

Operations / Experiments Covered Under the Project:

1.	 Formatting	the	document

2.	 Formatting	text,	removing	manual	formatting

XI_Auditing_Chapter_10.indd   142 26-04-2022   18:23:59



143Auditing Related Computer Applications

3.	 Formatting	paragraph	and	using	bullets	and	numbering

4.	 Assigning	color,	border	and	background	to	paragraph

5.	 Formatting	the	page

Procedure:

Tools and Equipment Required:

s.no Name of the tools/ equipment Range/Value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft		offi		ce MS	offi		ce	2019 1

1. Format the Document: 

Step	1:	Open	Word	and	type	Ctrl+N	to	open	word’s	default	blank	document

Step	2:	Type	Ctrl+S	to	save	this	blank	document

Step	3:	Save	the	document	as	‘My	layout.docx’	to	a	chosen	location	(e.g.	Favorites)	on	
your	computer.

Format the document

You	now	have	created	a	new	document	in	which	to	save	your	preferred	layout.	To	set	
the	page	margins,	select	the	Layout	ribbon.

Step	4:	In	the	layout	menu,	click	on	the	small	icon	in	the	right	bottom	corner	of	the	
Page	Setup	section	of	the	ribbon	to	bring	up	the	Page	Setup	dialog	box.
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Step	5:	Click	the	Margins	tab

Margin tab

Step	6:	Set	the	Left		margin	width	to	3	cm

Step	7: 	choose	Portrait	page	under	orientation

Step	8:	check	that	the Apply	to is	set	to whole	document in	the	drop-down	box	and	click	
OK.

Orientation tab

Th	 e	page	margin	and	orientation	settings	will	now	be	applied	to	your	whole	document.

Specify the page layout:

To	set	page	margins	and	numbering	for	printing	double-sided	documents,	select	the	Layout	
tab	in	the	same	Page	Setup	window	as	used	in	step	4.
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Step	9:	Click	the diff	erent	odd	and	even option	in	the	headers	and	footers	section

Header and Footer section

Step	10:	Click	the Diff	erent	fi	rst	page option

Step	11.	Make	sure	to	check	that	the Apply	to is	set	to Whole	document	in	the	drop-
down	box.

Th	 ese	 page	 layout	 settings	 will	 now	 be	 applied	 throughout	 your	 whole	
document.	 Th	 ey	 ensure	 that	 page	 numbering	 can	 be	 adjusted	 for	 odd	 and	 even
pages	and	that	the	inside	margin	will	be	wide	enough	to	bind	your	printed	document

Session 2: Formatting text, Removing Manual Formatting:

Step	1:	Select	the	text	you	want	to	format.

Step	2:	To	select	a	single	word,	double-click	it.	To	select	a	line	of	text,	click	to	the	right	of	it.

Step	3:	Select	an	option	to	change	the	font,	font	size,	font	color,	or	make	the	text	bold,	
italic,	or	underline.

Font alignment
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Step	4:	Select	the	text	with	the	formatting	you	want	to	copy.

Step	5:	Click Format	Painter  ,	and	then	select	the	text	you	want	to	copy	the	formatting	to.

Removing Manual formatting

Step	1:	Select	the	text from	which	you	want	to	remove	formatting	in	Word.	Use	your	
mouse	to	highlight	only	part	of	the	text	or	select	all	the	text	in	the	document	by	selecting	
anywhere	inside	the	document	and	pressing Ctrl+A to	highlight	all	the	text.

Step	 2:	 Select	 the  drop-down arrow  in	 the	 lower-right	 corner	 of	 the	 Styles	 box	 to	
expand	the	Styles	menu.

Step	3:	Select Clear Formatting.	Any	 formatting	applied	 to	 the	selected	 text	will	be	
removed.

Common text Formatting:

To change the text case:

Step	1:	Select	the	text	you	want	to	modify.

Step	2: 	Click	the Change Case command	in	the Font group	on	the	Home	tab.

Change Case

Step	3:	Select	one	of	the	case	options	from	the	list.

To use the Bold, Italic, and Underline commands:

Step	1:	Select	the	text	you	want	to	modify.

Step	2:	Click	the	Bold,	Italic,	or	Underline	command	in	the Font group on	the	Home	tab.

To format font size:

Select	the	text	you	want	to	modify.
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Step	1:	Left	-click	the drop-down arrow next	to	the font size box on	the	Home	tab.	Th	 e	
font	size	drop-down	menu	appears.

Step	2:	Move	your	cursor	over	the	various	font	sizes.	A live preview of	the	font	size	will	
appear	in	the	document

Font size box

To format font color:

Step	1:	Select	the	text	you	want	to modify.

Step	2:	Left	-click	the	drop-down	arrow	next	to	the font color box on	the	Home	tab.	Th	 e	
font	color	menu	appears.

Font color box

Step	3:	Move	your	cursor	over	the	various	font	colors.	A	live	preview	of	the	color	will	
appear	in	the	document
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To format font style:

Step	1:	Select	the	text	you	want	to	modify.

Step	2:	Left	-click	the drop-down arrow next	to	the font style box on	the	Home	tab.	Th	 e	
font	style	drop-down	menu	appears.

Step	3:	Move	your	cursor	over	the	various	font	styles.	A live preview of	the	font	will	
appear	in	the	document

Font style box

Apply superscript or subscript formatting to text:

Step 1:	Select	the	text	you	want	to	format	as	either	a	superscript	or	subscript

Step	2:	In	the	ribbon,	click	the	Home	tab	and	then	click	either	the	Superscript	or 

Superscript or subscript formatting to text
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Subscript button, found in the lower row of the Font section. 

Session 3: Formatting paragraph and using bullets and numbering:

Paragraph style:

Styles	 can	 include	 character	 formatting	 (such	 as	 font,	 size,	 and	 color),	 paragraph	
formatting	(such	as	line	spacing	and	outline	level),	or	a	combination	of	both.	Styles	are	
stored	in	the	template	that	is	attached	to	a	document.

Step	1:	Home	tab

Step	2;	Styles	gallery

Step	3:	You	can	add	styles	to	the	gallery	or	remove	those	that	you	don’t	oft	en	use.

Style sets

Step	1:	Click	the	design	tab

Step	2:	Document	Formatting	gallery

To open the Styles pane:

Step	1:	click	the	Home	tab, 

Step	2:	Select	the	Styles	dialog	box	launcher

Step	3:	Select	the	text	you	want	to	style 
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Formatting gallery

To	format	a	paragraph,	you	can	use	diff	erent	commands	such	as	diff	erent	text	alignments,	
bullets,	numbering,	multi-level	list,	paragraph	indents,	sorting	text,	line	spacing,	shading,	
and	diff	erent	borders.	To	format	a	paragraph,	follow	the	steps	below	the	picture

Indenting paragraphs 

Step	1:	Select	the	text	you	want	to	indent

Step	2:	Th	 e	entire	paragraph	can	be	indented	in	one	step. 

Step	 3:	 Place	 the	 Text	 Cursor	 anywhere	 in	 the	 paragraph,	 select	 and	 click	 on	 the	
‘Increase	Indent’	tool.	Each	time	when	you	click	on	the	Increase	Indent	tool,	the	current	
paragraph’s	indent	will	increase.	Th	 ere	is	also	a	Decrease	Indent	tool	that	removes	the	
indent.
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Aligning paragraphs:

Step	1:	 Select	 the	 text	 and	 set	 the	paragraph	alignment	before	 you	 start	 typing	 into		
your	document.

Step	2:	Then	click	the	“Home”	tab	in	the	Ribbon.

Step	3:	Then	click	either	the	“Align	Left	(Ctrl+L)	,”	“Center	(Ctrl+E),”	“Align	Right	(Ctrl+R),”	
or	“Justify”	(Ctrl+J)	button	in	the	“Paragraph”	button	group	to	set	the	desired	paragraph	
alignment.

Creating a Bulleted List:

Step	1:	Go	to	the Home tab

Step	2:	Click	on	the	drop-down	arrow	of	the	Bullets,	which	is	the	first	option	in	the  	
Paragraph	group.

Step	3:	Under	the	command	“Bullet”,	Select	one	of	the	options	that	you	want	to	start	
the bulleted	list   

Step	4:	Now	the Bullet is	being	inserted	into	your	word	document	to	start	its	list

Step	5:	After	you	insert	the	bullet,	start	typing	the	word/sentence	that	you	want

Step	6:	Then	press	the enter key	to	start	the	next	bullet	point.	Do	this	in	the	same	way	
to	create	the Bulleted List.

Step	7:	To	start	the	new	section	with	a	word,	sentence	or	paragraph without	a Bulleted list,	
strike	the Enter key	2	times

Bulletin library
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Creating a Numbered List:

Step	1:	Go	to	the	Home	tab

Step	2:	Click	on	the	drop-down	arrow	of	the	Numbering,	which	is	the	second	option	in	
the Paragraph	group.

Step	3:	Under	the	command	“Numbering”,	Select	one	of	the	options	that	you	want	to	
start	the	numbered	list

Step	4:	Now	the Number is	being	inserted	into	your word	document to	start	its	list.

Step	5:	After	you	insert	the number,	start	typing	the	word/sentence	that	you	want, 

Step	6:	Then	press	the enter key	to	start	the	next	serial	number.	Do	this	in	the	same	way	
to	create	the Number List.

Step	 7:	 To	 start	 the	 new	 section	 with	 a	 word,	 sentence	 or	 paragraph  without	
a Numbered list,	strike	the Enter key	2	times.

 

Numbering list

Session 4: Assigning color, border and background:

Assign Page Color:

You	can	also	add	a	background	color	to	your	document.	This	color	will	only	appear	in	
digital	copies	of	the	document—Word	will	not	print	the	page	color.

Step	1:	On	the	Design	tab,	click	the Page	Color button.

Step	2	:	Select	a	color.
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Assign the color

Add Page Borders:

You	can	also	add	page	borders	along	the	margins	to	give	it	a	finished	look.

Step	1:	On	the	Design	tab,	click	the Page Borders button.

Using	the	Borders	and	Shading	dialog	box,	customize	how	you	want	the	border	to	look.

Step	2:	Select	a	border	style	from	the	Style	list.

You	can	choose	from	a	variety	of	solid	lines,	dotted	and	dashed	lines,	and	patterns.

Step	3:	Select	a	border	color.

Step	4:	Select	a	border	width.

Add page borders
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Step	5:	Choose	which	sides	of	the	page	will	have	a	border	by	clicking	the	top,	bottom,	
and/or	sides	of	the	preview.

Step	6:	Choose	which	sections	of	the	document	will	have	the	border.

Step	7:	You	can	choose	the	whole	document,	just	this	section,	just	the	first	page	in	this	
section,	or	every	page	in	the	section	but	the	first	page.

Step	8:	Click OK.

The	border	is	added	to	the	selected	pages.

Section 5: Page formatting:

To change page orientation:

Step	1:	Select	the Layout tab.

Step	2:	Click	the Orientation command	in	the	Page	Setup	group

Step	3:	A	drop-down	menu	will	appear.	Click 

either Portrait or Landscape to	change	the	page	orientation.

 

Page orientation

The	page	orientation	of	the	document	will	be	changed.
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Page size:

By	default,	the page size of	a	new	document	is	8.5	inches	by	11	inches.	Depending	on	
your	project,	you	may	need	to	adjust	your	document›s	page	size.	It’s	important	to	note	
that	before	modifying	the	default	page	size,	you	should	check	to	see	which	page	sizes	
your	printer	can	accommodate.

Step	1	: 	Select	the Layout tab,	then	click	the Size command

Step	2:	A	drop-down	menu	will	appear.	The	current	page	size	is 	highlighted.	Click	the		
desired predefined page size

Page size

The	page	size	of	the	document	will	be	changed

To use a custom page size:

Step	1	:	Click	the	Page Setup dialog	box.

Step	2: 	Click	page Layout>Size>More Paper Sizes from	the	drop-down	menu.

Step	3	:	The Page Setup dialog	box	will	appear.

Step	4	:	Adjust	the	values	for Width and Height,	then	click OK.
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Page Setup dialog box 

Step	5:	The	page	size	of	the	document	will	be	changed.

Page margins:

A margin  is	 the space between	the	text	and	the	edge	of	your	document.	By	default,	
a	new	document’s	margins	are	 set	 to Normal,	which	means	 it	has	a	one-inch	space	
between	the	text	and	each	edge.	Depending	on	your	needs,	word	allows	you	to	change	
your	document’s	margin	size.

Step	1:	Select	the Layout tab,	then	click	the Margins command.    

Step	2:	A	drop-down	menu	will	appear.	Click	the predefined margin size you	want

Page margins
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Step	3:	The	margins	of	the	document	will	be	changed.

Insert a page break in Word:

Word	automatically	adds	a	break	at	the	end	of	each	page.	You	can	also	insert	a	manual	
page	break	anytime	you	want	to	start	a	new	page	in	your	document.

Step	1:	Put	your	cursor	where	you	want	one	page	to	end	and	the	next	to	begin.	

Step	2:	Go	to Insert > Page	Break.

Page break

Add page numbers to a header or footer:

Step	1:	Click	or	tap	in	the	header	or	footer	where	you	want	the	page	numbers.

Step	2:	Go	to Insert > Page	Numbering.

Step	3:	Select Page	number

Step	4:	Choose	a	style.

Add a border to a page:

Step	1:	Go	to Design > Page Border

Step	2:	Make	selections	for	how	you	want	the	border	to	look.
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Page border

Step	3:	To	adjust	the	distance	between	the	border	and	the	edge	of	the	page,	select Options.	
Make	your	changes	and	select OK.

Step	4:	ok

Inserting symbols, images, shapes and special characters in a document:

You	 can	 easily	 insert	 a	 special	 character,	 fraction,	 or	 other	 symbol	 in	 your	 Word	
documents.

Step	1:	Place	your	cursor	in	the	file	at	the	spot	where	you	want	to	insert	the	symbol.

Step	2:	Go	to Insert > Symbol.

Step	3:	Pick	a	symbol,	or	choose More	Symbols.

Step	4:	Scroll	up	or	down	to	find	the	symbol	you	want	to	insert.	When	you	find	the	
symbol	you	want,	double-click	it.	The	symbol	will	be	inserted	in	your	file.

Step	5.	Select Close.
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Inserting equation and symbol

Result:

Th	 us	the	formatting	instructions	in	the	MS	word	document	has	been	practiced	successfully.

Video suggestions:

s.no Title/purpose Link
1 Formatting	the	document https://www.youtube.com/watch?v=F6Vhzl4XxvU
2 Formatting	text,	removing	

manual	formatting.
https://www.youtube.com/watch?v=SiVjclEjw9E

3 Formatting	paragraphs	and	
using	bullets,	numbering.

https://www.youtube.com/watch?v=yV4i29Xo0iM

4 Assigning	color,	border	and	
background	to	paragraphs.

https://www.youtube.com/watch?v=ZJyvWpZOTKY

5 Formatting	the	page. https://www.youtube.com/watch?v=Ci1P40GsDy8

XI_Auditing_Chapter_10.indd   159 26-04-2022   18:24:02



160 Auditing Related Computer Applications

Simple Assessments:

Student	project 1.	Students	should	create	a	voucher	for	organization.

2.	Should	prepare	an	advertisement 	poster	for	an	event	in	school	.

Guest	lecture	suggestions 1.	Invite	a MS	office	technician	for	a	guest	lecture.

2.	Invite	a computer	technician	for	a	guest	lecture.

3.	Invite	an	office	assistant	working	in	MS	office	platform.

Industrial/	 Field		
visit	suggestions

1.	A	field	Visit	to	an	office	nearby	the	school.

2.	Visit	nearby	banks	for	field	visit.

3.A	field	Visit	to	the	nearby	auditing	office.

10.6  Instructions to create tables and its various applications in MS word 
document

Objective:

To	practice	to	create	tables	and	learn	the	various	applications	in	MS	word.

Operations / Experiments Covered Under the Project:

Create	and	use	table

1.	 Inserting	and	Deleting	the	rows	&	columns	in	a	table.

2.	 Splitting	and	Merging	a	table

3.	 Deleting,	Copying	&	Moving	a	table

Tools and Equipment Required:

S.no Name of the tools/ 
equipment

Range/Value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft	office MS	office	2019 1

Procedure:

Section 1 : Create and use Table:

Step	1:	Place	the	insertion	point	where	you	want	the	table	to	appear.

Step	2:	Navigate	to	the	Insert	tab,	then	click	the	Table	command.
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Step	3:	Th	 is	will	open	a	drop-down	menu	that	contains	a	grid.	Hover	over	the	grid	to	
select	the	number	of	columns	and	rows	you	want.

 Insert the table

Step	4:	Click	the	grid	to	confi	rm	your	selection,	and	a	table	will	appear.

Step	5:	To	enter	text,	place	the	insertion	point	in	any	cell,	then	begin	typing.

Enter the text in table

Note :	 To	navigate	 between	 cells,	 use	 the	Tab	 key	 or	 arrow	keys	 on	 your	 keyboard.	 If	 the	
insertion	point	is	in	the	last	cell,	pressing	the	Tab	key	will	automatically	create	a	new	row.

Section 2: Inserting and deleting the rows/columns in a table :

To add a row or column:

Step	1: Hover	outside	the	table	where	you	want	to	add	a	row	or	column.	Click	the	plus	
sign	that	appears.

Step	2:	A	new	row	or	column	will	be	added	to	the	table
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To add a new column and row to the table

Note: You	 can	 also	 right-click	 the	 table,	 then	 hover	 over	 Insert	 to	 see	 various	 row	 and	
column	options.

To delete a row or column:

Step	1:	Place	the	insertion	point	in	the	row	or	column	you	want	to	delete.

Step	2:	Right-click,	then	select	Delete	Cells	from	the	menu.

Step	3:	A	dialog	box	will	appear.	Choose	Delete	entire	row	or	Delete	entire	column,	
then	click	OK.
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Delete a row or column to the table

Step	4:	Th	 e	row	or	column	will	be	deleted.

Section 3: Splitting a table:

Step 1:	Click	in	a	cell,	or	select	multiple	cells	that	you	want	to	split.

Step	2:	Under	Table	Tools,	on	the	Layout	tab,	in	the	Merge	group,	click	Split	Cells.

Step	 3:	 Enter	 the	 number	 of	 columns	 or	 rows	 that	 you	 want	 to	 split	 the	 selected	
cells	into 

Split table

Merging a table:

Step	1:	Select	the	cells	that	you	want	to	merge.

Step	2:	Under	Table	Tools,	on	the	Layout	tab,	in	the	Merge	group,	click	Merge	Cells.
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Section 4: Deleting, copying, & moving tables:

Deleting a table:

Step	1: Right-click	in	a	table	cell,	row,	or	column	you	want	to	delete.

Step	2:	On	the	Mini	toolbar,	click	Delete.

 

Deleting the table.

Merging table
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Step	3:	Choose	Delete	Cells,	Delete	Columns,	or	Delete	Rows	as	required.

Coping Table:

Step	 1:	 In	 the	 Print	 Layout	 view,	 rest	 the	 pointer	 on	 the	 table	 until	 the	 table	move	
handle appears.

Copying table

Step	2:	Click	the	table	move	handle	to	select	the	table.

Step	3:	Do	one	of	the	following:

1. 	To	copy	the	table,	press	CTRL+C.

2. 	To	cut	the	table,	press	CTRL+X.

Step	4: Place	the	cursor	where	you	want	the	new	table.

Step	5:	Press	CTRL+V	to	paste	the	table	in	the	new	location.

Moving a table:
Step	 1:	 In	 the	 Print	 Layout	 view,	 rest	 the	 pointer	 on	 the	 table	 until	 the	 table	move	
handle appears.

Step	2:	Keep	the	pointer	over	the	table	move	handle	until	the	pointer	becomes	a	four-
headed	arrow,	and	then	click	the	table	move	handle.

Step	3:	Drag	the	table	to	a	new	location.

Result:

Th	 us	the	tables	have	been	created	successfully.
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Thus	the	various	applications	in	MS	document	has	been	practiced	successfully.

Video suggestions:

s.no Title/purpose Link

1 Create	and	use	Table https://www.youtube.com/watch?v=XNBrCEgzddw

2 Inserting	and	deleting 	
the	rows	and	columns	in	
a	table

https://www.youtube.com/watch?v=Ctey7JNeoGg

https://www.youtube.com/watch?v=LS7WtlXsM5Q

3 Splitting	and	Merging		
a	table 

https://www.youtube.com/watch?v=mWY03aAZ4vM

Simple Assessments:

Student project students	should	make	a	class	time	table	and	a	month	calendar.

students	should	prepare	table	content	for	the	chapter

students	should	prepare	a	table for	daily	expenditure. 

Guest lecture suggestions 1.	Invite	a MS	office	technician	for	a	guest	lecture.

2.	Invite	a computer	technician	for	a	guest	lecture.

3.Invite	an	office	assistant	working	in	MS	office	platform.

Industrial/ Field visit  
suggestions

1.A	field	Visit	to	an	office	nearby	the	school.

2.	Visit	nearby banks	for	field	visits.

3.A	field	Visit	to	the	nearby	auditing	office.

10. 7  Instructions to take printout after completion of document

Objective:

To	practice	to	take	printout	after	completion	of	document	in	MS	word.

Operations/Exercises Covered Under the Project:

1.	 Viewing	print	preview	of	the	document

2.	 Editing	print	and	controlling	option	in	MS	word

3.	 Printing	the	document	in	MS	word

4.	 Printing	the	letters	and	documents	using	mail	merge	in	MS	word
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Safety Measures:

1.	 Put	your	printer	on	a	flat,	 stable	 surface	 such	as	a	desk	 that	 is	 free	of	vibration	and	
shocks. 

2.	 Use	the	printer	in	a	well-ventilated	room. 

3.	 DO	NOT	put	the	printer	where	the	ventilation	hole	of	the	printer	is	blocked.

Tools and Equipment Required:

S.No Name of the tools/ 
equipment

Range/Value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft	office MS	office	2019 1

Procedure:

Section 1: Viewing print preview of the document:

Step	1:	Open	the	MS	word	document	to	be	printed.

Step	2:	Click	File in	the	left	top	corner	of	the	word	file	or	press	CTRL + P

Step	3:	Select	print in	the	menu	bar	(Now	we	can	see	the	print	preview	of	the	document	
on	the	right	side.	(We	can	see	all	pages	by	scrolling	the	mouse	up	and	down) 

Print preview of the document
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Section 2: Editing print and controlling option in MS word:

Step	1:	Open	MS	word	Document	to	be	printed

Step	2:	Click	File in	the	left		top	corner	of	the	word	fi	le	or	Click	CTRL + P

Step	3:	Click	the	printer	option	to	select	the	printer	Which	is	currently	connected	with	
your	PC	or	laptop.

Step	4:	Click	the	up	and	down	arrow	of	copies	dialogue	box	to	change	the	number	of	
copies	of	the	printing.

Step	5:	Click	Print	all	pages	option	to	choose	print	all	pages,	print	current	page	only	or	
custom	print	option

Step	6:	Click	portrait	option.	we	can	choose	portrait	or	landscape	printing	option

Step	7:	Click	letters	to	select	size	of	the	paper	to	be	printed

Step	8:	Click	normal	margin	to	select	margin	of	the	printing	area	of	the	paper

Step	9:	Click	1	page	per	sheet	to	choose	number	of	pages	per	sheet	to	be	printed

Edit the printing option
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Section 3: Printing the document in MS word:

Step	1:	Open	the	MS	word	document	to	be	printed

Step	2:	Click	File in	the	left		top	corner	of	the	word	fi	le	or	Click	CTRL + P

Step	3:	Click	the	print	icon	to	print	the	document

Printing the document

Section 4: Printing the letters and documents using mail merge in MS word:

Open	the	blank	MS	word	document	or	existing	document	which	is	to	be	printed

Step	1:	Click	Mailing	tab

Step	2:	Click	Start	mail	merge	button

Step	3:	Click	step	by	step	mail	merge 

Opening of the mail merge
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Step	4:	Select	document	type 

Step	5:	Click	Next	Starting	document

Starting the document

Step	4:	Select	use	the	current	document	or	start	from	existing	document	(For	demo	we	
select	use	current	document	option)

Select recipient
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Step	5:	Click	Next:	select	recipients	and	select	type	a	new	list	or	existing	list(	for	demo	
we	select	type	a	existing	list)

Existing fi le selection

Select existing list from browse
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Step	6:	Click	the	browse	button	and	select	the	existing	fi	le.	If	you	don’t	have	an	existing	
address	list,	you	can	click	the	Type a new list	button	and	click	Create.	You	can	then	type	
your	address	list.

Step	7:	Click	Next:	Write	your	letter	which	one	you	want	to	be	printed.	Select	Address	
block,	 Greeting	 line,	 Electronic	 postage,	 or	More	 items	 from	 the	 task	 pane	 to	 add	
recipient	information	to	your	letter.

Writing your letter

Add recipient information
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Step	8:	Click	Next:	Preview	your	letter	to	view	letters	of	the	all	recipients

Print preview of the letter

Step	9:	Click	Next:	Complete	the	merge

Complete the merge
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Step	10:	Click	print	and	select	All option	and	click	ok	button.

Merge to printer dialog box

Printing the document

Result:

1.	 Thus	the	students	are	able	to	view	print	preview	of	the	document

2.	 Thus	the	students	are	able	to	know	different	printing	and	control	option	while	printing	
the	document

3.	 Thus	the	students	are	able	to	print	the	letter	and	document	using	mail	merge in	MS	word.
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Video suggestions:

s.no Title/purpose Link

1 Print	preview	of	the	document	in	MS	word https://youtu.be/OxudZfGR7lk

2 Printing	 and	 controlling	 option	 while	
printing	the	document	in	MS	word`

https://youtu.be/8PvKeny-_Fo

3 Print	 the	 letter	 and	document	using	mail	
merge in	MS	word

https://youtu.be/27-Vj4-71xw

Simple Assessments:

Student project 1.		Student	have	to	prepare	quotations	of	different	features	of	
various	printers	with	their	price	list.

2.	Students	have	to	prepare	printer	working	principles	in	a	chart.

3.		Students	should	take 	samples	of	print	out	while	working	
on file.

Guest lecture 
suggestions

1.	Invite	a MS	office	technician	for	a	guest	lecture.

2.	Invite	a computer	technician	for	a	guest	lecture.

3.	Invite	an	office	assistant	working	in	MS	office	platform.
Industrial/ Field visit 
suggestions

1.	A	field	Visit	to	an	office	nearby	the	school.

2.	Visit	nearby	banks	for	field	visits.

3.	A	field	Visit	to	the	nearby	auditing	office.

10. 8   Utility options in selecting a suitable template and image in MS 
word document.

Objective:

To	learn	about	utility	options	in	selecting	a	suitable	template	and	image	in	MS	excel	document.

Operations/Exercises Covered Under the Project:

1.	 Apply	styles	in	a	document

2.	 Insert	and	use	images	in	the	document

3.	 Create	and	use	templates	in	document

4.	 Create	table	of	contents	for	a	document
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Tools and Equipment Required:

S.no Name of the tools/equipment Range/value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft		offi		ce MS	offi		ce	2019 1

Safety Measures:

1.	 Make	sure	to	save	your	document	at	regular	intervals.

1.	 Remember	that	before	closing	your	word	document	should	save	the	document	and	its	
fi	le	location.

Procedure:

Section 1: Create and apply styles in the Document:

Step	1:	Open	a	MS	offi		ce	word	document.

Step	2:	Click	Home>Font for	fonts	modifying	options.

Step	3:	Click	Home>Paragraph for	paragraph	formatting.

Step	4:	Click	Home>Styles for	heading	styles.

Create and apply styles in the document
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Section 2: Insert and use images in document:

Step	1:	Click	Insert>Pictures and	select	images	from	the	source.

Insert and use images in document

Step	2:	Select	or	Click	picture	and	choose	Format	 in	the	top	right	corner,	Select	the	
mode	which	has	to	be	selected.

Formatting and resize the images in the document
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Step	3:	Enter	the	size	of	images	in	the	place	and	press	Enter.

Section 3: Create and use Template:

Step	1:	Prepare	a	template	fi	le	in	a	word	document.

Step	 2:	 Click	 Home>Save as and	 enter	 the	 fi	le	 name,	 Select	 the	 fi	le	 type	 as	Word	
Template(.dotx)	and	press	Enter or Click	Save.

Step	3:	Close	or	Open	a	new	Document	fi	le.

Step	4:	Click	File>Open>Personal and	select	your	template	fi	le.

Section 4: Create table of contents:

Step	1:	Open	a	word	document. 

Step	2:	Select	a	topic	which	you	want	to	make	in	table	of	content.

Step	3:	Enter	the	numbering	and	select	styles. 

Step	4:	Follow	step	2	&	3	to	the	entire	document.	Click	on	References>Table of contents, 
Select	the	type	of	contents	in	automatic	mode.

Create the table content
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Result:

Thus	the	utility	options	in	selecting	a	suitable	template	and	image	in	MS	word	document	has	
been	learned	successfully.

Simple Assessments :

1.	 Which	command	is	used	to	save	a	document?

2.	 How	will	you	create	or	modify	a	template?

3.	 How	to	resize	a	picture	in	a	document?

Video suggestions:

s.no Title/purpose Link

1 Create	and	update	new	styles	in	
a	document.

https://youtu.be/Gk5M32aqsjUhttps://youtu.be/
Gk5M32aqsjU

2 Insert	and	modify	pictures	in	the	
document.`

https://youtu.be/Lgd2QR0ltic

3 Create	and	use	templates	in	doc-
ument.

https://youtu.be/qs2HzP9Q9eg

4 Create	and	make	a	table	of	con-
tents	for	a	document.

https://youtu.be/0cN-JX6HP7c

Student project 1.	Create	a	template	for	a	student’s	identity	card.

2.	Create	a	title	of	content	for	any	paragraph	with	page	number.

3.	Create	a	new	style	and	update	in	your	computer.

Guest lecture 
 suggestions

1.	Invite	a	MS	office	technician	for	a	guest	lecture.

2.	Invite	a	computer	subject	expert	for	a	guest	lecture.

3.	Invite	an	office	assistant	working	in	MS	office	platform.

Industrial/ Field visit 
suggestions

1.	A	field	Visit	to	an	office	nearby	the	school.

2.	Visit	to	nearby	e-seva	center	for	field	visit.

3.	A	field	Visit	to	the	nearby	computer	center.
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10. 9  Creating a purchase order for items needed for the classroom using MS word

Objective:

To	create	a	purchase	order	for	items	needed	for	the	classroom	using	MS	word	document.

Operations/Exercises Covered Under the Project:

1.	 Create	a	word	document

2.	 Insert	tables	and	enter	the	data	of	the	purchase	order

3.	 Print	the	document

Tools and Equipment Required:

s.no Name of the tools/ 
equipment

Range/Value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft	office MS	office	2019 1

3 Printer Epson	L3250 1

Procedure:

Section 1: Create a word document:

Step	1:	Create	a	new	document	using	File.

Step	2:	Click	the	New	option	and	save	as	document	format.

Step	3:	Rename	the	document.

 Create the new word document
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Section 2: Insert tables and enter the data of the purchase order:

Step	1:	Select	the	insert	tab.

Step	2:	Insert	the	tables	using	the	table	option.

Step	3:	Enter	the	data	in	purchase	order	for	your	classroom.

Insert tables and enter the data of the purchase order

Section 3: Print the document:

Step	1:	Open	the	MS	word	document	to	be	printed

Step	2:	Click	File >	Print or	Click	CTRL + P

Step	3:	Click	the	print	icon	to	print	the	document

Print the document
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Result:

Thus	the	purchase	order	for	 items	needed	for	the	classroom	using	MS	word	document	has	
been	created	successfully.

Video suggestions:

s.no Title/purpose Link

1 Creating	a	purchase	order	for	items	need-
ed	for	the	classroom	using	MS	word

https://youtu.be/lyx8Anp9d-4

2 Insert	 tables	 and	 enter	 the	 data	 of	 the	
purchase	order

https://youtu.be/zKkWZgIaRrQ

3 Print	the	document https://youtu.be/cweN_MQlTQE

Simple Assessments:

Student project 1.	Students	have	to	prepare	the	checklist	for	classroom	items.

2.	Students	have	to	prepare	the list	of	students	in	class.    

Guest lecture suggestions 1.	Invite	a MS	office	technician	for	a	guest	lecture.

2.	Invite	a computer	technician	for	a	guest	lecture.

3.	Invite	an	office	assistant	working	in	MS	office	platform.

Industrial/ Field visit 
suggestions

1.	A	field	Visit	to	an	office	nearby	the	school.

2.	Visit	nearby	stores	for	field	visits.

Excel Basics:

1. Introduction:

MS-EXCEL	 is	 a	part	of	Microsoft	office	 suite	 software.	 It	 is	 an	electronic	 spreadsheet	with	
numerous	 rows	 and	 columns,	 used	 for	 organizing	 data,	 graphically	 represent	 data(s)	 and	
performing	different	calculations.

It	consists	of	1048576	rows	and	16383	columns.	A	row	and	a	column	together	make	a	cell.	
Each	cell	has	an	address	defined	by	column	name	and	row	number.

Eg:	A1	-	Row	No.

B2	-	Column	Name.

By	default,	a	workbook	consists	of	3	spread	sheets	(sheet	1,	sheet	2	&	3)
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2. Features of MS EXCEL:

1.	 Easy	to	store	and	analyze	huge	amount	of	data.

2.	 Easy	to	recover	Data.

3.	 Application	of	Mathematical	Formulasv

4.	 Neater	and	Cleaner	visibility	of	information	stored	at	workbook

5.	 Spreadsheets	 is	excel	used	to	segregate,	handle	and	helps	to	product	using	password	
protection	features.

10. 10  Create an Excel file and using of its various options

Objective:

To	create	an	excel	file	and	using	of	its	various	options	MS	word	document.

Operations/Exercises Covered Under the Project:

1.	 Identify	the	rows	number	and	columns	letter,	cell	address.

2.	 Identify	the	row	range,	column	range,	row	&	column	range	of	cells.

3.	 Demonstrate	to	enter	the text,	numeric	data	in	a	cell.

4.	 Construct	the	formula	using	mathematical	operators

5.	 Use	the	basic	functions	to	perform	calculations	on	data

Tools and Equipment Required:

Sl.No Name of the tools/  
equipment

Range/Value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft	office MS	office	2019 1

XI_Auditing_Chapter_10.indd   183 26-04-2022   18:24:04



184 Auditing Related Computer Applications

Shortcut keys:

Sl.no To do this Shortcut keys
1 Close	a	workbook. Ctrl+W
2 Open	a	workbook. Ctrl+O
3 Go	to	the	Home	tab. Alt+H
4 Save	a	workbook. Ctrl+S
5 Copy	selection. Ctrl+C
6 Paste	selection. Ctrl+V
7 Undo	recent	action. Ctrl+Z
8 Remove	cell	contents. Delete
9 Choose	a	fill	color. Alt+H, H
10 Cut	selection. Ctrl+X
11 Go	to	the	Insert	tab. Alt+N
12 Apply	bold	formatting. Ctrl+B
13 Center	align	cell	contents. Alt+H, A, C
14 Go	to	the	Page	Layout	tab. Alt+P
15 Go	to	the	Data	tab. Alt+A
16 Go	to	the	View	tab. Alt+W
17 Open	the	context	menu. Shift+F10 or Windows Menu key
18 Add	borders. Alt+H, B
19 Delete	column. Alt+H, D, C
20 Go	to	the	Formula	tab. Alt+M
21 Hide	the	selected	rows. Ctrl+9
22 Hide	the	selected	columns. Ctrl+0

Procedure:

Section 1:

Identify	the	rows	number	and	columns	number,	cell	address.	MS	excel	sheet:	The	MS	excel	
sheet	can	have	many	sheets.	Each	sheet	can	have	many	individual	cells	arranged	in	rows	and	
columns.	The	sheet	tab	shows	its	default	name	as	Sheet1,	Sheet2,	Sheet3,	….

Rows and columns:	The	 sheet	 is	 divided	 into	 vertical	 columns	 and	horizontal	 rows.	Each	
sheet	can	have	a	maximum	of	1,048,576	(220)	rows	and	1024	(210)	columns.	The	rows	are	
numbered	as	1,2,3,4,…	and	columns	are	numbered	as	A, B, C, D, …., Z, AA, AB, AC, …., AZ, 
BA to BZ, CA,…., AMJ.  
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Cell and cell address:	The	 intersection	of	a	 row	and	column	 is	called	a	cell.	 It	 is	 the	basic	
element	of	a	MS	excel	sheet.	It	holds	data,	such	as	text,	numbers,	formulas	and	so	on.	A	cell	
address	is	denoted	by	its	column	(letter)	and	row	number.	For	example,	D4,	E9,	Z89	are	the	
valid	example	of	cell	address.

Active cell:	In	a	MS	excel	sheet,	cell	is	the	place	where	we	enter	the	data.	Before	entering	any	
data	in	the	cell,	it	has	to	be	first	selected	by	placing	a	cursor	on	it.	When	we	position	the	mouse	
cursor	on	a	cell,	 it	gets	 selected,	and	 is	 ready	 to	 take	data	 from	the	user.	This	selected	and	
activated	cell	is	called	an	active	cell.	It	is	always	highlighted,	with	a	thick	border.	The	address	
of	the	active	cell	is	displayed	in	the	name	box. 

Section 2: Identify the row range, column range, Cell range:

Key or Key Combination Result of Key or Combination

Arrow	keys	(←↑→↓) Move	a	single	cell	in	arrow	direction

Ctrl	+	Arrow	Keys Moves	the	cell	to	the	end	of	the	data	range	in	a	particular	
direction

Home Moves	to	column	A	along	the	row	where	the	active	cell	is	there.

Ctrl	+	Home Moves	the	cell	to	A1	position

Ctrl	+	End Moves	to	bottom	right	cell	of	the	data	range

Page	Up Moves	the	worksheet	one	screen	up

Page	Down Moves	the	worksheet	one	screen	down

The	column range is	the	number	of	cells	spread	across	the	column.	The	cell	address	is	represented	
by	single	column	letter	and	multiple	row	number	in	a	sequence.	In	this	example	the	column	
letter	C	is	constant	with	rows	varying	from	2	to	7.	The	range	of	cells	starts	in	C2	and	ends	in	
C7.	This	range	of	cells	consists	of	the	cells,	namely	C2,	C3,	C4,	C5,	C6,	and	C7.	The	range	of	
cells	starts	in	C2	and	ends	in	C7	and	it	is	represented	by	C2:C7.	The	row range is	the	number	of	
cells	spread	across	the	row.	The	cell	address	is	represented	by	single	row	number	with	columns	
varying	from	B	to	D	columns.	The	range	of	cells	starts	in	B3	and	ends	in	D3.	This	range	of	cells	
consists	of	the	cells,	namely	B3,	C3,	D3,	and	it	is	represented	by	B3:D3	The	row and column 
range is	the	number	of	cells	spread	across	the	row	and	columns.	This	range	is	a	matrix	with	the	
number	of	rows	and	number	of	columns.	In	this	example,	the	range	starts	in	cell	B2	and	ends	
in	cell	C7.	This	range	of	cells	consists	of	the	cells	from	B2	to	B7	and	cells	from	C2	to	C7.	The	
range	it	is	represented	by	B2:C7.

Note: The	control	key	is	used	to	select	more	than	one	‘range	of	cells’	in	a	worksheet.	The	control	
key	is	marked	as	‘Ctrl’	on	the	keyboard.
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Section 3: Demonstrate to enter the text, numer3ic data in a cell:

To	enter	any	data	in	a	worksheet,	practically	in	the	cell,	 it	 is	required	to	select	the	cell.	Cell	can	be	
selected	by	positioning	the	pointer	in	a	cell.	The	data	to	be	entered	can	be	the	label,	values	or	formula. 

1.	 Label:	 Label	 is	 any	 text	 entered	 by	 using	 a	 keyboard.	 It	may	 combine	 with	 letters,	
numbers,	and	special	symbols.

2.	 Values:	The	numerical	data	consisting	of	only	numbers	are	called	values.	By	default,	
values	are	right	aligned.	There	are	various	forms	of	values,	such	as	integer,	decimal	and	
so	on.

3.	 Formulae:	Any	expression	that	begins	with	an	equals	‘=’	is	treated	as	formula.	In	the	
expression,	the	‘=’	followed	by	values,	cell	address	and	functions	are	called	as	formula.	
When	a	formula	is	entered	in	a	cell	in	a	worksheet	the	value	of	the	equation	is	displayed	
in	the	cell	and	the	formula	is	shown	in	the	formula	bar.

Section 4: Construct the for formula using mathematical operators:

MS	 Excel	 Software	 has	 the	 most	 powerful	 features	 to	 calculate	 numerical	 data	 using	
formulae.	As	we	 use	 a	 calculator	 for	 calculation,	 excel	 sheet	 can	 add,	 subtract,	 divide,	
multiply	 and	much	more.	 LibreOffice	Calc	 uses	 standard	 operators	 for	 formulae,	 such	
as	 a	 plus(+),	minus(-),	multiplication	 (*),	 a	 division	 (/)	 for	 arithmetic	 operation.	Note: 
The	order	of	evaluation	can	be	changed	by	using	brackets.	 (The	expressions	within	 the	
brackets	are	evaluated	first)

Symbols Operations
+ addition

- subtraction
* multiplication
/ division
^ exponentiation	(power)

Operator Formula Result

Addition	(+) =	23+	7 30

Subtraction 0	–	3 -	3

Multiplication	(*) 9*6 54

Division	(/) 77/7 11
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Section 5: Use the basic functions to perform calculations on data:

Th	 e	main	advantage	of	entering	formulas	with	cell	addresses	and	operators,	works	just	like	a	
variable.	When	the	values	of	the	cells	concerned	change,	the	results	obtained	by	the	formula	
also	get	updated	accordingly.	Suppose	to	add	the	values	in	two	cells	A1	and	A2	and	get	the	
addition	in	cell	A3.	If	we	position	the	cursor	in	cell	A3	and	simply	add	the	values	as	=5+8,	then	
we	will	get	the	correct	addition	in	cell	A3.	But	if	we	change	the	values	in	cell	A1	to	6	and	A2	to	
7,	then	again	we	have	to	get	the	addition	in	cell	A3	by	writing	=6+7.	But	if	we	write	the	general	
formula	in	cell	A3	is	=A1+A2.	Th	 en	we	need	not	do	the	addition	in	cell	A3.	We	will	get	the	
respective	addition	with	the	change	in	values	in	cell	A1	and	A2	For	calculating	the	volume	of	
a	box	with	given	length,	width	and	height	in	cells	A2,	B2	and	C2,	respectively,	see	the	formula	
derive	the	volume	entered	in	cell	D2.

Basic functions to perform calculations on data

In	the	example	of	the	Stationery	Bill,	to	calculate	the	total	cost	of	all	the	items	to	obtain	the	bill	
amount,	we	need	to	add	the	amount	of	each	item.	We	may	add	each	cell	by	using	the	formula.	
Position	the	cursor	on	the	cell	D8,	and	enter	the	formula	‘=D2+D3+D4+D5+D6+D6+D7’	and	
get	the	total	in	cell	D8.	But	this	may	not	be	practically	possible	if	there	are	hundreds	of	items	
and	also	there	are	more	chances	of	error.	When	there	is	a	large	quantity	of	data	it	becomes	
diffi		cult	and	complex	task	to	write	formula	using	only	the	cell	addresses.	In	such	situations,	Ms	
Offi		ce	Calc	provides	built	in	functions.	SUM	is	the	function	to	get	the	sum	of	range	of	cells.	So	
we	can	use	the	function,	‘Sum(D2:D7)’	in	D8	cell	to	obtain	the	total	cost	of	all	the	items.	In	the	
function	we	need	to	include	only	the	cell	range	(starting	and	last	cell	address).
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Summation of stationery bill in excel sheet

Th	 ink	on,	which	of	the	following	method	will	be	more	appropriate	to	add	cell	data. 

Method	1

=	SUM	(D2:D7)

Method	2

=	D2+D3+D4+D5+D6+D7 

Th	 e	spreadsheet	applications	contain	diff	erent	functions	to	meet	the	requirements	of	diff	erent	
fi	elds. 

Function Syntax Use
SUM =SUM	(Number1,	Number2,.....) Adds	 the	 values	 contained	 in	 a	

range	of	cells.
AVERAGE =AVERAGE	(Number1,	Number2,....). Finds	out	the	average	of	the	val-

ues	contained	in	a	range	of	cell
MAX =MAX	(Number1,	Number2,......) Finds	out	the	largest	value	con-

tained	in	a	range	of	cells.
MIN =MIN(Number1,Number2,......) Finds	 out	 the	 smallest	 value	

contained	in	a	range	of	cells.
COUNT =COUNT(Number1,Number2,.....) Counts	 the	 number	 of	 cells	

within	a	range	of	cells

Step	4:	Calculate	the	students	mark	sheet	 for	5	students	using	formula.	Use	all	 the	above	5	
formula	in	it.

Result:

Th	 us	the	excel	fi	le	has	been	created	successfully.

Th	 us	the	various	options	in	MS	excel	has	been	used	successfully.
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Video suggestions:

s.no Title/purpose Link

1 create	a	MS	excel	sheet. https://youtu.be/NzwQ_BbD2G4

2 entering	and	editing	the	text	in	MS	excel	sheet. https://youtu.be/bK1YP_y0SWE

3 Create	a	Excel	file	and	using	of	its	various	
options

https://youtu.be/NzwQ_BbD2G4

Simple Assessments:

Student project 1.		Students	have	to	prepare	shop	bills	by	using	formulas	for	cal-
culation.

2.		Students have	to	prepare	a	budget	for	the	month	by	expenses. 

Guest lecture  
suggestions

Create	a	data	of	your	assessment	marks.

Create	data	and	average	your	class	result.

Create	a	new	style	and	update	it	on	your	computer.

Industrial/ Field visit  
suggestions

1.	Invite	a	MS	office	technician	for	a	guest	lecture.

2.	Invite	an	accounts	auditor	for	a	guest	lecture.

3.	Invite	an	office	assistant	working	in	MS	office	platform.

10. 11  Instructions to format the MS excel document

Objective:

To	practice	to	use	formatting	instructions	in	MS	excel	document.

Operations/Exercises Covered Under the Project:

1.	 Formatting	toolbar

2.	 Format	range	of	cells	with	decimal	places

3.	 Format	range	of	cells	to	labels

4.	 Format	of	a	cell	range	as	scientific

5.	 Format	a	range	of	cells	to	display	time
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6.	 Align	the	cell	data	range

7.	 Create	number	series	using	fill	handle

8.	 Copy	formula	by	dragging	the	formula	using	fill	handle

Tools and Equipment Required:

S.No Name of the tools/ 
equipment

Range/Value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft	office MS	office	2019 1

Procedure:

Section 1: Formatting toolbar:

Step	1:	Change	the	font	by	clicking	the	font	option(Times	new	roman).

Step	2:	Change	the	size	of	the	font	by	clicking	the	font	size	option	(12	font	size).

Step	3:	Change	the	font	color(Black).

Step	4: 	Make	the	text	bold,	italics,	or	underline	by	clicking	bold,	italics	or	underline	
option(if	required).Change	the	alignment	by	clicking	the	alignment	option(Left,	Right,	
Center	and	Justify).Change	the	borders	by	clicking	the	borders	option.	Fill	(highlight)	
the	text	by	clicking	the	highlight	option.

Section 2: Format range of cells with decimal place:

Step	1:	Select	the	cells	to	limit	the	number	of	decimal	places.

Step	2:	Right	click	the	selected	cells	and	select	the	Format	Cells	from	the	right-clicking	
menu	on	the	screen.
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Format range of cells with decimal place

Step	3:I	n	 the	Format	Cells	dialog	box,	go	 to	 the	Number	 tab,	click	 to	highlight	 the	
Number	in	the	Category	box,	and	then	type	a	number	in	the	Decimal	Places	box.

For	example,	 if	you	 limit	only	2	decimal	place	 for	selected	cells,	 just	 type	2	 into	 the	
Decimal	places	box.

Different categories of format cell

Step	4:	Click	the	OK	in	the	Format	Cells	dialog	box.	Now	the	selected	decimals	in	cells	
are	changed	to	two	decimal	places.
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Conversion of format cell

Section 3: Format range of cells to labels:

•• Open	the	‘format	cells	dialog’	box

•• Click	the	Number	tab

•• Select	Text

•• Click	‘OK’

•• Enter	numbers

Section 4: Format of a cell range as scientific:

Step	1:	The	Scientific	format	(also	referred	to	as	Standard	or	Standard Index	form	)	is	a 	
way	to	display	very	large	or	very	small	numbers.

For	example,	instead	of	writing	0.0000000043,	you	can	write	4.3	x	10-9.	And	if	you	apply	
the	Excel	Scientific	notation	format	to	the	cell	containing	0.0000000043,	the	number	
will	be	displayed	as	4.2E-09.

Step	2:	Select	the	cells	and	right-clicking	menu	of the	mouse.

Step	3:	Select	the	Format	Cells	from	the	right-clicking	menu	in	the	screen.

Step	4:	In	the	coming	Format	Cells	dialog	box,	go	to	the	Scientific	tab	and	select	the	
decimal places.
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Format of a cell range as scientific 

To	quickly	 apply	 the	default	Excel	 Scientific	notation	 format	with	 2	decimal	places,	
press	Ctrl+Shift+^	on	the	keyboard

Section 5: Format a range of cells to display time:

Step	1:	To	quickly	use	the	default	date	or	time	format,	click	the	cell	that	contains	the	
date	or	time,	and	then	press	CTRL+SHIFT+#	or	CTRL+SHIFT+@.

Step	2:	 If	a	cell	displays	#####	after	you	apply	date	or	 time	 formatting	 to	 it,	 the	cell	
probably	isn’t	wide	enough	to	display	the	data.	To	expand	the	column	width	or	double-
click	the	right	boundary	of	the	column	containing	the	cells.	This	automatically	resizes	

XI_Auditing_Chapter_10.indd   193 26-04-2022   18:24:04



194 Auditing Related Computer Applications

the	column	to	fit	the	number.	You	can	also	drag	the	right	boundary	until	the	columns	
are	the	size	you	want.

Step	3:	When	you	try	to	undo	a	date	or	time	format	by	selecting	General	in	the	Category	
list,	Excel	displays	a	number	code.	When	you	enter	a	date	or	time	again,	Excel	displays	
the	default	date	or	time	format.	To	enter	a	specific	date	or	time	format,	such	as	January	
2010,	you	can	format	it	as	text	by	selecting	Text	in	the	Category	list.

Step	4:	To	quickly	enter	the	current	date	in	your	worksheet,	select	any	empty	cell,	and	
then	press	CTRL+;	(semicolon),	and	then	press	ENTER,	if	necessary.	To	insert	a	date	
that	will	update	to	the	current	date	each	time	you	reopen	a	worksheet	or	recalculate	a	
formula,	type	=TODAY	()	in	an	empty	cell,	and	then	press	ENTER.

Step	5:	On	the	Home	tab,	in	the	Number	group,	click	the	Dialog	Box	Launcher	next	to	
Number.

Number group

Step	6:	You	can	also	press	CTRL+1	to	open	the	Format	Cells	dialog	box.

•• In	the	Category	list,	click	Date	or	Time.

Category list, click Date or Time

Step	 7:	 In	 the	 Type	 list,	 click	 the	 date	 or	 time	 format	 that	 you	 want	 to	 use.	
Note:	Date	 and	 time	 formats	 that	 begin	with	 an	 asterisk	 (*)	 respond	 to	 changes	 in	
regional	date	and	time	settings	that	are	specified	in	Control	Panel.	Formats	without	an	
asterisk	are	not	affected	by	Control	Panel	settings.
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Step	8:	To	display	dates	and	times	in	the	format	of	other	languages,	click	the	language	
setting	that	you	want	in	the	Locale	(location)	box.

Language setting and  Locale (location) box

Step	9:	The	number	in	the	active	cell	of	the	selection	on	the	worksheet	appears	in	the	
Sample	 box	 so	 that	 you	 can	 preview	 the	 number	 formatting	 options	 that	 you	 have	
selected.

Sample box  in formatting cell

Create a custom date or time format:

Step	1:	On	the	Home	tab,	click	the	Dialog	Box	Launcher	next	to	Number.	You	can	also	
press	CTRL+1	to	open	the	Format	Cells	dialog	box.

Step	2:	In	the	Category	box,	click	Date	or	Time,	and	then	choose	the	number	format	
that	is	closest	in	style	to	the	one	you	want	to	create.	(When	creating	custom	number	
formats,	it’s	easier	to	start	from	an	existing	format	than	it	is	to	start	from	scratch.)

Step	3:	In	the	Category	box,	click	Custom.	In	the	Type	box,	you	should	see	the	format	
code	matching	the	date	or	time	format	you	selected	in	the	step	3.	The	built-in	date	or	
time	format	can’t	be	changed	or	deleted,	so	don’t	worry	about	overwriting	it.

Step	4:	In	the	Type	box,	make	the	necessary	changes	to	the	format.	You	can	use	any	of	
the	codes	in	the	following	tables:	Days,	months,	and	years

XI_Auditing_Chapter_10.indd   195 26-04-2022   18:24:04



196 Auditing Related Computer Applications

To display Use this code
Months	as	1–12 m
Months	as	01–12 mm
Months	as	Jan–Dec mmm
Months	as	January–December mmmm
Months	as	the	first	letter	of	the	month mmmmm
Days	as	1–31 d
Days	as	01–31 dd
day	as	sun	-sat ddd
Day	as	sunday-saturday dddd
Years	as	00–99 yy
Years	as	1900–9999 yyyy

If	you	use	“m”	immediately	after	the	“h”	or	“hh”	code	or	 immediately	before	the	“ss”	code,	
Excel	displays	minutes	instead	of	the	month.

Hours, minutes, and seconds:

To display Use this code

Hours	as	0–23 h

Hours	as	00–23 hh

Minutes	as	0–59 m

Minutes	as	00–59 mm

Seconds	as	0–59 s

Seconds	as	00–59 ss

Hours	as	4	AM h	AM/PM

Time	as	4:36	PM h:mm	AM/PM

Time	as	4:36:03	P h:mm:ss	A/P

Elapsed	time	in	hours;	for	example,	25.02 [h]:mm

Elapsed	time	in	minutes;	for	example,	63:46 [mm]:ss

Elapsed	time	in	seconds [ss]

Fractions	of	a	second h:mm:ss.00

AM	and	PM:		If	the	format	contains	an	AM	or	PM,	the	hour	is	based	on	the	12-hour	clock,	
where	“AM”	or	“A”	indicates	times	from	midnight	until	noon	and	“PM”	or	“P”	indicates	times	
from	noon	until	midnight.	Otherwise,	 the	hour	 is	based	on	the	24-hour	clock.	The	“m”	or	
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“mm”	code	must	appear	immediately	aft	er	the	“h”	or	“hh”	code	or	immediately	before	the	“ss”	
code;	otherwise,	Excel	displays	the	month	instead	of	minutes.

Creating	 custom	 number	 formats	 can	 be	 tricky	 if	 you	 haven’t	 done	 it	 before.	 For	 more	
information	 about	 how	 to	 create	 custom	 number	 formats,	 see	 Create	 or	 delete	 a	 custom	
number	format. 

Section 6:Align the cell data range:

Change the orientation of text in a cell:

Step	1:	Select	a	cell,	row,	column,	or	a	range.

Step	2:	Select	Home	>	Orientation 	 ,	and	then	select	an	option.You	can	rotate	your	
text	up,	down,	clockwise,	or	counterclockwise,	or	align	text	vertically.

Align the cell data range

Rotate text to a precise angle:

Step	1:	Select	a	cell,	row,	column,	or	a	range.

Step	2:	Select	Home	>	Orientation 	  	>	Format	Cell	Alignment.

Step	3:	Under	Orientation	on	the	right	side,	in	the	Degrees	box,	use	the	up	or	down	
arrow	to	set	the	exact	number	of	degrees	that	you	want	to	rotate	the	selected	cell	text.	
Positive	numbers	rotate	the	text	upward.	Negative	numbers	rotate	the	text	downward.

Align a column or row

Step	1:	Select	the	cells	you	want	to	align.

Step	2:	On	the	Home	tab,	in	the	Alignment	group,	select	a	horizontal	alignment	option:

Align	Left	 Center Align	Right
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On	the	Home	tab,	in	the	Alignment	group,	select	a	vertical	alignment	option:

Top	Align Middle	Align Bottom	Align

Alignment group

Section 7: Create number series using fill handle:

Step	1:	Select	the	first	cell	in	the	range	that	to	fill.

Step	2:	Type	the	starting	value	for	the	series.

Step	3:	Type	a	value	in	the	next	cell	to	establish	a	pattern.

Tip:	For	example,	if	you	want	the	series	1,	2,	3,	4,	5...,	type	1	and	2	in	the	first	two	cells.	
If	you	want	the	series	2,	4,	6,	8...,	type	2	and	4.

Step	4:	Select	the	cells	that	contain	the	starting	values.

Step	5:	Drag	the	fill	handle	 	across	the	range	that	you	want	to	fill.

Note:	As	you	drag	the	fill	handle	across	each	cell,	Excel	displays	a	preview	of	the	value.	
If	 you	want	a	different	pattern,	drag	 the	fill	handle	by	holding	down	 the	 right-click	
button,	and	then	choose	a	pattern.	

To	fill	in	increasing	order,	drag	down	or	to	the	right.	To	fill	in	decreasing	order,	drag	up	
or	to	the	left.

Section 8: Copy formula by dragging the formula using fill handle

Step	1:	Enter	a	formula	in	the	top	cell.

Step	2:	Select	the	cell	with	the	formula,	and	hover	the	mouse	cursor	over	a	small	square	
at	the	lower	right-hand	corner	of	the	cell,	which	is	called	the	Fill	handle.	As	you	do	this,	
the	cursor	will	change	to	a	thick	black	cross.

Step	3:	Hold	and	drag	the	fill	handle	 	down	the	column	over	the	cells	where	you	
want	to	copy	the	formula.
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Copy formula by dragging the formula using the fill handle

In	a	similar	manner,	you	can	drag	formula	into	adjacent	cells	to	the	right,	to	the	left	or	upwards.

If	 the	 formula	 includes	 relative	cell	 references	 (without	 the	$	 sign),	 they	will	 automatically	
change	based	on	a	relative	position	of	rows	and	columns.	So,	after	copying	the	formula,	verify	
that	the	cell	references	have	got	adjusted	properly	and	produce	the	result.	If	necessary,	switch	
between	absolute,	relative	and	mixed	references	by	using	the	F4	key.

In	 the	above	example,	 to	make	sure	 the	 formula	was	copied	correctly,	 let’s	 select	 some	cell	
in	column	C,	say	C4,	and	view	the	cell	reference	 in	the	formula	bar.	As	you	can	see	 in	the	
screenshot	below,	the	formula	is	all	right	-	relative	to	row	4,	exactly	as	it	should	be:

Using references

Result:

Thus	the	formatting	instructions	in	the	MS	excel	document	has	been	practiced	successfully.
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Video suggestions:

s.no Title/purpose Link

1 MS	Excel	-	Editing	&	Formatting	Data	in	Tamil https://youtu.be/y7GZnwbf4EE

2 Complete	Excel	learning https://youtu.be/YGG1aXJws4A

3 Excel	 basics	 and	 fundamentals	 for	 Beginners		
in	Tamil

https://youtu.be/3qNOa9JjBZk

4 How	to	add	an	zero	in	front	of	numbers https://youtu.be/mijhtkFLKCY

Simple Assessments:

Student project 1.Students	have	to	prepare	a	mark	list	by	using	formulas	for	calculation.

2.	Students have	to	prepare	a	scorecard	of	cricket	match. 

Guest lecture 
suggestions

Create	a	data	of	your	assessment	marks.

Create	data	and	average	your	class	result.

Create	a	new	style	and	update	it	on	your	computer.

Industrial/ Field 
visit suggestions

1.	Invite	a	MS	office	technician	for	a	guest	lecture.

2.	Invite	an	accounts	auditor	for	a	guest	lecture.

3.	Invite	an	office	assistant	working	in	MS	office	platform.

10.12  Use of referencing

Objective:

To	practice	to	use	of	referencing	in	MS	excel	document.

Operations/Exercises covered under the project:

1.	 Referencing

2.	 Concept	of	Referencing

3.	 Types	of	cell	Reference

4.	 Relative	Referencing

5.	 Mixed	Referencing	-	Column	letter	is	Absolute

6.	 Absolute	Referencing	-	No	change
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Tools and Equipment Required:

s.no Name of the tools/ 
equipment

Range/Value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft		offi		ce MS	offi		ce	2019 1

Procedure:

Section 1: How to do Referencing in a spreadsheet: 

Step	1:	Click	the	cell	in	which	you	want	to	enter	the	formula.

Step	2:	Type	the	equal	sign	(=).

Step	3:	Type	the	reference	directly	in	the	cell	or	in	the	formula	bar,	or	Click	the	cell	you	
want	to	refer	to.

Step	4:	Type	the	rest	of	the	formula	and	press	the	Enter	key	to	complete	it.

Step	5:	To	add	up	the	values	of	cells	A1	and	A2,	you	type	the	equal	sign,	click	A1,	type	
the	plus	sign,	click	A2	and	press	Enter:

Referencing in a spreadsheet.

Section 2: Relative cell reference in Excel:

Step	 1:	 A	 relative	 reference	 is	 the	 one	 without	 the	 $	 sign	 in	 the	 row	 and	 column	
coordinates,	like	A1	or	A1:B10.	By	default,	all	cell	addresses	in	Excel	are	relative.

Step	2:	To	multiply	numbers	in	column	A	by	5,	you	enter	this	formula	in	B2:	=A2*5

Step	3:	When	copied	from	row	2	to	row	3,	the	formula	will	change	to:	=A3*5

Relative cell reference in Excel
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Section 3: Absolute cell reference in Excel:

Step	1:	An	absolute	reference	is	the	one	with	the	dollar	sign	($)	in	the	row	or	column	
coordinates,	like	$A$1	or	$A$1:$B$10.

Step	 2:	To	multiply	 the	numbers	 in	 column	A	by	 the	number	 in	B2,	 you	 input	 the	
following	formula	in	row	2,	and	then	copy	the	formula	down	the	column	by	dragging	
the	fi	ll	handle:	=A2*$B$2

Absolute cell reference in Excel

Section 4: Mixed cell reference:

Step	1:	A	mixed	reference	contains	one	relative	and	one	absolute	coordinate,	like	$A1	
or	A$1.

Step	 2:	 To	multiply	 a	 column	 of	 numbers	 (column	A)	 by	 3	 diff	erent	 numbers	 (B2,	
C2	and	D2),	you	put	the	following	formula	in	B3,	and	then	copy	it	down	and	to	the	
right:=$A3*B$2

Step	3:	As	the	result,	all	the	calculations	are	performed	with	a	single	formula,	which	
changes	properly	for	each	row	and	column	where	it	is	copied:

Mixed cell reference

Result:

Th	 us	all	types	of	referencing	in	the	MS	excel	document	has	been	practiced	successfully.
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Video suggestions:

S.no Title/purpose Link

1 How	 to	 Make	 Referenc-
ing	in	a	spreadsheet.

https://www.youtube.com/watch?v=pHEz6MrdYfo

2 Relative	 cell	 reference	 in	
Excel

https://www.youtube.com/watch?v=s3EiyUSR59c

3 Absolute	cell	reference	in	
Excel

https://www.youtube.com/watch?v=pJYCll3Uh30

4 Mixed	cell	reference https://www.youtube.com/watch?v=SfV_MT2wWjs

Simple Assessments:

Student project 1.	Students	have	to	prepare	a	reference	material	and	price.	

(use	reference)

2.	 students	 have	 to	 prepare	 relative,	 absolute,	 mixed	 with	
	person,	salary,	with	allowance. 

Guest lecture suggestions 1.	Invite	a MS	office	technician	for	a	guest	lecture.

2.	Invite	a computer	subject	expert	for	a	guest	lecture.

3.	Invite	an	office	assistant	working	in	MS	office	platform.

Industrial/ Field visit sug-
gestions

1.A	field	Visit	to	an	office	nearby	the	school.

2.	Visit	to	nearby	banks	for	field	visit.

3.	A	field	Visit	to	the	nearby	auditing	office.

10. 13  Prepare a chart in MS excel

Objective:

To	prepare	a	chart	in	MS	excel.

Operations/Exercises Covered Under the Project:

1.	 Column	chart

2.	 Line	chart

3.	 Pie	chart

4.	 Bar	chart
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Tools and Equipment Required:

S.No Name of the tools/  
equipment

Range/Value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft	office MS	office	2019 1

Procedure:

Section 1: Column chart:

Step	1:	Create	a	new	excel	sheet	and	save	the	document.

Step	2:	Enter	the	sales	and	expenses	of	the	month.

Step	3:	Click	insert	option	in	toolbar.

Step	4:	Select	the	typed	cells	and	click	the	clustered	column	chart	option.

Step	5:	It	shows	the	sales	and	expenses	of	the	month	in	column	chart.

Column chart

Section 2: Line chart:

Step	1:	Create	a	new	excel	sheet	and	save	the	document

Step	2:	Enter	the	product	trends	by	the	month
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Step	3:	Click	insert	option	in	tool	bar.

Step	4:	Select	the	typed	cells	and	click	the	line	chart	option.

Step	5:	It	shows	the	product	trends	by	the	month	in	line	chart

Line chart

Section 3: PIE chart:

Step	1:	Create	a	new	excel	sheet	and	save	as	the	document

Step	2:	Enter	the	profit	of	the	months.

Step	3:	Click	insert	option	in	tool	bar.

Step	4:	Select	the	typed	cells	and	click	the	pie	chart	option.

Step	5:	It	shows	the	profit	of	the	different	month	in	pie	chart.

Step	6:	Click	the	layout	option	in	tool	bar	and	click	the	data	labels	-->	center	for	view	
the	data’s	in	center	of	pie	chart.

pie chart

XI_Auditing_Chapter_10.indd   205 26-04-2022   18:24:05



206 Auditing Related Computer Applications

Section 4: Bar chart:

Step	1:	Create	a	new	excel	sheet	and	save	the	document

Step	2:	Enter	the	product	life	in	days 

Step	3:	Click	insert	option	in	tool	bar.

Step	4:	Select	the	typed	cells	and	click	the	bar	chart	option.

Step	5:	It	shows	the	product	life	in	days	in	bar	chart.

Bar chart

Result:

Thus	the	chart	has	been	prepared	successfully.

Video suggestions:

S.no Title/purpose Link

1 Excel	chart	in	tamil https://youtu.be/CamobfRkSbI

2 MS	Excel	-	Pie,	Bar,	Column	&		
Line	Chart

https://youtu.be/Z2gzLYaQatQ

3 Chart	creation	and	in	types	in	excel		
in	Tamil

https://youtu.be/W7m8cNdMz94
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Simple Assessments:

Across

1. which	chart	will	be	more	useful	to	view	sales	information?

2. which	chart	will	be	used	to	track	changes	over	short	and	long	periods	of	time

Down

1. it	shows	data	changes	over	a	period	of	time	or	for	illustrating	comparisons	among	items.

2. which	chart	will	be	used	to	show	comparisons	between	categories	of	data?

Student project Draw	the	pie	chart	to	view	your	quarterly	examination	marks	
subject	wise.

Draw	the	column	chart	to	view	the	January	month	income	
and	expenditure	of	your	family.

Guest lecture suggestions 1.	Invite	a MS	office	technician	for	a	guest	lecture.

2.	Invite	a computer	subject	expert	for	a	guest	lecture.

3.	Invite	an	office	assistant	working	in	MS	office	platform.

Industrial/ Field visit  
suggestions

1.	A	field	Visit	to	an	office	nearby	the	school.

2.	Visit	nearby	banks	for	field	visits.

3.	A	field	Visit	to	the	nearby	auditing	office.
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10.14  Advance Creation Of Electronics Spreadsheet In Ms Excel.

To	create	a	spreadsheet	using	references,	hyperlinks	and	macro,	share	the	spreadsheet	reviewing	
and	merging	in	Ms	excel.

OPERATIONS:

•• Consolidating	data

•• Creating	data

•• Setting	up	multiple	worksheet	creating	reference

•• Creating	and	using	‘What	if	analysis’

•• Using	Macro	Recorder

SAFETY MEASURE

These	are	the	top	do’s	and	don’ts	to	keep	in	mind	when	using	Excel:

•• Do plan	your	spreadsheet.

•• Don’t leave	blank	rows	or	columns	when	entering	related	data.

•• Do save	frequently	and	save	in	two	places.

•• Don’t use	numbers	as	column	headings	and	don’t	include	units	with	the	data.

•• Do use	cell	references	and	named	ranges	in	formulas.

•• Don’t leave	cells	containing	formulas	unlocked.

•• Do sort	your	data.

TOOLS AND EQUIPMENT REQUIRED:

S.No Name	of	the	tools/equipment Range/Value Quantity
1 Computer	or	Laptop i5	processor/4GB	RAM 1
2 Microsoft	office MS	office	2019 1
3	 Printer Epson 1

PROCEDURE

SECTION 1: CREATING AND USING ‘ WHAT – IF  ANALYSIS’ IN MS-EXCEL

Step	1-	In	Ms	Excel	Open	a	new	workbook.

Step	2-Type	the	following	data:
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S.No A B
1 Price 83
2 Qty 12
3 Amt 996

Scenario Manager

Step	3	-	Click	Data	>	What	if	analysis	in	Data	Tools	group	and	select	Scenario	Manager.

Step	4	-	Scenario	Manager	Dialog	box	appears.

Step	5	-	Click	add	button,	Add	Scenario	dialog	box	appears.

Add Scenario dialog box

Step	6	–	In	‘Scenario	Name’	textbox,	type	the	Scenario	name.	In	‘changing	cells’	textbox,	
select	the	cell	address	whose	value	is	to	be	changed.	Click	OK	button.

Step	7-	Scenario	values	dialog	box	appears.	Enter	values	for	changing	cells	then	click	
OK	button.

Step		8	–Follow	steps	from	5	to	7	to	create	more	scenarios.

Step		9	-	Finally	click	Summary	button.	Scenario	summary	dialog	box	appears.

Step		10	–	Select	Report	type	and	click	OK	button.	

Step	11-	Scenario	summary	will	appear	in	a	new	sheet.	
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SECTION 2: INSERTING HYPER LINK IN MS EXCEL

Step	1	–	In	Ms	Excel	Open	a	new	workbook.

Step	2	–	Click	Insert	>	Hyperlink,	dialog	box	appears.

Step	3	–	From	link	to:	section	select	place	in	this	document.

Hyperlink dialog box

Step		4	–	In	text	to	display	textbox	type	the	text	to	display	as	hyperlink.

Step	5	–	In	Type	the	cell	reference	textbox,	type	the	cell	address	or	select	the	cell	reference	
from	the	given	list.	Click	OK	button.

Step	6	–	In	Active	cell	the	text	is	highlighted	as	blue	in	color	with	underlined.	This	is	
the	hyperlink,	by	clicking	on	it	the	cursor	will	take	you	to	the	place	where	it	is	linked.

Step	7	–	Once	visited,	the	color	of	the	hyper	link	text	will	be	changed.

SECTION 3: LINKING EXTERNAL DATA

To	import	data	from	MS	Access	database,	

Step	1	–	In	Ms	Excel	Open	a	new	workbook.

Step	2	–	On	Data	tab,	in	Get	external	data	group,	click	from	Access.

Get External Data
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Step	3	–	Select	any	MS	Access	file	and	click	open.

Step	4	–	Select	a	table	and	click	OK.	In	Import	data	dialog	box	select	table	and	existing	
workbook.	Click	OK.

Step	5	–	Now	we	can	see	our	database	records	in	MS	Excel.	

Import Data Dialog box

SECTION 4: RECORDING A MACRO

Step	1	–	In	Ms	Excel	Open	a	new	workbook.

Step	2	–	Click	View	>	Macros	>	Record	Macro.	A	dialog	box	will	appear.	

Recording a Macro

Step	3	–	Give	a	name	for	the	Macro.	Assign	shortcut	key	for	the	macro	apart	from	the	
regular	shortcut	keys	used	in	MS	Excel.

Step	4	–	Type	the	description	for	macro.	Click	OK	button.

Step	5	–	Now	do	the	actions	(typing	text	or	number	or	formatting)	to	record,	click	
stop	recording	once	you	complete.	
Step	6	–	The	created	macro	will	be	available	in	view	macro	option.

Step	7	–	Now	we	can	use	the	shortcut	key	or	Click	Run	button	in	View	Macro	option	to	
see	our	repeated	actions
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CONCLUSION:

Thus	the	spreadsheets	using	external	data,	hyperlinks	and	macro,	‘what	if	analysis’	in	MS	excel	
clearly	obtained	and	verified.

VIDEO SUGGESTIONS:

S.No Title Video	link
1 What	if	analysis	in	Excel https://youtu.be/FXaV4lckino
2 MS	Excel	-	multiple	worksheet	creating	

reference,	hyperlink,	sharing	the	spread	sheet
https://www.youtube.com/
watch?v=0-I1BpSlE3sz

3 MS	Excel	-	sorting	the	columns	using	macro	
recorder

https://www.youtube.com/
watch?v=KobPARZhN2c

SIMPLE ASSESSMENTS:

1.		____________ can	be	used	 in	spreadsheet	 software	 to	 jump	to	a	different	 location	 from	
within	a	spreadsheet 

2.		A	__________	is an	action	or	a	set	of	actions	that	you	can	run	as	many	times	as	you	want	
in	spreadsheet.

3.	__________refers	to	a	cell	or	a	range	of	cells	on	a	worksheet.

4.	__________	short	cut	key	is	used	to	open	an	existing	workbook.

5.	___________	short	cut	key	is	used	to	insert	a	new	worksheet.

Answer	(1.	hyper	link 	2.	macro 	3.	cell	reference	4.	ctrl+o 	5.	shift+f11	)

1 Student project Prepare	an	account	summary	sheet	with	a	blank	Balance	
column	by	using	what	if	analysis.

Prepare	a	macro	file	with	an	example

Prepare 	a	hyperlink	data	file	with	an	example

2 Guest lecture suggestions 1.	Invite	a	MS	office	subject	expert	for	a	guest	lecture.

2.	Invite	an	auditor	for	a	guest	lecture.

3.	Invite	a	business	analyst	working	in	MS	office	platform.
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3 Industrial/ Field visit 
suggestions

1.	A	field	Visit	to	an	auditing	office	nearby	the	school.

2.	Visit	nearby	banks	for	field	visits.

3.		A	field	Visit	to	the	nearby	front	office	of	the	organization.

10.15  Prepare a balance sheet in MS excel

Objective:

To	prepare	a	balance	sheet	in	MS	excel.

Operations/Exercises Covered Under the Project:

1.	 Creating	the	excel	file

2.	 Enter	the	data’s	of	balance	sheet

3.	 Print	the	document

Tools and Equipment Required:

S.No Name of the tools/equipment Range/Value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft	office MS	office	2019 1

3 Printer Epson	L3250 1

Procedure:

Section 1: Creating the excel file:

Step	1:	Open	Excel.

Step	2:	Click	New	Blank	Workbook.

Step	3:	Enter	column	headers	into	row	1.

Step	4:	Enter	data	on	individual	rows.

Step	5:	Click	the	Page	Layout	tab	to	format	the	data.

Step	6:	Click	File	>	Save	As	to	save	the	document.
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Creating the excel file

Section 2: Enter the datas of balance sheet:

Step	1:	Pick	the	balance	sheet	date

Step	2:	List	all	of	assets

Step	3:	Add	up	all	of	assets

Step	4:	Determine	current	liabilities

Step	5:	Calculate	long-term	liabilities

Step	6:	Add	up	liabilities. 

Step	7:	Calculate	owner’s	equity

Step	8:	Add	up	liabilities	and	owners’	equity

Enter the datas of the balance sheet
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Section 3: Print the document:

Step	1:	Open	the	MS	excel	document	to	be	printed

Step	2:	Click	File in	the	left	top	corner	of	the	excel	file	or	Click	CTRL + P

Step	3:	Click	the	print	icon	to	print	the	document

Print the document

Result:

Thus	the	balance	sheet	in	Ms	excel	has	been	prepared	successfully.

Video suggestions:

s.no Title/purpose Link

1 How	 to	 Prepare	 Balance	 Sheet	 in	 Tamil	 |	
	Final	Accounts	in	Tamil

https://youtu.be/2JY04NU_qsk

2 Salary	Sheet	of	Cutechinfo	Pvt	Ltd	in	excel https://youtu.be/B--Dkqpcqd8

3 Microsoft	excel	Personal	Accounts	example	
|	House	incomes	and	Expenses	Sheet

https://youtu.be/HDlTAYedZjs
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Simple Assessments:

Student project 1.		Student	should	have	to	prepare	the	balance	sheet	of	the	sole	trader.

2.		Student	should	have	to	prepare	the	balance	sheet	of	a	partnership	
firm.

3.		Student	 should	have	 to	prepare	 the	balance	 sheet	of	 a	 joint	 stock	
company.

4.		Students	should	have	to	prepare	the	balance	sheet	of	a	not	for	profit	
organisation.

Guest lecture 
 suggestions

1.	Invite	a MS	office	subject	expert	for	a	guest	lecture.

2.	Invite	an	office	assistant	working	in	MS	office	platform.

2.	Invite	an	auditor	working	in	MS	office	platform.

Industrial/ Field 
visit suggestions

1.	A	field	Visit	to	an	office	nearby	the	school.

2.	Visit	nearby	banks	for	field	visit.

3.	A	field	Visit	to	the	nearby	auditing	office.

10.16  Create a PowerPoint presentation and its various options

Objective:

To	create	a	power	point	presentation	and	use	of	various	options	in	MS	power	point	presentation.

Operations/Exercises Covered Under the Project:

1.	 Create	a	presentation

2.	 Work	with	slides

3.	 Format	the	text	in	presentation

4.	 Create	and	use	tables	in	presentation

5.	 Insert	and	format	image	in	presentation

6.	 Work	with	slide	master

Tools and Equipment Required:

S.No Name of the tools/  
equipment

Range/Value Quantity

1 Computer	or	Laptop I5	processor/4gb	ram 1

2 Microsoft	office MS	office	2019 1
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Shortcut keys:

Table showing Shortcut keys

Sl.no To do this Press

1 Create	new	presentation. Ctrl+N

2 Add	a	new	slide. Ctrl+M

3 Make	selected	text	bold. Ctrl+B

4 Change	the	font	size	for	selected	text. Alt+H, F, S

5 Open	the	Zoom	dialog	box. Alt+W, Q

6 Cut	selected	text,	object,	or	slide. Ctrl+X

7 Copy	selected	text,	object,	or	slide. Ctrl+C

8 Paste	cut	or	copied	text,	object,	or	slide. Ctrl+V

9 Undo	the	last	action. Ctrl+Z

10 Save	the	presentation. Ctrl+S

11 Insert	a	picture	from	your	device. Alt+N, P, D

12 Insert	a	shape. Alt+N, S, H

13 Select	a	theme. Alt+G, H

14 Select	a	slide	layout. Alt+H, L

15 Go	to	the	next	slide. Page down

16 Go	to	the	previous	slide. Page up

17 Go	to	the	Home	tab. Alt+H

18 Go	to	the	Insert	tab. Alt+N

19 Start	the	slide	show. F5

20 End	the	slide	show. Esc

21 Close	PowerPoint. Ctrl+Q

Procedure:

Section 1: Create a presentation:

Step	1:	To	create	a	new	blank	presentation,	select	the	File	Menu→New	or	click	on	the	
icon	New	or	use	the	combination	of	keys	Ctrl+N. 

Step	2:	A	window	‘Select	a	Template’	will	appear.	Choose	a	template	as	per	your	choice	
by	clicking	on	the	template 
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Create a presentation

Section 2: Working with slides:

The	 appropriate	 layout	 can	 be	 selected	 from	 the	 Layouts	 section	 in	 the	 Properties	
window.	The	layouts	included	in	Libre	Office	range	from	a	blank	slide	to	a	slide	with	six	
content	boxes	and	a	title.	You	can	also	select	a	slide	layout	by	using	menu,	Slide	→	Slide	
Layout	→	Title	slide 

Working with slides

Adding text: 

To	add	text	to	a	slide	that	contains	a	text	frame,	click	on	Click	to	add	text	in	the	text	
frame	and	then	type	your	text.	The	Outline	styles	are	automatically	applied	to	the	text	
as	you	insert	it. 

Saving a presentation: 

While	creating	a	presentation,	you	can	save	it	to	the	disk	with	some	name,	so	that	the	
content	may	not	be	lost	or	to	use	the	presentation	further.	Select	the	File	Menu→Save,	
or,	use	the	shortcut	key	combination	Ctrl+S,	or	click	on	the	Save	button	on	the	Standard	
Toolbar. 
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To Select the slide you want to duplicate from the Slides Pane:

Step	1:	Select	from	menu	bar	Slide	→	Duplicate	Slide.

Step	2:	Or	right-click	on	the	slide	and	select	Duplicate	Slide	from	the	menu.

Step	3:	Or	right-click	on	a	slide	in	Workspace	and	select	Slide	→	Duplicate	Slide	from	
the	menu.

Step	4:	Or	click	the	Duplicate	Slide	icon	in	the	Presentation	toolbar.	Select	from	menu	
bar	Slide	→	New	Slide.

Step	5:	Or	right-click	on	a	slide	and	select	New	Slide	from	the	context	menu. 

Step	6:	Or	right-click	in	an	empty	space	in	the	Workspace	and	select	Slide	→	New	Slide	
from	the	context	menu.

Section 3: Create and use tables in presentation:

A	Table	can	be	inserted	from	the	Insert	menu	by	selecting	Insert→Table.	In	the	Insert	Table	
dialog	box,	the	Number	of	columns	and	the	Number	of	rows	are	specified	in	the	Insert	
Table	dialog	box,	the	Number	of	columns	and	the	Number	of	rows	are	specified.	Adjusting	
column	width	and	row	height	using	the	mouse	to	change	the	width	of	the	column,	position	
on	the	border	line	between	the	two	columns,	and	when	the	cursor	changes	to	a	(↔)	sign,	
press	the	left	mouse	button,	hold	and	drag	it	until	the	column	achieves	the	desired	width.	
The	same	can	be	done	for	adjusting	the	row	height.	The	various	table	formatting	options	
can	be	applied	on	the	table	just	like	Writer.	The	borders	and	background can	be	assigned	
to	the	table.	To	do	this,	right	click	on	the	table	border,	the	Table	Properties	dialog	box	will	
open	from	where	you	can	change	the	borders	and	background	of	the	table.

Create and use tables in presentation
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Section 4: Insert and format image in a presentation:

Step	1:	To	insert	an	image	into	the	presentation,	select	Insert	→	Image	on	the	menu	bar	
or,	click	on	the	Insert	 Image	 icon	 located	on	the	standard	toolbar.	The	Insert	 Image	
dialog	opens.	Select	the	file	from	the	desired	directory.	By	selecting	the	Preview	option,	
a	thumbnail	of	the	selected	image	will	be	displayed	in	the	preview	pane	on	the	right	
Moving	images.

Insert and format image in a presentation

Step	 2:	 To	move	 the	 image	 in	 the	 slide,	 click	 on	 an	 image,	 observe	 that	 the	 cursor	
changes	to	hand	shape. 

Step	3:	Click	and	drag	the	picture	to	the	desired	position.

Step	4:	Release	the	mouse	button.

Resizing images:

Step	1:	Select	the	image	by	clicking	on	it.	Observe	that	selection	handles	are	displayed.

Step	2:	Position	the	cursor	over	one	of	the	selection	handles.	The	cursor	changes	the	
shape	giving	a	graphical	representation	of	the	direction	of	the	resizing. 

Step	3:	Click	and	drag	to	resize	the	image

Step	4:	Release	the	mouse	button	when	satisfied	with	the	new	size.

The image can be rotated in any direction using the Rotate icon. To manually rotate an image:

Step	1:	Select	the	image	to	display	the	selection	handles.

Step	2:	Click	the	Rotate	icon	on	the	Line	and	Filling	toolbar.
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Step	3:	Click	again	on	the	selected	image	and	the	selection	handles	change	shape	and	colour	
Formatting	using	the	Image	toolbar	When	an	image	is	selected,	the	Image	toolbar	becomes	
available	 under	 the	 Properties	 window.	This	 toolbar	 provides	 a	 number	 of	 formatting	
options.	The	Image	toolbar	can	also	be	displayed	by	selecting	View	→	Toolbars→Image	from	
the	menu	bar.

Drawing tools:

Powerpoint	provides	various	drawing	tools.	The	Drawing	toolbar	having	the	majority	
of	the	tools	are	used	to	create	graphical	objects.	To	activate	this	toolbar,	select	View	→	
Toolbars	→Drawing	from	the	main	menu	bar.

Section 5: Work with slide master:

Working	 with	 Slide	Masters	 comes	 with	 various	 slide	masters.	These	 slide	masters	
are	available	 in	 the	Master	Pages	 section	of	 the	Sidebar.	There	are	 three	 subsections	
namely,	 used	 in	 this	 Presentation,	 Recently	 Used,	 and	 Available	 for	 Use.	 Click	 the	
expand	marker	next	to	the	name	to	expand	it.	It	will	show	thumbnails	of	the	slides.	Just	
click	the	collapse	marker	to	collapse	the	subsection	to	hide	the	thumbnails.	Every	slide	
masters	shown	in	the	Available	for	Use	lists	form	templates	with	the	same	name. 

Adding transitions:

Step	 1:	 In	 the	 Slidebar,	 select	 the	 Slide	Transition	 icon	 to	open	 the	 Slide	Transition	
section.

Step	2:	In	the	Slides	pane	or	Slide	Sorter	view,	select	the	slides	to	apply	the	transition.	If	
you	want	to	apply	the	transition	to	all	the	slides,	do	not	select	any	slides.

Step	3:	In	the	Apply	to	selected	slides	list,	select	a	transition.

Step	4:	Modify	the	selected	transition	by	changing	the	speed	or	adding	a	sound,	in	the	
Modify	transition	section.	To	play	a	sound	during	transitions,	select	a	sound	from	the	
Sound	list.

Step	5:	 If	a	 sound	 is	 selected,	 the	Loop	until	 the	next	 sound	option	becomes	active.	
Select	this	option	to	play	the	sound	repeatedly	until	another	sound	starts. 

Step	6:	Select	how	to	advance	to	the	next	slide:	manually	(By	mouse	click)	or	automatically	
(Automatically	after).	To	select	an	automatically	advance,	you	will	have	to	specify	how	
long	the	slide	should	remain	visible	before	it	automatically	advances	to	the	next	slide.

Step	7:	To	apply	transition	to	all	slides,	click	Apply	to	All	Slides.

Step	8:	To	start	the	slide	show	from	the	current	slide,	check	transitions,	click	Slide	Show.
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Work with slide show
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Work with slide master

Result:

Thus	the	power	point	presentation	has	been	created	successfully.

Thus	the	various	options	in	MS	power	point	presentation	has	been	used	successfully.

Video suggestions:

s.no Title/purpose Link

1 PowerPoint	Tutorial	in	Tamil https://youtu.be/gtGz4elezS8

2 DATA	 ENTRY	 WORK	 IN	 EXCEL	 IN	
TAMIL	 |	 How	 to	 do	 data	 entry	 work	 in	
	excel	in	Tami

https://youtu.be/TwRf2J8xj_Y

3 MS	PowerPoint	-	Basic	Presentation https://youtu.be/tcj2BhhCMN4

4 PowerPoint	Full	Tutorial	in	Tamil  https://youtu.be/S2KqmNq7eP8

Simple Assessments:

Student project

Guest lecture suggestions 1.	Invite	a MS	office	subject	expert	for	a	guest	lecture.

2.	Invite	a computer	technician	for	a	guest	lecture.

3.	Invite	an	office	assistant	working	in	MS	office	platform.
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Industrial/ Field visit sugges-
tions

1.A	field	Visit	to	an	office	nearby	the	school.

2.	Visit	nearby	banks	for	field	visit.

3.A	field	Visit	to	the	nearby	auditing	office.

10. 17  Prepare the +1 accountancy journal entries and ledger accounts

Objective:

To	prepare	 the	+1	accountancy	 journal	 entries	 and	 ledger	accounts	using	MS	power	point	
presentation.

Tools and Equipment Required:

S.No Name of the tools/equipment Range/value Quantity

1 Computer	or	Laptop i5	processor/4gb	ram 1

2 Microsoft	office MS	office	2019 1

Flow chart:

1.	 Create	a	presentation	using	PowerPoint

2.	 Create	a	new	slide

3.	 Insert	a	table

4.	 Enter	the	labels	and	datas

Safety Measures:

1.	 Make	sure	to	save	your	presentation	at	regular	intervals.

2.	 Remember	 that	 before	 closing	 your	 PowerPoint	 document	 you	 need	 to	 save	 the	
document	and	it’s	file	path	location.

Procedure:

Step	1:	Open	a	presentation	on	your	computer.

Step	2:	Click	File>New >Blank presentation. Double	click	on	the	blank	presentation.
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Create a new presentation

Step	3:	Click	Design>Th emes,	Select	any	theme	shown	in	the	options.

Add design in the presentation

Step	4:	Enter	your	title	name	and	submit	it	by	your	name	in	boxes.

XI_Auditing_Chapter_10.indd   225 26-04-2022   18:24:06



226 Auditing Related Computer Applications

Step	5:	Click	on	slide	1	and	press	enter.

Add more slides and enter data in the presentation

Step	6:	Enter	 the	 title	 for	 the	 Journal	Entries.	And	Click	Insert>Table>Insert Table 
enter	the	no	of	rows	and	columns.

Insert the table in presentation
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Step	7:	Enter	Labels	and	data	in	the	table.

Insert the labels in table

Step	8:	Follow	step	5	&	6	for	Ledger	Accounts.

Prepare ledger account in presentation
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Step	9:	Click	Home>Layout and	choose	your	layout	for	thanks.

End of the slides

Step	10:	Click	Slide show>From beginning or	Press F5 key to	view	in	full	screen	for	
presentation.

Result:

Th	 us	the	+1	accountancy	journal	entries	and	ledger	accounts	has	been	prepared	successfully.

Video suggestions:

s.no Title/purpose Link

1 PowerPoint	Tutorial	in	Tamil https://youtu.be/gtGz4elezS8

2 DATA	ENTRY	WORK	 IN	EXCEL	 IN	TAMIL	 |	
How	to	do	data	entry	work	in	excel	in	Tami

https://youtu.be/TwRf2J8xj_Y

3 Class	11	-	Accountancy	-	PPT	Presentation	-	
Journal,	Meaning,	Objectives,	Limitations	
7-8-20	-	MCS

https://youtu.be/82WeltyaYog
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Simple Assessments:

1.	 Write	down	the	method	to	open	a	presentation	page?

2.	 Which	shortcut	key	is	used	to	view	your	presentation	in	full	screen?

3.	 How	many	rows	and	columns	are	used	for	a	Ledger	account?

Student project 1.	Create	a	data	ledger	presentation	for	your	school.

2.	Create	a	data	of	journal	presentation	for	your	school.

3.		Create	 a	 presentation	 of	 a	 trial	 balance	 with	 an	 imaginary		
Figure.

4.	Create	a	presentation	and	present	it	to	your	friends.

Guest lecture  
suggestions

1.	Invite	a	MS	office	subject	expert	for	a	guest	lecture.

2.	Invite	an	accounts	auditor	for	a	guest	lecture.

3.	Invite	an	office	assistant	working	on	the	MS	office	platform.

Industrial/Field visit 
suggestions

1.		A	 field	 Visit	 to	 an	 office	 or	 data	 maintaining	 center	 nearby		
the	school.

2.	Visit	the	nearby	insurance	office	for	a	field	visit.

3.	A	field	Visit	to	the	nearby	computer	center.

10.18 Introduction

A	database	management	 system	 (DBMS)	 is	 a	
software	tool	to	organize	(create,	retrieve,	update	
and	manage)	 data	 in	 a	 database.	 A	 Database	
Management	System	is	a	computerized	record	
–	keeping	system.	It	is	a	container	for	collection	
of	computerized	data	files.

   10.18.1. Meaning

A	database	is	a	collection	of	logically	related	data	
items	stored	in	an	organized	manner.	According	
to	the	requirements	of	the	user,	the	data	being	
stored	 in	 a	 database	 can	 be	 added,	 modified,	
deleted	or	displayed.	The	software	that	 is	used	
to	create,	update	and	retrieve	data	is	known	as	
database	Management	System	(DBMS).

   10.18.2 Definition

Database	defined,	a	database	is	an	organized	
collection	of	structured	 information	or	data,	
typically	 stored	 electronically	 in	 a	 computer	
system.	A	database	is	usually	controlled	by	a	
database	management	system	(DBMS).

   10.18.3 Features of DBMS

•	 Controls	 who	 can	 access	 and	 edit	 the	
data.

•	 Create	Backups.
•	 Allows	data	to	be	shared	by	many	users.
•	 Provides	 user	 interfaces	 to	work	with	 the	

data.
•	 Provides	High	level	of	security.
•	 Permanent	storage	of	Data.
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   10.18.4 Concept of DBMS:

A	Database	Management	System	 (DBMS)	 is	 a	
software	package	designed	to	define,	manipulate,	
retrieve	and	manage	data	in	a	database.

A	DBMS	generally	manipulates	the	data	itself,	
the	data	format,	field	names,	record	structure	
and	 file	 structure.	 It	 also	 defines	 rules	 to	
validate	and	manipulate	this	data.

Database Management System

Concept and examples of relational database

The	Relational	Database	Model	was	proposed	
in	 1970	 by	 E.F.	 Codol,	 Relational	 database	
model	 is	 the	most	common	type	of	database	
model.	 The	 data	 elements	 are	 stored	 in	
different	tables	made	up	of	rows	and	columns.

Eg.	Oracle,	MYSQL,	IBM,	etc.,

Field	 :	 A	 field	 is	 the	 smallest	 entity	 in	 the	
database.

Record	:A	collection	of	fields	makes	a	record.

Table	:	A	collection	of	records	makes	a	table.

Database	:Collection	of	tables	makes	a	database.

Primary Key

A	primary	key	is	a	column	or	a	group	of	columns	
that	uniquely	identifies	the	rows	in	that	table.

Register	No. Name	of	
the	Student

DOB Marks

^	←Primary	
Key

Composite Primary Key 

A	primary	key	having	two	or	more	attributes	
is	 called	 composite	 primary	 key.	 It	 is	 a	
combination	of	two	or	more	columns.

Register	No. Name	of	
the	Student

DOB Marks

	←—------------------------------>	
Composite	Primary	Key

Foreign Key 

A	 foreign	key	 is	 the	one	 that	 is	 used	 to	 link	
two	tables	together	via	the	Primary	Key.

Register	No. Name	of	
the	Student

DOB Marks

PRIMARY	
KEY

	|

	|

	\/

Register	No. Name	of	
the	Student

DOB Marks

Foreign	Key
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   10.18.5 Database 
Management System 
(CDMS) Software

One	of	the	DBMS	software	Libre	Office	Base.

Introduction:

Libreoffice	 Base	 is	 a	 free	 and	 open	 source	
DBMs.	 It	 can	 be	 downloaded	 from	 www.
libreoffice.org	and	is	available	for	both	Linux	
and	 windows	 operating	 systems.	 Data	 has	
to	be	stored	in	an	organized	manner	using	a	
DBMS.	Also,	 the	 data	 being	 stored	 can	 be	 a	
text,	number,	date	or	in	any	other	form.	Steps	
to	create	the	database:

1.	 Start	 the	 Libreoffice	 Base	 as	 per	 the	
standard	 process	 of	 starting	 the	 application	
in	Windows	or	Linux.

In	 windows,	 click	 start.	 Libreoffice	 (or)	
double/click	 on	 the	 Libreoffice	 icon	 on	 the	
desktop	(or)	select	base	Database	option	form	
the	bottom	left	pane)

2.	 A	 Database	 wizard	 opens.	 It	 allows	 you	
to	create	a	new	database	or	open	an	existing	
database.

3.	Click	create	a	new	database	ratio	button.

4.	 Gives	 the	 option	 to	 register	 our	 database	
with	Libre	office.org.

5.	 Open	 option	 enables	 the	 user	 to	 edit	 the	
database.

6.	 Click	 the	 Finish	 button	 to	 complete	 the	
database	creation	process.

7.	The	Save	As	dialog	box	appears.

8.	Browse	for	the	drive	and	folder	where	you	
want	to	store	your	database.

9.	Type	the	name	in	the	file	name	text	box.

10.	Click	the	Save	button.

Database Management Software

10.19  Create a Table Using 
Table Wizard 

Creating a Table 

Once	 the	 database	 is	 created,	 we	 can	 start	
working	 with	 objects	 of	 the	 database.	 First	
and	foremost	is	the	creation	of	the	table.

In	 Libreoffice	 Base,	 a	 table	 can	 be	 created	
using	a	wizard	or	using	the	design	View.

To	 create	 a	 table	 at	 the	 time	 of	 creating	 a	
database	 in	database	wizard,	select	 the	radio	
button	 with	 option	 “create	 tables	 using	 the	
table	wizard”,	then	click	on	the	Finish	Button.

In	Base,	ready-made	tables	are	available.

•	 Click	the	sample	tables	List	Box	and	select	
any	one	table.

•	 Click	on	Next	Button	–	steps	2
•	 Click	on	Next	Button	–	steps	3
•	 Click	 on	 Next	 Button	 –	 to	 complete	 the	

process	of	creating	a	table	using	wizard.
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•	 By	 default	 the	 “Insert	 data	 immediately”	
option	is	selected.

•	 Click	on	the	Finish	Button.

Data types

Data	 types	 are	 used	 to	 identify	which	 type	 of	
data	(value)	we	are	going	to	store	in	the	database.

Data	 types	 are	 broadly	 classified	 into	 five	
categories	are	listed	below:

1.	Numeric	Types	(	o	to	9)

2.	Alphanumeric	Types	(	a/A	to	3	/	z	&	o	to	9)

3.		Binary	types	(storing	photos,	music	files,	etc.,)

4.	Date	time	(DD/MM/YYYY)

5.	Other	variable	types.

Option to set primary key 

Once	 the	 take	 is	 created,	 it	will	 ask	 the	user	
to	set	a	primary	key.	The	user	can	select	 the	
appropriate	option	to	set	 the	primary	key	or	
leave	the	table	without	a	primary	key.

   10.19.1 Table Data View 
Dialog Box

Table	 data	 view	 dialog	 box	 enables	 the	 user	
to	define	the	layout	of	the	table	and	insert	the	
data	into	the	appropriate	fields	of	the	table.

10.20  Perform Operations 
on Table

Inserting data in the table

To	insert	the	data	in	the	table,	select	the	table	
and	 double	 click	 on	 it.	 The	 table	 will	 open	

in	 the	Datasheet	 view	 in	 which	 data	 can	 be	
inserted.

Edit Records in the table:

To	edit	the	data	either	click	on	the	edit	icon	or	
double	click	on	the	data	in	the	cell	of	a	label	
and	modifications	can	be	done.

Deleting Records from the table:

To	remove	the	data	from	the	table	follow	the	
steps:

Select	the	date	–	right	click	on	selected	date	–	
select	delete	option.

Sorting Data:

Sorting	means	 to	 arrange	 the	 data	 in	 either	
ascending	 order	 or	 descending	 order.	 Select	
the	 columns	 and	 then	 click	 on	 sort	 buttons.	
The	data	will	be	displayed	accordingly.

Referential Integrity:

Referential	integrity	used	to	link	between	two	
or	more	 tables	with	 the	help	of	primary	key	
and	foreign	key	constraints.

Creating	 and	 Editing	 Relationships	 between	
Tables:

A	 relationship	 refers	 to	 an	 association	 or	
connection	between	two	or	more	tables.	When	
the	user	relates	two	tables,	then	the	same	data	
need	not	be	entered	in	separate	tables.

There	 are	 three	 types	of	 relationships	which	
can	be	created	in	tables.

1.	One	to	One

2.	One	to	many	or	many	to	one

3.	Many	to	Many
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One	to	one	relation:

In	this	relationship,	both	the	tables	must	have	
a	primary	key	column.

Register	No. Name	of	
the	Student

DOB Marks

PRIMARY	
KEY

	|

	|

	\/

Register	No. Group Student	/	STD

Primary	Key

One to Many or Many to one Relation:

In	 relational	 databases,	 one	 –	 to	 –	 many	
relationships	exist	when	one	row	in	table	A	may	
be	 linked	with	many	 rows	 in	 table	B,	 but	 one	
row	in	B	is	linked	to	only	one	row	in	table	A.

In	this	relationship,	one	of	the	table	must	have	
Primary	Key	column

Table	A

←—------->

←—------->

←—------->

Table	B

Record
Record

Record

Record

Many to Many relationship:

In	many	relationships	no	table	has	the	primary	
key	column.	A	many	to	many	relationship	occurs	

when	multiple	records	in	a	table	are	associated	
with	multiple	records	in	another	table.

Eg.	A	Many	 –	 to	 –	Many	 relationships	 exist	
between	customers	and	products.

Customers	can	purchase	various	products	and	
products	can	be	purchased	by	many	customers.

Customers products

10.21  Retrieve Data using 
Query

As	 the	 name	 suggests,	 query	 is	 to	 collect	
specific	information	from	the	pool	of	data.

A	query	is	one	of	the	most	important	features	
of	any	DBMS.	Using	a	query,	we	can	retrieve	
and	display	data	from	one	or	more	tables	in	a	
database.

A	Query	can	be	created	in	three	ways.

1.	Using	a	Wizard
2.	In	design	View
3.	In	SQT	View

Steps:

1.	In	the	Database	Design	Window,	click	the	
queries	button.

2.	 In	 the	Tasks	Area,	 click	 on	 use	wizard	 to	
create	a	query	option.

3.	Select	fields	from	the	respective	tables.

4.	 From	 the	 list	 box,	 select	 the	 event	 name	
field.

5.	Click	on	 the	next	 button	 that	will	 display	
the	screen	to	select	the	storing	order.
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6.	To	set	the	search	conditions	or	the	criteria	on	
the	basis	of	which	records	will	be	filtered	 from	
the	table.

7.	 Select	 field	 from	Fields	drop	down	 list,	 is	
equal	to	from	condition,

8.	 Steps	 4,	 5,	 6	 given	 in	 the	 steps	 pane	 deal	
with	tasks	 like	summarizing	and	performing	
numerical	calculations.

9.	 To	 give	 an	 alias	 name	 i.e.	 the	 column	
header	name	will	be	displayed	when	we	 run	
the	query.

10.	Displays	the	entire	overview	of	the	query

11.	Click	on	the	finish	button.

Creation of query using design View:

This	 is	 a	 more	 flexible	 method	 to	 create	 a	
Query	from	either	a	single	or	a	multiple	table	
of	a	database.

1.	Click	the	Queries	icon	on	the	objects	pane	
in	the	Database	window.

2.	 Click	 create	 Query	 in	 design	 view…icon	
in	the	tasks	Pane.	The	Query	Design	window	
appears.

3.	Click	on	the	Event	 table	 to	be	used	 in	 the	
Query	and	then	click	on	Add	button.

4.	 Similarly	 add	 table	 to	 tables	 Pane	 of	 The	
Query	Design	Window.

5.	Click	the	close	button	in	the	ADD	Table	or	
Query	dialog	box	to	close	it.

6.	Next	step	is	to	select	the	fields.

7.	 In	 the	grid,	 there	 is	 a	 row	 titled	Alias.	As	

mentioned	 before,	 it	 can	 be	 used	 to	 display	
meaning	names	in	the	output.

8.	 By	 default,	 the	 data	 that	 is	 displayed	 as	 a	
result	of	 the	query	 is	not	 sorted.	To	sort	 the	
records	 in	 either	 ascending	 or	 descending	
orders	 of	 a	 particular	 field,	 the	 sort	 row	 is	
given	in	the	grid.

9.	 Once	 the	 query	 is	 designed,	 click	 Run	
Query	Button	on	the	toolbar	or	press	F5	key.

10.	Click	on	save	button	to	save	the	query.

11.	 By	 default,	 the	 query	 name	 will	 be	
displayed.	Type	a	different	name	if	required.	
Click	on	the	OK	button	to	save	the	query.

10.22 STUCTURED QUERY 
LANGUAGE (SQL)
SQL	 stands	 for	 Structured	Query	 Language.	
It	 is	 used	 for	 storing	 and	managing	 data	 in	
relational	 database	 management	 systems	
(RDMS).	 It	 is	 a	 standard	 Language	 for	
Relational	database	System.	It	enables	a	user	
to	 create,	 read,	 update	 and	 delete	 relational	
databases	and	tables.

SQL	 comprises	 both	 data	 definition	 and	
data	manipulation	 languages.	Using	 the	data	
definition	properties	of	SQL,	one	can	design	
and	 modify	 database	 schema,	 whereas	 data	
manipulation	 properties	 allow	 SQL	 to	 store	
and	retrieve	data	from	a	database.

SQL	 uses	 the	 following	 set	 of	 commands	 to	
define	a	database.

A.	CREATE 

Create	new	databases,	 tables	and	views	from	
RDBMS.

XI_Auditing_Chapter_10.indd   234 26-04-2022   18:24:09



235Auditing Related Computer Applications

Syntax: 

Create	database	students	record

Create	table	article

Create	view	for	–	students

B.	DROP

Drops	commands,	tables	and	databases	from	
RDBMS.

Syntax:	Drop	database	students	record

Drop	Table	article.

C.	ALTER :

Modifies	database

Syntax:	Alter	table	article	add	subject	varchar	
&	Date	time

A SELECT:	Statement	retrieves	zero	or	more	
rows	 from	 one	 or	 more	 database	 tables	 or	
database	views.	In	most	applications,	select	is	
the	most	commonly	used	Data	manipulation	
Language	(DML)	command.

The SELECT 

Statement	has	many	optional	clauses:

WHERE specifies	which	rows	to	retrieve

Order by	 specified	 an	 order	 in	 which	 to	
return	the	rows.

To

Retrieve	all	the	columns	in	a	table.

The	syntax	is	SELECT	from	<	Table	Name	>;

In	 order	 to	 execute	 queries	 click	 on	 the	
Queries	 option	 available	 on	 the	 left	 side	
under	the	database	section,	click	create	query	
in	SQL	view.

Data Sorting

10.23 Grouping of Data

To	 display	 the	 records	 containing	 the	 same	
type	of	values	 “WHERE”	clause	can	be	used	
with	the	select	SQL	command.

Ex.:	 To	 get	 details	 about	 the	 list	 of	 students	
whose	favorite	color	is	blue

Syntax	 used:	 Select	 from	 S	 Details	 Where	
color	=	‘Blue’;

   10.23.1 Create forms and 
reports using wizard 

Libreoffice	base	provides	the	form	&	reports	
feature	for	data	entry	purposes.	Both	reports	
and	 forms	 are	 considered	 as	 objects	 of	 the	
database	and	are	present	in	the	database	pane	
of	the	libreoffice	Base	user	interface.

   10.23.2 Forms in Base 

A	 form	 is	 an	object	of	 the	database	 that	has	
a	 user-friendly	 interface	 where	 data	 can	 be	
entered	and	seen	in	an	attractive	and	easy	to	
read	format.

XI_Auditing_Chapter_10.indd   235 26-04-2022   18:24:09



236 Auditing Related Computer Applications

   10.23.3 Creating a form 
using wizard 

This	 is	 the	 simplest	 way	 to	 create	 a	
form.

Steps	 to	 create	 form	 using	 form	
wizard

Step 1:	 Open	 the	 Database	 created	
in	Libreoffice	and	click	the	form	icon	
on	the	database	pane.

Step 2:	To	select	the	tables	or	queries	
for	which	the	form	has	to	be	created,

Step 3:	 After	 selecting	 the	 table,	 all	
the	fields	of	the	table	will	be	listed	in	
the	available	fields	list	Box.’

Step 4:	to	appear	all	the	fields	in	the	
form,	 shift	 all	 the	fields	of	 the	 table	
from	available	field’s	list	box	to	fields	
in	the	form	list	box	using	>>	button.

Click	 on	 the	 next	 button	 to	 move	
forward.

Step 5:	 To	 apply	 styles	 to	 the	 form	
being	created

Step 6:	Click	 the	next	 button	 to	 set	
the	name	of	the	form.

Step 7:	Click	the	Finish	button.

Managing a form:

To	manage	a	form	click	on	the	forms	
object	 in	 the	 Database	 pane	 and	
select	the	form	from	the	forms	pane.

Use	the	forms	toolbar	to	open,	edit,	
enter	or	remove	data,	to	modify	data,	
to	change	label	background,	to	search	
record	 and	 to	 insert	 and	 delete	 the	
data	in	forms.

   10.23.4 Steps to Create 
Report Using Wizards

Report	 helps	 to	 present	 information	 from	 the	
database	 in	 an	 easy	 to	 read,	 visually	 printable	
format.

Libre	 office	 Base	 makes	 it	 easy	 to	 create	 and	
customize	a	report	using	data	from	the	database.

To	 create	 Reports	 using	 wizard	 is	 the	
recommended	method	for	quickly	and	easily	
creating	a	report.

STEPS:

Step 1:	From	the	database	pane	view	
select	reports.

Step 2:	 Task	 view	will	 appear	 from	
that	 click	 “Use	 wizard	 to	 create	
Report”	options.

Step 3:	In	this	step,	select	the	tables’	
fields	that	are	to	be	displayed	in	the	
report.

Eg.	 From	 the	 ‘student	 record’	
Database,	choose	fields	in	reports.

Reg.	No./	Name	of	the	student	/	DOB

Step 4:	Click	the	next	button	and	the	
report	generates	labels	for	each	field.

Step 5:	 A	 Report	 can	 group	 the	
results	by	one	or	more	fields

Eg.	:	To	group	the	results	by	assigning	
names	as	‘student	info’.

Step 6:	In	this	step,	choose	the	layout	
for	the	data	&	the	headers	and	footers	
of	the	report.

Step 7:	 Here	 we	 specify	 the	 ‘Title’	
and	the	‘Type’	of	the	report

Step 8:	 Click	 “Crete	 Report	 Now”	
option

Step 9:	Click	the	‘finish’	button.
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Objective Types (10x1 = 10 Marks)

I. Choose the correct answer:

1.	 DBMS	stand	for	
a.	 Database	management	system

b.	 Data	building	master	system

c.	 Data	bundle	management	system

d.	 Databank	management	services.

2.	 A	 Database	 is	 Collection	 of	

a.	 Unorganized	data

b.	 Logically	related	data

c.	 Irrelevant	data

d.	 Queries	

3.	 The	 relational	 Database	 Model	 was	
proposed	in	

a.	 1980

b.	 1975

c.	 1970

d.	 1972

4.	 A	 collection	 of	 	
makes	a	table

a.	 Field

b.	 Table

c.	 Database

d.	 Record.

 EVALUATION 

•	 A	DBMS	is	a	software	tool.
•	 A	database	is	a	collection	of	data	in	an	organized	manner.
•	 A	Database	is	usually	controlled	by	a	database	management	system.
•	 Data	 in	 the	database	 can	be	grouped	or	 segregated	using	primary,	 composite	primary	

and	Foreign	Keys.
•	 Libreoffice	Base	is	one	of	the	DBMS	software.
•	 SQL	is	a	standard	language	for	storing,	retrieving	and	managing	data	in	a	database.

POINTS TO BE REMEMBERED:

•	 Data	–	Data	are	individual	facts,	statistics,	or	items	of	information,	often	numeric.	In	a	
more	technical	sense.

•	 Database	 –	A	 database	 is	 an	 organized	 collection	 of	 structured	 information	 or	 data,	
typically	stored	electronically	in	a	computer	system.

•	 SQL	–	SQL	stands	for	structured	Query	Language.	It	is	used	for	storing	and	managing	
data	in	relational	database	management	systems	(RDMS).

•	 DBMS –	A	database	management	system	(DBMS)	is	a	software	tool	to	organize	(create,	
retrieve,	update	and	manage)	data	in	a	database.

KEY TERMS
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5.	 	key	is	
uniquely	identified	the	rows	in	a	table

a.	 Composite	Primary	Key

b.	 Foreign	Key	

c.	 Primary	key

d.	 Composite	Key	

6.	 Which	 one	 is	 the	 DBMS	 software	
from	the	following?

a.	 Linux	

b.	 Windows	

c.	 Libreoffice	base

d.	Mac	

7.	 	 is	
the	recommended	method	to	quickly	
and	easily	create	a	report.	

a.	 Design	view

b.	 Wizard	

c.	 SQL	view

d.	 Table	view

8.	 	can	
present	 data	 in	 the	 database	 in	 an	
attractive	and	easy	to	read	format.

a.	 Forms

b.	 Report

c.	 Table

d.	Wizard

9.	 The	_____________________	key	is	
used	 to	 link	 two	 tables	 together	 via	
the	primary	key.

a.	 Primary	Key

b.	 Composite	Key

c.	 Foreign	Key

d.	 Composite	Primary	Key	

10.	 	Types	
of	relationships	in	creation	of	tables.

a.	 3

b.	 4	

c.	 2	

d.	 5	

Answers: 1. (a); 2. (b); 3. (c); 4. (a); 5.(c) 6. (c); 7. (b); 8. (a); 9. (c); 10.(a)  

Part - B

II. Very Short Answers: 5 x 3 = 15 Marks

1.	 Define	DBMS

2.	 What	is	the	primary	key?

3.	 Classify	Data	types	in	Database?

4.	 What	 are	 the	 types	 of	 relationships	 in	
tables?

5.	 What	is	a	Query?

Part - C

III. Short Answers: 3 x 5 = 15 Marks

1.	 What	are	the	features	of	DBMS?

2.	 Define	the	concept	of	relational	Database	
and	its	elements.

3.	 Explain	 about	 different	 types	 of	 keys	 in	
Relational	Database.
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Part - D

IV. Essay type Questions: 2 x 10 = 20 Marks

1.	 Explain	 about	 creating	 and	 editing	
relationships	between	Tables.

2.	 Explain	 about	 types	 of	 operations	
performed	on	Table.

Activity

Teachers Activity

1.	 Teach	 the	 students	 about	 the	 procedure	
to	 download	 Libreoffice	 Base	 DBMS	
Software.

2.	 Teach	the	students	about	the	functions	of	
DBMS	software.

Student Activity

1.	 Perform	step	by	step	procedure	for		
creating	a	form	losing	a	wizard.

SIMPLE ASSESSMENTS:

1	____________ can	be	used	in	spreadsheet	
software	to	jump	to	a	different	location	from	
within	a	spreadsheet 

2.	 A	 __________	 is  an	 action	 or	 a	 set	 of	
actions	 that	 you	 can	 run	 as	many	 times	 as	
you	want	in	spreadsheet.

3.	 __________refers	 to	 a	 cell	 or	 a	 range	 of	
cells	on	a	worksheet.

4.	__________	short	cut	key	is	used	to	open	
an	existing	workbook.

5.	 ___________	 short	 cut	 key	 is	 used	 to	
insert	a	new	worksheet.

Answer	(1.	hyper	link	2.	macro		
3.	cell	reference	4.	ctrl+o	5.	shift+f11)

References:

1.	 www.psscove.ac.in

2.	 http://en.m.wikipedia.org

3.	 Other	relevant	websites.
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